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ΕΙΣΑΓΩΓΗ 

Σκοπός της εργασίας είναι η δημιουργία ενός εκπαιδευτικού DVD για 
την εκμάθηση του λογισμικού Avid Xpress. 

Μέσα σε αυτόν τον εκπαιδευτικό οδηγό, οι χρήστες θα ξεναγηθούν στο 
περιβάλλον εργασίας του Avid Xpress, θα μάθουν πως να εισάγουν 
αρχεία, πώς να χειρίζονται τα αρχεία, να δημιουργούν ακολουθίες και 
να επεξεργάζονται τις ακολουθίες. Θα μάθουν να εφαρμόζουν εφέ στην 
ακολουθία, να επεξεργάζονται τα ηχητικά μέρη και να εφαρμόζουν 
διόρθωση χρωμάτων στα κλιπ. Επίσης θα εκπαιδευτούν να κάνουν 
trimming στα κλιπ και να εφαρμόζουν τίτλους. Τέλος θα μάθουν πώς να 
εξάγουν το υλικό τους σε διάφορους τύπους αρχείων. 

 

ΛΙΓΑ ΛΟΓΙΑ ΓΙΑ ΤΗΝ ΕΦΑΡΜΟΓΗ 

Το Avid Xpress Pro είναι ένα μη-γραμμικό λογισμικό επεξεργασίας 
βίντεο που απευθύνεται στους επαγγελματίες της τηλεόρασης και της 
βιομηχανίας του κινηματογράφου. Το Xpress Pro περιλαμβάνει πολλές 
από τις high-end λειτουργίες επεξεργασίας που προσφέρονται από 
άλλα συστήματα επεξεργασίας της Avid και είναι αρκετά βασισμένο στα 
συστήματα Avid Media Composer. Σε συνδυασμό με το Avid Mojo 
hardware, παρέχει σε πραγματικό χρόνο την επεξεργασία ασυμπίεστου 
βίντεο σε επαγγελματικό επίπεδο. Το Xpress Pro είναι σε θέση να 
μοιράζεται αρχεία πολυμέσων, με τα προηγμένα συστήματα 
επεξεργασίας Media Composer της Avid, καθιστώντας το ικανό logging ή 
offline σύστημα επεξεργασίας για τα μεγάλα έργα. 
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Κεφάλαιο 1  

Ξεκινώντας 

1.1 Εκκίνηση της εφαρμογής Avid Xpress Pro 

Για να εκκινήσετε την εφαρμογή κάντε ένα από τα παρακάτω: 

Ø Διπλό κλικ στο εικονίδιο Avid Xpress Pro στην επιφάνεια εργασίας. 

 
1.1.1 Εκκίνηση της εφαρμογής 

Ø Πηγαίνετε Έναρξη > Όλα τα προγράμματα > Avid >Avid Xpress. 

 
1.1.2 Εκκίνηση της εφαρμογής 
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1.1.3 Εκκίνηση της εφαρμογής 

 

1.2 Δημιουργία ενός νέου Project 

Αφού έχετε εκκινήσει την εφαρμογή, το πρώτο παράθυρο που θα δείτε, 
είναι το παράθυρο του Select Project.  

 
1.2.1 Το παράθυρο του Select Project 

Ας ρίξουμε μια γρήγορη ματιά στα διάφορα στοιχεία που περιέχει. Το 
πρώτο στοιχείο είναι το User. Το User μας δείχνει τον χρήστη ο οποίος 
έχει κάνει log on στην εφαρμογή τη συγκεκριμένη στιγμή. Το δεύτερο 
στοιχείο είναι το Folder το οποίο μας δείχνει τη διαδρομή για το φάκελο 
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στον οποίο έχουμε αποθηκεύσει κάποιο Project. Το στοιχείο User 
Profile μας δίνει τη δυνατότητα: 

Ø Να αλλάξουμε χρήστη εφόσον υπάρχουν και άλλοι χρήστες. 
Ø Να δημιουργήσουμε ένα νέο χρήστη. 
Ø Να εισάγουμε χρήστη ή προφίλ χρήστη. Αν έχουμε σε κάποια 

εξωτερική πηγή κάποιο χρήστη ή χρήστη προφίλ, μπορούμε να το 
εισάγουμε. 

Στο παραθυράκι Select a Project μας δίνεται η δυνατότητα τριών 
επιλογών για το σημείο αποθήκευσης του νέου Project στο σύστημα, 
αυτές είναι: 

1. Private: Η οποία αποθηκεύει το Project στον ιδιωτικό φάκελο του 
χρήστη του συστήματος και αυτό σημαίνει ότι μόνο ο 
συγκεκριμένος χρήστης έχει τη δυνατότητα πρόσβασης σε αυτό το 
Project. 

2. Shared: Η οποία αποθηκεύει το Project στον κοινόχρηστο φάκελο 
του συστήματος και αυτό σημαίνει ότι όλοι οι χρήστες μπορούν να 
έχουν τη δυνατότητα πρόσβασης σε αυτό το Project. 

3. External: Η οποία μας δίνει τη δυνατότητα να ορίσουμε εμείς το 
σημείο αποθήκευσης που επιθυμούμε στο σύστημα ή στο δίκτυο, το 
οποίο μπορεί να γίνει πατώντας το εικονίδιο του φακέλου δεξιά του 
πλαισίου Folder . 

Πατώντας καθεμιά από αυτές τις επιλογές, παρατηρήστε στο πλαίσιο 
Folder τη διαδρομή που αλλάζει σε συγκεκριμένη διαδρομή κάθε φορά 
ανάλογα με την επιλογή. 

Επίσης, σε περίπτωση που υπάρχουν αποθηκευμένα projects σε κάποια 
από τις τρείς ή και στις τρείς επιλογές, αυτά τα Project εμφανίζονται με 
τις ονομασίες που τους έχουν δοθεί, στο παραθυράκι αριστερά των 
τριών επιλογών. 

Εφόσον έχουμε επιλέξει το που θα αποθηκεύσουμε το καινούριο μας 
project, πατάμε στο κουμπί New Project. Έχοντας πατήσει το κουμπί 
New Project, εμφανίζεται το παράθυρο New Project.  
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1.2.2 Το παράθυρο New Project 

Δίνουμε την ονομασία που επιθυμούμε για το project μας, στο πλαίσιο 
Project Name και επιλέγουμε το Format (πρότυπο) το οποίο θέλουμε να 
έχει το project μας. Η εφαρμογή διαθέτει όλα τα Format από τα 
στάνταρ – ευκρίνειας NTSC και PAL έως και τα υψηλής ευκρίνειας HDV.  

Αφού έχετε δώσει την ονομασία που επιθυμείτε και το Format, πατήστε 
το OK. Παρατηρήστε ότι μόλις πατήσατε OK στο New Project, αμέσως 
εμφανίστηκε το project με την ονομασία που του δώσατε στο μικρό 
πλαίσιο του Select a Project. 

 
1.2.1 Το παράθυρο του Select Project 

Έχοντας κάνει όλα τα παραπάνω, πατήστε το OK στο παράθυρο Select 
Project για να μπείτε στην εφαρμογή και να δουλέψετε με το project 
σας ή εφόσον επιθυμείτε να δουλέψετε αργότερα, πατήστε το Quit και 
στο παράθυρο που εμφανίζεται  
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πατήστε το Leave για να εγκαταλείψετε την εφαρμογή. 

1.3 Διαγραφή ενός Project. 

Για να διαγράψετε κάποιο project, κάντε ένα από τα παρακάτω: 

Ø Από το παράθυρο του Select Project, επιλέξτε το project που θέλετε 
να διαγράψετε και πατήστε το πλήκτρο Delete από το πληκτρολόγιο 
σας. Στο προειδοποιητικό παράθυρο που εμφανίζεται πατήστε Ok. 

Ø Εντοπίστε το φάκελο του Project στο σύστημα σας και διαγράψτε 
το. 

1.4 Ξενάγηση στις εφαρμογές 

Αφού μπείτε στην εφαρμογή κάνοντας τα παραπάνω, η εφαρμογή 
ανοίγει στην Basic Toolset μορφή της και τα παράθυρα που 
εμφανίζονται είναι: 

Ø Το παράθυρο του Project. Το παράθυρο του Project σας παρέχει 
τον έλεγχο για την οργάνωση και την εξέταση σημαντικών 
πληροφοριών σχετικά με το τρέχων project σας. Μπορείτε να 
τροποποιήσετε διάφορες ρυθμίσεις από το παράθυρο του Project 
και να εμφανίσετε μια λίστα από εφέ. 

Ø Το παράθυρο του Bin. Το παράθυρο του Bin χρησιμοποιείται για 
την αποθήκευση και οργάνωση του υλικού σας. 

Ø Το παράθυρο του Timeline. Το παράθυρο του Timeline σας δίνει τη 
δυνατότητα να δημιουργείτε ακολουθίες από βίντεο και ήχο από το 
υλικό που έχετε εισάγει, να κάνετε περαιτέρω επεξεργασία με το 
σύνολο από εργαλεία επεξεργασίας που διαθέτει το Timeline καθώς 
και να εφαρμόζετε εφέ. 

Ø Το παράθυρο του Composer. Τα κομμάτια ήχου και βίντεο που 
έχουν εισαχθεί στο Timeline, παίζουν στην οθόνη του Composer. Η 



Σελίδα | 19  
 

οθόνη του Composer έχει και αυτή ένα σύνολο από εργαλεία 
επεξεργασίας για περαιτέρω επεξεργασία της ακολουθίας σας. 

 
1.4.1 Η Basic Toolset εμφάνιση της εφαρμογής 

1.5 Χρήση συντομεύσεων πληκτρολογίου 

Η εφαρμογή έχει προσαρμοσμένα από προεπιλογή, πολλά από τα 
κουμπιά της εφαρμογής, σε πλήκτρα του πληκτρολογίου. Για να δείτε 
την αντιστοίχηση των κουμπιών με τα πλήκτρα, πηγαίνετε στο 
παράθυρο του Project > καρτέλα Settings > διπλό κλικ στο keyboard. Θα 
σας ανοίξει το παράθυρο του Keyboard, με τα σύμβολα των διαφόρων 
κουμπιών, πάνω στα πλήκτρα ενός εικονικού πληκτρολογίου. 

 
1.5.1 Το παράθυρο του Keyboard 
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Για να προσαρμόσετε τα κουμπιά στα πλήκτρα όπως εσείς επιθυμείτε, 
ανοίγετε το παράθυρο του Keyboard και το παράθυρο Command 
Palette από το μενού της εφαρμογής Tools > Command Palette ή Ctrl + 
3, όπου υπάρχουν όλα τα κουμπιά της εφαρμογής ταξινομημένα ανά 
κατηγορίες.  

 
1.5.2 Το παράθυρο Command Palette 

Επιλέξτε την επιλογή Button to Button Reassignment αν δεν είναι ήδη 
επιλεγμένη και κάντε κλικ στα κουμπιά που χρειάζεστε και σύρετε τα 
στα πλήκτρα του πληκτρολογίου που επιθυμείτε. 

Μπορείτε επίσης να προσαρμόσετε σε πλήκτρο του πληκτρολογίου, 
κάποια εντολή από το μενού της εφαρμογής. Για να το πετύχετε, 
επιλέξτε την επιλογή Menu to Button Reassignment στο παράθυρο 
Command Palette, στη συνέχεια κάντε κλικ σε ένα πλήκτρο στο 
παράθυρο του Keyboard και μετά επιλέξτε κάποια εντολή από το μενού 
της εφαρμογής. 

Η επιλογή Active Palette στο παράθυρο Command Palette, ενεργοποιεί 
τα κουμπιά ώστε να μπορείτε να δείτε τη λειτουργία τους. 

Για να επιστρέψετε στην προεπιλεγμένη προσαρμογή των πλήκτρων, 
πηγαίνετε στην καρτέλα Settings > δεξί κλικ στο Keyboard > Restore to 
default > Restore. Σε περίπτωση που θέλετε να κρατήσετε ένα 
αντίγραφο των δικών σας προσαρμογών επιλέξτε το Copy & Restore. 

Μια καλή πρακτική θα ήταν, να κάνετε αντίγραφο του Keyboard στην 
καρτέλα Settings και αφού του δώσετε ονομασία, να πραγματοποιήσετε 
εκεί τις όποιες αλλαγές σχετικά με τα πλήκτρα. Για να κάνετε αντίγραφο 
του Keyboard, κάντε δεξί κλικ πάνω στο Keyboard στην καρτέλα Settings 
και επιλέξτε το Duplicate. Σε περίπτωση που δεν φανεί το αντίγραφο 
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του Keyboard σας, κάντε δεξί κλικ σε κενό χώρο της καρτέλας Settings 
και επιλέξτε το All Settings. 

1.6 Προσαρμογή των παραθύρων σας 

Μπορείτε να προσαρμόσετε τα παράθυρα στην εφαρμογή όπως εσείς 
επιθυμείτε, απλά μεταφέροντας τα στη θέση που θέλετε και 
μεγαλώνοντας ή μικραίνοντας τα, για να σας βολεύουν στην εργασία 
σας. Οι αλλαγές σας αυτές αποθηκεύονται αυτόματα στην επιλογή 
Workspace στην καρτέλα Settings και κάθε φορά που θα ανοίγετε την 
εφαρμογή θα εμφανίζονται τα παράθυρα όπως τα έχετε οργανώσει.  

Εναλλακτικά μπορείτε να φτιάξετε πολλαπλά περιβάλλοντα εργασίας, 
που μπορεί να χρειαστείτε για διαφορετικές περιπτώσεις εργασίας. 
Κάντε δεξί κλικ στην επιλογή Workspace στην καρτέλα Settings και από 
το μενού επιλέξτε το Duplicate, με αυτή την επιλογή κάνετε ένα 
αντίγραφο του αρχικού Workspace, του δίνετε την ονομασία που 
επιθυμείτε και το οργανώνεται εξαρχής όπως το χρειάζεστε. 

Η εφαρμογή διαθέτει και προκαθορισμένες προσαρμογές που μπορείτε 
να χρησιμοποιήσετε. Μπορείτε να τις επιλέξετε από το μενού Toolset 
και είναι οι παρακάτω: 

Ø Basic. Το Basic Toolset, ανοίγει με το βασικό σύνολο παραθύρων της 
εφαρμογής, που είναι το παράθυρο του Project, το παράθυρο του 
Bin, το παράθυρο του Composer και το Timeline. 

Ø Color Correction. Το Color Correction Toolset, εμφανίζει το 
Composer με τρείς οθόνες και ανοίγει την εργαλειοθήκη διόρθωσης 
χρωμάτων. 

Ø Source/Record Editing. To Source/Record Editing Toolset, εμφανίζει 
το Composer με διπλή οθόνη με το Source Monitor στα αριστερά και 
το Record Monitor στα δεξιά. Μπορείτε να επεξεργάζεστε τα κλιπ 
στο Source Monitor και τις ακολουθίες στο Record Monitor. 

Ø Effects Editing. To Effects Editing Toolset, εμφανίζει το Effect editor, 
την καρτέλα των εφέ στο παράθυρο του Project, το παράθυρο του 
Bin, το παράθυρο του Composer και το Timeline. 
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Ø Audio Editing. To Audio Editing Toolset, εμφανίζει το Audio Mixer, 
το Audio Tool, το παράθυρο του Project, το παράθυρο του Bin, το 
παράθυρο του Composer και το Timeline. 

Ø Capture. To Capture Toolset, εμφανίζει το Capture Tool, το 
παράθυρο του Project, το παράθυρο του Bin, το παράθυρο του 
Composer και το Timeline. 

1.7 Κλείσιμο της εφαρμογής 

Για να κλείσετε την εφαρμογή, κάντε ένα από τα παρακάτω: 

Ø Πατήστε το κουμπί κλεισίματος  της εφαρμογής, πάνω δεξιά. 
Εμφανίζεται το παράθυρο Leave Application?, πατήστε το Ok για να 
κλείσετε την εφαρμογή ή πατήστε Cancel ή το κουμπί κλεισίματος 
για να ακυρώσετε το κλείσιμο. 

Ø Από τη γραμμή μενού της εφαρμογής, πηγαίνετε File > Exit ή Ctrl + 
Q. 

Ø Από τη γραμμή μενού της εφαρμογής, πηγαίνετε File > Close Project 
ή Ctrl + W και από το παράθυρο του Select Project επιλέξτε το Quit 
και ύστερα Leave. 

Ø Πατήστε το κουμπί κλεισίματος του παραθύρου του Project και από 
το παράθυρο του Select Project επιλέξτε το Quit και ύστερα Leave. 
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Κεφάλαιο 2  

Το Παράθυρο του Project 

Το παράθυρο του Project, είναι ίσως το πιο σημαντικό παράθυρο της 
εφαρμογής και στο οποίο θα αναφέρεστε συχνά κατά τη διάρκεια της 
εργασίας σας. Το παράθυρο του Project έχει πέντε καρτέλες, οι οποίες 
είναι: 

Ø Η καρτέλα Bins 
Ø Η καρτέλα Settings 
Ø Η καρτέλα Effect 
Ø Η καρτέλα Format 
Ø Η καρτέλα Info 

 

2.1 Η καρτέλα Bins  

Η καρτέλα Bins είναι η καρτέλα στην οποία βρίσκονται όλα τα Bins που 
δημιουργείτε για το Project σας. Το Bin είναι ουσιαστικά ένας φάκελος 
που μπορείτε να χρησιμοποιήσετε για να αποθηκεύετε οποιοδήποτε 
αριθμό στοιχείων, που μπορεί να είναι βίντεο, ήχος, γραφικά κτλ. 
Περισσότερα για την καρτέλα Bins θα αναλύσουμε στο Κεφάλαιο 3. 

 
2.1.1 Η καρτέλα Bins 
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2.2 Η καρτέλα Settings 

Στην καρτέλα Settings εμφανίζεται μία λίστα με τις διαθέσιμες 
ρυθμίσεις για την εφαρμογή. Δίπλα από τις ρυθμίσεις υπάρχει το τικ το 
οποίο σημαίνει ότι η αντίστοιχη ρύθμιση είναι ενεργή. Κάνοντας διπλό 
κλικ σε κάθε μία από τις επιλογές αυτές, ανοίγει ένα παράθυρο 
ρυθμίσεων το οποίο σας δίνει τη δυνατότητα να κάνετε τις ρυθμίσεις 
που επιθυμείτε για την εμφάνιση και τη συμπεριφορά της εφαρμογής. 
Περισσότερα για τις ρυθμίσεις θα ανατρέχουμε και θα εξηγούμε στα 
επόμενα κεφάλαια. 

 
2.2.1 Η καρτέλα Settings 

 

2.3 H καρτέλα Effect 

Η καρτέλα των εφέ έχει τα εφέ τα οποία είναι διαθέσιμα από την 
εφαρμογή και είναι οργανωμένη σε δύο στήλες. Στην αριστερή στήλη 
εμφανίζονται οι κατηγορίες των εφέ. Κάνοντας κλικ σε μία κατηγορία, 
στην δεξιά στήλη παρουσιάζονται τα εφέ που ανήκουν στην κατηγορία 
αυτή.  
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Κάποια από αυτά τα εφέ είναι τα μεταβατικά εφέ (Transitions) τα οποία 
τοποθετούνται ενδιάμεσα από δύο κλιπ στην ακολουθία, ώστε να 
επηρεάζουν τη μετάβαση από το ένα κλιπ στο άλλο και τα άλλα είναι τα 
εφέ τα οποία τοποθετούνται επάνω στο κλιπ και επηρεάζουν την εικόνα 
του κλιπ. Περισσότερες πληροφορίες για τα εφέ θα αναλύσουμε στο 
''Κεφάλαιο 11: Δουλεύοντας με τα Εφέ''. 

 
2.3.1 Η καρτέλα Effect 

 

2.4 Η καρτέλα Format 

Η καρτέλα Format σας επιτρέπει να δείτε τις βασικές πληροφορίες για 
το Project, όπως τη μορφή βίντεο (PAL, για παράδειγμα). Οι 
πληροφορίες που σας εμφανίζονται, δείχνουν τις επιλογές που κάνατε 
στο παράθυρο New project όταν δημιουργήσατε το Project. 

Το Project Type μενού σας επιτρέπει να αλλάξετε το πρότυπο του 
project σε ένα άλλο το οποίο έχει το ίδιο ρυθμό καρέ. Για παράδειγμα, 
αν εργάζεστε σε 1080i/59.94 HD project, μπορείτε να αλλάξετε το 
πρότυπο του project σε 30i NTSC. 
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Για τα 24p PAL projects,η οθόνη του Format σας δείχνει τον ρυθμό 
μετάδοσης του ήχου που επιλέξατε όταν δημιουργήσατε το project. Ο 
πραγματικός ρυθμός μετάδοσης του ήχου μπορεί να είναι διαφορετικός 
από αυτόν που δείχνει στην οθόνη εφόσον έχετε χρησιμοποιήσει το 
παράθυρο διαλόγου Film settings για να αλλάξετε τον ρυθμό μετάδοσης 
του ήχου.  

 
2.4.1 Η καρτέλα Format 

2.5 Η καρτέλα Info 

 
2.5.1 Η καρτέλα Info 
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Η καρτέλα Info σας επιτρέπει να δείτε πληροφορίες σχετικά με: 

Ø Την χωρητικότητα των σκληρών σας δίσκων. 
Για να εμφανίσετε τις πληροφορίες για την χωρητικότητα των 
σκληρών σας δίσκων πατήστε το κουμπί Hardware και στο 
παράθυρο Hardware Tool επιλέξτε την καρτέλα Drives. 

 
2.5.2 Η καρτέλα Drives του παράθυρου Hardware Tools 

 
Ø Το λειτουργικό σας σύστημα. 

Για να εμφανίσετε τις πληροφορίες για το λειτουργικό σας σύστημα 
πατήστε το κουμπί Hardware και στο παράθυρο Hardware Tool 
επιλέξτε την καρτέλα System. 

 
2.5.3 Η καρτέλα System του παράθυρου Hardware Tools 

 
Ø Τη μνήμη του συστήματος. 

Για να εμφανίσετε τις πληροφορίες για τη μνήμη του συστήματος 
πατήστε το κουμπί Memory. 

 
2.5.4 Το παράθυρο Memory 
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Η καρτέλα Info, σας δίνει επίσης και την λειτουργία εκκαθάρισης της 
μνήμης των Bin. Για να καθαρίσετε τη μνήμη των Bin, πατήστε το 
κουμπί Clear Bin Memory και στο παράθυρο που θα εμφανιστεί 
πατήστε το Ok. 

 
2.5.5 Το παράθυρο με το προειδοποιητικό μήνυμα του Clear Bin Memory 
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Κεφάλαιο 3  

Δουλεύοντας με την καρτέλα Bins και το 
παράθυρο Bin 

3.1 Δουλεύοντας με την καρτέλα Bins 

 
3.1.1 Η καρτέλα Bins 

3.1.1 Δημιουργία νέου Bin 

Όταν δημιουργείτε νέο Project, δημιουργείται αυτόματα ένα νέο Bin 
στην καρτέλα Bins. Μπορείτε να δημιουργήσετε και άλλα Bin κάνοντας 
ένα από τα παρακάτω: 

Ø Κάντε κλικ στο κουμπί New Bin . 
Ø Από το Fast Menu  της καρτέλας Bin, επιλέξτε το New Bin. 
Ø Δεξί κλικ σε κενό χώρο και επιλέξτε το New Bin. 
Ø Από το πληκτρολόγιο πατήστε Ctrl + N. 

Όταν δημιουργείται το νέο Bin, αυτό ανοίγει αυτόματα στο παράθυρο 
του. 

3.1.2 Δημιουργία φακέλου 

Μπορείτε επίσης να δημιουργήσετε φακέλους μέσα στην καρτέλα Bins, 
στους οποίους θα αποθηκεύετε τα Bin σας και θα σας βοηθήσουν να 
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οργανώσετε καλύτερα τα Bin σας. Για να δημιουργήσετε ένα φάκελο, 
κάντε ένα από τα παρακάτω: 

Ø Από το Fast Menu  επιλέξτε το New Folder. 
Ø Δεξί κλικ στο κενό χώρο και επιλέξτε το New Folder. 

Δημιουργείται ο φάκελος σας και μπορείτε να αποθηκεύσετε τα Bin που 
επιθυμείτε, απλά πιάνοντας και σύροντας τα (drag and drop) πάνω στο 
φάκελο στον οποίο θέλετε να αποθηκευθούν. 

Για να εμφανίσετε τα περιεχόμενα του φακέλου, κάντε κλικ στο 

τριγωνάκι αριστερά του φακέλου  ή κάντε διπλό κλικ στο 
εικονίδιο του φακέλου . 

3.1.3 Μετονομασία Bin και φακέλου 

Όταν δημιουργείτε νέο Bin ή φάκελο, το Bin παίρνει αυτόματα το όνομα 
που έχετε δώσει στο Project και ο φάκελος την ονομασία Untitled 
Folder, τα οποία είναι φωτισμένα και μπορείτε να τα μετονομάσετε 
πληκτρολογώντας την ονομασία που επιθυμείτε και πατώντας ύστερα 
το Enter. 

                       
3.1.2 Νέο Bin με φωτισμένη ονομασία                    3.1.3 Νέος φάκελος με φωτισμένη ονομασία 

 
Εάν θελήσετε να αλλάξετε το όνομα σε ήδη υπάρχων Bin ή φάκελο, 
κάντε ένα κλικ πάνω στο όνομα του Bin ή του φακέλου που θέλετε να 
μετονομάσετε, αυτό φωτίζεται και σας δίνει τη δυνατότητα να 
πληκτρολογήσετε το νέο όνομα. 

3.1.4 Τρόποι επιλογής, απoεπιλογής των Bin και των 
φακέλων 
Για να επιλέξετε ένα Bin ή ένα φάκελο, κάντε ένα από τα παρακάτω: 

Ø Μονό κλικ στο τετραγωνάκι  αριστερά του ονόματος του Bin 
Ø Μονό κλικ στο εικονίδιο του φακέλου  αριστερά του ονόματος του 

φακέλου. 
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Για να επιλέξετε περισσότερα από ένα Bin ή φάκελο, κάντε ένα από 
τα παρακάτω: 

Ø Έχοντας πατημένο το Ctrl στο πληκτρολόγιο, κάντε μονό κλικ στα 
τετραγωνάκια  ή στα φακελάκια  ή και στα δυο, αριστερά των 
Bin ή των φακέλων που θέλετε να επιλέξετε. 

Ø Κάντε κλικ και κρατήστε το πλήκτρο του ποντικιού πατημένο στο 
κενό χώρο στην καρτέλα Bin και σύρετε το ποντίκι προς τη μεριά 
των bin ή των φακέλων που θέλετε να επιλέξετε. 

Για να επιλέξετε όλα τα στοιχεία της καρτέλας Bins, κάντε ένα από τα 
παρακάτω: 

Ø Πατήστε από το πληκτρολόγιο Ctrl + A. 
Ø Κάντε κλικ και κρατήστε το πλήκτρο του ποντικιού πατημένο στο 

κενό χώρο στα αριστερά ή στα δεξιά ή κάτω της καρτέλας Bins και 
σύροντας το ποντίκι, επιλέξτε όλα τα στοιχεία. 

Ø Από το μενού της εφαρμογής, πηγαίνετε Edit > Select-All. 

Όταν κάποιο στοιχείο είναι επιλεγμένο, είναι φωτισμένο με μία μπλε 
γραμμή. 

 
3.1.4 Επιλεγμένο στοιχείο στην καρτέλα Bins 

Για να αποεπιλέξετε ένα ή περισσότερα στοιχεία, κάντε ένα από τα 
παρακάτω:  
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Ø Κάντε κλικ σε οποιοδήποτε κενό χώρο της καρτέλας Bins. 
Ø Από το μενού της εφαρμογής πηγαίνετε Edit > Deselect-All. 
Ø Πατήστε από το πληκτρολόγιο Shift + Ctrl +A. 

3.1.5 Άνοιγμα του Bin 

Για να ανοίξετε ένα Bin, κάντε ένα από τα παρακάτω: 

Ø Διπλό κλικ στο τετραγωνάκι  αριστερά του ονόματος του Bin. 
Ø Επιλέξτε το Bin και από το Fast Menu  επιλέξτε το Open Selected 

Bins. 
Ø Κάντε δεξί κλικ στο Bin που θέλετε να ανοίξετε και επιλέξτε το Open 

Selected Bins. 
Ø Επιλέξτε το Bin και πατήστε Ctrl + O από το πληκτρολόγιο. 

Για να ανοίξετε περισσότερα από ένα Bin ταυτόχρονα, επιλέξτε τα Bin 
που θέλετε να ανοίξετε και κάντε ένα από τα παρακάτω: 

Ø Διπλό κλικ σε ένα τετραγωνάκι  από τα επιλεγμένα Bin. 
Ø Από το Fast Menu  επιλέξτε το Open Selected Bins. 
Ø Κάντε δεξί κλικ σε ένα από τα επιλεγμένα Bin και επιλέξτε το Open 

Selected Bins. 
Ø Πατήστε Ctrl + O από το πληκτρολόγιο. 

Το κάθε Bin ανοίγει σε δικό του ξεχωριστό παράθυρο. 

Για να εισάγετε ένα Bin από κάποια εξωτερική πηγή στην εφαρμογή, 
αποεπιλέξτε όλα τα στοιχεία σε περίπτωση που έχετε κάποιο 
επιλεγμένο και από το Fast Menu  ή πατώντας δεξί κλικ σε κενό 
σημείο, επιλέξτε το Open Bin ή πατήστε από το πληκτρολόγιο Ctrl + O. 
Στο παράθυρο Open a Bin αναζητήστε το Bin στην τοποθεσία που το 
έχετε αποθηκεύσει και πατήστε Άνοιγμα. 
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3.1.5 Το παράθυρο Open a Bin 

Το εισαγόμενο Bin σας θα τοποθετηθεί σε φάκελο με ονομασία Other 
Bins, την οποία μπορείτε να αλλάξετε και παραμένει εκεί, διότι δεν 
μπορείτε να το μετακινήσετε ανάμεσα στα Bin που δημιουργείτε. 

3.1.6 Κλείσιμο των Bin 

Για να κλείσετε ένα ή περισσότερα Bin που έχετε ανοιχτά, κάντε ένα 
από τα παρακάτω: 
Ø Πατήστε το κουμπί Close  του κάθε παραθύρου Bin. 
Ø Επιλέξτε τα Bin που θέλετε να κλείσετε από την καρτέλα των Bins 

και από το Fast Menu  επιλέξτε το Close Selected Bins. 
Ø Επιλέξτε τα Bin που θέλετε να κλείσετε από την καρτέλα των Bins 

και κάνοντας δεξί κλικ πάνω τους, επιλέξτε το Close Selected Bins. 
Ø Επιλέξτε τα Bin που θέλετε να κλείσετε από την καρτέλα των Bins 

και πατήστε Ctrl + W. 
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3.1.7 Διαγραφή Bin ή φακέλου. 

Για να διαγράψετε ένα ή περισσότερα Bins ή φακέλους, κάντε ένα 
από τα παρακάτω: 

Ø Επιλέξτε τα Bin που θέλετε να διαγράψετε και κάντε δεξί κλικ πάνω 
στα επιλεγμένα Bins και από το μενού επιλέξτε Delete Selected Bins. 
Αυτός ο τρόπος ισχύει για τους φακέλους, μόνο άμα επιλεχθούν να 
διαγραφούν μαζί με Bins, δεν ισχύει αν θέλετε να διαγράψετε μόνο 
φακέλους. 

Ø Επιλέξτε τα Bin ή τους φακέλους ή και τα δύο ταυτόχρονα και από 
το Fast Menu  επιλέξτε το Delete Selected Bins. 

Ø Επιλέξτε τα Bin ή τους φακέλους ή και τα δύο ταυτόχρονα και 
πατήστε το πλήκτρο Delete ή το πλήκτρο Backspace από το 
πληκτρολόγιο σας. 

Όταν διαγράφετε Bins ή φακέλους, το Avid δημιουργεί ένα κάδο 
ανακύκλωσης (Trash) στην καρτέλα Bins και αποθηκεύει προσωρινά 
εκεί τα διαγραφέντα στοιχεία ώστε να μπορείτε να τα επαναφέρετε σε 
περίπτωση που ξαναχρειαστείτε κάποιο από αυτά. 

 
3.1.6 Ο κάδος ανακύκλωσης (Trash) 

Για να αδειάσετε τον κάδο ανακύκλωσης και να διαγράψετε οριστικά 
τα περιεχόμενα του: 

Ø Επιλέξτε από το Fast Menu  την επιλογή Empty Trash 
Ø Κάντε δεξί κλικ στο κενό χώρο της καρτέλας ή πάνω σε κάποιο Bin 

και επιλέξτε το Empty trash. 
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Στο παράθυρο προειδοποίησης που εμφανίζεται πατήστε το Empty 
Trash. Πατήστε το Don’t Empty ή το κουμπί Close του παραθύρου, σε 
περίπτωση που δεν θέλετε να γίνει οριστική διαγραφή ακόμη. 

 
3.1.7 Το προειδοποιητικό παράθυρο του Empty Trash 

Για να επαναφέρετε κάποιο Bin ή κάποιο φάκελο από τον κάδο 
ανακύκλωσης, απλά σύρετε το από τον κάδο και αφήστε το πάνω στα 
υπόλοιπα αρχεία πάνω από τον κάδο. 

3.1.8 Reveal File 

Το Reveal File, είναι μια λειτουργία που σας επιτρέπει να εμφανίσετε σε 
παράθυρο των Windows την τοποθεσία στην οποία είναι 
αποθηκευμένο κάποιο Bin. Μπορείτε να το επιτύχετε με τρείς τρόπους. 
Αρχικά επιλέξτε τα Bin που θέλετε και στη συνέχεια: 

Ø Από το Fast Menu , επιλέξτε το Reveal File. 
Ø Δεξί κλικ πάνω στα Bin και επιλέξτε το Reveal File. 
Ø Από τη γραμμή μενού της εφαρμογής, πηγαίνετε File και επιλέξτε το 

Reveal File. 

Σε περίπτωση που τα Bin σας είναι αποθηκευμένα σε διαφορετικές 
τοποθεσίες, θα σας εμφανιστούν αντίστοιχα παράθυρα των Windows. 

 

3.1.9 Flat view 

Υπάρχει μια πολύ χρήσιμη λειτουργία στην καρτέλα Bins, όταν 
εργάζεστε με φακέλους, που λέγεται Flat view. Ας φανταστούμε ότι 
έχετε μεγάλο αριθμό από φακέλους και ο κάθε φάκελος περιέχει 
μεγάλο αριθμό από Bins και θέλετε να εντοπίσετε ένα συγκεκριμένο Bin 
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και έχετε ξεχάσει πού το έχετε βάλει. Πηγαίνετε στο Fast Menu  ή 
κάντε δεξί κλικ οπουδήποτε στην καρτέλα εκτός από τους φακέλους και 
επιλέξτε την επιλογή Flat view. Αφού την επιλέξετε, αυτή ουσιαστικά 
αφαιρεί τους φακέλους και σας εμφανίζει πάλι τα Bin, δηλαδή είναι σαν 
μια επισκόπηση των Bin σας. Και τώρα μπορείτε εύκολα να εντοπίσετε 
το Bin που χρειάζεστε και αφού το εντοπίσετε, μπορείτε να κλείσετε τη 
λειτουργία με τον ίδιο τρόπο και θα ξαναεμφανιστούν οι φάκελοι σας 
όπως ήταν πριν. 

    
3.1.8 Πριν την εφαρμογή Flat View                                        3.1.9 Μετά την εφαρμογή Flat View 

3.1.10 Αποθήκευση των Bin 

Τα Bin αποθηκεύονται στον φάκελο του Project σας, στην τοποθεσία 
που έχετε ορίσει στο παράθυρο του Select Project, όταν δημιουργήσατε 
το Project. Οι διάφορες τροποποιήσεις που κάνετε κατά τη διάρκεια της 
εργασίας σας στα Bin, αποθηκεύονται αυτόματα από την εφαρμογή ανά 
τακτά χρονικά διαστήματα, τα οποία είναι ορισμένα από προεπιλογή να 
αποθηκεύονται κάθε 15 λεπτά.  

Τα χρονικά αυτά διαστήματα, μπορείτε να τα αλλάξετε πηγαίνοντας 
στην καρτέλα Settings > διπλό κλικ στην επιλογή Bin και στο παράθυρο 
Bin Settings-Current που ανοίγει, στο πλαίσιο Auto-Save Interval, ορίστε 
το χρόνο που επιθυμείτε και πατήστε το Ok. Ο χρόνος αυτός αφορά τα 
λεπτά. 
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3.1.10 Το παράθυρο Bin Settings-Current 

Σε περίπτωση που φτιάξατε κάτι σημαντικό το οποίο θέλετε να το 
αποθηκεύσετε άμεσα, μπορείτε να το επιτύχετε έχοντας ανοιχτό και 
επιλεγμένο το Bin που θέλετε να αποθηκεύσετε και από τη γραμμή 
μενού της εφαρμογής, πηγαίνετε File > Save Bin ή Ctrl + S από το 
πληκτρολόγιο. 

Αν θέλετε να αποθηκεύσετε όλα τα Bin ταυτόχρονα οποιαδήποτε 
στιγμή, αποεπιλέξτε όλα τα Bin και από τη γραμμή μενού της 
εφαρμογής, πηγαίνετε File > Save All ή Ctrl + S από το πληκτρολόγιο. 

Αν θέλετε να αποθηκεύσετε ένα αντίγραφο κάποιου Bin με διαφορετικό 
όνομα και διαφορετική τοποθεσία, μπορείτε να το επιτύχετε έχοντας 
ανοιχτό και ενεργό το Bin που θέλετε να αποθηκεύσετε και από τη 
γραμμή μενού της εφαρμογής, πηγαίνετε File > Save Bin Copy As, στο 
παράθυρο που σας εμφανίζεται, ορίστε την τοποθεσία και την 
ονομασία που επιθυμείτε για το αντίγραφό σας και πατήστε 
Αποθήκευση. 
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3.1.11 Το παράθυρο Save Bin Copy As 

3.2 Το Παράθυρο του Bin 
Στο παράθυρο του Bin αποθηκεύετε τα στοιχεία που πρόκειται να 
χρησιμοποιήσετε για το Project σας.  

 
3.2.1 Το παράθυρο του Bin 

Το παράθυρο του Bin έχει τέσσερις διαφορετικούς τρόπους για να 
εμφανίζονται τα στοιχεία σας, οι οποίοι είναι: 

Ø Brief view: Εμφανίζει τα στοιχεία σας με πολύ συνοπτική 
επισκόπηση. Σας δείχνει μόνο πέντε στήλες πληροφορίας για τα 
στοιχεία σας. 
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3.2.2 Brief View 
 

Ø Text view: Εμφανίζει τα στοιχεία σας με περισσότερες πληροφορίες 
και μπορεί να έχει περισσότερες από 24 στήλες τις οποίες μπορείτε 
να διαμορφώσετε εσείς, επιλέγοντας από το Fast Menu του 
παραθύρου του Bin την επιλογή Headings και να επιλέξετε ή να 
αποεπιλέξετε όσες στήλες επιθυμείτε ή χρειάζεστε. Μπορείτε 
επίσης να διαμορφώσετε τη σειρά εμφάνισης των στηλών όπως 
εσείς επιθυμείτε με drag and drop και να αποθηκεύσετε τη 
διαμόρφωση σας, ούτως ώστε να μην χρειάζεται να διαμορφώνεται 
τη σειρά κάθε φορά που εργάζεστε στην εφαρμογή. Για να σώσετε 
τη διαμόρφωση σας, κάνετε τις επιθυμητές αλλαγές σας και 
πατήστε το κουμπί που γράφει Untitled και από το μενού επιλέξτε 
Save As, στο παράθυρο που εμφανίζεται δώστε την ονομασία που 
επιθυμείτε και πατήστε Ok, η διαμόρφωση σας τώρα θα είναι 
διαθέσιμη για επιλογή από το ίδιο μενού μαζί με τις 
προκαθορισμένες διαμορφώσεις της εφαρμογής.  

 
3.2.3 Text View 
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Ø Frame view: Εμφανίζει τα στοιχεία σας σαν εικονίδια (thumbnails). 
Μπορείτε επίσης να κάνετε προεπισκόπηση πατώντας πάνω στο 
στοιχείο που επιθυμείτε και μετά Ctrl + L. 

 
3.2.4 Frame View 
 

Ø Script view: Εμφανίζει τα στοιχεία σας σαν thumbnails και υπάρχει 
και ένα text box για κάθε στοιχείο στο οποίο μπορείτε να γράψετε 
οποιαδήποτε σημείωση ή χρήσιμη πληροφορία. 

 
3.2.5 Script View 

3.3 Superbin 

Το Superbin σας επιτρέπει να έχετε ανοιχτά πολλά παράθυρα Bin σε 
ένα. Αυτό είναι αρκετά χρήσιμο, για λόγους εξοικονόμησης χώρου.  

 
3.3.1 Το παράθυρο του Superbin 
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Από προεπιλογή το Superbin δεν είναι ενεργοποιημένο στην εφαρμογή. 
Για να το ενεργοποιήσετε, πηγαίνετε: 
1. Καρτέλα Settings. 
2. Διπλό κλικ στην επιλογή Bin. Εμφανίζεται το παράθυρο Bin Settings-

Current. (Εικόνα 3.1.10) 
3. Kάντε κλικ στο Enable Superbin. 
4. Πατήστε το Ok. 

Τώρα όταν θα ανοίγετε οποιοδήποτε Bin, αυτό θα ανοίγει στο 
παράθυρο Superbin. 

Όταν είναι ενεργοποιημένο το Superbin, τα Bin ανοίγουν στο Superbin 
με μονό κλικ, ενώ με διπλό κλικ ανοίγουν στο παράθυρο του Bin. 

Το παράθυρο του Superbin έχει την ίδια μορφή και τις ίδιες λειτουργίες 
με το παράθυρο του Bin, πλην όμως της λειτουργίας εναλλαγής Bin που 
διαθέτει. Αυτή η λειτουργία σας επιτρέπει, εφόσον έχετε ανοιχτά δύο ή 
περισσότερα Bin, να εναλλάσσεστε μεταξύ αυτών. Για να εναλλάσσεστε 

μεταξύ των Bin, πατήστε το κουμπί  στο παράθυρο του Superbin και 
στη λίστα που ανοίγει βρίσκονται όλα τα Bin που έχετε ανοιχτά. 
Επιλέξτε το Bin που χρειάζεστε και αυτό θα εμφανιστεί στο Superbin. 
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Κεφάλαιο 4 

Timeline 

Το παράθυρο του Timeline, είναι το παράθυρο στο οποίο δημιουργείτε 
την ακολουθία σας, εφαρμόζετε εφέ και κάνετε περαιτέρω 
επεξεργασία. Η εφαρμογή Avid απεικονίζει κάθε επεξεργασία και εφέ 
σε μια δομή γραφικού χρονοδιαγράμματος (Timeline) για να σας 
βοηθάει να παρακολουθείτε και να χειρίζεστε τα στοιχεία της 
ακολουθίας σας. Επιπλέον, το Timeline έχει το δικό του σύνολο από 
εργαλεία επεξεργασίας που μπορείτε να χρησιμοποιήσετε για να 
δημιουργήσετε και να διορθώσετε επεξεργασίες και μεταβάσεις  σε 
πολλαπλά track. Τα audio και video track στο Timeline, παίζουν στην 
οθόνη του Composer. Μπορείτε να επεξεργάζεστε συνεχόμενα τις 
ακολουθίες σας και να ελέγχετε τις αλλαγές σας στο Composer μέχρι να 
είστε ευχαριστημένοι με το αποτέλεσμα. Η ακολουθία χτίζεται από τα 
αριστερά στα δεξιά όπως τα διαβάζει και τα προβάλλει ο δείκτης θέσης.  

4.1 Γνωριμία με το Timeline 

Στο πάνω και κάτω μέρος του Timeline υπάρχουν διάφορα κουμπιά 
εργαλείων με τα οποία μπορείτε να πραγματοποιήσετε την επεξεργασία 
της ακολουθίας ή την επεξεργασία των εφέ στην ακολουθία, να 
τοποθετήσετε ή να αφαιρέσετε εφέ στα κλιπ της ακολουθίας καθώς και 
να αλλάζετε ποιότητα στο βίντεο και να εστιάζετε στα κλιπ. Επίσης στο 
Timeline υπάρχουν δυο Fast Menu.  

Στο Fast Menu στο πάνω μέρος, υπάρχουν επιπλέον κουμπιά εργαλεία 
τα οποία δεν εμφανίζονται στο άμεσο περιβάλλον του Timeline. Η 
παλέτα Tool στην οποία βρίσκονται αυτά τα εργαλεία αποσπάται και 
μπορείτε να την τοποθετήσετε όπου επιθυμείτε για τη διευκόλυνση 
σας.  

Επίσης μεγαλώνοντας την παλέτα από τα άκρα, εμφανίζονται κενά 
κουμπιά στα οποία μπορείτε να προσαρμόσετε διάφορα κουμπιά ή 
εντολές από το μενού της εφαρμογής, με τον ίδιο τρόπο με τον οποίο 
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αναφέρεται στην παράγραφο 1.5 Χρήση συντομεύσεων 
πληκτρολογίου του πρώτου κεφαλαίου. 
Στο Fast Menu στο κάτω μέρος, σας δίνονται διάφορες επιλογές που 
μπορείτε να επιλέξετε για την εμφάνιση των βίντεο και ηχητικών κλιπ 
σας, να χρωματίσετε τα κλιπ σας, να επιλέξετε ποια track θέλετε να 
εμφανίζονται από την επιλογή Show Track, να κάνετε Zoom In και Zoom 
Out καθώς και να επαναφέρετε το Timeline στην προεπιλεγμένη του 
μορφή επιλέγοντας το Default Setup. 

Στη μέση του Timeline τοποθετούνται τα κλιπ για τη δημιουργία της 
ακολουθίας. Όταν τοποθετείτε τα κλιπ στο Timeline, αριστερά των κλιπ 
εμφανίζονται τα track που αντιστοιχούν στο κάθε κλιπ. Τα track 
εμφανίζονται επίσης όταν δημιουργείται νέα ακολουθία χωρίς να 
εισάγετε κλιπ. 

 
4.1.1 Το παράθυρο του Timeline 

4.2 Τα κουμπιά εργαλεία του Timeline 

Τα κουμπιά εργαλεία του πάνω μέρους του Timeline είναι τα εξής: 

 
Effect 
Mode 

Το Effect Mode είναι η λειτουργία, με την οποία 
μπορεί να γίνει τροποποίηση των μεταβατικών ή 
των τμηματικών εφέ που έχουν εφαρμοστεί στα 

κλιπ. 

 
Trim 

Mode 

Το Trim Mode είναι η λειτουργία, με την οποία 
μπορεί να γίνει κοπή με μεγάλη ακρίβεια στα 

σημεία κοπής ανάμεσα στα κλιπ. 

 Step In Το Step In σας δίνει τη δυνατότητα να εισέρχεσθε 
στα ένθετα εφέ και να τα επεξεργάζεστε. 

 Step Οut Το Step Out σας δίνει τη δυνατότητα να 
εξέρχεσθε από τα ένθετα εφέ. 
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Quick 

Transition 

Με αυτή τη λειτουργία μπορείτε να εφαρμόσετε 
τα βασικά εφέ μετάβασης χωρίς να 

χρησιμοποιήσετε την παλέτα των εφέ ή να μπείτε 
στη λειτουργία Effect Mode. 

 
Render 
Effect 

Με αυτή τη λειτουργία μπορείτε να κάνετε 
render στα εφέ που έχετε εφαρμόσει σε 

συγκεκριμένο κλιπ ή μετάβαση. Με το Render 
Effect δημιουργείτε ένα φάκελο για τα εφέ που 

σας επιτρέπει να αναπαράγετε τα εφέ σε 
πραγματικό χρόνο. 

 Collapse 

Με αυτή τη λειτουργία μπορείτε να χτίσετε ένα 
multilayer εφέ και ύστερα να ενσωματώσετε το 
εφέ μέσα σε ένα μονό Submaster εφέ, με ένα 

βήμα. 

 
Remove 

Effect 

Με αυτή τη λειτουργία, αφαιρείτε τα μεταβατικά 
ή τα τμηματικά εφέ που έχετε εφαρμόσει στην 

ακολουθία σας. 

 Mark In Σηματοδοτεί το τρέχων καρέ σαν σημείο In, 
δηλαδή σαν σημείο αρχής. 

 Mark Out Σηματοδοτεί το τρέχων καρέ σαν σημείο Out, 
δηλαδή σαν σημείο τέλους. 

 Mark Clip Σηματοδοτεί την αρχή και το τέλος του τρέχων 
κλιπ. 

 
Clear 
Both 

Marks 
Αφαιρεί τα Mark In και Out σημεία. 

 
Fast 

Menu 

Το Fast Menu του επάνω μέρους. Περιέχει την 
παλέτα Tools με τα επιπλέον εργαλεία 

επεξεργασίας του Timeline. 

 Add Edit 
Με αυτή τη λειτουργία, προσθέτετε κάποια 
επεξεργασία στην τρέχουσα θέση του για τα 

επιλεγμένα κομμάτια. 

 Extract 

Με αυτή τη λειτουργία, αφαιρείτε το υλικό 
μεταξύ των Mark IN και OUT σημείων και κλείνει 

το κενό, μειώνοντας έτσι τη διάρκεια της 
ακολουθίας. 
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 Lift 

Με αυτή τη λειτουργία, αφαιρείτε το υλικό 
μεταξύ των Mark IN και OUT σημείων, αφήνοντας 
κενό στο σημείο που αφαιρείτε για να μπορείτε 

να προσθέσετε κάποιο άλλο υλικό. Δεν 
επηρεάζεται η διάρκεια της ακολουθίας. 

 

Δεξιά των κουμπιών αυτών υπάρχει ο μετρητής επιπέδου ήχου (Audio 
Level Meter), ο οποίος απεικονίζει τα επίπεδα του ήχου σε πραγματικό 
χρόνο. 

 
4.2.1 Μετρητής επιπέδου ήχου 

Στον παρακάτω πίνακα θα αναφέρουμε τα επιπλέον κουμπιά εργαλεία 
της παλέτας Tool του Fast Menu των πάνω κουμπιών του Timeline 
καθώς και τις λειτουργίες τους. 

 Fade Effect 
Μπορείτε να χρησιμοποιήσετε το κουμπί 

Fade Effect, ώστε να κάνετε Fade στα 
τμηματικά εφέ γρήγορα και εύκολα. 

 Rewind Επιστρέφει στην προηγούμενη μετάβαση στο 
Timeline. 

 Fast Forward Προχωράει στην επόμενη μετάβαση στο 
Timeline. 

 
Clipboard 
Contents 

Εμφανίζει τα περιεχόμενα του Clipboard στο 
Source Monitor (για τα κλιπ) ή στο Record 

Monitor (για τις ακολουθίες). 

 Match Frame 

Βρίσκει το πηγαίο κλιπ για το τρέχων καρέ 
που εμφανίζεται στην οθόνη του Composer. 
Φορτώνει το πηγαίο κλιπ στο Source Monitor, 
σημαδεύει στο match frame και σημειώνει 
ένα In point για να το προετοιμάσει για 

επεξεργασία. 
 Make Subclip Σας επιτρέπει να δημιουργήσετε ένα Subclip. 

 Title Tool Ανοίγει το Title Tool για τη δημιουργία ή 
επεξεργασία των τίτλων. 

 Add Keyframe 
Προσθέτει ένα καρέ κλειδί στο σημείο που 

βρίσκεται ο δείκτης θέσης της οθόνης 
προεπισκόπησης των εφέ. 
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 Grid Εμφανίζει τις κατευθυντήριες γραμμές στην 
οθόνη προεπισκόπησης των εφέ. 

 Go to In Μετακίνηση στο σημείο Mark In. 

 Go to Out Μετακίνηση στο σημείο Mark Out. 

 Splice In Εισάγει υλικό από πηγαίο κλιπ στην 
ακολουθία. 

 Overwrite Αντιγράφει υλικό από πηγαίο κλιπ πάνω σε 
ένα τμήμα της ακολουθίας. 

 Audio Eq Ανοίγει το εργαλείο ισοστάθμισης του ήχου 
Audio Eq. 

 Audio Mixer Ανοίγει το εργαλείο ρύθμισης εντάσεων του 
ήχου Audio Mixer. 

 
Audio Punch 

In Ανοίγει το εργαλείο Audio Punch In. 

 Audio Suite Ανοίγει το εργαλείο Audio Suite. 

 

Τα κουμπιά εργαλεία του κάτω μέρους του Timeline είναι τα εξής: 

 Fast Menu 
Το Fast Menu του κάτω μέρους. 

Περιέχει διάφορες επιλογές για τη 
μορφοποίηση του Timeline. 

 Focus 

Κεντράρει την τρέχουσα θέση στο 
Timeline και διαστέλλει ή συμπιέζει 
την κλίμακα του Timeline. Κάντε 

κλικ ξανά για να επιστρέψετε στην 
προηγούμενη κλίμακα Timeline. 

 
Toggle Source/Record 

in Timeline 

Σας επιτρέπει να κάνετε εναλλαγή 
μεταξύ του Timeline για το Record 

Monitor και του Timeline για το 
τρέχον φορτωμένο πηγαίο υλικό 

στο Source Monitor. 
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 Video Quality Menu 

Το κουμπί αυτό σας επιτρέπει να 
αλλάξετε την ποιότητα του βίντεο 
στο Source ή Record Monitor, 

μεταξύ της υψηλής ευκρίνειας και 
δυο χαμηλής ευκρίνειας αναλύσεις, 
ώστε να μπορείτε να δείτε καλύτερη 

πολυπλοκότητα των εφέ σε 
πραγματικό χρόνο. 

 Step In 
Το Step In σας δίνει τη δυνατότητα 
να εισέρχεσθε στα ένθετα εφέ και 

να τα επεξεργάζεστε. 

 Step Out 
Το Step Out σας δίνει τη 

δυνατότητα να εξέρχεσθε από τα 
ένθετα εφέ. 

 
Segment Mode 

(Extract/Splice-in) 

Όταν αυτό το κουμπί είναι ενεργό, 
μπορείτε να εξαγάγετε και να 

ενώσετε τμήματα, μεταφέροντάς τα 
από ένα σημείο στο άλλο στο 

Timeline. Πατήστε ξανά το κουμπί 
για να βγείτε από το Segment mode. 

 
Segment Mode 
(Lift/Overwrite) 

Όταν αυτό το κουμπί είναι ενεργό, 
μπορείτε να αφαιρέσετε και να 
αντικαταστήσετε τμήματα, 

μεταφέροντάς τα από ένα σημείο 
στο άλλο στο Timeline. Πατήστε 

ξανά το κουμπί για να βγείτε από το 
Segment mode. 

 

 

4.3 Track Panels 

Όπως προαναφέραμε, όταν εισάγετε κάποιο κλιπ στο Timeline ή 
δημιουργείτε νέα ακολουθία, εμφανίζονται στα αριστερά από το 
σημείο που τοποθετείται το πρώτο κλιπ, τα track panels. Το track είναι η 
περιοχή του κλιπ ή της ακολουθίας όπου τοποθετείται βίντεο ή ήχος. Τα 
track χωρίζονται σε video που είναι για την εικόνα του κλιπ και σε audio 
που είναι για τον ήχο του κλιπ, το οποίο χωρίζεται σε δυο track, διότι ο 
στερεοφωνικός ήχος έχει δυο κανάλια ήχου.  
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Επίσης, τα Track χωρίζονται στα Track του Source Monitor και του 
Record Monitor. Όταν φορτώνετε κάποιο κλιπ στο Source Monitor, 
εμφανίζονται τα Track του Source Monitor και οι λειτουργίες τους 
αφορούν το κλιπ που έχει φορτωθεί στο Source Monitor. Όταν εισάγετε 
κάποιο κλιπ στο Timeline ή δημιουργείτε νέα ακολουθία, εμφανίζονται 
τα Track του Record Monitor και οι λειτουργίες τους αφορούν τα κλιπ 
που βρίσκονται στο Timeline. Όταν έχετε φορτωμένα κλιπ, ταυτόχρονα 
και στο Source Monitor και στο Timeline, ενεργοποιούνται ταυτόχρονα 
στο παράθυρο του Timeline, τα track του Source Monitor που είναι τα 
αριστερά track και τα track του Record Monitor που είναι τα δεξιά track. 

 
4.3.1 Τα Track Panels 

 

4.3.1 Τρόποι επιλογής αποεπιλογής των Track 

Για να επιλέξετε ή να αποεπιλέξετε κάποιο track, κάντε ένα από τα 
παρακάτω: 

Ø Κλικ πάνω στο όνομα του track.  
Ø Κάντε κλικ στο κενό χώρο πάνω ή κάτω από τα Track και έχοντας 

πατημένο το πλήκτρο του ποντικιού, σύρετε το ποντίκι στα Track 
που θέλετε να επιλέξετε ή να αποεπιλέξετε. 

Τα track εμφανίζονται από προεπιλογή με μωβ χρώμα, αυτό σημαίνει 
ότι είναι επιλεγμένα. Όταν τα track είναι μη επιλεγμένα το χρώμα τους 
αλλάζει από μωβ σε γκρι. 

            
4.3.2 Επιλεγμένα Track                     4.3.3 Μη επιλεγμένα Track 
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Για να επιλέξετε ή να αποεπιλέξετε όλα τα Track ταυτόχρονα, 
επιλέξτε το παράθυρο του Timeline και κάντε ένα από τα παρακάτω: 

Ø Από το μενού της εφαρμογής, πηγαίνετε Edit και Select-All Tracks 
για να επιλέξετε όλα τα Track και Deselect-All Tracks για να 
αποεπιλέξετε όλα τα Track. 
Ο τρόπος αυτός ισχύει μόνο για τα Track των οποίων τα κλιπ 
εμφανίζονται τη δεδομένη στιγμή στο Timeline. 

Ø Από το πληκτρολόγιο πατήστε Ctrl + A για να επιλέξετε όλα τα Track 
και Shift + Ctrl + A για να αποεπιλέξετε όλα τα Track. 
Ο τρόπος αυτός ισχύει μόνο για τα Track των οποίων τα κλιπ 
εμφανίζονται τη δεδομένη στιγμή στο Timeline. 

Ø Κάντε κλικ στο κενό χώρο πάνω ή κάτω από τα Track και έχοντας 
πατημένο το πλήκτρο του ποντικιού, σύρετε το ποντίκι σε όλα τα 
Track για να τα επιλέξετε ή να τα αποεπιλέξετε. 
Με αυτόν τον τρόπο μπορείτε να επιλέξετε ή αποεπιλέξετε όλα τα 
Track.  

4.3.2 Ενεργοποίηση και απενεργοποίηση των Track 

Συχνά κατά την εργασία σας, μπορεί να χρειαστεί να παρακολουθήσετε 
κάποια συγκεκριμένα κλιπ της ακολουθίας σας και τα υπόλοιπα κλιπ να 
σας εμποδίζουν να το πράξετε. Για το λόγο αυτό υπάρχουν τα κουμπιά 
ενεργοποίησης και απενεργοποίησης των Track. 

Ø Κάντε κλικ στο κουμπί  για να ενεργοποιήσετε ή 
απενεργοποιήσετε τα Video Track. 

Ø Κάντε κλικ στο κουμπί  για να ενεργοποιήσετε ή 
απενεργοποιήσετε τα Audio Track. 

Τα κουμπιά αυτά βρίσκονται στην αριστερή πλευρά των αριστερών 
Track και στη δεξιά πλευρά των δεξιών Track.  

Καταλαβαίνετε ότι το Track είναι απενεργοποιημένο, όταν το χρώμα 
του γίνεται γκρι. 
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4.3.3 Απομόνωση των Track (Solo Track) 

Όταν επεξεργάζεστε, μπορείτε να απομονώσετε κάποιο ή κάποια Video 
ή Audio track για την καλύτερη παρακολούθηση τους, χωρίς να 
χρειαστεί να απενεργοποιήσετε όλα τα υπόλοιπα Track. 

Για να απομονώσετε κάποιο ή κάποια Track, κρατήστε πατημένο το 
πλήκτρο Ctrl στο πληκτρολόγιο σας και κάντε κλικ στα κουμπιά 
ενεργοποίησης/απενεργοποίησης των Track. 

Όταν απομονώνεται κάποιο Track, γίνεται πράσινο το κουμπί 
ενεργοποίησης/απενεργοποίησης του Track. 

 
4.3.4 Ενεργοποιημένη απομόνωση των Track 

Για να επανέλθετε από την κατάσταση απομόνωσης, κάντε την ίδια 
διαδικασία ή κάντε διπλό κλικ πάνω στο κουμπί ενεργοποίησης/ 
απενεργοποίησης του Track. 

4.3.4 Διαμόρφωση του ύψους των Tracks 

Μπορείτε να διαμορφώσετε το ύψος του κάθε track πηγαίνοντας το 
ποντίκι ενδιάμεσα από δυο track και όταν το βελάκι του ποντικιού γίνει 
διπλό βέλος, κάντε κλικ και κρατήστε το πλήκτρο του ποντικιού και 
μετακινήστε το ποντίκι πάνω ή κάτω και διαμορφώστε τα ύψη των 
tracks όπως εσείς επιθυμείτε. 

4.3.5 Μετονομασία των Track 

Για να μετονομάσετε κάποιο track, κάντε τα παρακάτω: 

1. Κάντε δεξί κλικ στο track που θέλετε να μετονομάσετε. 
2. Από το μενού επιλέξτε την επιλογή Rename Track.  
3. Στο παράθυρο Comments που εμφανίζεται, δώστε την ονομασία 

που επιθυμείτε στο κενό πλαίσιο και πατήστε Ok. 
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4.3.5 Το παράθυρο Comments 

Για να αφαιρέσετε την ονομασία από κάποιο track και να έχει την 
αρχική μορφή, κάντε τα παραπάνω και στο παράθυρο που εμφανίζεται 
από την επιλογή του Rename Track, επιλέξτε το Remove. 

4.3.6 Αλλαγή χρώματος 

Για να αλλάξετε χρώμα στα κλιπ κάποιου track, κάντε τα παρακάτω: 

1. Επιλέξτε το track ή τα track που θέλετε να αλλάξετε το χρώμα και 
αποεπιλέξτε τα άλλα που δεν θέλετε να εφαρμοστεί το χρώμα. 

2. Κάντε κλικ στο Fast Menu. 
3. Πηγαίνετε το ποντίκι στην επιλογή Track Color, αυτόματα ανοίγει 

μια παλέτα με χρώματα.  
4. Κάντε κλικ στο χρώμα που επιθυμείτε και αυτόματα όλα τα κλιπ του 

track ή των track που έχετε επιλεγμένα παίρνουν το συγκεκριμένο 
χρώμα. 

4.3.7 Timecode Bar 

Κάτω από τα κλιπ υπάρχει το Timecode bar, το οποίο σας δίνει τη 
δυνατότητα να πλοηγείστε στην ακολουθία με μεγαλύτερη ακρίβεια και 
εγγύηση ότι ο δείκτης θα συμπεριφέρεται όπως εσείς θέλετε. Το 
Timecode bar έχει το δικό του Track το TC1, το οποίο βρίσκεται στα 
Track του Record Monitor.  

 
4.3.6 To Timecode Bar 
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4.3.8 Δημιουργία νέου Track 

Για να προσθέσετε νέο track, κάντε ένα από τα παρακάτω: 

Ø Από το μενού της εφαρμογής, πηγαίνετε Clip και επιλέξτε New 
Video Track ή New Audio Track ανάλογα με το τι θέλετε να εισάγετε. 

Ø Κάντε δεξί κλικ οπουδήποτε μέσα στο Timeline και από το μενού 
επιλέξτε New Video Track ή New Audio Track ανάλογα με το τι 
θέλετε να εισάγετε.  

Ø Για συντομία μπορείτε να χρησιμοποιήσετε και τις συντομεύσεις 
τους, Ctrl + Y  για τα Video Track και Ctrl + U για τα Audio Track. 

 

4.3.9 Διαγραφή Track 

Για να διαγράψετε ένα ή περισσότερα Track, επιλέξτε τα Track που 
θέλετε να διαγράψετε και αποεπιλέξτε αυτά που δεν θέλετε και κάντε 
ένα από τα παρακάτω: 

Ø Πατήστε το πλήκτρο Backspace ή Delete από το πληκτρολόγιο σας. 
Ø Από το μενού της εφαρμογής, πηγαίνετε Edit και επιλέξτε το Delete. 

Και στις δυο περιπτώσεις θα σας εμφανιστεί το προειδοποιητικό 
παράθυρο Delete Track. Πατήστε Ok ώστε να διαγράψετε τα Track. 

 
4.3.7 Tο προειδοποιητικό παράθυρο Delete Track 
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4.3.10 Δείκτης θέσης 

Ο δείκτης θέσης στο Timeline σηματοδοτεί τη θέση σας στην 
ακολουθία. Επίσης, καθορίζει το πώς ερμηνεύονται κάποιες από τις 
εντολές σας.  

Αν κάνετε zoom στο δείκτη θέσης, θα παρατηρήσετε ότι υπάρχει και 
ένας δεύτερος δείκτης θέσης ο οποίος είναι διακεκομμένος. Η 
απόσταση μεταξύ αυτών των δυο ισούται με ένα καρέ. Ο δείκτης θέσης 
έχει μπλε χρώμα. Ο δείκτης θέσης αλλάζει σε πράσινο χρώμα όταν 
έχετε πατήσει  το κουμπί Toggle Source/Record in Timeline  και 
έρχεται το κλιπ του Source Monitor στο προσκήνιο. 

                          
4.3.8 Μπλε δείκτης θέσης                                   4.3.9 Πράσινος δείκτης θέσης 

4.3.11 Η λειτουργία Sync Lock 

Η λειτουργία Sync Lock σας επιτρέπει να διατηρήσετε το συγχρονισμό 
μεταξύ πολλών Track ενώ προσθέτετε ή αφαιρείτε καρέ στη λειτουργία 
Trim mode ή στο Source/Record Mode. 

Για να ενεργοποιήσετε τη λειτουργία Sync Lock, πατήστε το γκρι κουμπί 
που βρίσκεται στην αριστερή πλευρά των δεξιών Track. Όταν είναι 
ενεργοποιημένο το κουμπί, το χρώμα του γίνεται μωβ και απεικονίζεται 

ένα σύμβολο . Για να απενεργοποιήσετε τη λειτουργία Sync Lock, 
επαναλάβετε την ίδια διαδικασία. 

Για να ενεργοποιήσετε τη λειτουργία Sync Lock σε όλα τα Track, 
πατήστε το κουμπί Sync Lock από το TC1 ή EC1 Track. Επαναλάβετε την 
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ίδια διαδικασία για να απενεργοποιήσετε τη λειτουργία Sync Lock σε 
όλα τα Track. 

4.3.12 Δρομολόγηση των Track (Track Patching) 

Όταν εργάζεστε με πολλαπλά Track, μπορεί να υπάρξουν περιπτώσεις 
που θα πρέπει να επεξεργαστείτε τα πηγαία Audio ή Video σε άλλα 
παράλληλα Track. Για να επεξεργαστείτε το πηγαίο υλικό σε άλλα 
Record Track που βρίσκονται από πάνω ή από κάτω, θα πρέπει να 
δρομολογήσετε το Source Track με το Record Track στο οποίο θέλετε να 
κάνετε την επεξεργασία. 

Για να κάνετε δρομολόγηση των Track, κάντε ένα από τα παρακάτω: 

Ø Κάντε κλικ και κρατήστε το πλήκτρο του ποντικιού στο track του 
Source Monitor που θέλετε να δρομολογήσετε και σύρετε το ποντίκι 
στο Record Track στο οποίο θέλετε να γίνει η δρομολόγηση. Κατά τη 
διάρκεια του συρσίματος εμφανίζεται ένα βέλος.  

Τα track πρέπει να αντιστοιχίζονται βίντεο με βίντεο και ήχος με ήχος. Ύστερα 
από τη δρομολόγηση, τα Track στα οποία ήταν η δρομολόγηση προηγουμένως, 
αποεπιλέγονται αυτόματα. 

                           
4.3.8 Πριν την δρομολόγηση          4.3.9 Κατά τη διάρκεια                    4.3.10 Μετά τη δρομολόγηση 

Ø Κάντε κλικ και κρατήστε πατημένο το κουμπί του ποντικιού πάνω 
στο Track το οποίο θέλετε να δρομολογήσετε. Εμφανίζεται ένα 
μενού επιλογής των Track. Επιλέξτε με το ποντίκι, σε ποιο Track 
θέλετε να δρομολογήσετε το Track σας. 
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4.3.11 Δρομολόγηση των Track  

4.3.13 Κλείδωμα των Track 

Μπορείτε να κλειδώσετε επιλεγμένα Track, για να αποτρέψετε 
περαιτέρω επεξεργασία επάνω σε αυτά. 

Για να κλειδώσετε τα Track, κάντε ένα από τα παρακάτω: 

Ø Επιλέξτε τα Track που θέλετε να κλειδώσετε και κάντε δεξί κλικ στο 
Timeline και επιλέξτε Lock Track. 

Ø Επιλέξτε τα Track που θέλετε να κλειδώσετε και από το μενού της 
εφαρμογής, πατήστε Clip και επιλέξτε Lock Track. 

Ø Κάντε δεξί κλικ στο Track που θέλετε να κλειδώσετε και επιλέξτε το 
Lock Track. 

Όταν ένα Track είναι κλειδωμένο, εμφανίζεται ένα σύμβολο λουκέτου 

στο κουμπί του Sync Lock . 

Για να ξεκλειδώσετε τα Track, ακολουθήστε τις ίδιες διαδικασίες και 
επιλέξτε το Unlock Track αντί του Lock Track. 

4.3.14 Αποθήκευση των προσαρμογών σας 

Οι προσαρμογές που κάνετε στο Timeline για να σας βολεύουν κατά τη 
διάρκεια της εργασίας σας, μπορείτε να τις αποθηκεύσετε ούτος ώστε 
να μην χρειάζεται να κάνετε την προσαρμογή κάθε φορά που 
εργάζεστε. 

Για να αποθηκεύσετε τις προσαρμογές σας, κάντε τα παρακάτω: 

1. Κάντε κλικ στο κουμπί View Menu στο κάτω μέρος του Timeline. 
. 
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Όταν δεν έχετε αποθηκεύσει κάποια προσαρμογή, εμφανίζεται το 
όνομα Untitled στο κουμπί View Menu. 

2. Από το μενού επιλέξτε το Save As. 
Ανοίγει το παράθυρο διαλόγου View Menu. 

3. Πληκτρολογήστε μια ονομασία για την προσαρμογή του Timeline 
σας στο φωτισμένο πλαίσιο του παραθύρου View Menu. 

4. Κάντε κλικ στο Ok. 

Τώρα η προσαρμογή σας θα είναι διαθέσιμη από το κουμπί View Menu 
ανά πάσα στιγμή. 

 

4.4 Οι επιλογές Zoom στο Timeline 

Κατά τη διάρκεια της εργασίας σας στο Timeline, θα υπάρξουν πολλές 
περιπτώσεις που θα χρειαστεί να εστιάσετε σε κάποια σημεία. Για να 
κάνετε Zoom In και Zoom Out, μπορείτε να χρησιμοποιήσετε έναν από 
τους παρακάτω τρόπους: 

Ø Σύρετε τη μπάρα πλοήγησης στο πλαίσιο Scale Bar  
στο κάτω μέρος, προς τα δεξιά για να κάνετε Zoom In και ύστερα 
προς τα αριστερά για να κάνετε Zoom Out. 

Ø Πατήστε στο πληκτρολόγιο Ctrl + ] για να κάνετε Zoom In και Ctrl + [ 
για να κάνετε Zoom Out. 

Ø Από το Fast Menu στο κάτω μέρος, επιλέξτε More Detail για να 
κάνετε Zoom In και Less Detail για να κάνετε Zoom Out. 
Ø Από το Fast Menu στο κάτω μέρος επιλέξτε το Zoom In, με αυτή την 

επιλογή το βελάκι του ποντικιού αλλάζει σχήμα και γίνεται διπλό 
βέλος αριστερά δεξιά, κάνοντας κλικ και σέρνοντας το ποντίκι, 
εμφανίζεται ένα πλαίσιο επιλογής σημείου και όταν επιλέξετε το 
σημείο που θέλετε να εστιάσετε, αφήστε το πλήκτρο του ποντικιού 
και εστιάζει στο σημείο αυτό. Για να κάνετε Zoom Out, από το Fast 
Menu επιλέξτε το Zoom Back. 

Η επιλογή Show Entire Sequence από το Fast Menu ή πατώντας Ctrl + / 
σας εμφανίζει ολόκληρη την ακολουθία. 
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Κεφάλαιο 5  

Το Παράθυρο του Composer 

Το παράθυρο του Composer, απεικονίζει την ακολουθία που 
δημιουργείτε στο Timeline και είναι το Record Monitor που αναφέραμε 
στα προηγούμενα κεφάλαια. 

5.1 Γνωριμία με το παράθυρο του Composer 

Στο επάνω μέρος του Composer, υπάρχει μια γκρι περιοχή στην οποία 
στα αριστερά υπάρχει το Tracking Information Menu, στο οποίο αν 
κάνετε κλικ μπορείτε να εμφανίσετε πληροφορίες σχετικά με τη 
διάρκεια ή το σύνολο αποσπασμάτων, για τα φορτωμένα κλιπ και 
ακολουθίες.  

Στην ίδια περιοχή στα δεξιά υπάρχει επίσης το Clip Name Menu, το 
οποίο εμφανίζει το όνομα του τρέχοντος τοποθετημένου κλιπ ή της 
ακολουθίας. Κάνοντας κλικ στο Clip Name Menu εμφανίζεται ένα μενού, 
από το οποίο μπορείτε να επιλέξετε διάφορες εντολές ή να επιλέξετε 
άλλο κλιπ ή ακολουθία. 

Στο κάτω μέρος υπάρχουν τα κουμπιά χειρισμού και επεξεργασίας της 
ακολουθίας. Μεταξύ αυτών του κουμπιών υπάρχει και ένα Fast Menu, 
το οποίο έχει ακριβώς την ίδια παλέτα εργαλείων με το Fast Menu του 
πάνω μέρους του Timeline.  

Ακριβώς πάνω από τα κουμπιά του Composer, υπάρχει ένα λευκό 
πλαίσιο με το οποίο μπορείτε να πλοηγείστε στην ακολουθία σας και 
είναι συνδεδεμένο με το Timecode Bar του Timeline. 
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5.1.1 Το παράθυρο του Composer 
 

5.1.1 Τα κουμπιά του Composer 

Τα κουμπιά χειρισμού και επεξεργασίας του Composer, είναι τα 
παρακάτω: 

 Fast Menu 

Το Fast Menu του Composer, το 
οποίο έχει ακριβώς την ίδια 

παλέτα Tool με το Fast Menu του 
πάνω μέρους του Timeline. 

Ανατρέξτε στην παράγραφο 4.2.2 
του κεφαλαίου 4 για την 

επεξήγηση των εργαλείων. 

 Trim Mode 

Το Trim Mode είναι η λειτουργία, 
με την οποία μπορεί να γίνει 
κοπή με μεγάλη ακρίβεια στα 

σημεία κοπής ανάμεσα στα κλιπ. 

 Step Backward 1 Frame 
Σας δίνει τη δυνατότητα να 
προχωράτε ένα καρέ προς τα 

πίσω. 
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 Step Forward 1 Frame 
Σας δίνει τη δυνατότητα να 
προχωράτε ένα καρέ προς τα 

μπρος. 

 Mark In 
Σηματοδοτεί το τρέχων καρέ σαν 
σημείο In, δηλαδή σαν σημείο 

αρχής. 

 Play Αναπαράγει τα κλιπ που 
υπάρχουν στο Timeline. 

 Mark Out 
Σηματοδοτεί το τρέχων καρέ σαν 
σημείο Out, δηλαδή σαν σημείο 

τέλους. 

 Mark Clip Σηματοδοτεί την αρχή και το 
τέλος του τρέχων κλιπ. 

 Go To Previous Edit 
Μετακίνηση στην προηγούμενη 
μετάβαση στα επιλεγμένα Track 

τη δεδομένη στιγμή. 

 Go To Next Edit 
Μετακίνηση στην επόμενη 

μετάβαση στα επιλεγμένα Track 
τη δεδομένη στιγμή. 

 Add Edit 

Με αυτή τη λειτουργία, 
προσθέτετε κάποια επεξεργασία 
στην τρέχουσα θέση του για τα 

επιλεγμένα κομμάτια. 
 

5.2 Γνωριμία με το Source Monitor. 

Το Source Monitor όπως έχει προαναφερθεί σε προηγούμενα κεφάλαια, 
ανοίγει με το φόρτωμα κάποιου κλιπ, με διπλό κλικ από το παράθυρο 
του Bin.  

Στο Source Monitor μπορείτε να πραγματοποιείτε επεξεργασία στα κλιπ 
σας, πριν αυτά εισαχθούν στο Timeline. 

Το  Source Monitor έχει ελάχιστες διαφορές με το Record Monitor. Οι 
διαφορές αυτές είναι η μη ύπαρξη του Clip Name Menu στην πάνω γκρι 
περιοχή και διαφοροποίηση στα κουμπιά χειρισμού και επεξεργασίας 
των κλιπ. 
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Το Fast Menu είναι ακριβώς το ίδιο με αυτό του Record Monitor και του 
πάνω μέρους του Timeline. 

 
5.2.1 Το Source Monitor 
 

5.2.1 Τα κουμπιά του Source Monitor 
Τα κουμπιά χειρισμού και επεξεργασίας του Source Monitor, είναι τα 
παρακάτω: 
 

 
Fast 

Menu 

Το Fast Menu του Composer, το οποίο έχει 
ακριβώς την ίδια παλέτα εργαλείων με το Fast 

Menu του πάνω μέρους του Timeline. 
Ανατρέξτε στην παράγραφο 4.2.2 του 
κεφαλαίου 4 για την επεξήγηση των 

εργαλείων. 

 
Add 

Locator 

Προσθέτει ένα σημάδι εντοπισμού. Η 
εφαρμογή Avid, τοποθετεί ένα σημάδι στο 

Timeline και στο αντίστοιχο καρέ. 

 
Step 

Backward 
1 Frame 

Σας δίνει τη δυνατότητα να προχωράτε ένα 
καρέ προς τα πίσω. 
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Step 

Forward 
1 Frame 

Σας δίνει τη δυνατότητα να προχωράτε ένα 
καρέ προς τα μπρος. 

 Mark In Σηματοδοτεί το τρέχων καρέ σαν σημείο In, 
δηλαδή σαν σημείο αρχής. 

 Play Αναπαράγει τα κλιπ που υπάρχουν στο 
Timeline. 

 Mark Out Σηματοδοτεί το τρέχων καρέ σαν σημείο Out, 
δηλαδή σαν σημείο τέλους. 

 
Clear In 

Mark Αφαιρεί το Mark in σημείο. 

 
Clear Out 

Mark Αφαιρεί το Mark Out σημείο. 

 Mark Clip Σηματοδοτεί την αρχή και το τέλος του τρέχων 
κλιπ. 

 
Motion 
Effect 

Ανοίγει ένα παράθυρο διαλόγου, για τη 
δημιουργία ενός Motion Effect, για το τρέχων 

κλιπ του Source Monitor. 
 
 
5.3 Source/Record Editing Toolset 

Το Source/Record Editing toolset εμφανίζει την οθόνη του Composer σαν 
διπλό μόνιτορ, όπου το Source monitor είναι το αριστερό και το Record 
το δεξί. Επεξεργάζεστε τα πηγαία κλιπ σας στο Source monitor και τις 
ακολουθίες σας στο Record monitor. 

 
5.3.1 Η οθόνη του Composer σαν διπλό μόνιτορ. 
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Για να μπείτε στη λειτουργία του Source/Record Editing toolset, από το 
μενού της εφαρμογής πηγαίνετε Toolset > Source/Record Editing ή κάντε 
κλικ στο αριστερό πλαίσιο του Composer και τραβήξτε το πλαίσιο προς 
τα αριστερά, μέχρι να εμφανιστεί το Source Monitor. 
Ομοίως, για να επιστρέψετε στην Basic Toolset μορφή της εφαρμογής, 
από το μενού της εφαρμογής, πηγαίνετε Toolset > Basic ή κάντε κλικ στο 
αριστερό πλαίσιο του Composer και τραβήξτε το πλαίσιο προς τα δεξιά, 
μέχρι να εξαφανιστεί το Source Monitor. 
 
Για να εναλλάσσεστε μεταξύ του Source και Record Monitor, μπορείτε 
να το κάνετε με τους εξής τρόπους: 
Ø Πατήστε το πλήκτρο Esc από το πληκτρολόγιό σας. 
Ø Κάντε κλικ πάνω στις οθόνες. 
Ø Κάντε κλικ στην γκρι περιοχή μεταξύ των λευκών περιοχών της 

πλοήγησης, κάτω από το μόνιτορ που επιθυμείτε. 
 
5.3.1 Εμφάνιση του Source/Record Editing Toolset 
Η εμφάνιση του Source/Record Editing Toolset, διαφέρει ελάχιστα με τις 
εμφανίσεις των μόνιτορ όταν είναι μεμονωμένα και οι διαφορές αυτές 
είναι κυρίως στη διάταξη των κουμπιών. 

Στην επάνω γκρι περιοχή, υπάρχουν και στα δυο μόνιτορ τα Tracking 
Information Menu και Clip Name Menu. 

Πάνω από τα κουμπιά υπάρχουν οι μπάρες πλοήγησης οι οποίες δεν 
διαφέρουν από αυτές των μεμονωμένων Source και Record Monitor. 

Στα κουμπιά του Source/Record Editing Toolset, έχουν αφαιρεθεί από το 
Source Monitor τα κουμπιά Clear In Mark  και Clear Out Mark  
και έχει προστεθεί το κουμπί Clear Both Marks , και από το Record 
Monitor έχει αφαιρεθεί το κουμπί Add Edit . Επίσης έχει αφαιρεθεί 
και από τα δυο μόνιτορ το Fast Menu και έχει τοποθετηθεί στη μέση 
μαζί με τα προστιθέμενα κουμπιά Splice-In  και Overwrite . 
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Κεφάλαιο 6 

Καταγραφή Υλικού 

Καταγραφή υλικού είναι η διαδικασία δημιουργίας ψηφιακών 
πολυμέσων με εισαγωγή βίντεο ή ήχου από κάποια εξωτερική πηγή. 
Όταν κάνετε καταγραφή, μετατρέπετε το πηγαίο υλικό σε βασικό υλικό 
το οποίο περιέχει πληροφορίες αναφοράς. Επίσης δημιουργείτε 
σχετιζόμενα αρχεία πολυμέσων που περιέχουν ψηφιακό βίντεο και ήχο. 
Οι διαδικασίες που χρειάζεται να κάνετε για να καταγράψετε πολυμέσα 
περιγράφονται στις παρακάτω ενότητες. 

6.1 Εισαγωγή Shot Log αρχείων 

Μπορείτε να εισάγετε οποιοδήποτε log που έχει δημιουργηθεί ή 
μετατραπεί ώστε να πληροί τις Avid log προδιαγραφές. Μπορείτε 
επίσης να συνδυάσετε ή να συγχωνεύσετε τα γεγονότα κατά την 
εισαγωγή του αρχείου log ώστε να απαιτούν για την καταγραφή, 
λιγότερες master ταινίες. 

Το σύστημα εισάγει οποιαδήποτε πρόσθετη πληροφορία που είναι 
συνδεδεμένη με το κάθε κλιπ. 

Για να εισάγετε shot log αρχεία σε bin: 

1. Ανοίξτε ένα bin, κάντε κλικ οπουδήποτε σε ανοιχτό bin για να το 
επιλέξετε ή δημιουργήστε νέο bin για την εισαγωγή του shot log. 

2. Από το μενού της εφαρμογής επιλέξτε File > Import. 
Ανοίγει το παράθυρο διαλόγου Select Files to Import. 

3. Κάντε ένα από τα παρακάτω: 
Ø Αν εισάγετε .ale αρχεία, κάντε κλικ στο πλαίσιο Αρχεία τύπου του 

παραθύρου Select Files to Import και επιλέξτε το Shot Log Files. Το 
σύστημα εμφανίζει μόνο τα αρχεία που ανήκουν στην κατηγορία 
αυτή. 
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Εικόνα 6.1.1 Παράθυρο Select Files to Import με επιλογή Shot log αρχείων. 

 

Ø Αν εισάγετε αρχεία κειμένου, κάντε κλικ στο πλαίσιο Αρχεία τύπου 
και επιλέξτε All Files.  
Το σύστημα εμφανίζει όλα τα αρχεία ανεξάρτητα από τον τύπο 
αρχείου. Χρησιμοποιείστε αυτή την επιλογή αν θέλετε να εισάγετε 
πολλαπλούς τύπους αρχείων. 

4. Κάντε κλικ στο κουμπί Options για να ανοίξετε το παράθυρο 
διαλόγου Import Settings αν θέλετε να επιλέξετε τις επιλογές για τον 
συνδυασμό γεγονότων κατά την εισαγωγή από τις ρυθμίσεις 
εισαγωγής. 

5. Κάντε κλικ στην καρτέλα Shot Log. 

 
Εικόνα 6.1.2 Παράθυρο διαλόγου Import Settings - Καρτέλα Shot Log 
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6. Αφού επιλέξετε την κατάλληλη επιλογή κάντε κλικ στο OK για να 
κλείσετε το παράθυρο Import Settings και να επιστρέψετε στο 
παράθυρο διαλόγου Select Files to Import. 

7. Κάντε κλικ στο μενού Διερεύνηση σε για να εντοπίσετε το φάκελο 
που περιέχει το πηγαίο αρχείο. 

8. Επιλέξτε το αρχείο 
9. Κάντε κλικ στο Άνοιγμα. 

Όταν το σύστημα τελειώνει την εισαγωγή του αρχείου, το κλιπ 
εμφανίζεται στο επιλεγμένο bin. 

10. Αποθηκεύστε το bin. 

6.2 Επιλέγοντας την ανάλυση Βίντεο. 

Για να επιλέξετε ανάλυση βίντεο από το παράθυρο διαλόγου Media 
Creation: 

1. Κάντε διπλό κλικ στο Media Creation στην καρτέλα Settings του 
παραθύρου του Project ή από το μενού της εφαρμογής πηγαίνετε 
Tools > Media Creation ή από το πληκτρολόγιο πατήστε Ctrl + 5. 

2. Κάντε κλικ στην καρτέλα Media Type και επιλέξτε είτε OMF είτε MXF 
τύπο αρχείου. 

 
Εικόνα 6.2.1 Παράθυρο Media Creation - Καρτέλα Media Type 

 

Τα HD πολυμέσα θα πρέπει να είναι MXF. Χρησιμοποιήστε OMF για 
συμβατότητα με παλιότερα συστήματα Avid. 

3. Κάντε κλικ στην καρτέλα Capture. 
4. Κάντε κλικ στο Video Resolution μενού και επιλέξτε μια ανάλυση 

βίντεο. 
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Το Video Resolution μενού περιέχει μια λίστα με τις διαθέσιμες 
αναλύσεις. Η λίστα με τις αναλύσεις εξαρτάται από το μοντέλο του 
Avid συστήματος σας και τον τύπο του project. 
Για τα HD project, η λίστα δείχνει αναλύσεις Avid DNxHD και 
DVCPRO HD, ανάλογα με την είσοδο του βίντεο σας. 
Για τα HDV project, δεν υπάρχουν διαθέσιμες αναλύσεις για την 
καταγραφή, καθώς η εφαρμογή Avid επιλέγει αυτόματα τη σωστή 
ανάλυση.  

 
Εικόνα 6.2.2 Παράθυρο Media Creation - Καρτέλα Capture, Video Resolution 
 

5. Κάντε κλικ στο OK για να σώσετε τη ρύθμιση σας. 
Για πιο λεπτομερείς πληροφορίες σχετικά με τις αναλύσεις, 
ανατρέξτε στην ενότητα Resolutions and Storage Requirements της 
Βοήθειας της εφαρμογής. 

6.3 Επιλογή οδηγών από το παράθυρο διαλόγου Media 
Creation. 

Για να επιλέξετε οδηγούς από το παράθυρο διαλόγου Media Creation: 

1. Κάντε διπλό κλικ στο Media Creation στην καρτέλα Settings του 
παραθύρου του Project ή από το μενού της εφαρμογής πηγαίνετε 
Tools > Media Creation ή από το πληκτρολόγιο πατήστε Ctrl + 5. 

2. Κάντε κλικ στην καρτέλα Drive Filtering. 
Μπορείτε να καταργήσετε από τη λίστα με τους διαθέσιμους 
οδηγούς, τον οδηγό όπου βρίσκεται το λειτουργικό σας σύστημα και 
τον οδηγό όπου βρίσκεται η εφαρμογή Avid. Αυτή η λειτουργία σας 
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επιτρέπει να αποθηκεύετε αρχεία πολυμέσων μόνο σε οδηγούς με 
επαρκές χώρο αποθήκευσης. 

3. Επιλέξτε ένα από τα παρακάτω: 
Ø Filter Based on Resolution: Αφαιρεί ως επιλογή αποθήκευσης τους 

δίσκους που δεν μπορούν να υποστηρίξουν την επιλεγμένη 
ανάλυση. Αυτή η επιλογή θέτει το σύστημα επεξεργασίας Avid να 
χρησιμοποιήσει μόνο τα Avid MediaDrives. 

Ø Filter Out System Drive: Αφαιρεί ως επιλογή αποθήκευσης τον 
δίσκο στον οποίο είναι εγκατεστημένο το λειτουργικό σύστημα. 

Ø Filter Out Launch Drive: Αφαιρεί ως επιλογή αποθήκευσης τον 
δίσκο στον οποίο είναι εγκατεστημένη η εφαρμογή επεξεργασίας 
Avid. 
Μπορείτε να μην επιλέξετε καμιά από αυτές τις επιλογές. 

 
Εικόνα 6.3.1 Παράθυρο Media Creation - Καρτέλα Drive Filtering & Indexing 

 

4. Κάντε κλικ στην καρτέλα Capture. 

 
Εικόνα 6.3.2 Παράθυρο Media Creation - Καρτέλα Capture 
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5. Πατήστε το κουμπί  για να σας ανοίξει το 
μενού με τους διαθέσιμους οδηγούς και να επιλέξτε τον οδηγό στον 
οποίο θα καταγράψετε το βίντεο και τον οδηγό στον οποίο θα 
καταγράψετε τον ήχο. Για να επιλέξετε τον ίδιο οδηγό και για βίντεο 

και για τον ήχο, κάντε κλικ στο κουμπί Single/Dual Drives Mode 
μέχρι να εμφανιστεί το μενού ενός μόνο οδηγού. 

6. Για να εφαρμόσετε την επιλογή των οδηγών σας για όλες τις 
καρτέλες του Media Creation και την υπόλοιπη εφαρμογή, κάντε 
κλικ στο κουμπί Apply to All. 
Αυτό θέτει τους επιλεγμένους οδηγούς για το βίντεο και τον ήχο για 
όλες τις καρτέλες του παραθύρου διαλόγου Media Creation. Τα 
θέτει επίσης για οποιοδήποτε σημείο στην εφαρμογή όπου έχετε τη 
δυνατότητα να επιλέξετε οδηγούς. 

7. Κάντε κλικ στο OK για να σώσετε τις ρυθμίσεις σας. 

6.4 Διαμόρφωση των Deck 

Οι ρυθμίσεις διαμόρφωσης των Deck, σας επιτρέπουν να καθορίσετε τις 
παραμέτρους του ελέγχου των deck, για ένα deck ή για πολλαπλά deck. 
Όπως και με όλες τις ρυθμίσεις, μπορείτε να δημιουργήσετε πολλαπλές 
εκδόσεις, επιτρέποντας σας να επιλέξετε μεταξύ αυτών για τις συχνές 
αλλαγές στη διαμόρφωση του hardware. 

Η διαμόρφωση των deck και οι προτιμήσεις ελέγχου των γενικών deck 
παρουσιάζονται ως ξεχωριστά αντικείμενα στη λίστα των Setting στο 
παράθυρο του project. 

Θα πρέπει να διαμορφώσετε χειροκίνητα τις κατάλληλες συνδέσεις του 
hardware πριν οι ρυθμίσεις διαμόρφωσης των deck τεθούν σε ισχύ. 

 

Για να διαμορφώσετε ένα ή πολλαπλά deck: 

1. Κάντε κλικ στην καρτέλα Settings από το παράθυρο του Project. 
2. Κάντε διπλό κλικ στην επιλογή Deck Configuration. 

Ανοίγει το παράθυρο διαλόγου Deck Configuration. 
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Εικόνα 6.4.1 Παράθυρο διαλόγου Deck Configuration 

 

Αν διαμορφώνετε το σύστημά σας για πρώτη φορά, κάντε κλικ στο 
κουμπί Add Channel για να προσθέσετε ένα νέο κανάλι στην 
αριστερή πλευρά του παραθύρου διαλόγου Deck Configuration και 
αυτόματα ανοίγει το παράθυρο διαλόγου Channel. 

 
Εικόνα 6.4.2 Παράθυρο διαλόγου Channel 

 

3. Κάντε κλικ στο μενού Channel Type και επιλέξτε ένα από τα 
παρακάτω αντικείμενα, ανάλογα με την διαμόρφωση του 
συστήματός σας:  

¾ Firewire, αν συνδέετε μια DV κάμερα ή deck μέσω Firewire 
σύνδεσης. 

¾ Direct, αν συνδέετε ένα deck απευθείας στη σειριακή θύρα του 
επεξεργαστή και χρησιμοποιείτε transcoder ή το Avid Mojo ή Avid 
Mojo SDI για να εισάγετε δεδομένα στο σύστημα σας. 

4. Κάντε κλικ στο Port μενού και επιλέξτε τη θύρα στην οποία θα 
συνδέσετε το deck: 

¾ (Για Avid Mojo ή Avid Mojo SDI συστήματα) Avid DNA αν επιλέξατε 
Firewire για το κανάλι. 
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¾ (Για Software - only systems) OHCI αν επιλέξατε Firewire για το 
κανάλι. 

¾ (Windows only) COM1 ή COM2 αν επιλέξατε Direct για το κανάλι. 
Αν δεν είστε σίγουροι ποιά θύρα να επιλέξετε, ελέγξτε τις 9-pin 
σειριακές θύρες στο πίσω μέρος του συστήματος. Αν η θύρα δεν 
έχει ετικέτα, ανατρέξτε στο εγχειρίδιο του hardware που παρέχεται 
με το σύστημά σας. 

5. Κάντε κλικ στο OK για να κλείσετε το παράθυρο διαλόγου Channel. 
Ένα παράθυρο διαλόγου ανοίγει ρωτώντας σας αν θέλετε να 
διαμορφώσετε αυτόματα το κανάλι τώρα. 

 
Εικόνα 6.4.3 Παράθυρο ερώτησης για αυτόματη διαμόρφωση 

 

6. Κάντε κλικ στο Yes αν θέλετε να γίνει αυτόματη διαμόρφωση του 
καναλιού. 
Ένα νέο κανάλι εμφανίζεται στην περιοχή προβολής του παραθύρου 
διαλόγου Deck Configuration. 

 
Εικόνα 6.4.4 Παράθυρο διαλόγου Deck Configuration με δημιουργημένο κανάλι 

Μπορείτε να ξανανοίξετε τις ρυθμίσεις του Channel για να αλλάξετε 
τις επιλογές οποιαδήποτε στιγμή κάνοντας διπλό κλικ στο κουμπί 
στο παράθυρο του channel. 
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7. Για να προσθέσετε ένα Deck ή transcoder, κάντε τα παρακάτω: 
α. Κάντε κλικ στο Add Deck για να ανοίξετε το παράθυρο διαλόγου 
Deck Settings. 

 
Εικόνα 6.4.5 Παράθυρο διαλόγου Deck Settings 

 

Με ήδη συνδεδεμένο deck στο σύστημα, μπορείτε να κάνετε κλικ 
στο κουμπί Auto-configure για να παρακάμψετε το παράθυρο 
διαλόγου Deck Settings και να διαμορφώσετε αυτόματα το deck με 
τις προεπιλεγμένες ρυθμίσεις. 
Δεν ανταποκρίνονται όλες οι DV συσκευές στην εντολή Auto-
configure. Εξαιτίας αυτού του περιορισμού, το Auto-configure 
επιλέγει μόνο τις γενικές συσκευές. 
β. (Επιλογή) Όταν μια ψηφιακή κάμερα ή ένα transcoder είναι 
προσαρτημένο στο σύστημά σας, κάντε κλικ στο Device μενού στο 
παράθυρο διαλόγου Deck Settings και επιλέξτε την κατάλληλη 
συσκευή. Όταν ένα deck με transcoder είναι προσαρτημένο, 
επιλέξτε το κατάλληλο deck. 
Αν το transcoder σας δεν εμφανίζεται στη λίστα, επιλέξτε Generic 
και ύστερα DVTranscoder. 
Οι προσαρμογές συσκευών από παλιότερα συστήματα Avid δεν 
είναι συμβατά με τα συστήματα Avid Mojo ή το Avid Mojo SDI. Μην 
αντιγράφετε προσαρμογές Meridien στα συστήματα Avid Mojo ή το 
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Avid Mojo SDI και μην αντιγράφετε προσαρμογές Avid Mojo ή Avid 
Mojo SDI στα συστήματα Meridien. 
γ. Επιλέξτε τις ρυθμίσεις με βάση τη συσκευή σας. Για περισσότερες 
πληροφορίες σχετικά με τα Deck Settings ανατρέξτε στην ενότητα 
Deck Settings της βοήθειας της εφαρμογής. 
δ. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Deck 
Settings και να επιστρέψετε στο παράθυρο διαλόγου Deck 
Configuration, το οποίο τώρα εμφανίζει το deck. 

 
Εικόνα 6.4.6 Παράθυρο Deck Configuration με εμφάνιση του Deck 

 

Μπορείτε να ξανανοίξετε το παράθυρο διαλόγου Deck Settings για 
να αλλάξετε τις επιλογές οποιαδήποτε στιγμή κάνοντας διπλό κλικ 
στο κουμπί του καναλιού του deck στο παράθυρο διαλόγου Deck 
Configuration. 

8. Επαναλάβετε τα βήματα από το 3 έως το 8 για κάθε επιπλέον 
κανάλι ή deck που θέλετε να ρυθμίσετε. 

9. (Επιλογή) Τσεκάρετε την επιλογή "Verify configuration against actual 
decks" αν θέλετε το σύστημα να ελέγξει την διαμόρφωση των deck 
έναντι της φυσικής σύνδεσης των συσκευών στο σύστημα. 
Το σύστημα ελέγχει τη διαμόρφωση των deck αφού κάνετε κλικ στο 
Apply στο παράθυρο διαλόγου Deck Configuration και όταν θα 
εκκινείτε την εφαρμογή Avid. Ένα προειδοποιητικό μήνυμα θα σας 
εμφανιστεί σε περίπτωση που η διαμόρφωση δεν ταιριάζει με το 
deck. 

10.  Πληκτρολογήστε μια ονομασία στο παράθυρο κειμένου 
Configuration Name για να ονομάσετε την διαμόρφωση του deck. 
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Η νέα διαμόρφωση του deck εμφανίζεται στη λίστα Settings του 
παραθύρου Project. 

11.  Κάντε κλικ στο Apply για να ολοκληρώσετε τις διαμορφώσεις και να 
κλείσετε το παράθυρο διαλόγου Deck Configuration. 

12.  Αν είναι απαραίτητο, κάντε διπλό κλικ στο Deck Preferences στη 
λίστα Settings από το παράθυρο του Project για να ρυθμίσετε τις 
επιλογές του γενικού ελέγχου των deck. Για περισσότερες 
πληροφορίες ανατρέξετε στην ενότητα Deck Preferences Settings 
της βοήθειας της εφαρμογής. 

 
Εικόνα 6.4.7 Παράθυρο Deck Preferences 

Για να διαγράψετε μια διαμόρφωση deck: 
1. Κάντε κλικ στα ονόματα των τωρινών διαμορφωμένων καναλιών ή 

deck στην περιοχή προβολής. 
Ολόκληρη η περιοχή προβολής θα πρέπει να έχει κόκκινο 
περίγραμμα. 

2. Κάντε κλικ στο Delete. 
3. Κάντε κλικ στο Apply για να ολοκληρώσετε τις αλλαγές και να 

κλείσετε το παράθυρο διαλόγου. 

6.5 Ορισμός προτιμήσεων των Deck 

Οι προτιμήσεις των deck, είναι γενικές ρυθμίσεις για τον βασικό έλεγχο 
των deck. Αυτές οι ρυθμίσεις εφαρμόζονται σε όλα τα deck τα οποία 
είναι συνδεδεμένα στο σύστημα ανεξάρτητα από τη διαμόρφωση των 
deck. Μπορείτε να ανοίξετε το παράθυρο διαλόγου Deck Preferences 



Σελίδα | 74  
 

που βρίσκεται στη λίστα Settings στο παράθυρο του Project. Αυτές οι 
επιλογές αναλύονται στην ενότητα Deck Preferences Settings της 
βοήθειας της εφαρμογής. 

6.6 Ρύθμιση του εργαλείου Capture 

Το εργαλείο Capture σας παρέχει τον έλεγχο για την παρακολούθηση, 
τη σήμανση, την καταγραφή βίντεο και προσδιορίζει παραμέτρους 
καταγραφής όπως το σημείο πηγής και αποθήκευσης. 

 
Εικόνα 6.6.1 Το εργαλείο Capture 

Οι παρακάτω ενότητες παρέχουν περισσότερες πληροφορίες σχετικά με 
το εργαλείο Capture: 

6.6.1 Αλλαγή του συνδυασμού της Παροχής Ενέργειας 
Αν εγκαθιστάτε την εφαρμογή επεξεργασίας Avid σε φορητό 
υπολογιστή με λειτουργικό σύστημα Windows, μπορεί να εμφανιστεί 
στη δεξιά πάνω γωνία του εργαλείου Capture ένα κουμπί 
προειδοποίησης Ασυμβίβαστης Παροχής Ενέργειας (Incompatible 
Power Scheme). Κάποιοι από τους βασικούς συνδυασμούς παροχής 
ενέργειας που διατίθενται σε laptop που έχουν εγκατεστημένα 
Windows XP μπορεί να επηρεάσει την απόδοση των λειτουργιών 
επεξεργασίας, συμπεριλαμβανομένης και της καταγραφής. Η Avid 
συνιστά να χρησιμοποιείτε το συνδυασμό παροχής ενέργειας “Always 
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On” και να απενεργοποιείτε την προφύλαξη οθόνης όταν εργάζεστε με 
εφαρμογές Avid. 
Μπορείτε να επιλέξετε ένα νέο συνδυασμό παροχής ενέργειας 
πηγαίνοντας στις ιδιότητες της Παροχής Ενέργειας από τον Πίνακα 
Ελέγχου του συστήματος σας. 
 
6.6.2 Άνοιγμα του εργαλείου Capture 
Για να ανοίξετε το εργαλείο Capture, κάντε ένα από τα παρακάτω: 
Ø Από το μενού της εφαρμογής πηγαίνετε Toolset > Capture. 
Ø Από το μενού της εφαρμογής πηγαίνετε Tools > Capture. 
Ø Από το πληκτρολόγιο πατήστε Ctrl + 7. 

 
6.6.3 Επιλογή Deck (Εξωτερική συσκευή) 
Το Deck Selection μενού στο εργαλείο Capture περιέχει μια λίστα από 
deck ή κάμερες που ήταν συνδεδεμένα με το σύστημα, τροφοδοτημένα 
και αρχικοποιημένα όταν ανοίξατε το εργαλείο Capture. Το πρώτο deck 
ή κάμερα στη λίστα είναι επιλεγμένο από προεπιλογή, εκτός αν όλες οι 
συσκευές είναι αποσυνδεδεμένες. 
Για να ενεργοποιήσετε την αναπαραγωγή από διαθέσιμο deck ή 
κάμερα, κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ στο μενού και επιλέξτε το όνομα του deck ή της κάμερας 

το οποίο είχε προηγουμένως διαμορφωθεί. 
Ø Επιλέξτε το Auto-configure για να εγκαταστήσει αυτόματα τις 

προεπιλεγμένες ρυθμίσεις της συσκευής για VTR το οποίο είναι 
συνδεδεμένο τη συγκεκριμένη στιγμή στο σύστημα. 

Σε περίπτωση που ξεχάσατε να ενεργοποιήσετε ή να συνδέσετε το 
deck ή την κάμερα πριν εισέλθετε στο Capture mode: 

1. Σιγουρευτείτε ότι η συσκευή είναι συνδεδεμένη και 
ενεργοποιημένη. 

2. Κάντε κλικ στο Deck Selection μενού στο εργαλείο Capture και 
επιλέξτε Check Decks για να αποκαταστήσετε τον έλεγχο της 
συσκευής. 
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6.6.4 Επιλογή βίντεο και ηχητικής εισόδου. 

Τα Video και Audio μενού σας δείχνουν τις τωρινές ρυθμίσεις εισόδου 
για το Video Input εργαλείο και για την καρτέλα Input στο παράθυρο 
διαλόγου Audio Project Settings.  

 
Εικόνα 6.6.2 Video και Audio μενού στο εργαλείο Capture 

 

 
Εικόνα 6.6.2 Παράθυρο Audio Project Settings - Καρτέλα Input 

 

Τα μενού παρέχουν επίσης ένα βολικό τρόπο να αλλάξετε αυτές τις 
ρυθμίσεις, αν είναι απαραίτητο. 
Οι επιλογές είναι οι εξής (εξαρτάται από τη διαμόρφωση του 
συστήματος σας): 

· Video Input: Composite, SVideo , Component, Host-1394. 
· Audio input: RCA (-10 dBu), Host-1394. 

Για να επιλέξετε Audio ή Video input στο εργαλείο Capture: 

Ø Κάντε κλικ Audio ή Video μενού και επιλέξτε μια επιλογή εισαγωγής. 

6.6.5 Επιλέγοντας την κασέτα (Tape) 
Για να επιλέξετε πηγαία κασέτα: 

1. Εισάγετε μια κασέτα στο σύστημα από το οποίο θα γίνει η 
καταγραφή. 
Ανοίγει το παράθυρο διαλόγου Select Tape. 
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Αν η κασέτα βρίσκεται ήδη στην κάμερα ή στο deck, κάντε κλικ στο 
Source Tape Display στο εργαλείο Capture. 

2.  Σε NTSC project, αναπαράγετε εν συντομία την κασέτα, ώστε το 
σύστημα να μπορεί να εντοπίσει το timecode format της κασέτας 
(drop-frame ή non-drop-frame). Διαφορετικά, το σύστημα διατηρεί 
το timecode format όπως έχει ρυθμιστεί στο παράθυρο διαλόγου 
Deck Preferences, ανεξάρτητα του format στην κασέτα και μπορεί 
να σας εμφανιστεί μήνυμα, υποδεικνύοντας μια λανθασμένη 
κασέτα. 
Το Drop-frame timecode εμφανίζεται στην ένδειξη timecode με 
σύμβολο άνω τελείας μεταξύ ωρών, λεπτών, δευτερόλεπτων και 
καρέ. Το Non-drop-frame timecode εμφανίζεται με άνω και κάτω 
τελεία. (Το Drop-frame και το Non-drop-frame timecode ισχύουν 
μόνο στα NTSC project.) για περισσότερες πληροφορίες σχετικά με 
το Drop-frame και το Non-drop-frame timecode, ανατρέξτε στη 
βοήθεια της εφαρμογής στην ενότητα Understanding Drop-frame 
and Non-drop-frame timecode. 

3. Παρέχετε στο σύστημα μια ονομασία κασέτας με έναν από τους 
παρακάτω τρόπους: 
Ø Επιλέξτε το όνομα της κασέτας από τη λίστα που εμφανίζεται στο 

παράθυρο διαλόγου Select Tape και πατήστε OK. 
Ø Επεκτείνετε τη λίστα επιλέγοντας την επιλογή “Show other 

projects” ή κάνοντας κλικ στο κουμπί Scan for tapes. 
Ø Κάντε κλικ στο New εφόσον η κασέτα δεν υπάρχει στη λίστα. 

Πληκτρολογήστε το νέο όνομα στο παράθυρο διαλόγου, κάντε κλικ 
στο OK και ύστερα ξανακάντε κλικ στο OK.

 
Εικόνα 6.6.4 Παράθυρο Select Tape 
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6.6.6 Επιλέγοντας πηγαία Tracks 
Μπορείτε να επιλέξετε να καταγράψετε συγκεκριμένα track από την 
πηγαία κασέτα. 
Για να επιλέξετε μόνο συγκεκριμένα track που θέλετε να 
καταγράψετε: 
Ø Κάντε κλικ στα κουμπιά Channel Selection στο Capture tool. 

Το TC (timecode) track είναι επιλεγμένο από προεπιλογή. 
Όταν χρησιμοποιείτε ελεγχόμενη Avid κάμερα ή deck, το TC 
(timecode) είναι επιλεγμένο από προεπιλογή και το σύστημα 
καταγράφει το timecode από την πηγαία κασέτα. Αν αποεπιλέξετε το 
TC κουμπί, το σύστημα καταγράφει με το timecode της ώρας της 
ημέρας. 
Αν δεν βλέπετε το πηγαίο βίντεο ή δεν ακούτε το πηγαίο ήχο στο 
Capture mode, κάντε κλικ στα κουμπιά Channel Selection για να 
σιγουρευτείτε ότι έχουν επιλεγεί τα σωστά track. 

Για να επιλέξετε ή αποεπιλέξετε όλα τα track ταυτόχρονα: 

Ø Πατήστε και κρατήστε πατημένο το κουμπί Alt και κάντε κλικ σε 
οποιοδήποτε Channel Selection κουμπί. 

6.6.7 Επιλέγοντας την ανάλυση στο Capture tool. 

Για να ορίσετε την ανάλυση της καταγραφής: 
Ø Κάντε κλικ στο μενού ανάλυσης (Res) στο Capture tool και επιλέξτε 

μία βίντεο ανάλυση. 
Η λίστα με τις αναλύσεις περιέχει όλες τις διαθέσιμες αναλύσεις 
ανάλογα με την έκδοση του Avid συστήματος σας. Για 25-fps και 30-fps 
project, η λίστα εμφανίζει single-field και two-field interlaced αναλύσεις 
και DV. Για 24p και 25p project, η λίστα εμφανίζει progressive, full-
frame αναλύσεις. Επιλέξτε 1:1 για ασυμπίεστα μέσα. Για HD project, η 
λίστα εμφανίζει DVCPRO HD. Για HDV project, η λίστα εμφανίζει τις HDV 
αναλύσεις του project. 
Το Avid Xpress Pro υποστηρίζει εγγραφές και ψηφιακές περικοπές ήχου 
των 32-kHz, 44.1-kHz και 48-kHz. Αν εγγράφετε DV ήχο, ρυθμίστε την 
κάμερα ή το deck να εγγράφει 16-bit ήχο (48 kHz). 
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6.6.8 Επιλέγοντας το Target Bin. 
Επιλέγετε ένα target bin, ως σημείο αποθήκευσης για κλιπ που 
δημιουργούνται όταν καταγράφετε εν κινήσει. Μπορείτε επίσης να 
επιλέξετε ένα target bin που θα περιέχει τα logged κλιπ που θα 
χρησιμοποιήσετε για την μαζική καταγραφή των πολυμέσων σας. 
Για να επιλέξετε ένα target bin, κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ στο μενού Bin στο Capture tool και επιλέξτε ένα υπάρχων 

bin. 
Ø Ενεργοποιήστε ένα bin που δημιουργήσατε προηγουμένως, 

επιλέγοντας από το μενού της εφαρμογής File > Open Bin, στο 
παράθυρο διαλόγου Open Bin αναζητήστε το bin και ανοίξτε το. 

Ø Δημιουργήστε νέο bin επιλέγοντας από το μενού της εφαρμογής File 
> New bin και μετά ονομάστε και ανοίξτε το νέο bin στο παράθυρο 
διαλόγου New Bin. 
 

6.6.9 Επιλέγοντας τους δίσκους αποθήκευσης. 
Για να ορίσετε τους δίσκους αποθήκευσης για το υλικό που έχει 
καταγραφεί: 

1. Σιγουρευτείτε ότι βρίσκεστε στο Capture mode. Αν το Capture tool 

είναι στο Log mode, κάντε κλικ στο κουμπί Capture/Log Mode  
για να επιστρέψετε στο Capture mode. 

2. Αποφασίστε εάν θα καταγράψετε ήχο ή βίντεο σε ένα δίσκο ή σε 
ξεχωριστούς δίσκους. 

3. Κάντε κλικ στα μενού και επιλέξτε το ακριβές δίσκο αποθήκευσης. 
Οι παρακάτω ενότητες παρέχουν περισσότερες πληροφορίες σχετικά με 
την αποθήκευση σε δίσκους: 
· Αποθήκευση σε ένα δίσκο 

Από προεπιλογή το Capture tool αποθηκεύει σε ένα δίσκο για 
καταγραφή βίντεο και ήχο για κάθε κλιπ. 
Για να αποθηκεύσετε σε ένα δίσκο: 

1. Από το μενού της εφαρμογής επιλέξτε Tools > Capture. 

2. Κάντε κλικ στο κουμπί Single/Dual Drives Mode  στο Capture 
tool μέχρι να εμφανιστεί το εικονίδιο με ένα δίσκο. 

3. Κάντε κλικ στο Target Drive μενού και επιλέξτε το δίσκο. 
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Το όνομα που εμφανίζεται με έντονη γραφή στο μενού έχει τη 
μεγαλύτερη διαθέσιμη χωρητικότητα. 
Ο εναπομείναντας χρόνος υπολογίζεται βάση της ανάλυσης που 
επιλέξατε. 

· Αποθήκευση σε ξεχωριστούς δίσκους για βίντεο και ήχο. 
Μπορείτε να αποθηκεύσετε σε ξεχωριστούς δίσκους τα βίντεο και 
ηχητικά track.  
Για να αποθηκεύσετε σε ξεχωριστούς δίσκους τα βίντεο και τα 
ηχητικά μέρη: 

1. Από το μενού της εφαρμογής επιλέξτε Tools > Capture. 

2. Κάντε κλικ στο κουμπί Single/Dual Drives Mode  στο Capture 
tool μέχρι να εμφανιστεί το εικονίδιο των δυο δίσκων. 

3. Κάντε κλικ στο μενού της κάθε αποθηκευτικής μονάδας και 
επιλέξτε ξεχωριστούς δίσκους για βίντεο και ήχο. 
Η αποθήκευση σε διαφορετικά τμήματα στην ίδια μονάδα μπορεί 
να επιβραδύνει την αναπαραγωγή. 
 

6.6.10 Καταγραφή σε πολλαπλά αρχεία πολυμέσων. 
Μπορείτε να καταγράψετε βίντεο και ήχο σε πολλαπλά αρχεία 
πολυμέσων σε πολλαπλούς δίσκους, με τα παρακάτω πλεονεκτήματα: 

· Μπορείτε να δημιουργήσετε μεγαλύτερα κλιπ των οποίων τα αρχεία 
πολυμέσων σε διαφορετική περίπτωση θα υπερέβαιναν τον 
περιορισμό του μεγέθους των αρχείων των 2 GB. 

· Μπορείτε να ομαδοποιήσετε όλους τους οδηγούς με τις επιλογές 
των πολλαπλών αρχείων, ενεργοποιώντας το σύστημα να 
καταγράφει μεγάλα κλιπ συνεχόμενα, π.χ. δορυφορική τροφοδοσία. 

· Το σύστημα κάνει πιο αποτελεσματική χρήση των χώρων των 
δίσκων, ιδιαίτερα όταν καταγράφετε μεγάλα κλιπ. 

Για να καταγράψετε βίντεο ή ήχο σε πολλαπλά αρχεία πολυμέσων: 
1. Κάντε κλικ στην καρτέλα Settings από το παράθυρο Project. 
2. Κάντε διπλό κλικ στο Capture. 

Ανοίγει το παράθυρο διαλόγου Capture. Αν έχετε επιλέξει OMF στην 
καρτέλα Capture του παραθύρου διαλόγου Media Creation, θα δείτε 
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μια καρτέλα με ετικέτα OMF Media Files. Αν έχετε επιλέξει MXF, η 
καρτέλα θα είναι με ετικέτα MXF Media Files. 

 
Εικόνα 6.6.5 Παράθυρο Capture Settings - καρτέλα OMF Media Files 

 

3. Κάντε ένα από τα παρακάτω: 
Ø Για OMF πολυμέσα, κάντε κλικ στην καρτέλα OMF Media Files. 
Ø Για MFX πολυμέσα, κάντε κλικ στην καρτέλα MFX Media Files. 

4. Στην καρτέλα OMF Media Files, επιλέξτε το Capture to multiple files. 
MXF media καταγράφει μόνο σε πολλαπλά αρχεία. 

5. Αποδεχτείτε την προεπιλεγμένη ή πληκτρολογήστε διαφορετική 
τιμή ορίου στο πλαίσιο κειμένου "Maximum capture time". 
Αν θεωρείτε ότι οποιοδήποτε από τα καταγεγραμμένα κλιπ σας 
μπορεί να υπερβαίνει τα 30 λεπτά, βεβαιωθείτε ότι εισάγετε μια 
υψηλότερη εκτίμηση στο πλαίσιο κειμένου, διαφορετικά το 
σύστημα σταματάει την καταγραφή στα 30 λεπτά. 

6. Κάντε κλικ στο OK για να κλείσετε το παράθυρο διαλόγου και να 
εφαρμόσετε τις επιλογές. 

7. Πηγαίνετε Tools > Capture.  
Ανοίγει το εργαλείο Capture. 

8. Για να καταγράψετε σε πολλαπλά αρχεία σε οδηγούς, κάντε κλικ στο 
μενού Target Drive στο εργαλείο Capture και επιλέξτε Change 
Group. 
Ανοίγει το παράθυρο διαλόγου Drive Group. 
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Εικόνα 6.6.6 Παράθυρο Drive Group 

 

9. Κάντε Ctrl + κλικ για να επιλέξετε τους οδηγούς που θέλετε να 
συμπεριληφθούν στην διαδικασία καταγραφής ή κάντε κλικ στην 
επιλογή All button για να επιλέξετε όλους τους οδηγούς. 
Αν κάνετε κλικ στο Clear, διαγράφονται όλες οι επιλογές. Πρέπει να 
επιλέξετε τουλάχιστον έναν οδηγό πριν κάνετε κλικ στο ΟΚ για να 
βγείτε από το παράθυρο διαλόγου. 

10. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου και να 
εφαρμόσετε τις αλλαγές. 

11. Συνεχίστε με την καταγραφή. 
Για τους σκοπούς διαχείρισης των αρχείων πολυμέσων, 
οποιοδήποτε κλιπ του οποίου τα πολυμέσα υπερβαίνουν το όριο 
των 2 GB έχει περισσότερα από ένα αρχείο πολυμέσων 
συνδεδεμένο μαζί του. 
 

6.6.11 Κατανόηση της μεθόδου Preroll 
Το μενού Preroll Method στο παράθυρο διαλόγου Capture Settings 
περιέχει τις παρακάτω τέσσερις μεθόδους που σας βοηθούν να 
καταγράψετε πιο αποτελεσματικά όταν η πηγαία κασέτα περιέχει 
διακοπές του Timecode: 

· Best Available: Το σύστημα Avid ελέγχει πρώτα την κασέτα για το 
Timecode για να το χρησιμοποιήσει για το preroll. 
¾Αν δεν υπάρχει timecode, ή δεν υπάρχει αρκετό timecode, το 

σύστημα χρησιμοποιεί το control track για το preroll. 
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¾Αν δεν υπάρχει αρκετό control track για το preroll, το σύστημα 
προσαρμόζει το καθορισμένο χρόνο preroll για να χωρέσει το 
σύνολο των έγκυρων control track που είναι διαθέσιμο. 
Αφού το σύστημα προσαρμόσει το preroll σε ξεχωριστά 
στιγμιότυπα, επιστρέφει στη χρήση χρόνου user-specified preroll, 
μέχρι να χρειαστεί να προσαρμόσει το χρόνο ξανά. 

¾Αν ο προσαρμοσμένος χρόνος preroll είναι ανεπαρκής για το 
συγχρονισμένο κλείδωμα στο σημείο IN, το σύστημα δεν 
καταγράφει το στιγμιότυπο και απεικονίζει μήνυμα σφάλματος 
(error message). 

Χρησιμοποιείστε αυτή τη μέθοδο για να καταγράψετε υλικό όσο πιο 
αυτόματα γίνεται. Καθώς το σύστημα κάνει πολλαπλές προσπάθειες 
για το preroll, η μέθοδος αυτή μπορεί μερικές φορές να είναι πιο 
αργή, αλλά σχεδόν πάντα εκτελεί το preroll χωρίς διακοπές. 

· Standard Timecode: Το σύστημα Avid χρησιμοποιεί το timecode για 
να προσδιορίσει το σημείο preroll. 
Αν δεν υπάρχει αρκετό συνεχόμενο timecode (π.χ. αν υπάρχει μια 
διακοπή στο timecode), το σύστημα δεν καταγράφει το στιγμιότυπο 
και απεικονίζει μήνυμα σφάλματος (error message). 
Χρησιμοποιήστε αυτή τη μέθοδο αν γνωρίζετε ότι το timecode είναι 
συνεχόμενο ή αν θέλετε να προσδιορίσετε αν υπάρχουν διακοπές 
στο timecode. 

· Best Available Control Track: Το σύστημα Avid χρησιμοποιεί το 
control track για να προσδιορίσει το preroll σημείο. 
¾Αν δεν υπάρχει αρκετό control track για το preroll, το σύστημα 

προσαρμόζει το καθορισμένο χρόνο preroll για να χωρέσει το 
σύνολο των έγκυρων control track που είναι διαθέσιμο. 
Αφού το σύστημα προσαρμόσει το preroll σε ξεχωριστά 
στιγμιότυπα, επιστρέφει στη χρήση χρόνου user-specified preroll, 
μέχρι να χρειαστεί να προσαρμόσει το χρόνο ξανά. 

¾Αν ο προσαρμοσμένος χρόνος preroll είναι ανεπαρκής για το 
συγχρονισμένο κλείδωμα στο σημείο IN, το σύστημα δεν 
καταγράφει το στιγμιότυπο και απεικονίζει μήνυμα σφάλματος 
(error message). 
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Χρησιμοποιείστε αυτή τη μέθοδο εάν γνωρίζετε ότι υπάρχουν 
διακοπές του timecode και θέλετε να καταγράψετε το υλικό όσο πιο 
αυτόματα γίνεται. Επειδή το σύστημα δεν χρησιμοποιεί timecode, 
μπορεί περιστασιακά να καταγράφει λάθος καρέ αν υπάρχει 
πρόβλημα με το control track. 

· Standard Control Track: Το σύστημα Avid χρησιμοποιεί το control 
track για να προσδιορίσει το preroll σημείο. 
Αν υπάρχει διακοπή στο control track, το σύστημα σταματάει την 
καταγραφή και απεικονίζει μήνυμα σφάλματος (error message). 
Χρησιμοποιείστε αυτή τη μέθοδο αν γνωρίζετε ότι το control track 
είναι συνεχόμενο ή αν θέλετε να προσδιορίσετε αν υπάρχουν 
διακοπές στο control track. 

 

6.6.12 Επιλέγοντας τη Preroll Method 
Για να ορίσετε τη preroll μέθοδο: 

1. Κάντε διπλό κλικ στο Capture από τη λίστα Settings στο παράθυρο 
του Project. 

2. Κάντε κλικ στο Preroll Method μενού και επιλέξτε μια μέθοδο. 
3. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου και να 

εφαρμόσετε τις επιλογές. 
 

 
Εικόνα 6.6.7 Παράθυρο Capture Settings - Preroll Method 
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6.7 Διερμηνεύοντας την οθόνη του εναπομείναντος χρόνου.  

Μπορείτε να διερμηνεύσετε τα νούμερα στην οθόνη του 
εναπομείναντος χρόνου (Time-Remaining display) στο εργαλείο Capture, 
βασισμένοι στους παρακάτω παράγοντες: 

· Κάθε καταγεγραμμένο κλιπ έχει μέγιστο μέγεθος αρχείου τα 2 GB. 
Οποιοδήποτε βίντεο κλιπ του οποίου το μέγεθος ξεπερνά τα 2 GB 
έχει περισσότερα από ένα αρχεία συνδεδεμένα με αυτό. 

· Όταν επιλέγετε διαφορετική ανάλυση, η οθόνη του εναπομείναντος 
χρόνου ρυθμίζεται ανάλογα. 

6.8 Προετοιμασία για την εισαγωγή ήχου 

Το σύστημα Avid υποστηρίζει απευθείας είσοδο τετρακάναλου ήχου 
μόνο όταν η ψηφιακή κάμερα ή το ψηφιακό deck είναι συνδεδεμένο 
μέσω FireWire και ο ρυθμός δειγματοληψίας ήχου είναι ρυθμισμένος 
στα 32 kHz. Αν η ψηφιακή κάμερα ή το ψηφιακό deck δεν είναι 
συνδεδεμένο και ο ρυθμός δειγματοληψίας ήχου δεν είναι 
ρυθμισμένος στα 32 kHz, η εφαρμογή Avid υποστηρίζει είσοδο ήχου 
μόνο δυο καναλιών. Η τοποθέτηση του πηγαίου track είναι 
δρομολογημένη απευθείας στα audio track στα καταγεγραμμένα κλιπ. 
Θα πρέπει επίσης να ρυθμίσετε τα επίπεδα εισόδου για κάθε 
βιντεοκασέτα όταν καταγράφετε, για να εξασφαλίσετε τη συνέχεια της 
ποιότητας της εικόνας μεταξύ των κασετών. 

Οι παρακάτω ενότητες παρέχουν περισσότερες πληροφορίες για την 
προετοιμασία για την εισαγωγή του ήχου: 

6.8.1 Προσαρμογή των ρυθμίσεων Audio Project 

Μπορείτε να χρησιμοποιήσετε το παράθυρο Audio Project Settings για 
να ελέγξετε την τρέχουσα διαμόρφωση του audio hardware και να 
επιλέξετε διάφορες επιλογές εισόδου και εξόδου. 

Κάποιες επιλογές εξαρτώνται από την ηχητική διαμόρφωση του 
συστήματος. Το σύστημα σας μπορεί να μην περιέχει κάποια 
χαρακτηριστικά και hardware τα οποία καλύπτονται στην τεκμηρίωση. 
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Για να ανοίξετε το παράθυρο Audio Project Settings: 

1. Κάντε κλικ στην καρτέλα Settings στο παράθυρο Project. 
Εμφανίζεται η λίστα Settings. 

2. Κάντε διπλό κλικ στο Audio Project. 
Ανοίγει το παράθυρο Audio Project Settings. 

Για περισσότερες πληροφορίες σχετικά με τα Audio Project Settings, 
ανατρέξτε στην ενότητα Audio Project Settings της βοήθειας της 
εφαρμογής. 

 
Εικόνα 6.8.1 Παράθυρο Audio Project Settings 

6.8.2 Επιλέγοντας μια ηχητική πηγή εισόδου (Audio Input 
Source) 
Μπορείτε να συνδέσετε μια ηχητική συσκευή στο σύστημά σας για την 
εισαγωγή του ήχου, ανάλογα με τη διαμόρφωσή σας. 

Για να επιλέξετε μια συσκευή εισόδου ήχου: 

1. Από το παράθυρο του Project, κάντε κλικ στην καρτέλα Settings. 
2. Κάντε διπλό κλικ στο Audio Project. 
3. Κάντε κλικ στην καρτέλα Input. 
4. Κάντε κλικ στο μενού Input Source και επιλέξτε μια πηγή για τον ήχο 

που θέλετε να καταγράψετε. 
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Εικόνα 6.8.2 Παράθυρο Audio Project Settings - Καρτέλα Input 

Το μενού εμφανίζει HD SDI σε HD projects και SD SDI σε SD projects. 
Οι επιλογές εισόδου εξαρτώνται από το ηχητικό εξοπλισμό που έχει 
εγκατασταθεί και συνδεθεί στο σύστημά σας. 

5. Κλείστε το παράθυρο Audio Project Settings. 
 

6.8.3 Επιλέγοντας τον τύπο αρχείου του ήχου 
Τα αρχεία ήχου AIFF-C και WAVE μπορούν να συνδυαστούν μέσα στο 
project. 
Ο ήχος είναι γραμμένος στον επιλεγμένο τύπο αρχείου όταν: 

· Καταγράφετε audio track στο Capture mode. 
· Χρησιμοποιείτε το Audio tool για να τονώσετε τα αρχεία ήχου. 
· Χρησιμοποιείτε το Audio Mixer tool για να μιξάρετε τα audio track. 
· Χρησιμοποιείτε το παράθυρο διαλόγου Import για να εισάγετε 

αρχεία. 
· Εφαρμόζετε το AudioSuite plug-in το οποίο δημιουργεί νέα πηγή 

ήχου. 
Αν διαφοροποιήσετε τον τύπο ήχου κατά τη διάρκεια του project, όλα 
τα νέα αρχεία ήχου που θα καταγραφούν, θα καταγραφούν με τον νέο 
τύπο με τις παρακάτω εξαιρέσεις: 

· Media αρχεία γραμμένα κατά τη διάρκεια rendering των ηχητικών 
εφέ: Το σύστημα χρησιμοποιεί τον τύπο αρχείου των A-side 
(εξερχόμενος ήχος) μέσων για τη μετάβαση.  

· Audio αρχεία γραμμένα όταν χρησιμοποιείτε το χαρακτηριστικό 
Consolidate: Media αρχεία τα οποία έχουν αντιγραφεί ή 
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δημιουργηθεί κατά τη διάρκεια της διαδικασίας consolidate, 
διατηρούν το αρχικό τους τύπο αρχείου. 

Για να επιλέξετε τον τύπο αρχείου του ήχου: 
1. Κάντε κλικ στην καρτέλα Settings από το παράθυρο του Project. 
2. Κάντε διπλό κλικ στο Audio Project. 
3. Κάντε κλικ στην καρτέλα Main. 
4. Κάντε κλικ στο μενού Audio File Format και επιλέξτε ανάμεσα σε 

WAVE (OMF) ή AIFF-C (OMF). 
5. Κλείστε το παράθυρο Audio Project Settings. 

 
Εικόνα 6.8.3 Παράθυρο Audio Project Settings-Audio File Format 

 
6.8.4 Χρήση του Audio Tool 
Το Audio tool μαζί με τις ηχητικές παραμέτρους του hardware σας, σας 
επιτρέπει να κάνετε τα παρακάτω στο πλαίσιο της προετοιμασίας για 
την είσοδο: 

· Έλεγχο και διαχείριση της εγκατάστασης του audio hardware σας. 
· Ρύθμιση των επιπέδων ήχου πριν την εγγραφή. 

Επιπλέον, οι ρυθμίσεις στο Audio tool σας επιτρέπουν να 
βαθμονομήσετε, να ορίσετε επίπεδα και να παράγετε 
προσαρμοσμένους τόνους βαθμονόμησης για την έξοδο σε ηχεία ή σε 
συσκευή εγγραφής. 
Για να ανοίξετε το Audio tool, κάντε ένα από τα παρακάτω: 
Ø Από το μενού της εφαρμογής, πηγαίνετε Tools > Audio Tool. 
Ø Κάντε κλικ στο κουμπί Audio tool από το Capture tool. 
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Ø Από το πληκτρολόγιο πατήστε Ctrl + 1. 
Ανοίγει το Audio tool και εμφανίζει μετρητές για δύο έως οχτώ κανάλια, 
ανάλογα με τη διαμόρφωση του συστήματός σας. 
 

 
Εικόνα 6.8.4 Το Audio tool 

 

Ο παρακάτω πίνακας περιγράφει τα στοιχεία του Audio tool. 
 
Audio tool Στοιχεία 
 

Στοιχείο Περιγραφή 

Reset Peak Button 

Επαναφέρει τις τρέχουσες 
μέγιστες μετρήσεις κορυφής. 
Επίσης σταματά την 
αναπαραγωγή του εσωτερικού 
τόνου βαθμονόμησης. 

In/Out toggle buttons 

Αλλάζει την ένδειξη των 
μετρητών για κάθε κανάλι 
μεταξύ των επιπέδων εισόδου 
από την πηγαία συσκευή και των 
επιπέδων εξόδου στα ηχεία ή τις 
συσκευές εγγραφής. Το I 
υποδηλώνει το Input (είσοδο) και 
το O, το Output (έξοδο). 
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Peak Hold Menu button 

Εμφανίζει ένα μενού το οποίο 
σας επιτρέπει να επιλέξετε 
επιλογές για την προσαρμογή της 
εμφάνισης των μετρητών και για 
τον καθορισμό της 
αναπαραγωγής του εσωτερικού 
τόνου βαθμονόμησης. 

Digital scale to the left of the 
meters 

Εμφανίζει ένα σταθερό εύρος 
τιμών από το 0 έως το -90 decibel 
(dB), σύμφωνα με τα κοινά 
πρότυπα του ψηφιακού μετρητή 
κορυφών. 

Volume unit (VU) scale (analog) 
to the right of the meters 

Εμφανίζει ένα εύρος τιμών που 
μπορείτε να ταιριάξετε σύμφωνα 
με την κάθετη απόσταση στάσης 
από την ηχητική πηγή. 

Meters 

Δυναμικά ακολουθεί τα επίπεδα 
του ήχου για κάθε κανάλι όπως 
παρακάτω: 
· Οι μετρητές δείχνουν με 

πράσινο χρώμα κάτω από το 
στοχευμένο επίπεδο 
αναφοράς (το προεπιλεγμένο 
επίπεδο αναφοράς είναι -14 
dBfs στην ψηφιακή κλίμακα). 

· Οι μετρητές δείχνουν με 
κίτρινο χρώμα για το 
κανονικό headroom εύρος, 
άνω του επιπέδου αναφοράς 
περίπου στα -3 dB. 

· Οι μετρητές δείχνουν με 
κόκκινο χρώμα όταν οι 
κορυφές πλησιάζουν την 
υπερφόρτωση, μεταξύ των -3 
dB και 0 dB. 

· Οι λεπτές πράσινες γραμμές 
στη βάση υποδεικνύουν τα 
σήματα κάτω από το εμφανές 
εύρος. 
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6.8.5 Ρύθμιση των επιπέδων εισόδου ήχου (Audio Input 
Levels) 
Μπορείτε να χρησιμοποιήσετε το Audio tool και το παράθυρο Audio 
Project Settings για να ρυθμίσετε τα επίπεδα εισόδου ήχου. 
Για να ρυθμίσετε τα γενικά επίπεδα εισόδου ήχου χρησιμοποιώντας 
το παράθυρο Audio Project Settings: 

1. Κάντε κλικ στα κουμπιά In/Out toggle στο Audio tool για τα κανάλια 
που χρησιμοποιείτε για την είσοδο. 
Το Audio tool εμφανίζει το Ι για το Input. 

2. Αναπαράγετε το πηγαίο ήχο (από την κάμερα ή κάποια άλλη 
συσκευή). Αν η εγγραφή περιέχει τόνο αναφοράς, κατευθυνθείτε 
προς τον τόνο και αναπαράγετε τον. 

3. Από το παράθυρο του Project, κάντε κλικ στην καρτέλα Settings και 
ύστερα διπλό κλικ στο Audio Project. 

4. Ρυθμίστε την εισαγωγή κάνοντας τα παρακάτω: 
i. Κάντε κλικ στην καρτέλα Input. 

ii. Σύρετε τη μπάρα κύλισης για να αυξήσετε ή χαμηλώσετε το 
επίπεδο εισόδου ήχου. 

iii. (Επιλογή) Αν θέλετε επιπλέον αύξηση, σύρετε τη μπάρα κύλισης 
προς τα κάτω του ελέγχου Input Gain, κάντε κλικ στο κουτάκι με 
το τικ +20 dB Gain και ρυθμίστε την ένταση στο Input Level 
μετρητή. 
 

6.8.6 Δημιουργία Tone Media 
Μπορείτε να δημιουργήσετε το δικό σας tone media master κλιπ για 
επεξεργασία απευθείας στις ακολουθίες. 
Για να δημιουργήσετε tone media και tone master κλιπ: 

1. Ανοίξτε ένα bin. 
2. Κάντε κλικ στο μενού PH (Peak Hold) στο Audio tool και επιλέξτε 

Create Tone Media. 
Ανοίγει το παράθυρο διαλόγου Create Tone Media. 

3. Ορίστε τις κατάλληλες παραμέτρους του calibration tone για το 
project σας. Μπορείτε επίσης να χρησιμοποιήσετε το 
προεπιλεγμένο επίπεδο του output tone media των -14 dB με σήμα 
των 1000 Hz. 
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Αν ορίσετε τη συχνότητα του tone media στο 0, το σύστημα παράγει 
απρογραμμάτιστο θόρυβο. Επίσης, μια τιμή των -777 παράγει το 
tone sweep. 

4. Επιλέξτε τον αριθμό των track των tone που θέλετε να 
δημιουργήσετε (μέχρι 8 track). 

5. Κάντε κλικ στα μενού και επιλέξτε το bin αποθήκευσης του tone 
master clip και τη μονάδα αποθήκευσης για το tone media αρχείο. 

6. Κάντε κλικ στο ΟΚ. 
Μετά από μερικά δευτερόλεπτα, το media αρχείο δημιουργείται και 
ένα master κλιπ εμφανίζεται στο bin που ορίσατε για την 
αποθήκευση. Το προεπιλεγμένο όνομα δείχνει τις επιλογές που 
έχετε επιλέξει. Μπορείτε να μετονομάσετε το κλιπ 
πληκτρολογώντας ένα νέο όνομα. 

 
6.9 Καλιμπράρισμα για την είσοδο βίντεο 
Θα πρέπει να καλιμπράρετε τα επίπεδα εισόδου για κάθε βιντεοκασέτα 
όταν καταγράφετε, για να σιγουρέψετε την συνέχεια της ποιότητας της 
εικόνας μεταξύ των κασετών. 
6.9.1 Πριν ξεκινήσετε το καλιμπράρισμα 
Πριν ξεκινήσετε να καλιμπράρετε για την είσοδο βίντεο, ελέγξτε ότι η 
οθόνη σας είναι σωστά καλιμπραρισμένη για την απεικόνιση των 
ακατέργαστων πλάνων βίντεο επακριβώς. Για περισσότερες 
πληροφορίες, ανατρέξτε στις οδηγίες χρήσης της οθόνης σας. 
6.9.2 Καλιμπράρισμα για την είσοδο βίντεο χειροκίνητα 
Για να καλιμπράρετε χειροκίνητα την εισαγωγή βιντεοκασέτας: 
Το εργαλείο Video Input εμφανίζεται μόνο όταν το σύστημα σας είναι 
συνδεδεμένο με τις συσκευές Avid Mojo ή Avid Mojo SDI. 

1. Πηγαίνετε Tools  > Video Input Tool. 
2. Κάντε κλικ στο μενού Input και επιλέξτε το κατάλληλο κανάλι 

εισόδου: Composite, SVideo, Component ή Host-1394. 
Το εργαλείο Video Input εμφανίζει τις κατάλληλες παραμέτρους για 
το επιλεγμένο τύπο βίντεο. 
Ο συγχρονισμός για την είσοδο του βίντεο προέρχεται από την πηγή 
που επιλέξατε στο εργαλείο Video Input. 
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Όταν καταγράφετε ήχο με βίντεο, ο ήχος είναι πάντα 
συγχρονισμένος στη βίντεο πηγή.  

3. Οδηγήστε την κασέτα στο τμήμα που περιέχει μέτρα και τόνους 
(συνήθως στην αρχή) και αναπαράγετε την κασέτα. 
Πάντα να αναπαράγετε την κασέτα όταν καλιμπράρετε. Η 
απεικόνιση του σήματος είναι ασταθής όταν η ταινία είναι σε 
παύση. 

4. Ανοίξτε την οθόνη Waveform κάνοντας κλικ στο κουμπί Waveform 
Monitor στο εργαλείο Video Input. 

5. Προσαρμόστε τη μπάρα κύλισης Line Selector που βρίσκεται κάτω 
από την οθόνη Waveform για να εμφανιστεί η κατάλληλη γραμμή 
του μοτίβου ελέγχου και στη συνέχεια ρυθμίστε τις τιμές 
φωτεινότητας. 

6. Κλείστε την οθόνη Waveform και ανοίξτε την οθόνη Vectorscope 
κάνοντας κλικ στο κουμπί Vectorscope. 

7. Προσαρμόστε τη μπάρα κύλισης Line Selector για να εμφανιστεί το 
σήμα για τις έγχρωμες γραμμές περίπου στη γραμμή 150 (αυτό 
εφαρμόζεται σε όλα τα σχήματα και σε όλους τους τύπους 
γραμμών). 

8. Χρησιμοποιείστε την οθόνη Vectorscope για να ορίσετε τη 
χρωμαύγεια προσαρμόζοντας τις μπάρες κύλισης Sat και Hue 
(Composite ή SVideo) ή τις μπάρες κύλισης RY Gain και BY Gain 
(Component), μέχρις ότου η γωνία και το πλάτος των έξι έγχρωμων 
διανυσμάτων, να εμπίπτουν στα πλαίσια στόχων στο vectorscope. 

6.10 Καταγραφή και Logging ταυτόχρονα. 

Όταν καταγράφετε χωρίς να έχετε εισάγει log πληροφορίες σε ένα bin 
από πριν, το σύστημα δημιουργεί κλιπ και σχετικά αρχεία πολυμέσων 
κατά την καταγραφή. Η καταγραφή με αυτόν τον τρόπο προϋποθέτει 
χειροκίνητη παρακολούθηση του πηγαίου αποσπάσματος μαζί με 
ελεγχόμενο σύστημα Avid χρησιμοποιώντας τα Deck controls στο 
Capture tool.  

Υπάρχουν κάμποσοι τρόποι για να καταγράψετε και να κάνετε log 
ταυτόχρονα: 
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6.10.1 Καταγραφή από το ένα σημείο στο άλλο 

Καταγράφοντας από IN point σε OUT point σας επιτρέπει να καθορίσετε 
ακριβώς το πού θα ξεκινήσει η καταγραφή και που θα τελειώσει. 
Μπορείτε να καθορίσετε μόνο ένα IN point ή OUT point και να 
μαρκάρετε τα άλλα σημεία κατά τη διάρκεια της καταγραφής. 
Χρησιμοποιήστε αυτή τη μέθοδο στις παρακάτω περιπτώσεις: 

· Αν τα log υπάρχουν σε μορφή κειμένου ή εκτυπώσιμη μορφή αλλά 
όχι σε κατάλληλο τύπο αρχείου για γρήγορη εισαγωγή στο σύστημα. 

· Αν τα IN και OUT σημεία είναι πρόχειρα και χρειάζεται διπλός 
έλεγχος για την εξακρίβωση των σημείων. 

· Αν είστε αρκετά εξοικειωμένοι με το πηγαίο υλικό ώστε να μπορείτε 
να υπολογίσετε το timecode για τα IN point, OUT point ή και τα δύο 
γρήγορα και με ακρίβεια. 

Οι παρακάτω ενότητες παρέχουν περισσότερες πληροφορίες σχετικά 
με τον ορισμό των Mark: 

6.10.1.1Καταγραφή από ένα IN point σε ένα OUT point 

Για να καταγράψετε από ένα IN point σε ένα OUT point: 
1. Προχωρήστε την κασέτα στην αρχή του κλιπ που θέλετε να 

καταγράψετε και ορίστε ένα IN point κάνοντας κλικ στο κουμπί . 
2. Προχωρήστε την κασέτα και μαρκάρετε ένα OUT point κάνοντας 

κλικ στο κουμπί , ή ορίστε το OUT point εν κινήσει όταν 
σταματήσετε την εγγραφή. 

3. Κάντε ένα από τα παρακάτω: 

Ø Κάντε κλικ στο κουμπί Capture  από το εργαλείο Capture. 
Ø Πατήστε F4 από το πληκτρολόγιο. 

4. Το εργαλείο Capture αυτόματα γυρνάει την κασέτα στο preroll 
σημείο πριν από το IN point του κλιπ και η κασέτα ξεκινάει να 

παίζει. Το πλαίσιο στη δεξιά πλευρά του κουμπιού Capture 
αναβοσβήνει φωτεινό κόκκινο και η γραμμή μηνυμάτων εμφανίζει 
το μήνυμα ότι το σύστημα καταγράφει. 

5. Ενώ το σύστημα καταγράφει, μπορείτε να πληκτρολογήσετε μια 
ονομασία για το κλιπ ή να εισάγετε σχόλια για το κλιπ. Όταν η 
κασέτα φτάνει στο σημείο OUT του κλιπ ή κάνετε κλικ στο κουμπί 



Σελίδα | 95  
 

Capture ξανά, η καταγραφή σταματάει και το σύστημα δημιουργεί 
ένα νέο κλιπ στο bin. 

 

6.10.1.2 Ορισμός και των δύο Mark. 
Για να καταγράψετε ορίζοντας και IN point και OUT point: 

1. Βεβαιωθείτε ότι έχετε επιλέξει όλες τις σωστές ρυθμίσεις για την 
καταγραφή και έχετε ρυθμίσει τα εργαλεία Capture και Audio όπως 
αναφέρθηκε στις προηγούμενες ενότητες. 

2. Ορίστε ένα IN point ή ένα OUT point για το κλιπ που θέλετε να 
καταγράψετε, χρησιμοποιώντας μία από τις παρακάτω μεθόδους: 
Ø Χρησιμοποιείστε τα κουμπιά ελέγχου του deck από το εργαλείο 

Capture. Προχωρήστε την πηγαία κασέτα στο σημείο που θέλετε 
να ξεκινήσετε ή να τελειώσετε το κλιπ και κάντε κλικ στα κουμπιά 
Mark IN  ή Mark OUT . 

Ø Αν το υλικό ξεκινάει σε γνωστό IN point ή τελειώνει σε γνωστό OUT 
point, τότε μπορείτε να πληκτρολογήσετε το timecode στην 
περιοχή οθόνης δίπλα από τα κουμπιά Mark. Κάντε κλικ στο Enter 
για να εισάγετε το mark. 
Για να ελέγξετε ξανά την ακρίβεια των IN ή OUT point, κάντε κλικ 
στο κουμπί Go to IN. Το σύστημα προχωράει την κασέτα και 
σταματάει το deck στο σημείο που βρίσκεται το mark. Μπορείτε να 
αναπαράγετε την κασέτα και να επαναφέρετε το mark, εφόσον 
είναι απαραίτητο. 

3. Για να τελειώσετε με το logging του κλιπ, χρησιμοποιείστε μια από 
τις παρακάτω μεθόδους: 
Ø Ορίστε το σχετικό IN ή OUT point. 
Ø Πληκτρολογήστε το timecode για τη διάρκεια των κλιπ στην 

περιοχή οθόνης δίπλα από τα Duration mark (κάτω από το OUT 
point) με τη σειρά HH:MM:SS:FF (ΩΩ:ΛΛ:ΔΔ:ΥΥ). 
Το σύστημα υπολογίζει αυτόματα το κατάλληλο timecode για τα 
αντίστοιχα IN point, OUT point ή τη διάρκεια. 

4. Κάντε κλικ στο κουμπί Capture  από το εργαλείο Capture. 

Το εργαλείο Capture αυτόματα γυρνάει την κασέτα στο preroll 
σημείο πριν από το IN point του κλιπ και η κασέτα ξεκινάει να 
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παίζει. Το πλαίσιο στη δεξιά πλευρά του κουμπιού Capture  
αναβοσβήνει φωτεινό κόκκινο και η γραμμή μηνυμάτων εμφανίζει 
το μήνυμα ότι το σύστημα καταγράφει. 

5. Ενώ το σύστημα καταγράφει, μπορείτε να πληκτρολογήσετε μια 
ονομασία για το κλιπ. Για να εισάγετε σχόλια για το κλιπ, πατήστε το 
πλήκτρο Tab αφού πληκτρολογήσατε την ονομασία του κλιπ και 
γράψτε σχόλια που θέλετε στο πλαίσιο σχολίων (comment box). Οι 
πληροφορίες που πληκτρολογείτε δεν εμφανίζονται στην οθόνη 
μέχρι να ολοκληρώσετε την καταγραφή. (Αφού κάνετε log στα κλιπ, 
μπορείτε να τροποποιήσετε τις πληροφορίες για να διορθώσετε 
εισαγωγικά σφάλματα ή να προσθέσετε πληροφορίες). 
Όταν η κασέτα φτάνει στο σημείο OUT του κλιπ ή κάνετε κλικ στο 
κουμπί Capture ξανά, η καταγραφή σταματάει και το σύστημα 
δημιουργεί ένα νέο κλιπ στο bin. 
 

6.10.1.3 Ορισμός μόνο του ενός Mark 
Για να ορίσετε μόνο ένα mark και να εισάγετε το άλλο κατά τη 
διάρκεια της καταγραφής, κάντε ένα από τα παρακάτω: 
Ø Μαρκάρετε ένα IN point και μετά κάντε κλικ στο κουμπί Capture 

 για να ξεκινήσει η καταγραφή. Έπειτα, ξανακάντε κλικ στο 
κουμπί Capture για να σταματήσετε την καταγραφή και να 
μαρκάρετε ένα OUT Point. 
Αυτή η μέθοδος είναι χρήσιμη αν δεν χρειάζεστε ένα ακριβές OUT 
point. Εξοικονομείτε χρόνο διότι δεν χρειάζεται να γυρίσετε όλη την 
ταινία για να εντοπίσετε το OUT point πριν την καταγραφή. 

Ø Ορίστε μόνο ένα OUT point και έπειτα μετακινηθείτε σε μία θέση 
στην κασέτα που είναι λίγα δευτερόλεπτα πριν από όπου θέλετε να 
αρχίσει η καταγραφή. Αναπαράγετε την κασέτα και στη συνέχεια 
κάντε κλικ αμέσως στο κουμπί Capture για να ξεκινήσετε 
καταγραφή εν κινήσει. Όταν η κασέτα φτάνει στο OUT point του 
κλιπ, σταματάει η καταγραφή. 
Αυτή η μέθοδος είναι χρήσιμη αν δεν χρειάζεστε ένα ακριβές 
σημείο IN αλλά χρειάζεστε να σταματήσετε σε ακριβές OUT σημείο, 
π.χ. πριν από τη διακοπή του timecode. 
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6.10.2 Καταγραφή εν κινήσει (On-the-fly) 
Χρησιμοποιείστε την μέθοδο καταγραφή εν κινήσει σε οποιαδήποτε 
από τις παρακάτω περιπτώσεις: 

· Αν θέλετε να ξεκινήσετε αμέσως την επεξεργασία και δεν υπάρχουν 
επαρκεί logs για την εισαγωγή στο σύστημα ή για τον ορισμό των 
mark. 

· Αν καταγράφετε από deck το οποίο δεν μπορεί να ελεγχθεί από το 
εργαλείο Capture. 

· Αν η πηγαία κασέτα δεν έχει timecode. 
· Αν καταγράφετε από ψηφιακή πηγή όπως CD-ROM ή DV κάμερα. 
· Αν καταγράφετε από ζωντανή πηγή. 
Υπάρχει μια μικρή καθυστέρηση αρκετών καρέ αφού επιλέξετε 
χειροκίνητα ένα σημείο για να ξεκινήσετε και να σταματήσετε την 
καταγραφή. Χρησιμοποιήστε αυτή τη μέθοδο όταν δεν χρειάζεστε 
ακριβή σημεία έναρξης και τέλους στο κλιπ σας. 

Για να καταγράψετε εν κινήσει: 

1. Κάντε κλικ στο κουμπί Capture/Log Mode  στο εργαλείο Capture 

μέχρι να εμφανιστεί το εικονίδιο CAP . Το εργαλείο Capture είναι 
έτοιμο για την καταγραφή.  

2. (Επιλογή) Κάντε κλικ στο τριγωνικό ανοιχτήρι στο εργαλείο Capture 
για να εμφανίσετε τα πλαίσια ονόματος (Name) και σχόλιου (Cmnt), 
αν σκοπεύετε να εισάγετε ονομασία ή σχόλιο στο κλιπ κατά τη 
διάρκεια της καταγραφής. 

3. Χρησιμοποιείστε τα κουμπιά ελέγχου deck στο εργαλείο Capture για 
να εντοπίσετε τη θέση στην κασέτα από όπου θέλετε να ξεκινήσετε 
την καταγραφή. 

4. Κάντε κλικ στο κουμπί Play και όταν το deck ανακτήσει τη σωστή 
ταχύτητα κάντε κλικ στο κουμπί Capture. 

5. Ενώ το σύστημα καταγράφει, μπορείτε να πληκτρολογήσετε την 
ονομασία του κλιπ στο πλαίσιο κειμένου Name. Πατήστε το πλήκτρο 
Tab αφού πληκτρολογήσατε το όνομα του κλιπ για να γράψετε 
σχόλια σχετικά με το κλιπ. 
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6. Κάντε κλικ στο κουμπί Pause οποιαδήποτε στιγμή για παύση της 
αναπαραγωγής. Μπορείτε επίσης να σταματήσετε τη διαδικασία της 
καταγραφής κάνοντας κλικ στο κουμπί Trash από το εργαλείο 
Capture. Το κλιπ αποβάλλεται. 

7. Για να σταματήσετε την καταγραφή και να εισάγετε ένα OUT σημείο 
στο κλιπ: 
Ø Κάντε κλικ στο κουμπί Capture. 
Ø Πατήστε το πλήκτρο Esc. 
Το σύστημα δημιουργεί ένα νέο κλιπ στο bin. 

 

6.10.3 Αυτόματη καταγραφή (Autocapture) 
Η αυτόματη καταγραφή μπορεί να σας εξοικονομήσει χρόνο, 
επιτρέποντας σας να παρακάμψετε τόσο τη διαδικασία logging όσο και 
το χρόνο που χρειάζεται για να σηματοδοτήσετε το κάθε κλιπ. Ωστόσο, 
αυτή η διαδικασία απαιτεί τον περισσότερο χώρο αποθήκευσης και 
δαπανάται περισσότερος χρόνος καθώς το σύστημα καταγράφει 
ολόκληρες κασέτες. 
Όταν καταγράφετε αυτόματα, εντοπίζετε και ορίζετε στην κασέτα το 
σημείο εκκίνησης και ξεκινάτε τη διαδικασία της αυτόματης 
καταγραφής μέσω του εργαλείου Capture. 
Όταν έχετε μεγάλα συνεχόμενα κλιπ, το καταγεγραμμένο υλικό για ένα 
κλιπ μπορεί να ξεπερνάει το όριο των 2 GB για τα μεγέθη των αρχείων 
στην εφαρμογή Avid. Σε αυτή την περίπτωση, θα πρέπει να επιλέξετε 
την επιλογή "Capture to multiple files" από το παράθυρο διαλόγου 
Capture Settings. 
Για να πραγματοποιήσετε αυτόματη καταγραφή: 

1. Κάντε κλικ στην καρτέλα Settings από το παράθυρο του Project. 
2. Κάντε διπλό κλικ στο Capture. 
3. Κάντε κλικ στην καρτέλα OMF Media Files ή στην καρτέλα MXF 

Media Files, ανάλογα τον τύπο των πολυμέσων σας. 
4. Επιλέξτε "Capture to multiple files" και έπειτα πληκτρολογήστε ένα 

χρόνο καταγραφής μεγαλύτερο της διάρκειας της κασέτας. 
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Εικόνα 6.10.1 Παράθυρο Capture Settings - καρτέλα OMF Media Files 
 

5. Κάντε κλικ στο ΟΚ. 
6. Στο εργαλείο Capture, κάντε κλικ στην ονομασία της κάμερας ή του 

deck και από το μενού επιλέξτε Adjust Deck. 
Ανοίγει το παράθυρο διαλόγου Deck Settings. 

 
Εικόνα 6.10.2 Παράθυρο διαλόγου Deck Settings 
 

7. Ορίστε μια preroll διάρκεια και αποεπιλέξτε το Fast Cue. 
8. Κάντε κλικ στο OK και κλείστε το παράθυρο διαλόγου Deck Settings. 
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9. Δημιουργήστε ένα νέο bin για κάθε πηγαία κασέτα και ονομάστε τα 
bin ύστερα από την ονομασία της κασέτας. Από προεπιλογή, όλα τα 
κλιπ ονομάζονται μετά την ονομασία της κασέτας και είναι 
αριθμημένα σταδιακά ξεκινώντας με .01. 

10. Επιλέξτε Tools > Capture και ανοίξτε το bin για την πρώτη κασέτα. 
11. Φορτώστε την πηγαία κασέτα και ελέγξτε για τυχών σφάλματα στην 

αρχή της κασέτας. 
12. (Επιλογή) Αν θέλετε το σύστημα να σταματά την καταγραφή από 

επιλεγμένο σημείο στην κασέτα, κάντε τα παρακάτω: 
α. Προχωρήστε την κασέτα στο επιλεγμένο OUT point. 
β. Κάντε κλικ στο κουμπί Mark OUT από το εργαλείο Capture. 
γ. Γυρίστε την κασέτα από την αρχή. 

13. Αναπαράγετε την κασέτα, περιμένετε 4 δευτερόλεπτα πριν κάνετε 
κλικ στο κουμπί Capture. 
Το σύστημα καταγράφει αυτόματα όλη την κασέτα. 

6.10.4 Καταγραφή από μη ελεγχόμενο από Avid, Deck 

Για να καταγράψετε με χειροκίνητο έλεγχο deck σε deck το οποίο δεν 
μπορεί να ελεγχθεί απευθείας από το σύστημα: 

1. Επιλέξτε από το μενού της εφαρμογής Tools > Capture. 
2. Επιλέξτε τις ηχητικές και βίντεο εισόδους. 

3. Κάντε κλικ στο κουμπί Toggle Source  στο εργαλείο Capture για 
να απενεργοποιήσετε τα κουμπιά ελέγχου των deck. 

 
Εικόνα 6.10.3 Το εργαλείο Capture- Απενεργοποιημένα κουμπιά ελέγχου 
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4. Κάντε κλικ στο μενού του Timecode Source και επιλέξτε ένα από τα 
παρακάτω: 
Η συσκευή που εμφανίζεται στο μενού Timecode Source 
δημιουργείται από τις τρέχων ρυθμίσεις του Deck Configuration. 

¾ Internal: Χρησιμοποιεί το εσωτερικό σύστημα timecode. Τα 
αποσπάσματα είναι καταγεγραμμένα με το time-of-day timecode 
που παράγεται από το σύστημα. 

¾ Auto Detect: Ανιχνεύει LTC εισόδους από προεπιλογή. Αν η LTC 
είσοδος είναι απενεργοποιημένη, το εργαλείο Capture μεταβαίνει 
αυτόματα στο εσωτερικό timecode. Αν η LTC είσοδος είναι ξανά 
ενεργοποιημένη, το εργαλείο Capture επιστρέφει στην LTC είσοδο. 

¾ Firewire Timecode: Ανιχνεύει το timecode μέσω μιας FireWire 
σύνδεσης. Το Firewire timecode είναι εισηγμένο στο μενού μόνο 
αν έχετε διαμορφώσει Firewire deck στο παράθυρο διαλόγου Deck 
Configuration. 

¾ RS422 Timecode: Ανιχνεύει το timecode μέσω μιας σειριακής 
σύνδεσης. Το RS422 Timecode είναι εισηγμένο στο μενού μόνο αν 
έχετε διαμορφώσει RS422 deck στο παράθυρο διαλόγου Deck 
Configuration. 

5. Κάντε κλικ στο κουμπί Source Tape Display. 
 
Επειδή η βάση δεδομένων των αρχείων πολυμέσων, δεν ανοίγει 
όταν ξεκινάτε το Avid σύστημα επεξεργασίας σας, δεν εμφανίζονται 
αυτόματα οι ονομασίες των κασετών όλων των συνδεδεμένων 
αρχείων πολυμέσων. 
Αν η ονομασία κασέτας την οποία αναζητάτε δεν εμφανίζεται στο 
παράθυρο διαλόγου Select Tape, κάντε κλικ στο κουμπί Scan for 
Tapes. Οι ονομασίες της κασέτας και του project εμφανίζονται στη 
λίστα. 
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Εικόνα 6.10.4 Παράθυρο Select Tape 

 

6. Δώστε μια ονομασία στην κασέτα με έναν από τους παρακάτω 
τρόπους: 
Ø Επιλέξτε μια ονομασία κασέτας από τη λίστα. Οι ονομασίες των 

κασετών και τα σχετιζόμενα project παρατίθενται σε δύο στήλες. 
Ø Κάντε κλικ στο New αν η κασέτα δεν βρίσκεται στη λίστα και 

πληκτρολογήστε μια νέα ονομασία στο πλαίσιο κειμένου που 
εμφανίζεται στο κάτω μέρος της λίστας Tape Name. 

Ø Κάντε κλικ στο Source Tape Display για να εμφανίσετε τις 
ονομασίες των κασετών και τις σχετιζόμενες project ονομασίες για 
όλα τα bin που έχουν ανοιχτεί στη τρέχουσα σύνοδο. 

Μπορείτε να σταματήσετε τη διαδικασία οποιαδήποτε στιγμή, 
πατώντας το πλήκτρο Cancel. 

7. Κάντε κλικ στο OK. Το όνομα της κασέτας εμφανίζεται στο εργαλείο 
Capture. 

8. Αναπαράγετε την κασέτα χειροκίνητα και κάντε κλικ στο κουμπί 

Capture  για να ξεκινήσετε ή να σταματήσετε την καταγραφή 
του κάθε κλιπ. 
 
Αν παρατηρήσετε ότι το καταγεγραμμένο υλικό σας χάνει ένα ή 
περισσότερα καρέ, επιλέξτε την επιλογή "Latency for no deck mode" 
από την καρτέλα General στο παράθυρο διαλόγου Capture Settings 
για να διορθώσετε το πρόβλημα. 
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6.10.5 Καταγραφή με Time-of-Day Timecode 
Όταν καταγράφετε με ένα Avid-ελεγχόμενο deck, μπορείτε να 
καταγράψετε τα αποσπάσματα σας με time-of-day timecode αντί του 
πηγαίου timecode. 
Για να καταγράψετε με time-of-day timecode: 

1. Ανοίξτε το εργαλείο Capture και προετοιμάστε το για καταγραφή. 
2. Όταν επιλέγετε τα track, κάντε κλικ στο κουμπί TC  για να το 

αποεπιλέξτε. 
3. Καταγράψτε με οποιαδήποτε τεχνική που περιγράφεται στην 

ενότητα 6.10.2 Καταγραφή εν κινήσει (On-the-fly). 
4. Θυμηθείτε να ξανά επιλέξετε το κουμπί TC πριν καταγράψετε με 

πηγαίο timecode ξανά. 
 

6.11 Δημιουργία Subclip κατά τη διάρκεια της καταγραφής 

Τα Subclip είναι μαρκαρισμένα τμήματα μεγαλύτερου master κλιπ που 
μπορείτε να εμφανίσετε και να επεξεργαστείτε όπως οποιοδήποτε άλλο 
αντικείμενο μέσα στο bin. Αυτή η ενότητα περιγράφει δύο μεθόδους 
για τη δημιουργία Subclip ενώ καταγράφετε: δημιουργώντας subclip εν 
κινήσει και δημιουργώντας χρονομετρημένα subclip. Ο μέγιστος 
αριθμός subclip που μπορείτε να δημιουργήσετε ενώ καταγράφετε ένα 
κλιπ, είναι 100.  
Όταν τα subclip δημιουργούνται σε 24p ή 25p project, πάντα 
δημιουργούνται ως "hard" subclip. Αυτό σημαίνει ότι δεν μπορείτε να 
κάνετε trim πέραν των ακμών του subclip όταν εφαρμόζετε transition 
και επεξεργασίες. Τα hard subclip προλαμβάνουν τα σφάλματα 
πληροφοριών film-tracking για επεξεργασία. 
 

6.11.1 Δημιουργία Subclip εν κινήσει 
Για να δημιουργήσετε ένα subclip εν κινήσει: 

1. Ξεκινήστε την καταγραφή ως συνήθως. 
2. Στο σημείο στο οποίο θέλετε να ξεκινήσει το subclip, πατήστε το 

πλήκτρο F1.  
Αυτό τονίζει το IN point του subclip στο εργαλείο Capture. 

3. Ενώ το σύστημα καταγράφει, μπορείτε να πληκτρολογήσετε μια 
ονομασία για το subclip. 
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Πατήστε το πλήκτρο Tab για να πληκτρολογήσετε σχόλια για το κλιπ. 
4. Όταν θέλετε να τελειώσει το subclip, πατήστε το πλήκτρο F2. 

Αυτό τονίζει το OUT point του Subclip στο εργαλείο Capture. 
Το subclip εμφανίζεται στο Bin που έχετε ορίσει για την αποθήκευση 
του όταν σταματάτε την καταγραφή. 
Όταν η καταγραφή είναι ολοκληρωμένη, εμφανίζεται ένας αριθμός 
μεταξύ των δεικτών subclip για να σας δείξει τον αριθμό των subclip 
που δημιουργήθηκαν. 

 
6.11.2 Δημιουργία χρονομετρημένων Subclip 

Μπορείτε να καταγράψετε subclip από μια προκαθορισμένη διάρκεια. 
Η καρτέλα Keys στο παράθυρο Capture Settings σας επιτρέπει να 
καθορίσετε τη διάρκεια του subclip που δημιουργείται αυτόματα όταν 
πατήσετε το πλήκτρο λειτουργίας που είναι αντιστοιχιζόμενο στο 
κουμπί Timed Subclip. Πατώντας το κουμπί Timed Subclip, 
δημιουργούνται IN και OUT σημεία σε προκαθορισμένα χρονικά 
διαστήματα πριν και μετά από το σημείο που έχετε σημειώσει στα 
πηγαία πολυμέσα. 
Για να ορίσετε τη διάρκεια του timed subclip: 

1. Κάντε διπλό κλικ στο Capture από την καρτέλα Settings του 
παραθύρου Project και κάντε κλικ στην καρτέλα Keys. 
 

 
Εικόνα 6.11.1 Παράθυρο Capture Settings - Καρτέλα Keys 
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2. Εισάγετε το χρόνο σε λεπτά και δευτερόλεπτα για να 
χρησιμοποιηθεί από το timed subclip, στα πλαίσια κειμένου Before 
(Λ:ΔΔ) και After (Λ:ΔΔ). 

3. Κάντε κλικ στο ΟΚ. 

Για να δημιουργήσετε ένα timed subclip: 

1. Ξεκινήστε να καταγράφετε ως συνήθως. 
2. Στο σημείο που θέλετε να ξεκινήσει το timed subclip, πατήστε το 

πλήκτρο F3. 
Αυτό τονίζει τα IN και OUT σημεία του subclip στο εργαλείο Capture 
και το subclip δημιουργείται αυτόματα. 

3. Ενώ το σύστημα καταγράφει, μπορείτε να πληκτρολογήσετε μια 
ονομασία για το subclip. Πατήστε το πλήκτρο Tab για να 
πληκτρολογήσετε σχόλια για το κλιπ. 
 

 
6.12 Καταγραφή στο Timeline 
Μπορείτε να καταγράψετε τα αποσπάσματα σας κατευθείαν από την 
κασέτα σε ακολουθία που είναι φορτωμένη στο Timeline με ένα βήμα, 
παρακάμπτοντας αρκετά βήματα όπως η οργάνωση και η αναθεώρηση 
του κλιπ, μαρκάρισμα σημείων επεξεργασίας και την εκτέλεση των 
επεξεργασιών. 
 
Για να καταγράψετε στο Timeline: 

1. Προετοιμάστε το σύστημα για την καταγραφή. 
2. Ορίστε τις παρακάτω επιλογές στο παράθυρο διαλόγου Capture 

Settings: 
α. Κάντε κλικ στην καρτέλα Settings στο παράθυρο Project. 
β. Από τη λίστα Settings, κάντε διπλό κλικ στο Capture. 
γ. Κάντε κλικ στην καρτέλα Edit. 
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Εικόνα 6.12.1 Παράθυρο Capture Settings - Καρτέλα Edit 

δ. Επιλέξτε Enable Edit to Timeline. 
ε. Ορίστε τη χειροκίνητη διάρκεια (το μέγεθος του αποσπάσματος 
που θέλετε να καταγράψετε πριν και μετά τα IN και OUT σημεία του 
κλιπ). 
στ. Κάντε κλικ στο ΟΚ. 

3. Φορτώστε μια ακολουθία στην οθόνη του Composer. 
4. (Επιλογή) Δρομολογήστε τα track στα οποία καταγράφετε (source 

tracks) στα track της ακολουθίας σας (record tracks). Δείτε στην 
ενότητα 6.12.1 Δρομολόγηση κατά τη διάρκεια της Καταγραφής 
στο Timeline. 

5. Μαρκάρετε ένα IN point στην ακολουθία ή μετακινήστε τον δείκτη 
θέσης εκεί που θέλετε να λάβει χώρα η επεξεργασία. 

6. Μαρκάρετε το πηγαίο υλικό που θέλετε να καταγράψετε 
χρησιμοποιώντας τα κουμπιά ελέγχου logging του εργαλείου 
Capture. 

7. (Επιλογή) Μαρκάρετε ένα OUT point βασισμένο στα παρακάτω: 
Ø Αν καταγράφετε στη μέση της ακολουθίας στο Timeline, 

μαρκάρετε και το IN και το OUT point για την ακρίβεια των καρέ. 
Ø Αν καταγράφετε προς το τέλος της ακολουθίας, μπορείτε να 

μαρκάρετε μόνο IN point και να μαρκάρετε το OUT point αργότερα 
εν κινήσει. 

8. Κάντε κλικ στο κουμπί Splice-in  ή το κουμπί Overwrite  στο 
Timeline για να επιλέξετε τον τύπο της επεξεργασίας. 
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9. Κάντε κλικ στο κουμπί Capture  για να ξεκινήσει η καταγραφή. 
10. Αν δεν μαρκάρατε το OUT point εκ των προτέρων, ξανά κάντε κλικ 

στο κουμπί Capture, όταν το απόσπασμα φτάσει στο κατάλληλο 
καρέ.  
Αν έχετε ήδη μαρκάρει ένα OUT point, η καταγραφή σταματάει 
αυτόματα όταν φτάσει στο OUT point. 
Όταν σταματάει η καταγραφή, το κλιπ εμφανίζεται στη θέση που 
του ορίσατε στην ακολουθία και ένα master κλιπ εμφανίζεται στο 
bin. 
 

6.12.1 Δρομολόγηση κατά τη διάρκεια της Καταγραφής στο 
Timeline 
Από προεπιλογή, τα track που έχετε επιλέξει για καταγραφή (V1, A1, A2 
και ούτω καθεξής) υπόκεινται σε επεξεργασία στα αντίστοιχα track στο 
Timeline. Μπορείτε να δρομολογήσετε το καταγεγραμμένο απόσπασμα 
σε οποιοδήποτε track στο Timeline. 
Για να δρομολογήσετε τα track όταν καταγράφετε στο Timeline: 

1. Στο εργαλείο Capture, κάντε κλικ και κρατήστε το κουμπί Channel 
Selection για το track (βίντεο ή ήχου) που θέλετε να δρομολογήσετε. 

2. Κάντε κλικ στο μενού και επιλέξτε το track στο οποίο θέλετε να 
δρομολογήσετε το καταγεγραμμένο απόσπασμα. 
Π.χ., αν θέλετε να καταγράψετε βίντεο απόσπασμα στο track V2, 
κάντε κλικ και κρατήστε το κόκκινο κουμπί V στο εργαλείο Capture 
και επιλέξτε V2. Το Track Selector πάνελ στο Timeline εμφανίζει την 
προκύπτουσα δρομολόγηση. 
 

6.13 Καταγραφή DV πολυμέσων απευθείας από DV συσκευή 
Μπορείτε να καταγράψετε DV 25, DV 50, DVCPRO HD και HD πολυμέσα 
κατευθείαν από DV κάμερα ή deck. Ο τρόπος που συνδέετε τη DV 
συσκευή εξαρτάται από τη διαμόρφωση του συστήματος σας και την 
ανάλυση DV που θέλετε να καταγράψετε. 
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6.13.1 Σύνδεση και επιλογή μιας DV συσκευής 
Η εφαρμογή επεξεργασίας Avid, σας επιτρέπει να καταγράψετε, να 
αναπαράγετε και να εξάγετε απευθείας σε DV κάμερα ή Deck (DV 
συσκευή). Ανάλογα με τη διαμόρφωση και τις απαιτήσεις, μπορείτε να 
συνδέσετε μια DV συσκευή σε μία από τις παρακάτω θύρες: 

· Στη θύρα 1394 στο Avid DNA hardware (Avid Mojo ή Avid Mojo SDI) 
εάν διαθέτετε. 

· Στη θύρα 1394 του υπολογιστή σας (Host 1394). 
 

6.13.1.1 Συνδέοντας μια συσκευή DV 
Ο παρακάτω πίνακας περιγράφει τις προτεινόμενες DV συνδέσεις που 
είναι διαθέσιμες για κάθε DV ανάλυση και διαμόρφωση του 
συστήματος. 
Στα Windows συστήματα με Avid Mojo, μπορείτε να καταγράψετε DV 
50, DVCPRO ή HDV μόνο μέσω μιας προαιρετικής IEEE-1394 κάρτας 
εγκαταστημένης στον υπολογιστή σας. Αυτή η κάρτα θα πρέπει να είναι 
σε ξεχωριστό δίαυλο από αυτό που χρησιμοποιείται από το Avid Mojo. 
Στα συστήματα με Avid Mojo SDI, μπορείτε να χρησιμοποιήσετε τη θύρα 
1394 του Avid Mojo SDI ή τη θύρα 1394 στον υπολογιστή σας. 
 

DV συνδέσεις για καταγραφή, αναπαραγωγή και ψηφιακή αποκοπή  
 

DV Ανάλυση Avid Mojo Avid Mojo SDI Μόνο Εφαρμογή 

DV 25 Avid Mojo ή Host 
1394 

Avid Mojo SDI ή Host 
1394 Host 1394 

DV 50 Host 1394 Avid Mojo SDI ή Host 
1394 Host 1394 

DVCPRO HD Host 1394 Avid Mojo SDI ή Host 
1394 Host 1394 

HDV1 Host 1394 Avid Mojo SDI ή Host 
1394 Host 1394 

1 Για τα HDV πολυμέσα, η αναπαραγωγή απευθείας με HDV συσκευή δεν υποστηρίζεται. Χρειάζεται 
να εξάγετε stream μεταφοράς. 
 

6.13.1.2 Επιλογή μιας DV συσκευής 
Όταν θέλετε να χρησιμοποιήσετε μια DV συσκευή για καταγραφή, 
αναπαραγωγή ή εξαγωγή,  θα πρέπει να το επιλέξετε στην εφαρμογή 
επεξεργασίας Avid. Μπορείτε να χρησιμοποιήσετε το Special > Device 
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μενού ή το κουμπί DNA/1394 στο παράθυρο Timeline για να επιλέξετε 
τη συσκευή χωρίς να αποσυνδέσετε τον εξοπλισμό σας. 
Αν το σύστημά σας έχει προσαρτημένο Avid DNA hardware, η 
προεπιλογή του συστήματος είναι DNA και όταν επιλέγεται ένα νέο 
Project, το σύστημα επιλέγει αυτόματα DNA. Αν το σύστημά σας δεν 
έχει προσαρτημένο Avid DNA hardware, η προεπιλογή του συστήματος 
είναι 1394 και δεν μπορείτε να μεταβείτε σε DNA. 
Για να επιλέξετε συσκευή για καταγραφή, αναπαραγωγή ή εξαγωγή, 
κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ στο κουμπί DNA/1394  πάνω από το Timeline για να 

εμφανίσετε το DNA ή το 1394, ανάλογα με το πώς είναι 
συνδεδεμένη η DV συσκευή σας. 

Ø Επιλέξτε Special > Device και έπειτα επιλέξτε Avid DNA ή IEEE 1394, 
ανάλογα με το πώς είναι συνδεδεμένο το Client monitor. 
Ένα σημάδι ελέγχου εμφανίζεται δίπλα από το IEEE 1394 στο μενού 
Device. 

Τα εργαλεία Video Input, Capture, Video Output και Digital Cut, 
εμφανίζουν όλα την επιλογή της συσκευής σας. 
Στα συστήματα που διαθέτουν μόνο λογισμικό, η μόνη διαθέσιμη 
επιλογή είναι το IEEE 1394. 
Αν καταγράφετε μέσω της θύρας 1394 στο Avid Mojo SDI, θα πρέπει να 
επιλέξετε IEEE 1394. Η θύρα 1394 στο Avid Mojo SDI περνάει το σήμα 
μέσω της θύρας 1394 στον υπολογιστή σας. 
 

6.13.2 Καταγραφή πολυμέσων DV 25 
Για τα συστήματα με Avid DNA hardware, μπορείτε να καταγράψετε DV 
25 μέσω μιας από τις παρακάτω συνδέσεις: 

· Μέσω της θύρας 1394 στο Avid hardware (Avid Mojo ή Avid Mojo 
SDI) 

· Μέσω της θύρας 1394 στον υπολογιστή σας (Host 1394). 
Στα Windows συστήματα με Avid Mojo, η θύρα πρέπει να είναι σε 
προαιρετική IEEE-1394 κάρτα εγκατεστημένη σε ξεχωριστό δίαυλο 
από αυτό που χρησιμοποιείται από το Avid Mojo.  

Εσείς καθορίζετε τη συσκευή εισόδου DV χρησιμοποιώντας το κουμπί 
DNA/1394 πάνω από το παράθυρο του Timeline ή με τις εντολές από το 
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μενού Device (δείτε στην ενότητα 6.13.1 Σύνδεση και επιλογή μιας DV 
συσκευής). 
DV 25 κωδικοποιητής λογισμικού 
Αν καταγράφετε μέσω του Avid Mojo, έχετε την επιλογή της χρήσης του 
Avid DNA hardware κωδικοποιητή ή το DV 25 κωδικοποιητή λογισμικού. 
Αν καταγράφετε μέσω του Avid Mojo SDI ή σε ξεχωριστό IEEE 1394, η 
εφαρμογή χρησιμοποιεί αυτόματα το DV 25 κωδικοποιητή λογισμικού. 
Επιλέξτε το DV 25 κωδικοποιητή λογισμικού, όταν είστε σε NTSC 
23.976p ή 24p project και καταγράφετε DV 25 από αναλογική συσκευή 
ή SDI. Ο DV 25 κωδικοποιητής λογισμικού, σας επιτρέπει να 
καταγράψετε με βασικό ή προχωρημένο pulldown. Αν δεν έχετε 
επιλέξει τον DV 25 κωδικοποιητή λογισμικού, μπορείτε να 
καταγράψετε μόνο προχωρημένο pulldown. 
 

Για να επιλέξετε τον DV 25 κωδικοποιητή λογισμικού: 
1. Kάντε διπλό κλικ στο Capture από τη λίστα Settings. 
2. Κάντε κλικ στην καρτέλα DV Options. 
3. Επιλέξτε "Use software DV 25 codec". 
4. Κάντε κλικ στο ΟΚ. 

 

6.13.3 Καταγραφή DV 50, DVCPRO HD, ή HDV Media 
Για τα συστήματα Avid Mojo, μπορείτε να καταγράψετε DV 50, DVCPRO 
HD, ή HDV πολυμέσα μόνο μέσω της θύρας IEEE-1394 στον υπολογιστή 
σας. Για τα συστήματα Windows, αυτή η θύρα πρέπει να είναι σε 
προαιρετική IEEE-1394 κάρτα εγκατεστημένη σε ξεχωριστό δίαυλο από 
αυτό που χρησιμοποιείται από το Avid Mojo. Εσείς καθορίζετε τη 
συσκευή εισόδου DV χρησιμοποιώντας το κουμπί DNA/1394 πάνω από 
το παράθυρο του Timeline ή με τις εντολές από το μενού Device (δείτε 
στην ενότητα 6.13.1 Σύνδεση και επιλογή μιας DV συσκευής). 
Για τα συστήματα Avid Mojo SDI, μπορείτε να χρησιμοποιήσετε τη θύρα 
1394 στο Avid Mojo SDI ή μια θύρα σε ξεχωριστή κάρτα 1394. Σε 
οποιαδήποτε περίπτωση, επιλέξτε IEEE 1394 ως είσοδος συσκευής. 
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Κεφάλαιο 7 

Εισαγωγή αρχείων 

Όταν εισάγετε αρχεία, το σύστημα τα μετατρέπει σε αντικείμενα σε ένα 
Bin. Μπορείτε να χειριστείτε και να επεξεργαστείτε αυτά τα 
αντικείμενα, όπως θα κάνατε με οποιοδήποτε άλλο κλιπ ή ακολουθία. 
Τυχόν αντίστοιχα αρχεία πολυμέσων αποθηκεύονται σε μια μονάδα 
δίσκου που καθορίζετε.  

Μπορείτε να εισάγετε αμφότερα, Single-layer και multilayered γραφικά 
που έχουν δημιουργηθεί στο Adobe Photoshop. Αν εισάγετε 
multilayered γραφικά μπορείτε να διατηρήσετε τα αρχικά layers και στη 
συνέχεια να τα επεξεργαστείτε μεμονωμένα στην Avid εφαρμογή σας. 

Μπορείτε επίσης να εισάγετε και να επεξεργαστείτε XDCAM DVCAM 
αρχεία πολυμέσων. Ωστόσο, το Avid Xpress Pro δεν υποστηρίζει την 
εργασία με XDCAM υψηλής ανάλυσης MPEG MXI αρχεία πολυμέσων. 

7.1 Προετοιμασία για την εισαγωγή αρχείων 

Πριν ξεκινήσετε τη διαδικασία εισαγωγής, βεβαιωθείτε ότι το σύστημα 
και τα αρχεία είναι έτοιμα για την εισαγωγή ως εξής: 

· Διαβάστε σχετικά με τα θέματα και συμβουλές για τα Mixed 
Resolution Projects στην παράγραφο 7.2 Δουλεύοντας με Mixed 
Resolution Project. 

· Για την εισαγωγή αρχείων γραφικών και OMFI (Open Media 
Framework Interchange), προετοιμάστε τα αρχεία εκ των προτέρων, 
σύμφωνα με τις προδιαγραφές που περιγράφονται στην 
παράγραφο File Format Specifications της βοήθειας της εφαρμογής. 

· Για την πλήρη περιγραφή όλων των επιλογών στο παράθυρο 
διαλόγου Import Settings, ανατρέξτε στην παράγραφο Import 
Settings της βοήθειας της εφαρμογής. 
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7.2 Δουλεύοντας με Mixed Resolution Project 

Μπορείτε να εργαστείτε με μεικτές αναλύσεις στην ίδια ακολουθία. 
Αυτό το χαρακτηριστικό σας επιτρέπει να εισάγετε γραφικά που 
ταιριάζουν με την ανάλυση της τελικής ακολουθίας. Δεν μπορείτε 
ωστόσο να αναμειγνύετε κλιπ με διαφορετικό ρυθμό καρέ. Για 
παράδειγμα, δεν μπορείτε να αναμείξετε NTSC με PAL. Η Avid συνιστά 
να μην αναμειγνύετε interlaced αναλύσεις με progressive αναλύσεις. Η 
ανάμειξη interlaced αναλύσεων με progressive αναλύσεις, μπορεί να 
αποτελέσει προβλήματα στους κυλιόμενους τίτλους, στην εξαγωγή και 
στην εκτέλεση Digital Cut. 

Για περισσότερες πληροφορίες σχετικά με τις αναλύσεις, μπορείτε να 
ανατρέξετε στην παράγραφο Resolutions and Storage Requirements 
της βοήθειας της εφαρμογής. 

Για να επανεισάγετε γραφικά που έχουν εισαχθεί, σε μεγαλύτερη 
ανάλυση, χρησιμοποιήστε το χαρακτηριστικό Batch Import, το οποίο 
διατηρεί δεσμούς με τα αρχικά κλιπ και τις ακολουθίες. Για 
περισσότερες πληροφορίες, μπορείτε να ανατρέξετε στην παράγραφο 
Reimporting Files της βοήθειας της εφαρμογής. 

7.3 Δημιουργία και χρήση των ρυθμίσεων εισαγωγής (Import 
Settings) 

Μπορείτε να δημιουργήσετε ένα ή περισσότερα σύνολα παραμέτρων 
εισαγωγής και να τα αποθηκεύσετε ως ρύθμιση εισαγωγής. Για 
παράδειγμα, μπορείτε να δημιουργήσετε μια ρύθμιση για την εισαγωγή 
Quicktime αρχείων και μια άλλη ρύθμιση για την εισαγωγή αρχείων από 
άλλη εφαρμογή. Το χαρακτηριστικό αυτό είναι ιδιαίτερα χρήσιμο όταν 
χρησιμοποιείτε τη μέθοδο drag-and-drop για την εισαγωγή πολλαπλών 
αρχείων. 

Η προεπιλεγμένη ρύθμιση εισαγωγής και τυχόν πρόσθετες ρυθμίσεις 
εισαγωγής που δημιουργείτε εμφανίζονται στην καρτέλα Settings. Αφού 
επιλέξετε μια ρύθμιση από την καρτέλα Settings, οι παράμετροι 
διατηρούν τις προεπιλεγμένες ρυθμίσεις για όλα τα αρχεία που έχουν 
εισαχθεί, εκτός αν τις αλλάξετε κατά τη διάρκεια της εισαγωγής. 
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7.3.1 Δημιουργία νέας Ρύθμισης Εισαγωγής. 

Για να δημιουργήσετε μία νέα ρύθμιση εισαγωγής, κάντε τα 
παρακάτω: 

1. Κάντε κλικ στην καρτέλα Settings στο παράθυρο του Project. 
2. Κάντε κλικ στο Import για να το επιλέξετε. 
3. Κάντε δεξί κλικ στο Import και επιλέξτε Duplicate ή από το μενού της 

εφαρμογής πηγαίνετε Edit > Duplicate ή από το πληκτρολόγιο 
πατήστε Ctrl + D. 

4. Δώστε ονομασία στη ρύθμιση: 
i. Κάντε κλικ στη μεσαία στήλη.  

Εμφανίζεται ένα πλαίσιο κειμένου με τον κέρσορα να 
αναβοσβήνει ή σε περίπτωση που έχει κάποια προεπιλεγμένη 
ονομασία, αυτή φωτίζεται. 

ii. Πληκτρολογήστε την ονομασία που επιθυμείτε. 
iii. Πατήστε το Enter από το πληκτρολόγιο. 

5. Κάντε διπλό κλικ στην καινούρια ρύθμιση εισαγωγής. 
 Ανοίγει το παράθυρο διαλόγου Import Settings. 

 
Εικόνα 7.3.1 Το παράθυρο Import Settings 
 

6. Επιλέξτε τις κατάλληλες επιλογές.  
Μπορείτε να ανατρέξετε στην παράγραφο Import Settings της 
βοήθειας της εφαρμογής για να βοηθηθείτε σχετικά με τις επιλογές. 
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7. Κάντε κλικ στο Ok. 

Μόλις δημιουργήσετε μια νέα ρύθμιση εισαγωγής, μπορείτε να 
επιλέξετε τη ρύθμιση κάθε φορά που εισάγετε ένα καρέ, κλιπ ή 
ακολουθία. 

7.3.2 Τροποποίηση υπάρχοντος Ρύθμισης εισαγωγής 

Για να τροποποιήσετε υπάρχον ρύθμιση εισαγωγής, κάντε τα 
παρακάτω: 

1. Κάντε κλικ στην καρτέλα Settings στο παράθυρο του Project. 
2. Διπλό κλικ σε ένα Import Setting. 

Ανοίγει το παράθυρο διαλόγου Import Settings. 
3. Επιλέξτε τις κατάλληλες επιλογές.                

Μπορείτε να ανατρέξετε στην παράγραφο Import Settings της 
βοήθειας της εφαρμογής για να βοηθηθείτε σχετικά με τις επιλογές. 

4. Κάντε κλικ στο Ok. 

7.4 Εισάγοντας Αρχεία 

Μπορείτε να αποκτήσετε πρόσβαση στα αρχεία για την εισαγωγή από 
οποιονδήποτε φάκελο, δίσκο, ή δίσκου που είναι τοποθετημένος στον 
υπολογιστή σας, όπως μια δισκέτα, σταθερό δίσκο, εξωτερικό δίσκο, ή 
διακομιστή δικτύου. Μπορείτε να εισάγετε περισσότερα από ένα 
αρχείο τη φορά, συμπεριλαμβανομένων των αρχείων πολλαπλών 
τύπων. 

Φροντίστε να αντιγράψετε όλα τα γραφικά αρχεία σε ένα φάκελο πριν 
από την εισαγωγή των αρχείων. Χρησιμοποιώντας αυτόν το φάκελο, 
σας βοηθά να διαχειρίζεστε γραφικά από πολλαπλές πηγές και 
βελτιστοποιεί τη διαδικασία επανεισαγωγής, διότι όλα τα γραφικά 
δείχνουν προς την ίδια αρχική διαδρομή. 

Για να εισάγετε αρχεία, κάντε τα παρακάτω: 

1. Αν έχετε δημιουργήσει ένα ή περισσότερα Import Settings, επιλέξτε 
το Import Setting που θέλετε να χρησιμοποιήσετε από την καρτέλα 
Settings. 



Σελίδα | 115  
 

2. Ανοίξτε το Bin, στο οποίο θέλετε να αποθηκεύσετε τα αρχεία που 
θέλετε να εισάγετε. 

3. Από το μενού της εφαρμογής, πηγαίνετε File > Import ή κάντε δεξί 
κλικ μέσα στο Bin και επιλέξτε Import. 
Ανοίγει το παράθυρο διαλόγου Select Files to Import. 
 

 
Εικόνα 7.4.1 Το παράθυρο Select files to Import 
 

4. Κάντε κλικ στα Αρχεία Τύπου και επιλέξτε έναν τύπο αρχείου 
εισαγωγής, για να εμφανίσετε μόνο τα αρχεία του επιλεγμένου 
τύπου αρχείου στη λίστα αρχείων προέλευσης. 

5. Κάντε κλικ στο Options για να προσαρμόσετε τις ρυθμίσεις 
εισαγωγής. 
Ανοίγει το παράθυρο διαλόγου Import Settings, στο οποίο μπορείτε 
να επιλέξετε διάφορες παραμέτρους. Τα περιεχόμενα του 
παραθύρου διαλόγου Import Settings, εξαρτώνται από τον τύπο του 
αρχείου που επιλέξατε. 

6. Για να εισάγετε μια σειρά από διαδοχικά αριθμημένα αρχεία, 
επιλέξτε το πρώτο αρχείο στην ακολουθία. Για να επιλεγεί 
αυτόματα ολόκληρη η ακολουθία των αρχείων, θα πρέπει να 
επιλέξετε την επιλογή Autodetect Sequential files από το παράθυρο 
διαλόγου Import Settings στην καρτέλα Image. 
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Εικόνα 7.4.2 Το παράθυρο Import Settings - Autodetect Sequential Files 
 

7. Επιλέξτε τις επιλογές ήχου στην καρτέλα Audio για να σιγουρευτείτε 
ότι τα εισαγόμενα αρχεία ταιριάζουν με το τρέχων ρυθμό 
δειγματοληψίας και βάθος Bit του Project. 

 
Εικόνα 7.4.3 Το παράθυρο Import Settings - Καρτέλα Audio 
Αυτές οι επιλογές είναι αποεπιλεγμένες από προεπιλογή. Το 
σύστημα Avid, προσπαθεί να εισάγει τα ηχητικά πολυμέσα με το 
πηγαίο ρυθμό δειγματοληψίας και βάθος Bit και μετατρέπει 
αυτόματα το ρυθμό δειγματοληψίας ή το βάθος Bit στο ρυθμό ή το 
βάθος Bit του Project μόνο αν τα πηγαία αρχεία είναι σε ρυθμό ή 
βάθος Bit στα οποία το σύστημα δεν υποστηρίζει. Επιλέξτε μία ή 
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περισσότερες επιλογές ήχου, εάν δεν θέλετε τα ηχητικά πολυμέσα 
να εισαχθούν με το πηγαίο ρυθμό δειγματοληψίας ή βάθος Bit. 

8. Επιλέξτε τις άλλες επιλογές που θέλετε και στη συνέχεια κάντε κλικ 
στο κουμπί OK για να αποθηκεύσετε τις ρυθμίσεις. 

9. Κλείστε το παράθυρο διαλόγου Import Settings και επιστρέψτε στο 
παράθυρο διαλόγου Select Files to Import. 

10. Κάντε κλικ στο πλαίσιο Διερεύνηση σε για να εντοπίσετε το φάκελο 
που περιέχει τα αρχεία προέλευσης. 

11. Επιλέξτε ή αποεπιλέξτε τα αρχεία που θέλετε να εισάγετε από το 
φάκελο προέλευσης χρησιμοποιώντας τις μεθόδους επιλογής του 
λειτουργικού συστήματος. 

12. Κάντε κλικ στο μενού Video Resolution και επιλέξτε την ανάλυση για 
τα εισαγόμενα πολυμέσα. 

13. Κάντε κλικ στο κουμπί Single/Dual Drives  και από το μενού 
επιλέξτε μια μονάδα δίσκου προορισμού για το αρχείο που θα 
εισαχθεί. 

14. Κάντε κλικ στο Open. 
Όταν το σύστημα ολοκληρώσει την εισαγωγή των αρχείων, τα κλιπ 
εμφανίζονται στo επιλεγμένο Bin. 

7.5 Εισαγωγή αρχείων με τη μέθοδο Drag-and-Drop 

Για να εισάγετε ένα ή περισσότερα αρχεία με τη μέθοδο Drag-and-
Drop, κάντε τα παρακάτω: 

1. Κάντε κλικ στην καρτέλα Settings στο παράθυρο του Project. 
2. Επιλέξτε τη ρύθμιση που θέλετε να χρησιμοποιήσετε για την 

εισαγωγή. Επιλέξτε είτε τη προεπιλεγμένη ρύθμιση εισαγωγής ή 
κάποια που έχετε δημιουργήσει εσείς. 

3. Ανοίξτε το Bin, στο οποίο θέλετε να αποθηκεύσετε τα αρχεία που 
θέλετε να εισάγετε. 

4. Ανοίξτε το φάκελο που περιέχει τα αρχεία που θέλετε να εισάγετε. 

Κάντε κλικ στο αρχείο που θέλετε να εισάγετε και σύρετε το αρχείο στο 
Bin. Για να επιλέξετε πολλά αρχεία, κάντε Ctrl + κλικ στα αρχεία που 
θέλετε να επιλέξετε και σύρετε τα αρχεία στο Bin. 
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Κεφάλαιο 8 

Δημιουργία Ακολουθίας 

8.1 Δημιουργία μιας νέας ακολουθίας 

Για να δημιουργήσετε μια ακολουθία: 

1. Από το μενού της εφαρμογής επιλέξτε Clip > New Sequence. 
Συμβαίνει ένα από τα ακόλουθα: 

¾ Αν είναι ανοιχτό μόνο ένα bin, ή αν είναι ανοιχτά μερικά bin και 
κάνατε κλικ σε συγκεκριμένο bin για να το ενεργοποιήσετε, η νέα 
ακολουθία εμφανίζεται στο bin. 

¾ Αν είναι ανοιχτά μερικά bin αλλά κανένα δεν είναι 
ενεργοποιημένο, εμφανίζεται το παράθυρο διαλόγου Select. 

 
Εικόνα 8.1.1 Το παράθυρο διαλόγου Select 
 

2. Επιλέξτε το bin στο οποίο θέλετε να αποθηκεύσετε τη νέα 
ακολουθία, ή κάντε κλικ στο κουμπί New Bin για να δημιουργήσετε 
και να ανοίξετε ένα νέο bin. 

3. Κάντε κλικ στο ΟΚ. 
Μια ανώνυμη ακολουθία εμφανίζεται στο bin, στο Composer 
monitor και στο Timeline. 
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Εικόνα 8.1.2 Εμφάνιση νέας ακολουθίας στο bin 
 

Για να μετονομάσετε την νέα ακολουθία: 
Ø Πληκτρολογήστε μια ονομασία ενώ είναι φωτισμένο το όνομα στο 

bin. 
Εάν κάνετε κλικ οπουδήποτε στην επιφάνεια αφού δημιουργήσετε 
τη νέα ακολουθία, απενεργοποιείται το πλαίσιο ονόματος της 
ακολουθίας. Θα πρέπει να κάνετε κλικ στο όνομα της ακολουθίας 
ξανά για να μετονομάσετε την ακολουθία. 

 
8.2 Αλλαγή των πληροφοριών της ακολουθίας 
Η παρακάτω προαιρετική διαδικασία σας επιτρέπει να μετονομάσετε τη 
νέα ακολουθία και να ορίσετε ένα προσαρμοσμένο start timecode 
χρησιμοποιώντας την εντολή Get Sequence Info. 
Για να μετονομάσετε μια ακολουθία και να ορίσετε ένα 
προσαρμοσμένο timecode: 

1. Έχοντας φορτωμένη την ακολουθία και ενεργοποιημένο το 
Composer μόνιτορ, επιλέξτε από το μενού της εφαρμογής File > Get 
Sequence Info. 
Εμφανίζεται το παράθυρο διαλόγου Sequence Info. 
 

 
Εικόνα 8.2.1 Το παράθυρο διαλόγου Sequence Info 
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2. Πληκτρολογήστε μια ονομασία στο πλαίσιο κειμένου Name. 
3. Σύρετε το δείκτη κατά μήκος του Start timecode και έπειτα 

πληκτρολογήστε ένα νέο timecode. 
4. (Επιλογή) Για 24p ή 25p projects, σύρετε το δείκτη κατά μήκος του 

start key number και πληκτρολογήστε ένα νέο start key number. 
5. Κάντε κλικ στο ΟΚ. 

 
8.3 Αλλαγή του Start Timecode για τις Ακολουθίες 
Για να αλλάξετε το χρόνο εκκίνησης μιας ακολουθίας που έχει ήδη 
δημιουργηθεί: 

1. Κάντε κλικ στον χρόνο εκκίνησης της ακολουθίας στο bin. 
2. Πληκτρολογήστε ένα νέο timecode. 

 
8.4 Ορισμός των Track για τη νέα ακολουθία 
Όταν δημιουργείτε μια νέα ακολουθία χρησιμοποιώντας την εντολή 
New Sequence και δεν έχει φορτωθεί κανένα υλικό στο Source pop-up 
μόνιτορ, το Timeline είναι άδειο. 
Για να προσθέσετε ένα νέο track σε ακολουθία που φορτώνεται στο 
Composer μόνιτορ: 
Ø Από το μενού της εφαρμογής επιλέξτε Clip > New Audio Track ή 

επιλέξτε Clip > New Video Track. 
Το νέο track εμφανίζεται στο Timeline. 

Όταν προσθέτετε ένα νέο track στην ακολουθία, το σύστημα Avid 
αναθέτει έναν αύξοντα αριθμό σε αυτό. Μπορείτε να αλλάξετε το 
σύστημα αρίθμησης των track αντί να χρησιμοποιήσετε την 
προεπιλεγμένη συνεχόμενη αρίθμηση. 
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Κεφάλαιο 9 

Επεξεργασία Υλικού 

9.1 Ξεκινώντας την επεξεργασία 

Για να ξεκινήσετε την επεξεργασία: 

1. Φορτώστε το πρώτο κλιπ στο Source μόνιτορ ή στο Source pop-up 
μόνιτορ. Αν δεν έχετε ήδη μαρκάρει IN και OUT σημεία για το κλιπ 
εκ των προτέρων ή δεν έχετε δημιουργήσει subclip, προβάλετε και 
μαρκάρετε το κλιπ όπως πρέπει. 

2. Κάντε κλικ στα κουμπιά στο Track Selector πάνελ στο Timeline για 
να επιλέξετε τα track που θέλετε να συμπεριλάβετε στην 
επεξεργασία. 
Μόνο τα track που έχουν καταγραφεί για το κλιπ εμφανίζονται ως 
πηγαία track στο Timeline. Για παράδειγμα, αν έχετε καταγράψει 
την ομιλία κάποιου, μπορείτε να επιλέξετε τα track V1 (εικόνα) και 
A2 (ήχος), αν η φωνή είχε καταγραφεί σε αυτό το track και 
απενεργοποιήστε το track A1, το οποίο μπορεί να έχει ανεπιθύμητο 
άγριο ήχο προερχόμενο από το δεύτερο μικρόφωνο ή να μην έχει 
καθόλου ήχο. 

 
3. Κάντε κλικ στο κλιπ και σύρετε το, από το Source μόνιτορ στο 

Timeline. 
To Composer μόνιτορ εμφανίζει, το τέλος του τελευταίου καρέ της 
νέας επεξεργασίας. (Μπορείτε να σύρετε τον δείκτη θέσης στο 
Timeline ή τη γραμμή θέσης κάτω από το Composer μόνιτορ για να 
επανελέγξετε το κλιπ.) Η επεξεργασία παράγει επίσης μια γραφική 
απεικόνιση της τομής στο Timeline. 

 
9.2 Δημιουργώντας ένα στιγμιαίο Rough Cut 
Ως εναλλακτική λύση για τη δημιουργία μιας νέας ακολουθίας 
επεξεργάζοντας ένα κλιπ κάθε φορά, μπορείτε γρήγορα να 
δημιουργήσετε τραχιά τομή επιλέγοντας και φορτώνοντας πολλαπλά 
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κλιπ απευθείας από το bin από το Frame view και σύροντας τα στο 
Timeline. 
Για να δημιουργήσετε μια τραχιά τομή από ένα bin: 
Για να δημιουργήσετε μια πιο ακριβέστερη τραχιά τομή, εμφανίστε και 
μαρκάρετε τα κλιπ στο bin εκ των προτέρων. 

1. Κάντε κλικ στην καρτέλα Frame για να εισέλθετε στο Frame view. 
2. Μέσα στο bin, ταξινομήστε τα κλιπ με τη σειρά με την οποία θέλετε 

να εμφανίζονται στην ακολουθία. 
3. Επιλέξτε τα track για την επεξεργασία. 
4. Κάντε ένα από τα παρακάτω: 
Ø Κάντε Ctrl + κλικ στα κλιπ. 
Ø Επιλέξτε περισσότερα από ένα κλιπ με το λάσο, το πλαίσιο που 

δημιουργείται με το κλικ και σύρσιμο του ποντικιού, σύροντας από 
αριστερά και πάνω προς τα δεξιά και κάτω ή ανάποδα. 

Ø Από το μενού της εφαρμογής επιλέξτε Edit > Select All αν δεν 
υπάρχουν άλλα κλιπ στο bin. 

5. Σύρετε τα επιλεγμένα κλιπ στο Timeline για να συγκολλήσετε τα 
κλιπ στη θέση που θέλετε. 
Τα κλιπ είναι ενωμένα για να σχηματίσουν μια νέα ακολουθία με 
βάση τη σειρά με την οποία είχαν επιλεγεί στο bin. 

 
9.3 Αναίρεση ή επαναφορά της αναίρεσης των 
επεξεργασιών. 
Μπορείτε να αναιρέσετε ή να επαναλάβετε μέχρι και 32 προηγούμενες 
ενέργειες που περιλαμβάνονται στο μενού Edit. 
 
Για να αναιρέσετε μόνο την προηγούμενη επεξεργασία ή λειτουργία: 
Ø Από το μενού της εφαρμογής επιλέξτε Edit > Undo. 
Ø Πατήστε Ctrl + Z από το πληκτρολόγιο. 

 
Για να επαναλάβετε μόνο την προηγούμενη επεξεργασία ή τη 
λειτουργία: 
Ø Από το μενού της εφαρμογής επιλέξτε Edit > Redo. 
Ø Πατήστε Ctrl + R από το πληκτρολόγιο. 
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9.4 Επεξεργασία επιπλέον κλιπ στην ακολουθία 
Οι κύριες λειτουργίες επεξεργασίας εκτός από το drag and drop είναι το 
splice-in και overwrite. Στις περισσότερες περιπτώσεις, εκτελείτε 
επεξεργασία τριών σημείων στο οποίο ορίζετε τρία μαρκαρίσματα - δύο 
στο πηγαίο υλικό και ένα στην ακολουθία ή το αντίστροφο. Το τέταρτο 
μαρκάρισμα καθορίζεται αυτόματα. Ο τρόπος που ορίζετε τα 
μαρκαρίσματα εξαρτάται από το είδος της επεξεργασίας που εκτελείτε. 

 
9.5 Εκτέλεση της επεξεργασίας Splice In 
Η επεξεργασία Splice-in εισάγει υλικό από το Source μόνιτορ μέσα στην 
ακολουθία χωρίς να αντικαθιστά το υλικό που υπάρχει ήδη στην 
ακολουθία.  Το υπάρχον υλικό στην ακολουθία μετακινείται δίπλα από 
το νέο υλικό, επιμηκύνοντας τη συνολική διάρκεια της ακολουθίας. 
Για να εκτελέσετε την επεξεργασία splice-in: 

1. Κάντε διπλό κλικ σε κλιπ για να το ανοίξετε στο Source μόνιτορ. 
2. Μαρκάρετε ένα IN σημείο. 
3. Μαρκάρετε ένα OUT σημείο. 
4. Μαρκάρετε ένα IN σημείο στην ακολουθία όπως παρακάτω: 

α. Μετακινήστε το δείκτη θέσης είτε στο Timeline είτε στη γραμμή 
θέσης του Composer στο σημείο στο οποίο θέλετε να συγκολλήσετε 
το κλιπ στην ακολουθία. 
β. Κάντε κλικ στο κουμπί Mark IN, ή πατήστε το πλήκτρο Mark IN 
από το πληκτρολόγιο. 
Αν δεν μαρκάρετε το IN σημείο, το σύστημα συγκολλάει το νέο κλιπ 
στην ακολουθία στο σημείο στο οποίο βρίσκεται ο δείκτης θέσης τη 
συγκεκριμένη στιγμή. 

5. Κάντε κλικ στο κουμπί Fast Menu. 
Ανοίγει η παλέτα Tool. 

6. Κάντε κλικ στο κίτρινο κουμπί Splice-in  ή πατήστε το πλήκτρο 
Splice-in από το πληκτρολόγιο για να ολοκληρώσετε την 
επεξεργασία. 
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Εικόνα 9.5.1 Διαδικασία Splice-In 
 
9.6 Εκτέλεση της επεξεργασίας Overwrite 
Η επεξεργασία Overwrite αντικαθιστά ένα τμήμα της ακολουθίας με το 
υλικό που επιλέγετε από το Source μόνιτορ. Σε αντίθεση με την 
επεξεργασία splice-in, η επεξεργασία overwrite αντικαθιστά το 
υπάρχων υλικό και συνεπώς δεν επιμηκύνει τη συνολική διάρκεια της 
ακολουθίας. 
Για να εκτελέσετε την επεξεργασία overwrite: 

1. Στο Source μόνιτορ, μαρκάρετε ένα IN σημείο ή ένα OUT σημείο, 
αλλά όχι και τα δυο, για να δείξετε την αρχή ή το τέλος του κλιπ που 
θέλετε να χρησιμοποιήσετε. 

2. Στο Composer μόνιτορ, μαρκάρετε και το IN σημείο και το OUT 
σημείο για να επιλέξετε το υλικό στην ακολουθία που θέλετε να 
αντικαταστήσετε. Μπορείτε επίσης να μαρκάρετε ένα OUT σημείο 
και να μετακινήσετε τον δείκτη θέσης στο Timeline ή τη γραμμή 
θέσης στο Composer για το IN σημείο. 

3. Κάντε κλικ στο κουμπί Overwrite  στην παλέτα Tool ή πατήστε το 
πλήκτρο Overwrite από το πληκτρολόγιο, για να ολοκληρώσετε την 
επεξεργασία. 
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9.6.1 Διαδικασία Overwite 

9.7 Εκτέλεση της επεξεργασίας Replace 

Για να εκτελέσετε την επεξεργασία replace: 
1. Επιλέξτε ένα καρέ συγχρονισμού στο πηγαίο κλιπ μετακινώντας το 

δείκτη θέσης για να εμφανίσετε εκείνο το καρέ στο Source μόνιτορ. 
Το καρέ συγχρονισμού μπορεί να είναι ένα IN σημείο, OUT σημείο, 
ή οποιοδήποτε καρέ ενδιάμεσα το οποίο θέλετε να συγχρονίσετε σε 
ένα καρέ στο υπάρχων πλάνο στην ακολουθία. 

2. Επιλέξτε το καρέ συγχρονισμού στην ακολουθία για το 
επεξεργασμένο πλάνο που θέλετε να αντικαταστήσετε 
μετακινώντας το δείκτη θέσης είτε στη γραμμή θέσης του Composer 
είτε στο Timeline σε εκείνο το καρέ. 

3. Από το μενού της εφαρμογής επιλέξτε Tools  > Command Palette. 
4. Κάντε κλικ στην καρτέλα Edit. 
5. Επιλέξτε Active Palette. 
6. Κάντε κλικ στο κουμπί Replace (μπλε). 

Το σύστημα αντικαθιστά το κλιπ. 

 
Εικόνα 9.7.1 Η παλέτα Command Palette - Καρτέλα edit 
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Εάν αντικαθιστάτε ένα κλιπ σε μια επεξεργασία επικάλυψης και ο 
δείκτης θέσης εμπίπτει στην επικάλυψη μπορείτε να καταλήξετε να 
αντικαταστήσετε το λάθος υλικό εκτός και αν επιλέξετε ολόκληρο το 
τμήμα που θέλετε να αντικαταστήσετε. 

 
9.8 Lifting, Extracting και Copying του υλικού 
Το Lifting, Extracting και Copying σας επιτρέπου να αφαιρέσετε ή να 
επανατοποθετήσετε το υλικό γρήγορα στην ακολουθία σας. Για 
παράδειγμα, μπορείτε να μετακινήσετε ένα κλιπ από το τέλος της 
ακολουθίας σας στην αρχή ή να μετακινήσετε το υλικό από την 
ακολουθία συνολικά. Οι επιλογές Lifting, Extracting και Copying 
τοποθετούν το αφαιρούμενο υλικό στο Clipboard (Πρόχειρο). Μπορείτε 
ύστερα να επικολλήσετε το υλικό οπουδήποτε αλλού στην ακολουθία ή 
σε άλλη ακολουθία συνολικά.  
 
9.8.1 Λειτουργία Lift 
Η λειτουργία Lift αφαιρεί το επιλεγμένο υλικό από το Track στην 
ακολουθία και αφήνει ένα μαύρο ενδιάμεσο κενό ή σιγή για να καλύψει 
το κενό. Μπορείτε αργότερα να μετακινήσετε ή να γεμίσετε αυτό το 
κενό με άλλο υλικό. Όταν κάνετε lift στο υλικό, η συνολική διάρκεια του 
track ή της ακολουθίας παραμένει η ίδια. 
Για να κάνετε lift στο υλικό: 

1. Μαρκάρετε IN και OUT σημεία στην ακολουθία στην αρχή και στο 
τέλος του υλικού που θέλετε να κάνετε lift. 

2. Επιλέξτε τα track που περιέχουν το υλικό. 
Το σύστημα εκτελεί την λειτουργία στα επιλεγμένα μόνο track. 

3. Κάντε κλικ στο κουμπί Lift  στην πάνω εργαλειοθήκη του 
Timeline, ή πατήστε το πλήκτρο Lift (Z) από το πληκτρολόγιο σας, 
για να ολοκληρώσετε την επεξεργασία 

 
Εικόνα 9.8.1 Λειτουργία Lift 
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9.8.2 Λειτουργία Extract 
Η λειτουργία Extract τέμνει επιλεγμένο υλικό από ένα track στην 
ακολουθία και κλείνει το κενό που αφήνει από την αφαίρεση. Ως 
αποτέλεσμα, όταν κάνετε extract σε υλικό, συρρικνώνετε τη διάρκεια 
του track ή της ακολουθίας. 
Για να κάνετε extract στο υλικό: 

1. Μαρκάρετε IN και OUT σημεία στην ακολουθία στην αρχή και στο 
τέλος του υλικού που θέλετε να κάνετε extract. 

2. Επιλέξτε τα track που περιέχουν το υλικό. 
Το σύστημα εκτελεί την λειτουργία στα επιλεγμένα μόνο track. 

3. Κάντε κλικ στο κουμπί Extract  στην πάνω εργαλειοθήκη του 
Timeline, ή πατήστε το πλήκτρο Extract (X) από το πληκτρολόγιο 
σας, για να ολοκληρώσετε την επεξεργασία. 

 
Εικόνα 9.8.2 Λειτουργία Extract 
 

9.8.3 Αντιγραφή (Copying) του υλικού 
Η λειτουργία Copy to Clipboard φτιάχνει αντίγραφα του επιλεγμένου 
υλικού στην ακολουθία και αφήνει το υλικό ανέπαφο. Όταν 
αντιγράφετε υλικό, η ακολουθία παραμένει ανεπηρέαστη. Στη συνέχεια 
μπορείτε να τοποθετήσετε το υλικό οπουδήποτε αλλού μέσα στην 
ακολουθία ή να το τοποθετήσετε σε άλλη ακολουθία . 
Για να αντιγράψετε υλικό στο Clipboard: 

1. Μαρκάρετε IN και OUT σημεία στην ακολουθία στην αρχή και στο 
τέλος του υλικού που θέλετε να κάνετε αντιγραφή. 

2. Επιλέξτε τα track που περιέχουν το υλικό. 
Το σύστημα εκτελεί την λειτουργία στα επιλεγμένα μόνο track. 

3. Από το μενού της εφαρμογής επιλέξτε Tools > Command Palette και 
κάντε κλικ στην καρτέλα Edit. 

4. Κάντε κλικ στο κουμπί Copy to Clipboard. 
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Το σύστημα αντιγράφει το επιλεγμένο υλικό στο πρόχειρο 
(Clipboard) και αφήνει την ακολουθία άγγιχτη. 

9.8.4 Χρησιμοποιώντας το Clipboard 

Το Avid Clipboard είναι ένα εργαλείο αποκοπής, αντιγραφής και 
επικόλλησης προσαρμοσμένο στις ειδικές ανάγκες του περιβάλλοντος 
επεξεργασίας. 

 
9.8.4.1 Τοποθέτηση ακολουθίας στο Clipboard 
Για να τοποθετήσετε ένα μαρκαρισμένο τμήμα της ακολουθίας στο 
Clipboard οποιαδήποτε στιγμή:  
Ø Κάντε κλικ στο κουμπί Lift  ή το κουμπί Extract  που 

βρίσκονται στην εργαλειοθήκη του πάνω μέρους στο Timeline ή το 
κουμπί Copy to Clipboard στην καρτέλα Edit της παλέτας Command. 

Η λειτουργία Copy to Clipboard είναι χρήσιμη για τη μετακίνηση ή την 
επανάληψη του υλικού στην ακολουθία χωρίς να μετακινείτε πολλαπλά 
τμήματα στο Segment mode ή για την ανακατασκευή του τμήματος σε 
άλλη θέση. Για παράδειγμα, μπορείτε να: 

· Αντιγράψετε ένα τμήμα μιας ακολουθίας για επικόλληση σε άλλη 
ακολουθία. 

· Απομονώσετε και να αντιγράψετε ένα τμήμα ενός ηχητικού 
κομματιού για looping μουσικής ή επαναλαμβάνοντας ένα ηχητικό 
εφέ. 

· Αντιγράψετε γραφικά στοιχεία για επανάληψη σε άλλες θέσεις σε 
μια μορφή περικοπής. 

 

9.8.4.2 Ανάκτηση υλικού από το Clipboard 
Το Clipboard σας βοηθά να ανακτήσετε γρήγορα τμήματα στα οποία 
έχει γίνει lift ή extract. Αυτό είναι ιδιαίτερα χρήσιμο αν έχετε εκτελέσει 
μια ή παραπάνω επεξεργασίες από τη στιγμή της αφαίρεσης του 
υλικού. Σε αντίθεση, αν χρησιμοποιείτε τη λειτουργία Undo για να 
ανακτήσετε το υλικό, το σύστημα αφαιρεί επίσης όλες τις επεξεργασίες 
που έχουν εκτελεστεί εν τω μεταξύ. Το Clipboard παρέχει το 
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πλεονέκτημα της ανάκτησης του υλικού διατηρώντας τις μετέπειτα 
αλλαγές. 
Αν κάνετε lift ή extract σε οποιοδήποτε περαιτέρω υλικό, θα 
αντικαθίσταται στο Clipboard. Φτιάξτε μια επακολουθία αν χρειάζεται 
να διατηρήσετε το υλικό παραπάνω από λίγα λεπτά. 
Για να ανακτήσετε το υλικό από το Clipboard: 

1. Κάντε ένα από τα παρακάτω: 
Ø Ανοίξτε το Clipboard στο δικό του μόνιτορ επιλέγοντας από το 

μενού της εφαρμογής Tools > Clipboard Monitor. 

 
Εικόνα 9.8.1 Το Clipboard Monitor 
 

Ø Εμφανίστε τα περιεχόμενα του clipboard στο Source μόνιτορ ή στο 
Record μόνιτορ κάνοντας κλικ στο Command Palette > καρτέλα Edit 
> Clipboard Contents ή από την παλέτα Tool του Timeline πατήστε 
το κουμπί Clipboard Contents . 

2. Επεξεργαστείτε τα περιεχόμενα του clipboard στην ακολουθία σας. 
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9.9 Αναπαραγωγή της νέας ακολουθίας 

Μπορείτε να αναπαράγετε μια ακολουθία ανά πάσα στιγμή και να το 
εμφανίσετε στο Composer μόνιτορ. 
Για να αναπαράγετε μια ακολουθία: 

1. Βεβαιωθείτε ότι το εικονίδιο Video Track Monitor  βρίσκεται στο 
ανώτερο βίντεο track για να εμφανίσετε όλα τα βίντεο track και εφέ 
κατά τη διάρκεια της αναπαραγωγής. 

2. Βεβαιωθείτε ότι τα κουμπιά του Audio Track Monitor  για τα 
ηχητικά track είναι επιλεγμένα για να εξασφαλιστεί σωστή 
αναπαραγωγή όλων των ηχητικών track. 

3. Πηγαίνετε στην αρχή της ακολουθίας στο Composer μόνιτορ ή στο 
Timeline κάνοντας κλικ στην αριστερή μεριά της γραμμής θέσης για 
να επανατοποθετηθεί ο δείκτης θέσης στην αρχή ή πατώντας το 
πλήκτρο Home από το πληκτρολόγιο. 

4. Χρησιμοποιήστε το δείκτη θέσης, κουμπιά, ή το πληκτρολόγιο για 
να πλοηγηθείτε μέσω των πλάνων, εμφανίζοντας τα στο Composer 
μόνιτορ. 
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Κεφάλαιο 10 

Δουλεύοντας στο Trim Mode 

Η βασική επεξεργασία στο Timeline παράγει αρχικά μια τραχιά 
περικοπή, η οποία μπορεί να οριστεί αόριστα ως μια σειρά από 
straight-cut επεξεργασίες με πολλές τραχιές άκρες και λίγα εφέ. Μετά 
τη δημιουργία της τραχιά περικοπής, μπορείτε να εισέλθετε στο Trim 
mode και να τελειοποιήσετε τις μεταβάσεις μεταξύ των κλιπ ή μεταξύ 
ολόκληρων τμημάτων. Μπορείτε επίσης να κάνετε επεξεργασίες trim 
καθώς χτίζετε την ακολουθία, αντί να δημιουργήσετε πρώτα μια τραχιά 
περικοπή. 

Μπορείτε να εισέλθετε στο Trim mode με διαφορετικούς τρόπους, 
ανάλογα με τον τύπο του trim που προσδοκάτε να εκτελέσετε. Μόλις 
εισέλθετε στο Trim mode, μπορείτε: 

· Να επιλέξετε τις trim πλευρές. 
· Να εκτελέσετε και να επανεξετάσετε το trim. 
· Να εκτελέσετε trim εν κινήσει. 
· Να κάνετε trim στα βίντεο track. 

 
10.1 Είσοδος στο Trim mode 
Για να εισέλθετε στο Trim mode, χρησιμοποιήστε μια από τις 
παρακάτω μεθόδους: 
Ø Πατήστε το πλήκτρο ([) από το πληκτρολόγιο που αντιστοιχεί στη 

λειτουργία Trim mode. 
Ø Κάντε κλικ στο κουμπί Trim mode  από την παλέτα Tool ή από 

την πάνω εργαλειοθήκη του Timeline. 
Από προεπιλογή, το σύστημα εισέρχεται στο Trim mode και επιλέγει 
τη μετάβαση που είναι πλησίον του δείκτη θέσης για dual-roller 
trimming. Αυτή η μέθοδος είναι χρήσιμη για επιλογή των straight-
cut μεταβάσεων σε ένα track ή κατά μήκος των βίντεο ή ηχητικών 
track. Αν οι μεταβάσεις δεν είναι straight cuts (overlap ή L-edits), το 
εικονίδιο του Dual-Roller εμφανίζεται στη μετάβαση πλησίον του 
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δείκτη θέσης στο ανώτερο track και όλα τα άλλα track είναι 
αποεπιλεγμένα. 

Ø Πατήστε το πλήκτρο Alt και κάντε κλικ στο κουμπί Trim mode για να 
επιλέξετε τις προηγούμενες ρυθμίσεις trim-roller. Από προεπιλογή, 
όταν εισέρχεσθε στο Trim mode, τα trim rollers είναι ορισμένα για 
dual-roller trimming. 

Ø Επιλέξτε με το λάσο τις μεταβάσεις στο Timeline. 
Η επιλογή με το λάσο γίνεται κάνοντας κλικ σε σημείο πάνω από το 
ανώτερο track στο Timeline και σύροντας το ποντίκι προς τα κάτω 
ώστε να περιληφθούν οι μεταβάσεις. Μπορείτε να σύρετε με το 
λάσο από τα αριστερά προς τα δεξιά ή αντίστροφα και μπορείτε να 
επιλέξετε με το λάσο μεμονωμένη μετάβαση σε αρκετά συνεχόμενα 
track. 
Αποφύγετε να επιλέγετε με το λάσο περισσότερες από μια 
μεταβάσεις σε μεμονωμένο track όταν επιλέγετε από αριστερά προς 
τα δεξιά, διότι αυτό ενεργοποιεί το Segment mode και από δεξιά 
προς τα αριστερά ενεργοποιεί το slipping trim mode. 

 
Εικόνα 10.1.1 Η εφαρμογή Avid σε Trim mode 

 



Σελίδα | 133  
 

10.2 Έξοδος από το Trim mode 
Για να εξέλθετε από το trim mode, χρησιμοποιείστε μια από τις 
παρακάτω μεθόδους: 
Ø Κάντε κλικ στο κουμπί Trim mode από την παλέτα Tool. 
Ø Πιέστε το πλήκτρο (]) ή το πλήκτρο ([). 
Ø Πατήστε το πλήκτρο Esc. 
Ø Κάντε κλικ σε συγκεκριμένο σημείο στο Timecode (TC1) track στο 

κάτω μέρος του πάνελ Track Selector. 
Ο δείκτης θέσης μετακινείται σε εκείνη τη θέση. 

10.3 Οι οθόνες του Trim mode 
Μπορείτε να κάνετε trim σε Big Trim mode ή σε Small Trim mode. Η 
επιλογή σας για το mode εξαρτάται από το εάν χρησιμοποιείτε το διπλό 
Source/Record μόνιτορ ή το μεμονωμένο Composer μόνιτορ. 
Για να κάνετε trim στο Big Trim mode: 
Ø Με τη διπλή οθόνη Source/Record να εμφανίζεται, κάντε κλικ στο 

κουμπί Trim Mode από την επάνω εργαλειοθήκη του Timeline ή από 
την παλέτα Tool. 
Το Big Trim Mode ανοίγει και στις δυο οθόνες. 

 
Εικόνα 10.3.1 Big Trim mode 
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Για να κάνετε trim στο Small Trim mode: 
Ø Με τη μεμονωμένη οθόνη του Composer να εμφανίζεται, κάντε κλικ 

στο κουμπί Trim Mode από την επάνω εργαλειοθήκη του Timeline ή 
από την παλέτα Tool. 
Το Small Trim Mode ανοίγει στο Composer μόνιτορ. 

 
Εικόνα 10.3.2 Small Trim mode 

 
10.4 Επιλέγοντας τις πλευρές για περικοπή (Trim) 
Μπορείτε να περικόψετε μια μετάβαση είτε από την εξερχόμενη 
πλευρά (A-side ή tail), είτε από την εισερχόμενη πλευρά (B-side ή head) 
είτε και από τις δυο (dual-roller). 
Για να επιλέξετε πλευρές μιας μετάβασης για να περικόψετε: 
Ø Κάντε κλικ στο εξερχόμενο (A-side) ή στο εισερχόμενο (B-side) 

μόνιτορ για να καθορίσετε ποια πλευρά της μετάβασης να 
περικόψετε. Ο δείκτης αλλάζει σε εικονίδιο Single-Roller A-Side, 
Single-Roller B-Side ή Dual Roller, ανάλογα με τη θέση του δείκτη. 

 
Εικόνα 10.4.1 Τα κουμπιά εναλλαγής μεταξύ A-side και B-side 
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Ø Χρησιμοποιήστε τα κουμπιά περικοπής πλευρών στην καρτέλα Trim 
της παλέτας Command για να επιλέξετε την πλευρά A, B ή και τις 
δυο. 

Ø Χρησιμοποιείστε το κουμπί Cycle Trim Sides στην καρτέλα Trim της 
παλέτας Command για να επαναλαμβάνεστε μεταξύ των επιλογών 
της πλευράς A, B ή και των δύο. 

 
Εικόνα 10.4.2 Η παλέτα Command - καρτέλα Trim 
 

Ø Στο Big Trim mode, χρησιμοποιείστε τους δείκτες καρέ Trim Counter 
που βρίσκονται κάτω από τα μόνιτορ. Κάντε κλικ στο A-side ή στο B-
side του δείκτη καρέ για να επιλέξετε single-roller περικοπή ή Shift + 
κλικ και στους δύο δείκτες καρέ για να επιλέξετε dual-roller 
περικοπή. 
Τα επιλεγμένα σημεία της μετάβασης είναι φωτισμένα και τα 
αντιστοιχιζόμενα roller εμφανίζονται στο Timeline. Επίσης ένας ή 
και οι δύο δείκτες μέτρησης καρέ κάτω από τα μόνιτορ είναι 
φωτισμένα για να αντανακλούν τις ενεργές πλευρές περικοπής: A-
side, B-side ή και οι δύο. Ο αριθμός δείχνει το πόσα καρέ έχουν 
προστεθεί ή αφαιρεθεί από τη μετάβαση. 

 
Εικόνα 10.4.3 Το Source/Record μόνιτορ στο Trim mode 
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Ø Κάντε κλικ μεταξύ των δύο καρέ που εμφανίζονται στο Composer 
μόνιτορ για να περικόψετε και τις δύο πλευρές. 

 
10.5 Επιλέγοντας πρόσθετες μεταβάσεις 
Ενώ βρίσκεστε στο Trim mode, μπορείτε να επιλέξετε πρόσθετες 
μεταβάσεις για περικοπή σε διαφορετικά περιβάλλοντα. 
Για να επιλέξετε πρόσθετες μεταβάσεις σε συνεχόμενα track για 
περικοπή στην ίδια πλευρά: 
Ø Κάντε κλικ στο αντιστοιχιζόμενο κουμπί Record Track στο Track 

Selector πάνελ. 
Επίσης, μπορείτε να αποεπιλέξετε track στο Track Selector πάνελ για 
να αφαιρέσετε τις μεταβάσεις σε εκείνα τα track από τη διαδικασία 
της περικοπής. 

Για να επιλέξετε πρόσθετες μεταβάσεις για single-roller περικοπή σε 
ποικίλες τοποθεσίες σε διαφορετικά track: 
Ø Κάντε Shift + κλικ στις μεταβάσεις στο Timeline. 

Αυτή η μέθοδος είναι χρήσιμη όταν εργάζεσθε με τμηματικές 
μεταβάσεις σε πολλαπλά track. Επίσης, σας επιτρέπει να επιλέξετε 
και τις δύο πλευρές A και B των μεταβάσεων για ταυτόχρονη 
περικοπή σε αντίθετες κατευθύνσεις (ασύμμετρη περικοπή). Αυτό 
δεν είναι δυνατό με τις dual-roller περικοπές. 

Καθώς μετακινείτε το δείκτη εμπρός και πίσω σε μια μετάβαση, το 
εικονίδιο του roller αλλάζει από το A-side roller (προς τα αριστερά) σε 
B-side roller (προς τα δεξιά) για να δείξει τον τύπο της επιλογής. 
Ø Κάντε κλικ στο διαχωριστικό μεταξύ των δυο καρέ στο παράθυρο 

του Composer. 
Ø Επιλέξτε μια πλευρά και μετά πατήστε Shift + κλικ για να επιλέξετε 

την άλλη πλευρά. 
 
Για να προσθέσετε γρήγορα πολλαπλές μεταβάσεις στην τρέχων 
επιλεγμένη μετάβαση: 
Ø Πατήστε και κρατήστε το πλήκτρο Shift και επιλέξτε με λάσο τις 

επιπλέον μεταβάσεις. 
Μπορείτε να επιλέξετε και να περικόψετε δύο κεφάλια ή ουρές 
ταυτόχρονα, σε οποιοδήποτε συνδυασμό, για κάθε track στην 
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ακολουθία. Όλες οι επιλεγμένες μεταβάσεις είναι περικομμένες κατά 
τον ίδιο αριθμό καρέ. Αυτό σας επιτρέπει να εξοικονομήσετε χρόνο και 
σε κάποιες περιπτώσεις για να διατηρήσει το συγχρονισμό εκτελώντας 
single-trim διαδικασία σε πολλαπλά track και μεταβάσεις. 
 
10.6 Εκτέλεση βασικής περικοπής 
Αφού έχετε επιλέξει τις μεταβάσεις και τις πλευρές περικοπής, μπορείτε 
να πραγματοποιήσετε τη βασική περικοπή. 
Για να εκτελέσετε μια περικοπή, χρησιμοποιείστε μια από τις 
παρακάτω διαδικασίες: 
Ø Χρησιμοποιείστε τα κουμπιά Trim για να περικόψετε προς τα 

εμπρός ή προς τα πίσω με προσαυξήσεις κατά 1 καρέ ή κατά 10 
καρέ ή με προσαυξήσεις κατά 1 καρέ ή κατά 8 καρέ (για 24p 
project). 

Ø Χρησιμοποιείστε τα πλήκτρα J-K-L για να περικόψετε προς τα 
εμπρός ή προς τα πίσω στην ακολουθία. 
¾ Αυτή η επιλογή είναι αποεπιλεγμένη σαν προεπιλογή. Για να 

περικόψετε με τα πλήκτρα J-K-L, κάντε κλικ στην καρτέλα 
Features του παραθύρου διαλόγου Trim Settings, επιλέξτε J-K-L 
Trim και πατήστε ΟΚ. 

 
Εικόνα 10.6.1 Τα παράθυρο trim Settings - καρτέλα Features 
 

Ø Χρησιμοποιείστε το αριθμητικό πληκτρολόγιο στη δεξιά πλευρά του 
πληκτρολογίου ως εξής: 
¾ Για να μετακινήσετε τη μετάβαση για συγκεκριμένο αριθμό 

καρέ, πατήστε το πλήκτρο (+) ή το πλήκτρο (-) και τον αριθμό 
καρέ (από το 1 έως το 99) που θέλετε να μετακινήσετε προς τα 
εμπρός ή προς τα πίσω. Και μετά πατήστε Enter. 
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Αν ο αριθμός των καρέ είναι μεγαλύτερος από το 99, 
πληκτρολογήστε ένα f μετά τον αριθμό για να υποδείξετε τον 
υπολογισμό των καρέ. Για παράδειγμα, για να εισάγετε 200 
καρέ, πληκτρολογήστε 200 και μετά το γράμμα f και πατήστε 
Enter. 

¾ Για να μετακινήσετε τη μετάβαση σε ακριβές timecode, 
πληκτρολογήστε έναν αριθμό timecode, μεγαλύτερο του 99, 
περιέχοντας καρέ. Για παράδειγμα, πληκτρολογήστε 102 για να 
εισάγετε 1 δευτερόλεπτο και 2 καρέ (1:02). 

Ø Χρησιμοποιείστε τα κουμπιά ελέγχου στο Timeline κάνοντας κλικ σε 
roller σε μια επιλεγμένη μετάβαση και σύροντας προς τα μπρός ή 
προς τα πίσω στην ακολουθία. 

Για να έχετε μεγαλύτερο έλεγχο: 
Ø Πατήστε το πλήκτρο Alt καθώς σύρετε ένα καρέ τη φορά. 
Ø Πατήστε το πλήκτρο Ctrl για να ενώσετε με άλλα σημεία μετάβασης. 

Καθώς περικόπτετε, όλα οι επιλεγμένες μεταβάσεις στο Timeline 
κινούνται από κοινού. Ο μετρητής περικοπής εμφανίζει τον υπολογισμό 
των καρέ προς τα πίσω ή προς τα εμπρός για ένα ή και για τις δυο 
πλευρές περικοπής και τα μόνιτορ εμφανίζουν τα νέα εισερχόμενα ή 
εξερχόμενα καρέ. 
 
10.7 Περικοπή εν κινήσει με τα πλήκτρα J-K-L 
Στο Trim mode, μπορείτε να χρησιμοποιήσετε τα πλήκτρα J-K-L από το 
πληκτρολόγιο για να αναπαράγετε το εξερχόμενο ή το εισερχόμενο 
υλικό και να μαρκάρετε σημεία περικοπής. Αυτή είναι παρόμοια 
διαδικασία με το μαρκάρισμα των στιγμιότυπων εν κινήσει. 
Για ευκολία, αυτή η μέθοδος απομονώνει τον έλεγχο της περικοπής σε 
μόνο τρία πλήκτρα. 
Για να περικόψετε εν κινήσει: 

1. Κάντε διπλό κλικ στο Trim από τη λίστα Settings στο παράθυρο του 
Project. 
Ανοίγει το παράθυρο διαλόγου Trim Settings. 

2. Κάντε κλικ στην καρτέλα Features. 
3. Επιλέξτε J-K-L Trim. 
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Για να χρησιμοποιήσετε τα πλήκτρα J-K-L στο Trim mode μόνο για 
αναπαραγωγή, βηματισμό και μεταφορά, χωρίς να γίνεται περικοπή, 
αποεπιλέξτε την επιλογή J-K-L Trim από το παράθυρο διαλόγου Trim 
Settings. 

4. Κάντε κλικ είτε στο εξερχόμενο (A-side) ή εισερχόμενο (B-side) 
μόνιτορ για να αναπαράγεται σε πραγματικό χρόνο κατά τη 
διάρκεια της περικοπής. 

5. Επιλέξτε μια ή περισσότερες μεταβάσεις για single-roller ή dual-
roller περικοπή. 

6. Χρησιμοποιήστε τα πλήκτρα J-K-L για βηματισμό, αναπαραγωγή ή 
μεταφορά μέσω του βίντεο σε ποικίλες ταχύτητες: 
Ø Πατήστε και κρατήστε το πλήκτρο K ενώ πατάτε το πλήκτρο J ή L 

για να βηματίσετε αργά προς τα πίσω ή προς τα εμπρός μέσω του 
βίντεο. Όταν βρείτε το καρέ όπου θέλετε να μεταφέρετε τη 
μετάβαση, αφήστε το πλήκτρο K για να ολοκληρώσετε την 
περικοπή. 

Ø Πατήστε το πλήκτρο J ή το L μια φορά για να αρχίσει η 
αναπαραγωγή σε κανονική ταχύτητα ή περισσότερες φορές από 
μια για να μεταφέρεστε με μεγαλύτερες ταχύτητες. Όταν δείτε το 
καρέ όπου θέλετε να μεταφέρετε τη μετάβαση, πατήστε το space 
bar ή το πλήκτρο K για να ολοκληρώσετε την περικοπή. 

Τα μόνιτορ και το Timeline ενημερώνονται για να απεικονίσουν την 
περικοπή. 
 Όταν κάνετε περικοπή με τα πλήκτρα J-K-L, δεν μπορείτε να περικόψετε 
εντελώς ένα τμήμα. Το σύστημα Avid αφήνει πάντα ένα καρέ. Για να 
αφαιρέσετε το υπόλοιπο καρέ, ανατρέξετε στην ενότητα 10.6 Εκτέλεση 
βασικής περικοπής. 
 
10.8 Περικοπή εν κινήσει με τα πλήκτρα Mark IN και Mark 
OUT 
Μπορείτε να κάνετε περικοπή εν κινήσει πατώντας το πλήκτρο Mark IN 
ή Mark OUT από το πληκτρολόγιο ενώ αναπαράγετε και 
επαναλαμβάνετε μια μετάβαση στο Trim mode. Το σύστημα ξανά κόβει 
τη μετάβαση στο μαρκάρισμα και επανεκκινεί την επαναλαμβανόμενη 
αναπαραγωγή, έτσι ώστε να μπορείτε να συνεχίζετε να ρυθμίζετε την 
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επεξεργασία, κάθε φορά που επαναλαμβάνεται. Αυτή η μέθοδος 
αναπαράγει και τις δύο πλευρές της μετάβασης αντί να αναπαράγει 
μόνο την πλευρά Α ή την πλευρά Β. 
Για να περικόψετε με τα πλήκτρα Mark IN και Mark OUT: 

1. Στο Trim mode, επιλέξτε την εξερχόμενη πλευρά, την εισερχόμενη 
πλευρά ή και τις δύο για περικοπή. 

2. Κάντε κλικ στο κουμπί Play Loop για επαναλαμβανόμενη 
αναπαραγωγή της επιλεγμένης μετάβασης. 

3. Κατά τη διάρκεια της επαναλαμβανόμενης αναπαραγωγής, πατήστε 
το πλήκτρο Mark IN ή το πλήκτρο Mark OUT. 
Το σύστημα περικόπτει τη μετάβαση στο μαρκαρισμένο σημείο και 
επανεκκινεί την επαναλαμβανόμενη αναπαραγωγή. 

Για να τελειοποιήσετε την περικοπή: 
Ø Πατήστε ένα από τα παρακάτω ισοδύναμα πλήκτρα του 

πληκτρολογίου για περαιτέρω περικοπή κατά τη διάρκεια της 
αναπαραγωγής: 
Κουμπί Περικοπής Ισοδύναμο πληκτρολογίου 
Περικοπή αριστερά 1 καρέ Κόμμα (,) 
Περικοπή δεξιά 1 καρέ Τελεία (.) 
Περικοπή αριστερά 10 καρέ M 
Περικοπή δεξιά 10 καρέ Δεξιά κάθετος (/) 
 

10.9 Περικοπή των βίντεο Track 
Στο Trim mode, όταν κάνετε κλικ στην πλευρά A ή στην πλευρά Β της 
μετάβασης, όλα τα roller περικοπής ορίζονται στις επιλεγμένες πλευρές. 
Για να επαναφέρετε τα roller περικοπής μόνο στα video track: 

1. Βεβαιωθείτε ότι βρίσκεστε στο Trim mode με επιλεγμένο βίντεο 
track. 

2. Πατήστε το πλήκτρο Alt και κάντε κλικ είτε στην πλευρά Α είτε στη Β 
στο μόνιτορ (όχι στο Timeline). 
Το roller περικοπής εμφανίζεται μόνο στα βίντεο track της 
επιλεγμένης πλευράς. 

Για να αποθηκεύσετε τη θέση των roller περικοπής: 
Ø Πατήστε το πλήκτρο Alt όταν κάνετε κλικ στο κουμπί Trim Mode για 

να επιστρέψετε στο Trim mode. 
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Κεφάλαιο 11 

Δουλεύοντας με τα εφέ 

Η εφαρμογή επεξεργασίας Avid, σας προσφέρει πολλά εφέ που 
μπορείτε να εφαρμόσετε στις ακολουθίες σας. Τα παρακάτω θέματα, 
εξηγούν τις έννοιες των βασικών εφέ που πρέπει να καταλάβετε πριν 
εργαστείτε με εφέ και παρέχει βασικές διαδικασίες για τη δημιουργία, 
την προσαρμογή, την αναπαραγωγή και το rendering των εφέ. 

11.1 Τύποι Εφέ 

Τα εφέ που είναι διαθέσιμα στην εφαρμογή επεξεργασίας Avid, 
χωρίζονται σε έναν αριθμό κατηγοριών οι οποίες περιγράφονται 
παρακάτω. 

Οι κατηγορίες αναφέρονται, για να σας δώσουν μια βασική κατανόηση 
της ποικιλίας των εφέ που διατίθενται και ως μια εισαγωγή σε κάποιες 
ορολογίες των εφέ που χρησιμοποιείται καθ’ όλη τη διάρκεια της 
τεκμηρίωσης των εφέ της Avid. 

11.1.1 Εφέ μετάβασης (Transition Effects) 

Τα εφέ μετάβασης, είναι τα εφέ που εφαρμόζονται στην τομή μεταξύ 
δυο βίντεο κλιπ τα οποία βρίσκονται στο ίδιο Track, στην ακολουθία. 
Κάποια από τα εφέ μετάβασης είναι τα dissolves, fades και wipes. 

11.1.2 Τμηματικά εφέ (Segment Effects) 

Τα τμηματικά εφέ εφαρμόζονται σε ένα ολόκληρο κλιπ ή σε μια ομάδα 
κλιπ σε μια ακολουθία. 

Τα τμηματικά εφέ εμπίπτουν σε δυο κατηγορίες. Τα single-layer 
τμηματικά εφέ εφαρμόζονται σε τμήμα σε ένα βίντεο Track και 
χρειάζεται μόνο ένα βίντεο stream για να δημιουργήσει το εφέ του. 

Το multilayer τμηματικό εφέ εφαρμόζεται στο πάνω και στο μεσαίο 
layer των τμημάτων που περιέχουν δύο ή περισσότερα βίντεο Tracks 
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που θα αναπαραχθούν ταυτόχρονα. Το multilayer τμηματικό εφέ 
χρειάζεται πάνω από ένα βίντεο layer για να δημιουργήσει το εφέ του. 

11.1.3 Εφέ Κίνησης (Motion Effects) 

Τα εφέ κίνησης χειρίζονται τα χαρακτηριστικά της κίνησης σε ένα κλιπ. 
Μπορείτε να δημιουργήσετε εφέ κίνησης με δυο τρόπους: με τη 
δημιουργία νέων κλιπ με σταθερά χαρακτηριστικά κίνησης ή 
χρησιμοποιώντας τα Timewarp εφέ για να αλλάξετε τα χαρακτηριστικά 
κίνησης των κλιπ που έχουν ήδη επεξεργαστεί στην ακολουθία. 

11.1.4 Εφέ Τίτλων (Title Effects) 

Τα εφέ Τίτλων περιέχουν κείμενο και γραφικά αντικείμενα που 
δημιουργείτε με ένα από τα εργαλεία τίτλων που διατίθεται στην 
εφαρμογή επεξεργασίας Avid. Τα εφέ Τίτλων αποθηκεύονται σε Bin ως 
ειδικού τύπου κλιπ και επεξεργάζονται στο δικό τους layer στην 
ακολουθία, συνήθως πάνω από όλα τα άλλα βίντεο layer. 

11.1.5 2D και 3D Εφέ 

Τα εφέ στην εφαρμογή επεξεργασίας Avid μπορεί να είναι είτε 2D είτε 
3D. Τα 2D εφέ φαίνεται να δρουν στις δύο διαστάσεις της οθόνης που 
βλέπει ο θεατής και δεν δίνουν την εντύπωση του βάθους. Τα 3D εφέ 
δίνουν την εντύπωση του βάθους. 

11.1.6 Ένθετα εφέ (Nested Effects) 

Τα ένθετα εφέ είναι τα εφέ που εφαρμόζετε μέσα σε άλλα εφέ στο ίδιο 
βίντεο layer. Η ένθεση των εφέ σας δίνει μεγάλη ευελιξία να 
εφαρμόζετε πολλαπλά εφέ στο ίδιο τμήμα στην ακολουθία. 

11.1.7 Key Effects 

Τα Key εφέ είναι τα εφέ που χρησιμοποιούν ειδικούς κανόνες για να 
ορίσετε το πώς, μέρη μιας εικόνας δείχνουν μέσα από μια άλλη εικόνα. 
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11.1.8 Camera Effects 

Τα εφέ της κάμερας είναι η κατηγορία των εφέ που ελέγχει την 
φαινομενική κίνηση της κάμερας. 

11.1.9 PlasmaWipe Effects 

Κάποιες εφαρμογές επεξεργασίας Avid έχουν μια ξεχωριστή κατηγορία 
εφέ που λέγεται Plasmawipe εφέ. Αυτά τα εφέ χρησιμοποιούν gradient 
εικόνες bitmap για να δημιουργήσουν ιδιαίτερα προσαρμόσιμα wipes 
και segments εφέ. Μπορείτε να χρησιμοποιήσετε ένα από τα πολλά 
προσαρμοσμένα εφέ ή να δημιουργήσετε το δικό σας χρησιμοποιώντας 
νέες gradient εικόνες. 

11.2 Real-Time Effects and Non-Real-Time Effects 

Τα εφέ στην εφαρμογή επεξεργασίας Avid μπορεί να είναι είτε σε 
πραγματικό χρόνο είτε σε μη πραγματικό χρόνο. Το εφέ σε πραγματικό 
χρόνο είναι το εφέ το οποίο μπορείτε να το εφαρμόσετε στην 
ακολουθία και να αναπαράγετε χωρίς να χρειάζεται να το κάνετε render 
πιο πριν. Το Rendering είναι μία λειτουργία επεξεργασίας που 
πραγματοποιεί η εφαρμογή επεξεργασίας Avid για να συγχωνεύσει τα 
layers του εφέ, δημιουργώντας μια ροή ψηφιακού βίντεο για 
αναπαραγωγή σε πραγματικό χρόνο. (Η επεξεργασία rendering 
χρειάζεται χρόνο και δημιουργεί ένα νέο αρχείο πολυμέσων που 
καταλαμβάνει χώρο στο δίσκο). Στα εφέ μη πραγματικού χρόνου, 
πρέπει να γίνει rendering πριν αναπαραχθούν. Χωρίς rendering, στα 
εφέ μη πραγματικού χρόνου μπορεί να γίνει προεπισκόπηση ή 
αναπαραγωγή ως περίγραμμα. 

Ένα εφέ πραγματικού χρόνου έχει μια μικρή πράσινη κουκκίδα στην 
παλέτα των εφέ αλλά και μέσα στο εικονίδιο του εφέ στο Timeline. Τα 
εφέ στα οποία πρέπει να γίνει render έχουν μια μικρή μπλε κουκκίδα 
μέσα στο εικονίδιο του εφέ στο Timeline. 
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11.3 Χρήση της παλέτας των εφέ (Effect Palette) 

Η παλέτα των εφέ είναι ένα παράθυρο που απαριθμεί όλα τα 
μεταβατικά και τμηματικά εφέ και κάποια εφέ κίνησης που είναι 
διαθέσιμα στην εφαρμογή επεξεργασίας σας. Η παλέτα των εφέ είναι 
το βασικό εργαλείο που χρησιμοποιείτε για να εφαρμόσετε εφέ στις 
ακολουθίες σας. 

Στην αριστερή πλευρά της παλέτας εμφανίζεται μια λίστα από 
κατηγορίες των εφέ. Στη δεξιά πλευρά εμφανίζονται τα εφέ που 
υπάρχουν για κάθε κατηγορία. 

Αν έχετε αποθηκεύσει κάποιο πρότυπο εφέ σε κάποιο bin και έχετε 
ανοιχτό αυτό το bin, αυτά τα πρότυπα εμφανίζονται επίσης στην 
παλέτα των εφέ. 

Για να εμφανίσετε την παλέτα εφέ: 

Ø Από το παράθυρο του Project, κάντε κλικ στην καρτέλα εφέ. 

 
Εικόνα 11.3.1 Η καρτέλα Effect στο παράθυρο του Project 
 

Ø Από το μενού της εφαρμογής, πηγαίνετε Tools > Effect Palette. 
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Εικόνα 11.3.2 Η παλέτα των εφέ 

Ø Από το πληκτρολόγιο πατήστε Ctrl + 11. 

11.4 Εφαρμόζοντας τα εφέ 

Σας δίνεται η δυνατότητα να εφαρμόζετε πλήθος εφέ στο βίντεο υλικό 
στην ακολουθία αφού έχει υποστεί επεξεργασία. Αυτή η ενότητα 
περιγράφει τις βασικές μεθόδους για την εφαρμογή των εφέ στην 
ακολουθία χρησιμοποιώντας: 

· Την παλέτα των εφέ 
· Το Quick Transition κουμπί  

Επιπροσθέτως των μεθόδων που περιγράφονται σε αυτή την ενότητα, 
μπορείτε επίσης: 

· Να χρησιμοποιήσετε το κουμπί Fade Effect  για την σταδιακή 
εισαγωγή ή εξαγωγή των segment εφέ. 

· Να δημιουργήσετε τίτλους και κάποιους τύπους από motion εφέ ως 
νέο κλιπ που μπορείτε στη συνέχεια να επεξεργαστείτε στην 
ακολουθία. 

Για περισσότερες πληροφορίες σχετικά με τη διαγραφή των εφέ από 
την ακολουθία, ανατρέξτε στην ενότητα Deleting Effects in a Sequence 
της βοήθειας της εφαρμογής. 
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11.4.1 Εφαρμογή εφέ από την παλέτα των εφέ 

Εφαρμόζετε κάποιο εφέ από την παλέτα των εφέ σύροντας το εφέ 
εικονίδιο στο Timeline και αφήνοντας το μεταξύ δυο κλιπ για τα εφέ 
μετάβασης ή πάνω σε κλιπ για τα τμηματικά εφέ, στα σημεία στα οποία 
θέλετε να εφαρμοστεί. 

Θυμηθείτε, ότι μπορείτε να εφαρμόσετε εφέ είτε σε μεταβάσεις (τα 
σημεία κοπής μεταξύ των δύο τμημάτων βίντεο), είτε σε κλιπ. Τα 
περισσότερα εφέ ταιριάζουν μόνο σε μια από αυτές τις εφαρμογές, π.χ. 
δεν μπορείτε να εφαρμόζετε όλα τα εφέ από την παλέτα των εφέ σε 
μεταβάσεις. 

Αυτή η ενότητα περιγράφει βασικές μεθόδους για την εφαρμογή ενός 
εφέ ή την εφαρμογή εφέ σε πολλαπλά τμήματα ταυτόχρονα. Μπορείτε 
επίσης να εφαρμόσετε εφέ σε πολλαπλές μεταβάσεις ταυτόχρονα. 

Για να εφαρμόσετε ένα εφέ σε μια μετάβαση ή σε ένα κλιπ στο 
Timeline: 

Ø Κάντε κλικ στο εικονίδιο του εφέ που επιθυμείτε να εφαρμόσετε 
από την παλέτα των εφέ, σύρετε το εικονίδιο του εφέ πάνω από τη 
μετάβαση ή το κλιπ στο Timeline και απελευθερώστε το κουμπί του 
ποντικιού. 

Για να εφαρμόσετε ένα εφέ σε πολλαπλά κλιπ στο Timeline: 

1. Εισέλθετε στο Effect mode επιλέγοντας από το μενού της 
εφαρμογής Toolset > Effects Editing. 

2. Κάντε κλικ στο κενό σημείο στο Timeline πάνω και αριστερά από τα 
κλιπ που θέλετε να επιλέξετε και σύρετε προς τα δεξιά και κάτω για 
να τα επιλέξετε. 

3. Όταν έχετε επιλέξει τα κλιπ που θέλετε αφήστε το πλήκτρο του 
ποντικιού. 
Τα κλιπ που έχετε επιλέξει εμφανίζονται φωτισμένα. 

 
Εικόνα 11.4.1 Φωτισμένα κλιπ στο Timeline 
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4. Αν τα κλιπ στα οποία θέλετε να εφαρμόσετε το εφέ δεν είναι 
συνεχόμενα, πατήστε Shift + κλικ πάνω στα κλιπ για να 
αποεπιλέξετε τα κλιπ που θέλετε να αποεπιλέξετε. 

5. Από την παλέτα των εφέ κάντε διπλό κλικ στο εικονίδιο του εφέ που 
θέλετε να εφαρμόσετε στα κλιπ. 
Το εφέ εφαρμόζεται στα φωτισμένα κλιπ του Timeline. 

 
Εικόνα 11.4.2 Εφαρμοσμένο εφέ σε κλιπ 
 

11.4.2 Τροποποίηση του μεγέθους των εφέ για να ταιριάξουν 
στα κλιπ 

Αν δεν υπάρχει υλικό αρκετής διάρκειας ούτος ώστε να εφαρμοστεί ένα 
transition εφέ στην προεπιλεγμένη του διάρκεια, ανοίγει το παράθυρο 
διαλόγου Insufficient Source. 

 
Εικόνα 11.4.3 Το παράθυρο διαλόγου Insufficient Source 

Αυτό το παράθυρο διαλόγου εμφανίζει μια γραφική απεικόνιση, η 
οποία σας δείχνει ποιο από τα κλιπ ανάμεσα στα οποία θέλετε να 
εφαρμόσετε το εφέ είναι ανεπαρκές. 

Για την αυτόματη τροποποίηση του μεγέθους του εφέ ώστε να 
ταιριάζει στα κλιπ: 

Ø Κάντε κλικ στο Size to Fit. 

Η εφαρμογή επεξεργασίας Avid ορίζει τη διάρκεια του εφέ ώστε να 
ταιριάζει στα διαθέσιμα κλιπ. Αν έχετε επιλέξει ευθυγράμμιση, η 
εφαρμογή προσπαθεί να την διατηρήσει. 
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Αν και η γραφική απεικόνιση στο παράθυρο διαλόγου Insufficient 
Source μοιάζει με αυτή του παραθύρου Quick Transition, δεν μπορείτε 
να προσαρμόσετε ένα εφέ σύροντας το στο παράθυρο διαλόγου 
Insufficient Source. 

11.4.3 Χρησιμοποιώντας το κουμπί Quick Transition 

Μπορείτε να χρησιμοποιήσετε το κουμπί Quick Transition  για να 
εφαρμόσετε τα παρακάτω εφέ μετάβασης χωρίς να χρησιμοποιείτε την 
παλέτα των εφέ και να τα προσαρμόσετε για τη θέση και τη διάρκεια 
χωρίς να εισέρχεσθε στο Effect mode: 

· Dissolves 
· Film Dissolves 
· Film Fades 
· Fade to Color 
· Fade from Color 
· Dip to Color 

Μπορείτε να προσθέσετε το ίδιο εφέ μετάβασης σε πολλαπλές 
μεταβάσεις μαρκάροντας τα IN και OUT points που επιλέγουν όλες τις 
μεταβάσεις στις οποίες θέλετε να εφαρμοστεί το εφέ στην ακολουθία. 
Όταν κάνετε κλικ στο κουμπί Quick Transition, το παράθυρο διαλόγου 
Quick Transition περιέχει ένα check box για την εφαρμογή σε όλες τις 
μεταβάσεις (Apply to All Transitions) (IN->OUT). 

Για να δημιουργήσετε ένα εφέ χρησιμοποιώντας το κουμπί Quick 
Transition: 

1. Μετακινήστε τον δείκτη θέσης σε μια μετάβαση στο Timeline. 
2. Κάντε κλικ στο κουμπί Quick Transition . 

Το παράθυρο διαλόγου απεικονίζει ένα γράφημα του εξερχόμενου 
(Α) και εισερχόμενου κλιπ (Β), με το εικονίδιο του Dissolve Effect να 
είναι εφαρμοσμένο στη μετάβαση. 
Η εφαρμογή κλιμακώνει το γράφημα για να απεικονίσει το σχετικό 
μέγεθος του Dissolve Effect και τα media που είναι διαθέσιμα για το 
εφέ. 
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Κάτω από το γράφημα στην αριστερή πλευρά, είναι ο αριθμός των 
καρέ του εισερχόμενου κλιπ (Β) που είναι διαθέσιμα πριν την κοπή 
και στα δεξιά είναι ο αριθμός των καρέ του εξερχόμενου κλιπ (Α) 
που είναι διαθέσιμα μετά την κοπή. 

 
Εικόνα 11.4.4 Το παράθυρο διαλόγου Quick Transition 

 
3. Κάντε κλικ στο Add menu στο πάνω μέρος του παραθύρου διαλόγου 

και επιλέξτε ένα εφέ μετάβασης. 
Όταν αποθηκεύετε ένα πρότυπο του Dissolve εφέ σε ένα bin με 
όνομα Quick Transitions, το πρότυπο αυτό του εφέ εμφανίζεται στο 
μενού Add. 
Όταν επιλέγετε color transition με Quick Transition, το 
προεπιλεγμένο χρώμα είναι μαύρο. Πρέπει να εισέλθετε στο Effect 
mode για να επιλέξετε άλλο χρώμα. 

4. Ορίστε τη διάρκεια της μετάβασης κάνοντας ένα από τα παρακάτω: 
Ø Πληκτρολογήστε την διάρκεια σε καρέ στο πλαίσιο κειμένου 

Duration. 
Ø Κάντε κλικ είτε στην αριστερή είτε στη δεξιά άκρη του εικονιδίου 

του Dissolve εφέ και σύρετε την ώστε να αλλάξει η διάρκεια. 
5. Προσαρμόστε τη θέση του εφέ σχετικά με το σημείο κοπής, με έναν 

από τους παρακάτω τρόπους: 
Ø Κάντε κλικ στο μενού Position και επιλέξτε την εντολή να τελειώνει 

το εφέ στο σημείο αποκοπής, να κεντράρεται στο σημείο 
αποκοπής ή να ξεκινάει στο σημείο αποκοπής.  

Ø Κάντε κλικ στο μενού Position, επιλέξτε Custom και ύστερα 
πληκτρολογήστε έναν αριθμό στο πλαίσιο κειμένου Start για να 



Σελίδα | 150  
 

προσδιορίσετε πόσα καρέ πριν από το σημείο αποκοπής θέλετε να 
ξεκινήσει το εφέ. 

Ø Κάντε κλικ στο εικονίδιο Dissolve Effect και σύρετε το για να 
τοποθετήσετε το εφέ σε σχέση με το σημείο αποκοπής. 

Ø Κάντε κλικ σε ένα από τα κουμπιά ευθυγράμμισης κάτω από το 
γράφημα. 

Αυτά τα κουμπιά εμφανίζονται όταν επιλέγετε Custom από το 
αναδυόμενο μενού του Position ή όταν κάνετε κλικ στο γράφημα. 
Η εφαρμογή τοποθετεί το εφέ, αναβαθμίζει το γράφημα για να 
απεικονίζει την καινούρια θέση του εφέ και αναβαθμίζει την τιμή 
στο πλαίσιο κειμένου Start. 
Αν επιλέξετε μια ευθυγράμμιση για την οποία δεν υπάρχει αρκετό 
υλικό, η εφαρμογή πλησιάζει όσο πιο κοντά γίνεται στην 
ευθυγράμμιση που ζητήσατε. 

6. Αν κάνετε κλικ στο εικονίδιο του Dissolve Effect και το σύρετε, το 
Position μενού αλλάζει σε Custom. Προσδιορίστε που να ξεκινήσει 
το εφέ, δηλαδή πόσα καρέ πριν την αποκοπή θέλετε να 
συμπεριληφθούν στο Dissolve. Κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ κοντά στη μέση του εικονιδίου Dissolve Effect και 

σύρετε το για να αλλάξει δυναμικά ο αριθμός των καρέ. 
Ø Κάντε κλικ στα κουμπιά ευθυγράμμισης κάτω από το γράφημα για 

να καθορίσετε το εφέ ως τελείωμα στην κοπή, κεντράρισμα στην 
κοπή ή ξεκίνημα στην κοπή. 

Ø Πληκτρολογήστε τον αριθμό των καρέ στο πλαίσιο κειμένου Start. 
7. Κάντε κλικ στο Target Drive μενού και επιλέξτε έναν οδηγό στον 

οποίο θα αποθηκεύσετε το εφέ που θα επιλέξετε να κάνετε render. 
8. (Επιλογή) Αν έχετε μαρκαρισμένα IN και OUT points στην ακολουθία 

σας, το παράθυρο διαλόγου Quick Transition περιέχει τις παρακάτω 
δυο επιλογές: 
 

¾  Apply to All Transitions (IN -> OUT) 
 

¾  Skip Existing Transition Effects 
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Κάντε ένα από τα παρακάτω: 
Ø Επιλέξτε Apply to All Transitions (IN -> OUT) για να 

αντικαταστήσετε όλα τα υπάρχοντα μεταβατικά εφέ μεταξύ των 
σημείων IN και OUT. 

Ø Επιλέξτε και τις δυο επιλογές για να αποφύγετε την αντικατάσταση 
των οποιονδήποτε υπαρχόντων μεταβατικών εφέ. 

 
Η επιλογή Skip Existing Transition Effects είναι χρήσιμη όταν θέλετε 
να προσθέσετε έναν αριθμό από dissolve στην ακολουθία, η οποία 
περιέχει ήδη μεταβατικά εφέ. 

 
9. Κάντε ένα από τα παρακάτω: 
Ø Για να προσθέσετε εφέ χωρίς να του κάνετε render, κάντε κλικ στο 

Add. 
Ø Για να προσθέσετε εφέ και να του κάνετε render, κάντε κλικ στο 

Add and Render. 
 

Η εφαρμογή Avid προσθέτει το εφέ στην επιλεγμένη μετάβαση στην 
ακολουθία ή αν έχετε επιλέξει Apply to All Transitions (IN ->  OUT), η 
εφαρμογή προσθέτει το εφέ σε όλες τις μεταβάσεις μεταξύ των 
σημείων IN και OUT. 

11.5 Ρύθμιση των Εφέ 

Αφού έχετε δημιουργήσει ένα εφέ και το έχετε εφαρμόσει σε μια 
μετάβαση ή σε κάποιο κλιπ στην ακολουθία, έχετε τη δυνατότητα να 
ρυθμίσετε την εμφάνιση και τη λειτουργία του. Για να κάνετε ρυθμίσεις 
για τα περισσότερα εφέ, εισέρχεσθε στο Effect mode και δουλεύετε με 
το Effect Editor και την οθόνη Effect Preview. 
 
11.5.1 Κατανόηση του Effect Mode 
Κάθε ιδιότητα του εφέ που μπορείτε να ελέγξετε είναι γνωστή ως 
παράμετρος. Το Effect Editor εμφανίζει κουμπιά ελέγχου που σας 
επιτρέπουν να ρυθμίσετε την κάθε παράμετρο ενός εφέ, καθώς και 
άλλα κουμπιά τα οποία σας βοηθούν να ρυθμίσετε τα εφέ. Από τη 
στιγμή που διαφορετικά εφέ έχουν διαφορετικά σύνολα παραμέτρων, 
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το Effect Editor εμφανίζει αλλαγές ανάλογα με το εφέ που έχετε 
επιλέξει. 
Το Effect Preview monitor εμφανίζει το επιλεγμένο εφέ στην 
ακολουθία, στη θέση που βρίσκεται ο δείκτης θέσης στο Timeline.  
Για κάποια εφέ, το Effect Preview monitor εμφανίζει εργαλεία που σας 
επιτρέπουν να ρυθμίσετε το εφέ κατευθείαν στο μόνιτορ.  
 
11.5.2 Εισαγωγή στο Effect Mode 
Αφού έχετε προσθέσει ένα εφέ στην ακολουθία, θα πρέπει να 
εισέλθετε στο Effect mode για να αλλάξετε τις παραμέτρους του εφέ. 
Όταν εισέρχεσθε στο Effect mode το Record monitor μετασχηματίζεται 
σε Effect Preview monitor και ανοίγει το Effect Editor. 
Για να εισέλθετε στο Effect mode, κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ στο κουμπί Effect Mode στο παράθυρο του Timeline. 
Ø Από το μενού της εφαρμογής, πηγαίνετε Toolset > Effects Editing 

Αν ο δείκτης θέσης στο timeline βρίσκεται πάνω σε εφέ, 
εμφανίζονται στο Effect Editor τα κουμπιά ελέγχου για τη ρύθμιση 
του εφέ. 

 
Εικόνα 11.5.1 Το παράθυρο Effect Editor με παραμέτρους εφέ 
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11.5.3 Βασικές ρυθμίσεις Εφέ 

Αυτή η ενότητα περιγράφει μια γενική διαδικασία για την επιλογή και 
τη ρύθμιση των εφέ. 
Για να κάνετε βασικές ρυθμίσεις εφέ: 

1. Εισέλθετε στο Effect mode. 
2. Στο Timeline, κάντε κλικ στο εφέ που θέλετε να ρυθμίσετε. 
3. (Επιλογή) Αν χρειαστεί να μετακινηθείτε μέσα στο εφέ, 

χρησιμοποιήστε τη γραμμή θέσης του μόνιτορ Effect Preview, 
καθώς και το δείκτη θέσης. 

4. Στο Effect Editor ή στο Effect Preview μόνιτορ, προσαρμόστε τις 
παραμέτρους των εφέ μέχρι να σας ευχαριστεί το αποτέλεσμα. 

 
11.5.4 Μετακίνηση διαμέσου του Εφέ 
Η γραμμή θέσης στο Effect Preview μόνιτορ αντιπροσωπεύει τη 
διάρκεια του τρέχοντος επιλεγμένου εφέ. Αν θέλετε να μετακινηθείτε 
σε διαφορετική τοποθεσία μέσα στο εφέ, μπορείτε να 
χρησιμοποιήσετε τη γραμμή θέσης του Effect Preview μόνιτορ με τον 
ίδιο τρόπο που χρησιμοποιείτε τη γραμμή θέσης στο Source/Record 
mode για να μετακινηθείτε διαμέσου του κλιπ ή της ακολουθίας. 
Μπορείτε επίσης να πληκτρολογήσετε timecode με τον ίδιο τρόπο που 
κάνετε κατά τη διάρκεια της κανονικής επεξεργασίας. Ο τύπος του 
timecode που εισάγετε (master timecode ή absolute timecode) 
εξαρτάται από τις tracking πληροφορίες που εμφανίζετε. 
Τα πλαίσια πληροφοριών θέσης πάνω από το Effect Preview μόνιτορ 
ενημερώνονται αυτόματα, κάθε φορά που αλλάζετε θέση. 
Για να μετακινηθείτε σε άλλο σημείο μέσα στο εφέ, κάντε ένα από τα 
παρακάτω: 
Ø Κάντε κλικ σε μία τοποθεσία στη γραμμή θέσης για να μετακινήσετε 

το δείκτη θέσης σε εκείνη την τοποθεσία. 
Ø Σύρετε το δείκτη θέσης στην τοποθεσία που θέλετε στη γραμμή 

θέσης. 
Ø Πληκτρολογήστε το timecode με τον ίδιο τρόπο που κάνετε όταν 

επεξεργάζεστε μια ακολουθία. 
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11.5.5 Χρήση του κουμπιού Fade Effect 

Μπορείτε να χρησιμοποιήσετε το κουμπί Fade Effect  για να κάνετε 
σταδιακή εισαγωγή/εξαγωγή του τμηματικού εφέ γρήγορα και εύκολα. 
Ένα παράθυρο διαλόγου ανοίγει το οποίο σας επιτρέπει να εισάγετε 
ένα αριθμό καρέ για το fade up και το fade down, δηλαδή την σταδιακή 
εισαγωγή και εξαγωγή του εφέ. 
Το χαρακτηριστικό Fade Effect δημιουργεί αυτόματα καρέ κλειδιά για 
το εφέ. Μπορείτε να έχετε πρόσβαση σε καρέ κλειδιά από το Effect 
Editor . 
Για να κάνετε σταδιακή εισαγωγή/εξαγωγή ενός ή περισσότερων 
τμηματικών εφέ στην ακολουθία: 

1. Επιλέξτε το τμηματικό εφέ στο Timeline: 
Ø Για να κάνετε σταδιακή εισαγωγή/εξαγωγή ενός τμηματικού εφέ, 

μετακινήστε τον δείκτη θέσης στο τμήμα. 
Ø Για να κάνετε σταδιακή εισαγωγή/εξαγωγή πολλαπλών 

τμηματικών εφέ, κάντε κλικ είτε στο κουμπί Extract/Splice-in  
είτε το κουμπί Lift/Overwrite  στην κάτω πλευρά του Timeline 
και ύστερα κάντε Shift + κλικ στα τμήματα. 

2. Πατήστε το κουμπί Fade Effect . 
3. Στο παράθυρο διαλόγου Fade Effect, πληκτρολογήστε τον αριθμό 

των καρέ για την σταδιακή εισαγωγή και εξαγωγή και κάντε κλικ στο 
ΟΚ. 
Μπορείτε άμεσα να δείτε τα αποτελέσματα κάνοντας αναπαραγωγή 
του τμήματος ή των τμημάτων. 

 
Εικόνα 11.5.2 Το παράθυρο διαλόγου Fade Effect 
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11.6 Δουλεύοντας με τα καρέ κλειδιά (Keyframes) 
Κάνετε χρήση των καρέ κλειδιών για να αλλάξετε την εμφάνιση και τη 
συμπεριφορά του εφέ σταδιακά. Ένα καρέ κλειδί είναι ένα σημείο στο 
εφέ στο οποίο μπορείτε να ορίσετε παραμέτρους. 
Όταν οι παράμετροι είναι ορισμένοι σε διαφορετικές τιμές σε 
διαφορετικά καρέ, η εφαρμογή επεξεργασίας Avid κινητοποιεί το εφέ 
υπολογίζοντας αυτόματα τις ενδιάμεσες τιμές για τις παραμέτρους 
μεταξύ των καρέ κλειδιών. 
Οι εφαρμογές επεξεργασίας Avid χρησιμοποιούν δύο είδη καρέ 
κλειδιών: τα standard και τα advanced. Τα standard καρέ κλειδιά 
εφαρμόζονται σε κάθε παράμετρο στο εφέ. Τα advanced καρέ κλειδιά 
σας επιτρέπουν να δημιουργήσετε ανεξάρτητα καρέ κλειδιά για κάθε 
keyframeable παράμετρο στο εφέ, το οποίο παρέχει περισσότερη 
ευελιξία και έλεγχο για ρυθμίσεις πολύπλοκων εφέ. Τα advanced καρέ 
κλειδιά είναι διαθέσιμα για πολλά αλλά όχι όλα τα εφέ. 
 
11.6.1 Κατανόηση των Standard καρέ κλειδιών 
Όταν δημιουργείτε ένα εφέ, η εφαρμογή επεξεργασίας Avid παρέχει 
πάντα τα καρέ κλειδιά αρχής και τέλους του εφέ. Αυτά τα καρέ κλειδιά 
είναι επιλεγμένα από προεπιλογή και επομένως τυχών αλλαγές των 
παραμέτρων είναι σταθερές σε κάθε σημείο του εφέ. Χρησιμοποιώντας 
τεχνικές για την προσθήκη, διαγραφή, μετακίνηση, επιλογή και 
αποεπιλογή των καρέ κλειδιών, μπορείτε να ξεκινήσετε να αλλάζετε την 
εμφάνιση και τη λειτουργία των εφέ σταδιακά εφαρμόζοντας αλλαγές 
στις παραμέτρους σε συγκεκριμένα καρέ κλειδιά. 
Οι δείκτες των standard καρέ κλειδιών εμφανίζονται σαν τρίγωνα στη 
γραμμή θέσης του Effect Preview μόνιτορ όταν επιλέγετε ένα εφέ και το 
Effect Editor είναι ενεργοποιημένο. Πριν κάνετε οποιαδήποτε αλλαγή 
καρέ κλειδιών στο εφέ, μπορείτε να δείτε τα προεπιλεγμένα καρέ 
κλειδιά έναρξης και λήξης στα άκρα της γραμμής θέσης (και τα δύο 
είναι ροζ, υποδεικνύοντας ότι και τα δύο είναι επιλεγμένα). 
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11.6.2 Προσθήκη ενός Standard καρέ κλειδιού 

Μπορείτε να δημιουργήσετε ένα standard καρέ κλειδί σε οποιοδήποτε 
σημείο στη γραμμή θέσης του εφέ. 
Για να δημιουργήσετε ένα standard καρέ κλειδί: 

1. Κάντε κλικ στη γραμμή θέσης κάτω από το Effect Preview μόνιτορ 
στο σημείο του εφέ που θέλετε να προσθέσετε το καρέ κλειδί. 

2. Κάντε ένα από τα παρακάτω για να προσθέσετε ένα καρέ κλειδί: 
Ø Είτε από τη γραμμή εργαλείων του Effect Preview μόνιτορ είτε από 

την παλέτα Tool, κάντε κλικ στο κουμπί Add Keyframe . 
Ø Ρυθμίστε χειροκίνητα την παράμετρο στο Effect Preview μόνιτορ 

(για τα τμηματικά εφέ μόνο). Για παράδειγμα, όταν κάνετε κλικ σε 
μια λαβή σε ένα περίγραμμα κάποιου εφέ και το σύρετε για να του 
αλλάξετε μέγεθος ή να το μετακινήσετε, η εφαρμογή επεξεργασίας 
Avid δημιουργεί αυτόματα ένα νέο καρέ κλειδί. 
 

11.6.3 Επιλέγοντας ένα Standard καρέ κλειδί  
Μπορείτε να επιλέξετε ένα μονό standard καρέ κλειδί ή πολλαπλά 
standard καρέ κλειδιά συγχρόνως. Ένας δείκτης καρέ κλειδιού γίνεται 
ροζ χρώμα όταν επιλέγεται , ενώ όταν είναι αποεπιλεγμένο έχει 
σκούρο χρώμα . 
Για να επιλέξετε ένα καρέ κλειδί: 
Στη γραμμή θέσης στο κάτω μέρος του Effect Preview μόνιτορ, κάντε 
κλικ σε έναν δείκτη καρέ κλειδιού. 
Για να επιλέξετε πολλαπλά καρέ κλειδιά: 
Πατήστε Shift + κλικ και επιλέξτε τα καρέ που θέλετε από τη γραμμή 
θέσης του εφέ. 
Για να επιλέξετε όλα τα καρέ κλειδιά στη γραμμή θέσης του εφέ, 
κάντε ένα από τα παρακάτω: 
Ø Πατήστε από το πληκτρολόγιο Ctrl + A. 
Ø Πατήστε και κρατήστε πατημένο από το πληκτρολόγιο Ctrl + Alt και 

κάντε κλικ σε ένα δείκτη καρέ κλειδιού. 
Για πιο γρήγορο τρόπο μετάβασης στο επόμενο ή προηγούμενο 
δείκτη καρέ κλειδιού, χρησιμοποιήστε τα κουμπιά Fast Forward και 
Rewind από την γραμμή εργαλείων του Effect Preview μόνιτορ. 
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11.6.4 Μετακίνηση ενός standard καρέ κλειδιού 
Αφού έχετε δημιουργήσει ένα standard καρέ κλειδί, μπορείτε να το 
μετακινήσετε σε άλλη θέση στη γραμμή θέσης στο κάτω μέρος του 
Effect Preview μόνιτορ. 
Με τα standard καρέ κλειδιά, δεν μπορείτε να μετακινήσετε τα καρέ 
κλειδιά της έναρξης και του τέλους. 
Για να μετακινήσετε ένα standard καρέ κλειδί, κάντε ένα από τα 
παρακάτω: 
Ø Κάντε Alt + Κλικ στο καρέ κλειδί που θέλετε να μετακινήσετε και 

σύρετε το στη νέα του θέση. 
Ø Επιλέξτε ένα καρέ κλειδί και κάντε κλικ σε ένα από τα παρακάτω 

κουμπιά: 
· Trim Left 1 Frame  
· Trim Right 1 Frame  
· Trim Left 10 Frames  
· Trim Right 10 Frames 
Αυτά τα κουμπιά βρίσκονται στην καρτέλα Trim της παλέτας 
Command. Μπορείτε να τα δρομολογήσετε στα κουμπιά της 
παλέτας tool. 

11.6.5 Αλλαγή παραμέτρου του standard καρέ κλειδιού 
Όταν εργάζεστε με standard καρέ κλειδιά, με ορισμένες κατηγορίες 
παραμέτρων, όπως το  Acceleration (επιτάχυνση), προσαρμόζετε τις 
παραμέτρους γενικά (σε όλα τα καρέ κλειδιά στο εφέ). Μπορείτε επίσης 
να αλλάξετε πολλές παραμέτρους για μεμονωμένα standard καρέ 
κλειδιά. 
 
Για να αλλάξετε τις παραμέτρους για τα standard καρέ κλειδιά: 

1. Στη γραμμή θέσης στο κάτω μέρος του Effect Preview μόνιτορ, κάντε 
κλικ σε έναν δείκτη καρέ κλειδιού. 

2. Ρυθμίστε οποιαδήποτε από τις παραμέτρους που εφαρμόζονται, 
από το Effect Editor. 
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11.6.6 Αντιγραφή και επικόλληση των παραμέτρων των 
standard καρέ κλειδιών 
Μπορείτε να αντιγράψετε και να επικολλήσετε παραμέτρους από ένα 
standard καρέ κλειδί και να τις εφαρμόζετε σε άλλο standard καρέ 
κλειδί. Μπορείτε επίσης να αντιγράψετε τις παραμέτρους από ένα εφέ 
σε ένα άλλο εφέ. 
 
Για να αντιγράψετε και να επικολλήσετε τις παραμέτρους των 
standard καρέ κλειδιών: 

1. Κάντε κλικ σε έναν δείκτη καρέ κλειδιού, στη γραμμή θέσης στο 
κάτω μέρος του Effect Preview μόνιτορ, του οποίου θέλετε να 
αντιγράψετε τις παραμέτρους. 

2. Από το μενού της εφαρμογής επιλέξτε Edit > Copy. 
3. Επιλέξτε ένα ή περισσότερα standard καρέ κλειδιά: 
Ø Για να αντιγράψετε τις παραμέτρους σε ένα καρέ κλειδί, κάντε κλικ 

σε ένα καρέ κλειδί. 
Ø Για να αντιγράψετε τις παραμέτρους σε πολλαπλά καρέ κλειδιά, 

κάντε Ctrl + κλικ σε πολλαπλά καρέ κλειδιά. 
Ø Για να αντιγράψετε τις παραμέτρους σε όλα τα καρέ κλειδιά, από 

το μενού της εφαρμογής επιλέξτε Edit > Select All. 
4. Από το μενού της εφαρμογής επιλέξτε Edit > Paste. 

 
11.6.7 Διαγραφή ενός Standard καρέ κλειδιού 
Μπορείτε να διαγράψετε οποιοδήποτε standard καρέ κλειδί 
δημιουργείτε. Δεν μπορείτε να διαγράψετε τα καρέ κλειδιά έναρξης και 
τέλους τα οποία δημιουργεί η εφαρμογή επεξεργασίας Avid. 
 
Για να διαγράψετε ένα standard καρέ κλειδί: 

1. Στη γραμμή θέσης στο κάτω μέρος του Effect Preview μόνιτορ, κάντε 
κλικ σε έναν δείκτη καρέ κλειδιού. 

2. Κάντε ένα από τα παρακάτω: 
Ø Από το πληκτρολόγιο πατήστε το κουμπί Delete. 
Ø Alt + κλικ στο κουμπί Add Keyframe. 
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11.7 Αναπαραγωγή του εφέ στο Effect Mode 

Ενώ ρυθμίζετε τα εφέ στο Effect mode, ίσως να θελήσετε να 
αναπαράγετε ένα μεμονωμένο εφέ για να ελέγξετε την όψη του. 
Μπορείτε να: 

· Αναπαράγετε το σύνολο ή μέρος ενός μεμονωμένου εφέ μια φορά. 
· Αναπαράγετε ένα μεμονωμένο εφέ σε συνεχόμενη επανάληψη. 
· Αναπαράγετε μια προεπισκόπηση περιγράμματος του εφέ- μια 

αναπαράσταση της θέσης, κλίμακας και πορείας της κίνησης του 
εφέ. 

Για να αναπαράγετε ένα εφέ στο Effect mode: 
1. Από το Timeline, επιλέξτε το εφέ. 
2. Στη γραμμή θέσης του Effect Preview μόνιτορ, μετακινήστε το 

δείκτη θέσης στην τοποθεσία που θέλετε να ξεκινήσει η 
αναπαραγωγή. 

3. Κάντε κλικ στο κουμπί Play  ή πατήστε το space bar. 
Το εφέ αναπαράγεται συνεχόμενα μέχρι το τέλος του εφέ, ή μέχρι 
να ξανά πατήσετε το κουμπί Play ή το space bar. 

Για να αναπαράγετε ένα εφέ σε συνεχόμενη επανάληψη στο Effect 
mode: 

1. Μετακινήστε το δείκτη θέσης στο Timeline στο εφέ που θέλετε να 
αναπαράγετε.  

2. Κάντε κλικ στο κουμπί Play Loop. 
Η αναπαραγωγή ξεκινάει από την αρχή του εφέ και συνεχίζει μέχρι 
να κάνετε κλικ στο κουμπί Play Loop ξανά ή μέχρι να πατήσετε το 
space bar. 

Για να αναπαράγετε μία προεπισκόπηση περιγράμματος του εφέ στο 
Effect mode: 

1. Από το Timeline, επιλέξτε το εφέ. 
2. Στη γραμμή θέσης του Effect Preview μόνιτορ, μετακινήστε το 

δείκτη θέσης στην τοποθεσία που θέλετε να ξεκινήσει η 
αναπαραγωγή. 

3. Στο Effect Editor, κάντε κλικ στο κουμπί Play Preview. 
Το εφέ αναπαράγεται μέχρι το τέλος του εφέ, ή μέχρι να ξανά 
κάνετε κλικ στο κουμπί Play Preview ή πατήσετε το space bar. 
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11.8 Προεπισκόπηση των καρέ των εφέ με Render On-the-Fly 
Όταν θέλετε να κάνετε προεπισκόπηση των εφέ στην ακολουθία, 
μπορείτε να χρησιμοποιήσετε το χαρακτηριστικό Render On-the-Fly για 
να ελέγξετε πως η εφαρμογή επεξεργασίας Avid, απεικονίζει το καρέ 
στο οποίο έχουν εφαρμοστεί ένα ή περισσότερα εφέ. Όταν είναι 
επιλεγμένο το Render On-the-Fly, μπορείτε να προσπεράσετε μέσω της 
ακολουθίας σας και να κάνετε προεπισκόπηση οποιουδήποτε καρέ για 
να ελέγξετε την εμφάνιση του εφέ που έχει εφαρμοστεί σε αυτό, 
ανεξάρτητα από τον τύπο ή τον αριθμό αυτών των εφέ. 
 
11.8.1 Απεικόνιση του εφέ άμεσα 
Για να απεικονίσετε τα εφέ άμεσα κατά τη διάρκεια της επεξεργασίας 
των εφέ: 
Ø Από το μενού της εφαρμογής πηγαίνετε Clip > Render On-the-Fly. 

Για να διακόψετε το Render On-the-Fly, κάντε ένα από τα παρακάτω: 
Ø Σύρετε τον δείκτη θέσης στο Timeline. 

Ενώ σύρετε, η ακολουθία εμφανίζεται στην οθόνη του Composer 
όπως θα συνέβαινε εάν το Render On-the-Fly δεν θα ήταν 
επιλεγμένο από το Clip μενού. 

Ø Αν κάνετε κλικ στο Timeline και ξεκινήσει το rendering, γρήγορα 
μετακινηθείτε σε άλλη τοποθεσία στο Timeline. Αυτό διακόπτει τη 
διαδικασία του rendering μέχρι να ελευθερώσετε το κουμπί του 
ποντικιού ξανά. 

 
11.9 Rendering των εφέ 
Η εφαρμογή επεξεργασίας Avid μπορεί να αναπαράγει πολλά 
ανεξάρτητα εφέ και συνδυασμούς εφέ σε πραγματικό χρόνο και για 
σκοπούς προεπισκόπησης καθώς επεξεργάζεστε και για την εξαγωγή. 
Ωστόσο, ανάλογα με την πολυπλοκότητα της ακολουθίας σας, ίσως να 
χρειαστεί να κάνετε render σε κάποια εφέ αν θέλετε να τα κάνετε 
προεπισκόπηση σε πραγματικό χρόνο και σε πλήρη ποιότητα ή πριν 
μπορείτε να εξάγετε μια ολοκληρωμένη ακολουθία. 
 



Σελίδα | 161  
 

11.9.1 Δημιουργία και χρήση των ρυθμίσεων Render 
Μπορείτε να δημιουργήσετε ένα ή περισσότερα σύνολα παραμέτρων 
render και να τα αποθηκεύσετε ως μια προσαρμοσμένη ρύθμιση 
Render. 
Για να δημιουργήσετε μια νέα ρύθμιση Render: 

1. Από το παράθυρο του Project, κάντε κλικ στην καρτέλα Settings. 
2. Από το Fast menu της καρτέλας Settings επιλέξτε All Settings. 
3. Κάντε κλικ στο Render 
4. Από το μενού της εφαρμογής επιλέξτε Edit > Duplicate ή κάντε δεξί 

κλικ στο Render και από το μενού επιλέξτε Duplicate. 
5. Δώστε μια ονομασία στη ρύθμιση κάνοντας τα παρακάτω: 
α. Κάντε κλικ στη μεσαία στήλη. 
β. Πληκτρολογήστε μια ονομασία. 
γ. Πατήστε το Enter. 

6. Επιλέξτε τις επιλογές της νέας ρύθμισης Render όπως περιγράφεται 
στον πίνακα Render Settings Options στην ενότητα Render Settings 
της βοήθειας της εφαρμογής. 
 

 
Εικόνα 11.9.1 Το παράθυρο Render Settings 
 

 
Για να ενεργοποιήσετε μια ρύθμιση Render: 
Ø Κάντε κλικ αριστερά της λέξης Render στη κενή στήλη. Η ρύθμιση 

είναι ενεργοποιημένη όταν εμφανιστεί το τικ. 
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Για να προσαρμόσετε τις επιλογές για τις ρυθμίσεις Render: 

1. Από την καρτέλα Settings του παραθύρου Project, κάντε διπλό κλικ 
στη ρύθμιση Render. 

2. Επιλέξτε τις κατάλληλες επιλογές, βασισμένες στον πίνακα Render 
Settings Options στην ενότητα Render Settings της βοήθειας της 
εφαρμογής και ύστερα κάντε κλικ στο ΟΚ. 

 
11.9.2 Μερικό Render 
Αν διακόψετε μια διαδικασία render η οποία δεν έχει ολοκληρωθεί, η 
εφαρμογή Avid σας επιτρέπει να αποθηκεύσετε το ολοκληρωμένο 
τμήμα του render. Μπορείτε να ολοκληρώσετε το render αργότερα 
επανυποβάλλοντας το εφέ για rendering. Η εφαρμογή σας τότε κάνει 
render μόνο στο τμήμα του εφέ που δεν έγινε render προηγουμένως 
και σώζει αυτό το τμήμα ως ξεχωριστό προϋπολογισμό. 
Αυτό το χαρακτηριστικό είναι ιδιαίτερα χρήσιμο αν πρέπει να 
διακόψετε μεγάλο render ενός εφέ, όπως το Submaster. 
Μπορείτε επίσης να χρησιμοποιήσετε την εντολή Render Ranges από το 
Fast Menu του Timeline για να προσαρμόσετε το Timeline, έτσι ώστε να 
δείχνει σε ποια μέρη ενός εφέ έχει γίνει render από την εφαρμογή 
επεξεργασίας Avid. 
 
Για να διακόψετε τη διαδικασία Render: 

1. Πατήστε Ctrl + period για να διακόψετε τη διαδικασία render. 
2. Κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ στο Keep για να σώσετε το υλικό στο οποίο έχει γίνει 

Render. 
Ø Κάντε κλικ στο Discard για να διακόψετε το render δίχως να 

σώσετε το υλικό στο οποίο έχει γίνει render. 
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Για να προσαρμόσετε την εμφάνιση του render range στο timeline: 

1. Kάντε κλικ στο Fast Menu στο κάτω μέρος του Timeline και επιλέξτε 
Render Ranges. 

2. Επιλέξτε ένα από τα παρακάτω από το υπομενού: 
¾ None - Απενεργοποιεί την εμφάνιση του Render ranges. 
¾ Partial Only - Εμφανίζει μια κόκκινη γραμμή στο τμήμα του 

οποιουδήποτε εφέ στο οποίο έχει γίνει render μερικώς, το οποίο 
είναι προσωρινά unrendered (αλλά δεν μαρκάρει εντελώς 
unrendered εφέ). Αυτή είναι η προεπιλεγμένη επιλογή. 

¾ All - Εμφανίζει μια κόκκινη γραμμή στο τμήμα του οποιουδήποτε 
εν μέρει rendered εφέ το οποίο είναι unrendered και για όλα τα 
εντελώς unrendered εφέ. 

11.9.3 Render μεμονωμένου εφέ 

Για να κάνετε render σε μεμονωμένο εφέ: 
1. Μετακινήστε το δείκτη θέσης στο Timeline στη θέση που βρίσκεται 

το εφέ. 
Σιγουρευτείτε ότι το track που περιέχει το εφέ είναι επιλεγμένο. 

2. Κάντε ένα από τα παρακάτω: 
Ø Από την παλέτα Tool, το Effect Editor ή το Effect Preview Monitor, 

κάντε κλικ στο κουμπί Render Effect. 
Ø Από το μενού της εφαρμογής επιλέξτε Clip > Render at Position. 
Για να αποτρέψετε το άνοιγμα του παραθύρου διαλόγου Render 
Effects την προκειμένη στιγμή, πατήστε και κρατήστε πατημένο το 
πλήκτρο Alt όταν κάνετε κλικ στο κουμπί Render Effect.  

3. Κάντε κλικ στο κουμπί Drive και επιλέξτε τη μονάδα δίσκου για τα 
rendered πολυμέσα. 

4. Κάντε κλικ στο ΟΚ. 
Αν δεν υπάρχει αρκετός χώρος στον οδηγό, η εφαρμογή 
επεξεργασίας Avid εμφανίζει ένα πλαίσιο μηνύματος με τις 
παρακάτω επιλογές: 

¾ Stop - Σταματάει τη διαδικασία του render και επιστρέφει στο 
παράθυρο διαλόγου Render Effect και στη συνέχεια επιλέξτε μια 
άλλη μονάδα δίσκου πριν συνεχίσετε. 
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¾ Continue - Προσπαθεί να κάνει render στο εφέ όπως και να 'ναι σε 
περίπτωση που θα μπορούσε να υπάρχει αρκετός χώρος στο 
δίσκο. 
Για να εμφανίσετε το εκτιμώμενο render χρόνο κατά τη διάρκεια του 
rendering, πατήστε το πλήκτρο T από το πληκτρολόγιο. Ξανά 
πατήστε το πλήκτρο T για να καθαρίσετε την οθόνη. Πατήστε το 
πλήκτρο P για να εμφανίσετε το ποσοστό που έχει γίνει render. 

11.9.4 Render πολλαπλών εφέ στη θέση τους 

Για να κάνετε render σε πολλαπλά εφέ στη θέση τους: 
1. Μετακινήστε το δείκτη θέσης στα εφέ στο Timeline. 
2. Επιλέξτε όλα τα track που περιέχουν εφέ που θέλετε να κάνετε 

render. 
3. Από το μενού της εφαρμογής επιλέξτε Clip > Render at Position. 

 
Εικόνα 11.9.2 Το παράθυρο Render Effects 

 
4. Κάντε κλικ στο κουμπί Drive και επιλέξτε τη μονάδα δίσκου στην 

οποία θα αποθηκευτούν τα rendered εφέ. 
5. Κάντε κλικ στο ΟΚ. 
6. Αν δεν υπάρχει αρκετός χώρος στον οδηγό, η εφαρμογή 

επεξεργασίας Avid εμφανίζει ένα πλαίσιο μηνύματος με τις 
παρακάτω επιλογές: 

¾ Stop - Σταματάει τη διαδικασία του render και επιστρέφει στο 
παράθυρο διαλόγου Render Effect και στη συνέχεια επιλέξτε μια 
άλλη μονάδα δίσκου πριν συνεχίσετε. 

¾ Continue - Προσπαθεί να κάνει render στο εφέ όπως και να 'ναι σε 
περίπτωση που θα μπορούσε να υπάρχει αρκετός χώρος στο 
δίσκο. 
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Για να εμφανίσετε το εκτιμώμενο render χρόνο κατά τη διάρκεια του 
rendering, πατήστε το πλήκτρο T από το πληκτρολόγιο. Ξανά 
πατήστε το πλήκτρο T για να καθαρίσετε την οθόνη. Πατήστε το 
πλήκτρο P για να εμφανίσετε το ποσοστό που έχει γίνει render. 

 
11.9.5 Render των εφέ μεταξύ των σημείων IN και OUT 
Αποθηκεύστε την ακολουθία σας πριν χρησιμοποιήσετε αυτή την 
λειτουργία. Ανάλογα με τον αριθμό, τύπο και την πολυπλοκότητα των 
εφέ, η διαδικασία της επεξεργασίας μπορεί να πάρει αρκετό χρόνο. 
 
Για να κάνετε render σε πολλαπλά εφέ χρησιμοποιώντας τα IN και 
OUT points: 

1. Επιλέξτε όλα τα track που περιέχουν τα εφέ που θέλετε να κάνετε 
render. 

2. Μαρκάρετε ένα IN point πριν από την έναρξη του πρώτου εφέ που 
θα γίνει render στην ακολουθία σας, μαρκάρετε ένα OUT point μετά 
το τελευταίο εφέ στο οποίο θα γίνει render. 

3. Από το μενού της εφαρμογής επιλέξτε Clip > Render In/OUT. 
4. Κάντε κλικ στο κουμπί Drive και επιλέξτε τη μονάδα δίσκου στην 

οποία θα αποθηκευτούν τα rendered εφέ. 
5. Κάντε κλικ στο OK. 

Η εφαρμογή επεξεργασίας Avid κάνει render σε όλα τα εφέ μεταξύ 
των σημείων IN και OUT. 
 

11.9.6 Rerender των εφέ 
Σε κάποιες περιπτώσεις χρειάζεται να ξανά κάνετε render σε εφέ στα 
οποία έχετε ήδη κάνει render. Για παράδειγμα, ίσως να έχετε κάνει 
render μια σειρά από εφέ σε χαμηλή ανάλυση και τώρα πρέπει να τα 
ξανά κάνετε render σε υψηλότερη ανάλυση.  
Για να κάνετε rerender σε μεμονωμένο εφέ: 

1. Μετακινήστε το δείκτη θέσης στο Timeline στη θέση που βρίσκεται 
το εφέ. 

2. Κρατήστε πατημένο το πλήκτρο Shift και κάντε κλικ στο κουμπί 
Render Effect. 

3. Κάντε κλικ στο ΟΚ. 
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Για να κάνετε rerender σε πολλαπλά εφέ σε μία θέση: 
1. Μετακινήστε το δείκτη θέσης στα εφέ στο Timeline. 
2. Επιλέξτε όλα τα track που περιέχουν τα εφέ που θέλετε να κάνετε 

render. 
3. Κρατήστε πατημένο το πλήκτρο Shift και από το μενού της 

εφαρμογής επιλέξτε Clip > Render at Position. 
Για να κάνετε rerender σε πολλαπλά εφέ χρησιμοποιώντας τα IN και 
OUT σημεία: 

1. Επιλέξτε όλα τα track που περιέχουν τα εφέ που θέλετε να κάνετε 
render. 

2. Μαρκάρετε ένα IN point πριν από την έναρξη του πρώτου εφέ που 
θα γίνει render στην ακολουθία σας, μαρκάρετε ένα OUT point μετά 
το τελευταίο εφέ στο οποίο θα γίνει render. 

3. Κρατήστε πατημένο το πλήκτρο Shift και από το μενού της 
εφαρμογής επιλέξτε Clip > Render In/OUT. 
 

11.9.7 Render HQ (Highest Quality) εφέ 
Ένας μικρός αριθμός εφέ, έχει δυο επιλογές render, το standard 
hardware-assisted render και το HQ software-based render. Το HQ 
render παράγει μια ανώτερη εικόνα, αλλά διαρκεί περισσότερο από το 
standard rendering. 
Το κουμπί HQ εμφανίζεται στο Effect Editor για εφέ τα οποία έχουν HQ 
rendering επιλογή. Χρησιμοποιήστε το κουμπί HQ για να επιλέξετε HQ 
render για μεμονωμένο εφέ στην ακολουθία σας. 
Η επιπλέον ποιότητα που επιτυγχάνεται χρησιμοποιώντας την επιλογή 
HQ rendering εξαρτάται από το εφέ και τα αμοντάριστα κλιπ που 
χρησιμοποιήθηκαν για να δημιουργηθεί το εφέ. Για παράδειγμα, το HQ 
rendering μπορεί συχνά να βελτιώσει την ποιότητα του εφέ που αλλάζει 
δυναμικά το μέγεθος σε εικόνα ή ένα εφέ που εφαρμόστηκε σε κλιπ με 
πολύ κίνηση. 
 
Για να επιλέξετε HQ rendering για μεμονωμένα εφέ: 

1. Στο Effect mode, μετακινήστε το δείκτη θέσης στο εφέ που θέλετε 
να επιλέξετε. 
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Αν το HQ rendering υπάρχει για το εφέ, το κουμπί HQ είναι 
διαθέσιμο στο Effect Editor. 

2. Κάντε κλικ στο κουμπί HQ . 
Το κουμπί γίνεται πράσινο . 
 

Για να επιλέξετε standard rendering για μεμονωμένο εφέ: 
Ø Ξανά κάντε κλικ στο κουμπί HQ . 

Το κουμπί γίνεται μαύρο . 
Το κουμπί HQ έχει μια γενική ρύθμιση στο παράθυρο διαλόγου Render 
Settings. Το μενού Effects Quality Render Using σας επιτρέπει να 
παρακάμψετε την επιλογή που κάνατε στο Effect Editor για 
μεμονωμένα εφέ. 
Μπορείτε εύκολα να αλλάξετε από Standard rendering σε HQ rendering 
για ολόκληρη την ακολουθία σας, μέχρις ότου να είστε ικανοποιημένοι 
με το προσχέδιο σας, χρησιμοποιώντας τις επιλογές Render Settings. 
Μπορείτε επίσης να επιλέξετε να ορίσετε σε όλα τα εφέ rendering to 
standard αν θέλετε να μειώσετε το χρόνο του rendering. 
 
Μόλις η εφαρμογή ξεκινήσει το rendering,αλλάζει όλες τις 
επηρεασμένες HQ ρυθμίσεις στο Effects Quality Render Using τιμή στην 
ενεργή ρύθμιση Render. Αν ακυρώσετε το render, οι ρυθμίσεις HQ για 
μεμονωμένα εφέ δεν επανέρχονται στις αρχικές τους τιμές. 
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Κεφάλαιο 12 

Διόρθωση χρωμάτων 

Η Avid εφαρμογή σας, περιέχει το Avid Color Correction, ένα εκτενές 
σύνολο από εργαλεία για τη διόρθωση και ρύθμιση των χρωμάτων. 

Το Avid Color Correction σας επιτρέπει να ρυθμίσετε τα χρωματικά 
χαρακτηριστικά του βίντεο υλικού που έχει επεξεργαστεί σε μια 
ακολουθία. Μπορείτε να διορθώσετε ένα τμήμα ή να διορθώσετε 
πολλά τμήματα ταυτόχρονα. Η διόρθωση χρωμάτων, όπως τα εφέ, δεν 
παραμορφώνουν τα αρχικά κλιπ σας με οποιοδήποτε τρόπο. Μπορείτε 
να τροποποιήσετε ή να αφαιρέσετε τις διορθώσεις χρωμάτων ανά πάσα 
στιγμή. Αν διορθώνετε ένα τμήμα σε μια ακολουθία, αυτή η διόρθωση 
δεν επηρεάζει το ίδιο βίντεο υλικό σε οποιαδήποτε άλλη  ακολουθία. 

Μπορείτε να κάνετε τις περισσότερες χρωματικές διορθώσεις 
εισέρχοντας στο Color Correction Mode και ρυθμίζοντας τα κουμπιά 
ελέγχου από το εργαλείο Color Correction. Κάθε κουμπί ελέγχου 
επηρεάζει μια συγκεκριμένη πτυχή του χρώματος σε μια εικόνα (για 
παράδειγμα, saturation) οπότε αυτά τα κουμπιά ελέγχου είναι σαν τα 
κουμπιά παραμέτρων για τα εφέ στο Effect Editor. Κάποια κουμπιά 
ελέγχου της διόρθωσης χρωμάτων μοιάζουν πολύ με αυτά των 
παραμέτρων για τα εφέ, ενώ άλλα έχουν μια πιο εξειδικευμένη 
εμφάνιση κατάλληλη για την ακριβή ρύθμιση του χρώματος. 

Μπορείτε επίσης να εκτελέσετε κάποια είδη χρωματικών διορθώσεων, 
εφαρμόζοντας το Color Correction εφέ από την κατηγορία Image της 
παλέτας των εφέ. 

Μπορείτε να κάνετε είτε αυτόματες είτε χειροκίνητες διορθώσεις 
χρωμάτων. Οι αυτόματες διορθώσεις είναι απλούστερες στη χρήση, 
διότι το Avid Color Correction υπολογίζει και κάνει τις απαραίτητες 
ρυθμίσεις για να διορθώσει το πρόβλημα σε κάποια εικόνα για σας. Οι 
χειροκίνητες διορθώσεις απαιτούν να έχετε μια πιο λεπτομερή 
κατανόηση των ελέγχων διόρθωσης χρώματος, αλλά επιτρέπουν 
μεγαλύτερη ακρίβεια και δημιουργικότητα. 
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Μόλις κάνετε τις χρωματικές διορθώσεις σας, μπορείτε να τις 
αναπαράγετε σε πραγματικό χρόνο στο Composer μόνιτορ ή σε ένα 
Client μόνιτορ,  που υπόκεινται στους ίδιους περιορισμούς 
αναπαραγωγής σε  πραγματικό χρόνο που επηρεάζουν την 
αναπαραγωγή των άλλων εφέ στο σύστημά σας. 

Ανάλογα με το μοντέλο της εφαρμογής επεξεργασίας Avid σας , την 
διαμόρφωση του hardware και την πολυπλοκότητα της ακολουθίας, 
ίσως να χρειαστεί να κάνετε render τουλάχιστον μερικές από τις 
χρωματικές διορθώσεις πριν εξάγετε την ακολουθία σας ή εκτελέσετε 
μια ψηφιακή περικοπή. 

Επίσης, το Avid Color Correction σας επιτρέπει να ορίσετε όρια 
ασφαλείας για τα χαρακτηριστικά χρωμάτων, για παράδειγμα να 
διασφαλιστεί ότι τα χρώματα στο πρόγραμμά σας πληρούν το πρότυπο 
ενός συγκεκριμένου ραδιοτηλεοπτικού φορέα για μετάδοση. Το 
σύστημά σας εμφανίζει προειδοποιήσεις όταν οι εικόνες σας 
υπερβαίνουν αυτά τα όρια και μπορείτε να κάνετε διορθώσεις για να 
λυθεί το πρόβλημα. 

12.1 Λόγοι πραγμάτωσης Χρωματικής διόρθωσης 

Για να μπορέσετε να κάνετε καλές χρωματικές διορθώσεις, θα πρέπει 
να έχετε μια ιδέα για το τι χρωματικά προβλήματα υπάρχουν στο βίντεο 
υλικό σας ή μια αίσθηση του γιατί θέλετε να αλλάξετε τις υπάρχουσες 
τιμές χρωμάτων. 

Τα δύο πιο κοινά προβλήματα χρώματος σε μια δεδομένη εικόνα είναι 
τα εξής: 

· Κακή αντίθεση (ή η έλλειψη ενός πλήρους φάσματος των τόνων). 
Για παράδειγμα, τμήματα της εικόνας που πρέπει να είναι μαύρο 
είναι μόνο σκούρο γκρι. Αν μια εικόνα δεν έχει ένα καλό φάσμα 
τόνων, οι λεπτομέρειες δεν ξεχωρίζουν έντονα. 

· Κακή ισορροπία των χρωμάτων (ή μια χρωματική απόκλιση). Για 
παράδειγμα, τμήματα της εικόνας που θα έπρεπε να είναι καθαρό 
λευκό είναι αντί αυτού ροζ ή τα μέρη που θα έπρεπε να είναι 
καθαρό γαλάζιο είναι αντί αυτού πρασινωπό-μπλε. 
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Οι αυτόματοι έλεγχοι διόρθωσης του Avid Color Correction έχουν 

σχεδιαστεί ειδικά για να διορθώνουν αυτά τα δύο προβλήματα. 
 
Εκτός από τη διόρθωση για αυτά τα δύο προβλήματα, άλλοι δύο 
βασικοί λόγοι για να μεταβάλλετε τις τιμές χρωμάτων στο βίντεο υλικό 
σας είναι: 

· Για να κάνετε τα χαρακτηριστικά χρωμάτων των γειτονικών 
τμημάτων ταιριαστά στην ακολουθία. Για παράδειγμα, τα γειτονικά 
τμήματα σε μια ακολουθία μπορεί να έχουν γυριστεί υπό ελαφρώς 
διαφορετικές συνθήκες φωτισμού, ή με τη χρήση δύο καμερών με 
διαφορετικές ρυθμίσεις ισορροπίας χρωμάτων. 

· Για να επιτευχθεί ένα συγκεκριμένο καλλιτεχνικό ή συντακτικό εφέ. 
Για παράδειγμα, ίσως να θέλετε να αυξήσετε ελαφρώς ή να 
μειώσετε μια ολόκληρη ακολουθία, ή να αυξήσετε τον κορεσμό για 
να κάνετε μια σκηνή να φαίνεται θερμότερη, ή να μεταβάλλετε την 
ισορροπία των χρωμάτων για να την κάνετε να φαίνεται σαν μια 
σκηνή που φωτίζεται από το απογευματινό φως του ήλιου. 

 

12.2 Color Correction Mode 

Αυτή η ενότητα, περιγράφει πώς να εισέρχεσθε και να εξέρχεσθε από 
το Color Correction mode και παρέχει βασικές επεξηγήσεις για το 
προεπιλεγμένο Color Correction mode interface. 

12.2.1 Είσοδος και έξοδος στο Color Correction mode 

Για να εισέλθετε στο Color Correction mode, κάντε ένα από τα 
παρακάτω: 

Ø Από το μενού της εφαρμογής επιλέξτε Toolsets > Color Correction. 
Ø Από το πληκτρολόγιο πατήστε Shift + F8. 
Ø Κάντε κλικ στο κουμπί Color Correction mode. 
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Εικόνα 12.2.1 Το Color Correction Mode 

Για να εξέλθετε από το Color Correction mode, κάντε ένα από τα 
παρακάτω: 

Ø Επιλέξτε άλλο toolset από το Toolset μενού που βρίσκεται στο 
μενού της εφαρμογής. 

Ø Χρησιμοποιήστε συντόμευση του πληκτρολογίου για άλλο toolset. 
Ø Πατήστε σε mode διαφορετικό από το Color Correction. 

12.2.2 Κατανόηση των μόνιτορ του Color Correction mode 

Στο Color Correction mode, το παράθυρο του Composer περιέχει τρία 
μόνιτορ. Από προεπιλογή, το κεντρικό μόνιτορ απεικονίζει το καρέ στο 
οποίο βρίσκεται ο δείκτης θέσης. Το αριστερό μόνιτορ απεικονίζει το 
προηγούμενο τμήμα από το σημείο που βρίσκεται ο δείκτης θέσης και 
το δεξί μόνιτορ απεικονίζει το επόμενο τμήμα από το σημείο που 
βρίσκεται ο δείκτης θέσης. Αυτή η διαρρύθμιση σας επιτρέπει να 
συγκρίνετε τα χρωματικά χαρακτηριστικά από τα διπλανά πλάνα στην 
ακολουθία σας. 
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Όταν μετακινείτε τον δείκτη θέσης σε άλλο τμήμα στο Timeline, 
αυτόματα ενημερώνονται και τα τρία μόνιτορ ώστε να σας 
απεικονίσουν τη νέα διαρρύθμιση των προηγούμενων, τρεχόντων και 
επόμενων πλάνων.  

Στις περισσότερες περιπτώσεις, τα μόνιτορ του παραθύρου Composer 
στο Color Correction mode λειτουργούν όπως και οι άλλες οθόνες στην 
εφαρμογή επεξεργασίας σας. Για παράδειγμα, λειτουργίες όπως 
ενεργοποίηση των οθονών, εμφάνιση και απόκρυψη του βίντεο, 
εμφάνιση πληροφοριών του Timecode και χρήση της γραμμής θέσης 
είναι τα ίδια. 

 
Εικόνα 12.2.2 Το Composer στο Color Correction Mode 

12.2.3 Τα κουμπιά του Composer στο Color Correction Mode 

Ορισμένα από τα κουμπιά κάτω από τα μόνιτορ του παραθύρου του 
Composer, έχουν στο Color Correction mode τις ίδιες λειτουργίες όπως 
και σε άλλα mode της εφαρμογής. Μερικά κουμπιά εκτελούν 
λειτουργίες ειδικά για τη διόρθωση χρωμάτων, όπως παρακάτω: 

 

Κουμπί Ονομασία Λειτουργία 

 

Μετάβαση στο 
προηγούμενο μη 
διορθωμένο πλάνο και 
μετάβαση στο επόμενο μη 
διορθωμένο πλάνο. 

Μετακίνηση στο 
προηγούμενο ή 
επόμενο τμήμα 
στο ενεργό track, 
στο οποίο δεν 
έχει εφαρμοστεί 
διόρθωση 
χρωμάτων. 
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 Αφαίρεση του εφέ 

Αφαίρεση της 
διόρθωσης 
χρωμάτων από το 
τρέχων τμήμα. 

 
Διάσπαση του μόνιτορ σε 
δύο  

Διαχωρίζει το 
μόνιτορ σε δύο 
μόνιτορ και 
απεικονίζει την 
εικόνα με και 
χωρίς τη 
χρωματική 
διόρθωση. 
Απενεργοποίηση 
του διαχωρισμού. 

 

12.2.4 Το Client μόνιτορ στο Color Correction mode 

Αν έχετε ένα Client μόνιτορ συνδεδεμένο στην εφαρμογή επεξεργασίας 
Avid σας, μπορείτε να δείτε τις διορθώσεις σας στο Client μόνιτορ. Στις 
περισσότερες εφαρμογές επεξεργασίας Avid, η διπλή διάσπαση της 
οθόνης εμφανίζεται επίσης στο Client μόνιτορ όταν έχετε επιλεγμένο το  
Dual Split για το τρέχων μόνιτορ στο παράθυρο του Composer. 

Είναι μια καλή ιδέα να χρησιμοποιείτε ένα Client μόνιτορ για να 
βλέπετε την εργασία διόρθωσης χρωμάτων σας, επειδή ένα Client 
μόνιτορ εμφανίζει τα χρώματα βίντεο με μεγαλύτερη ακρίβεια από ό, τι 
η οθόνη του υπολογιστή σας. 

12.2.5 Τα βασικά του εργαλείου Color Correction 

Τα στοιχεία ελέγχου του εργαλείου Color Correction είναι οργανωμένα 
σε καρτέλες. Η προεπιλεγμένη οθόνη δείχνει τα στοιχεία ελέγχου της 
καρτέλας Hue Offsets εντός της καρτέλας HSL (Hue, Saturation, 
Luminance). Τα κουμπιά ελέγχου στην καρτέλα αυτή παρέχουν ένα 
σύνολο εργαλείων για να διορθώσετε τα προβλήματα αντίθεσης και 
ισορροπίας χρώματος. 
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Οι δυο άλλες διαθέσιμες καρτέλες (η καρτέλα Control εντός της 
καρτέλας HSL και η καρτέλα Curves) παρέχουν επιπλέον σύνολα από 
κουμπιά ελέγχου. 

 
Εικόνα 12.2.3 Τα βασικά του εργαλείου Color Correction - Καρτέλα HSL 

12.3 Πραγματοποίηση βασικής Διόρθωσης Χρωμάτων 

Αυτή η ενότητα περιγράφει πώς να κάνετε τρεις από τις πιο χρήσιμες 
βασικές χρωματικές διορθώσεις: 

· Διορθώσεις  που να διορθώνουν αυτόματα την αντίθεση και τη 
χρωματική ισορροπία σε οποιοδήποτε αριθμό των στιγμιότυπων, 
πραγματοποιούνται με την εφαρμογή του Color Correction εφέ από 
την παλέτα Effect.  

· Πλήρως αυτόματη διόρθωση χρωμάτων, για να διορθώσει την 
αντίθεση και την ισορροπία των χρωμάτων, πραγματοποιούνται 
στην καρτέλα Hue Offsets στο εργαλείο Color Correction. 

· Διορθώσεις για να ταιριάξουν τα χρωματικά χαρακτηριστικά μεταξύ 
δυο στιγμιότυπων, πραγματοποιούνται στην καρτέλα Curves του 
εργαλείου Color Correction. 

 
Κάνοντας μία ή περισσότερες από αυτές τις διορθώσεις, μπορείτε να 
λύσετε με επιτυχία τα προβλήματα με την αντίθεση και την ισορροπία 
χρώματος, αλλά και να ταιριάξετε το χρώμα από το ένα πλάνο στο άλλο, 
για το περισσότερο βίντεο υλικό. 
 
12.3.1 Διόρθωση χρωμάτων αυτόματα με χρήση του Color 
Correction εφέ. 
Μπορείτε να χρησιμοποιήσετε το εφέ Color Correction από την παλέτα 
Effect, για να εφαρμόσετε μέχρι τρείς αυτόματες διορθώσεις 
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ταυτόχρονα απλά εφαρμόζοντας το εφέ στα επιλεγμένα τμήματα 
ακριβώς όπως κάθε άλλο Avid εφέ. 
Επειδή δεν χρειάζεται να χρησιμοποιήσετε οποιοδήποτε κουμπί 
ελέγχου από το εργαλείο Color Correction ή ακόμα και να εισέλθετε στο 
Color Correction mode, αυτός είναι ο απλούστερος τρόπος για να 
διορθώσετε βασικά χρωματικά προβλήματα σε οποιοδήποτε ή σε όλα 
τα τμήματα στην ακολουθία σας.  
Εσείς ορίζετε ποιες αυτόματες διορθώσεις χρώματος θα κάνει η 
εφαρμογή ορίζοντας τις επιλογές στην καρτέλα AutoCorrect του 
παραθύρου διαλόγου Correction Settings. Μια κοινή ρύθμιση η οποία 
συχνά διορθώνει τα περισσότερα βασικά χρωματικά προβλήματα 
εφαρμόζει δυο αυτόματες διορθώσεις, μια για να διορθώσει την 
αντίθεση και μια για να διορθώσει τη χρωματική ισορροπία. Η 
διαδικασία σε αυτήν την ενότητα περιγράφει πώς να ρυθμίσετε αυτήν 
τη ρύθμιση.  
Για να ορίσετε τις βασικές AutoCorrect επιλογές: 

1. Κάντε ένα από τα παρακάτω: 
Ø Από την καρτέλα Settings του παραθύρου Project, κάντε διπλό κλικ 

στην επιλογή Correction. 
Ø Στο παράθυρο Color Correction, κάντε κλικ στο κουμπί Correction 

Mode Settings . 
2. Κάντε κλικ στην καρτέλα AutoCorrect. 

 
Εικόνα 12.3.1 Το παράθυρο Correction Mode Settings - Καρτέλα AutoCorrect 
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3. Κάντε κλικ στο μενού First Correction και επιλέξτε HSL Auto 
Contrast. 

4. Κάντε κλικ στο μενού Second Correction και επιλέξτε HSL Auto 
Balance. 

5. Βεβαιωθείτε ότι το μενού Third Correction είναι ρυθμισμένο στο 
Nothing. 

Για να διορθώσετε μεμονωμένο τμήμα με το εφέ Color Correction: 
1. Στην κατάσταση επεξεργασίας, Effect mode ή Color Correction 

mode, κάντε κλικ στην καρτέλα Effect στο παράθυρο του Project. 
2. Από την παλέτα Effect, κάντε κλικ στην κατηγορία Image. 
3. Κάντε κλικ στο εικονίδιο Color Correction Effect και σύρετε το στο 

τμήμα στο Timeline στο οποίο θέλετε να εφαρμόσετε διορθώσεις. 
Για να διορθώσετε πολλαπλά τμήματα με το Color Correction εφέ: 

1. Στην κατάσταση επεξεργασίας ή Effect mode, επιλέξτε τα τμήματα 
στο Timeline που θέλετε να διορθώσετε. 

2. Κάντε κλικ στην καρτέλα Effect στο παράθυρο Project. 
3. Από την παλέτα Effect, κάντε κλικ στην κατηγορία Image. 
4. Κάντε διπλό κλικ στο εικονίδιο Color Correction Effect. 

 
12.3.2 Διόρθωση χρωμάτων αυτόματα στην καρτέλα Hue 
Offsets 
Μπορείτε να χρησιμοποιήσετε τα κουμπιά Automatic Color Correction 
στην καρτέλα Hue Offsets για να διορθώσετε τα προβλήματα αντίθεσης 
και ισορροπίας σε όλο το εύρος φωτεινότητας της εικόνας. 
Για να κάνετε αυτόματη χρωματική διόρθωση από την καρτέλα Hue 
Offsets: 

1. Εισέλθετε στο Color Correction mode, επιλέγοντας από το μενού της 
εφαρμογής Toolset > Color Correction. 

2. Στο Timeline, βεβαιωθείτε ότι το κουμπί Record Track για το βίντεο 
track στο οποίο θέλετε να κάνετε διορθώσεις είναι το ανώτατα 
επιλεγμένο track. 

3. Στο Timeline ή στο παράθυρο του Composer, μεταβείτε στο τμήμα 
που θέλετε να διορθώσετε. 
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4. Στην καρτέλα Hue Offset του εργαλείου Color Correction, κάντε κλικ 
σε ένα από τα κουμπιά Automatic Color Correction, όπως 
περιγράφεται στον παρακάτω πίνακα. 

Κουμπί Ονομασία Περιγραφή 

 Auto Balance 

Ισορροπεί τα χρώματα στην 
εικόνα (εξαλείφοντας κάθε 
χρωματική απόκλιση για τις 
περισσότερες εικόνες). 
Ρυθμίζει και τα τρία κουμπιά 
ελέγχου ChromaWheel.  

 Auto Black 

Κάνει τις πιο σκοτεινές 
περιοχές της εικόνας όσο το 
δυνατόν πιο σκοτεινές. 
Ρυθμίζει το ρυθμιστικό 
κύλισης Setup. 

 Auto White 

Κάνει τις πιο φωτεινές 
περιοχές της εικόνας όσο το 
δυνατόν πιο φωτεινές. 
Ρυθμίζει το ρυθμιστικό 
κύλισης Gain. 

 Auto Contrast 

Μεγιστοποιεί το τονικό 
εύρος της εικόνας, κάνοντας 
τις πιο φωτεινές περιοχές 
της εικόνας όσο το δυνατόν 
πιο φωτεινές και τις πιο 
σκοτεινές περιοχές της 
εικόνας όσο το δυνατόν πιο 
σκοτεινές. Ρυθμίζει τα 
ρυθμιστικά κύλισης Gain και 
Setup. 

 

12.3.3 Color Match Corrections στην καρτέλα Curves 

Το στοιχείο ελέγχου Color Match, το οποίο είναι διαθέσιμο σε κάθε 
καρτέλα του εργαλείου Color Correction σας επιτρέπει να ταιριάζετε τα 
χρώματα μεταξύ δυο στιγμιότυπων επιλέγοντας χρώματα με το 
σταγονόμετρο. 
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Αυτή η ενότητα περιγράφει πώς να κάνετε ένα συγκεκριμένο είδος color 
match correction για τα διπλανά στιγμιότυπα στην καρτέλα Curves του 
εργαλείου Color Correction. Σε αυτή την καρτέλα, ένα ειδικό 
χαρακτηριστικό του color match control λέγεται NaturalMatch  και σας 
επιτρέπει να αλλάξετε τα χρώματα σε μια εικόνα, διατηρώντας 
παράλληλα τις ιδιότητες κορεσμού και φωτεινότητας της εικόνας. 

 
Εικόνα 12.3.2 Τα βασικά του εργαλείου Color Correction - Καρτέλα Curves 

Για να κάνετε Color Match correction με NaturalMatch στα διπλανά 
στιγμιότυπα: 

1. Εισέλθετε στο Color Correction Mode. 
2. Στο Timeline, βεβαιωθείτε ότι το κουμπί Record Track για το βίντεο 

track στο οποίο θέλετε να κάνετε διορθώσεις είναι το ανώτατα 
επιλεγμένο track. 

3. Στο Timeline ή στο παράθυρο του Composer, μεταβείτε στο τμήμα 
που θέλετε να διορθώσετε. 
Το διπλανό στιγμιότυπο που θέλετε να ταιριάξετε είναι ορατό είτε 
ως Προηγούμενο είτε ως Επόμενο στιγμιότυπο στο παράθυρο του 
Composer. 

4. Στο εργαλείο Color Correction, κάντε κλικ στην καρτέλα Curves. 
5. Αν το κουμπί Match Type δεν είναι ορισμένο στο R+G+B, κάντε κλικ 

στο κουμπί Match Type και επιλέξτε R+G+B. 
6. Κάντε κλικ στο κουμπί Match Type και επιλέξτε NaturalMatch. 
7. Επιλέξτε το χρώμα εισόδου (το χρώμα με το οποίο θα αλλαχθεί): 
α. Μετακινήστε το δείκτη του ποντικιού πάνω από την είσοδο 

(αριστερά) του χρωματολογίου. 
β. Πατήστε και κρατήστε πατημένο το κουμπί του ποντικιού και στη 

συνέχεια, σύρετε το σταγονόμετρο στην περιοχή της εικόνας, στην 
οθόνη από την οποία θέλετε να επιλέξετε μια τιμή εισόδου. 
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γ. Απελευθερώστε το κουμπί του ποντικιού για να ολοκληρωθεί η 
επιλογή. 

8. Επιλέξτε το χρώμα εξόδου (το καλό χρώμα που θέλετε να 
χρησιμοποιήσετε ως σημείο αναφοράς για το ταίριασμα): 

α. Μετακινήστε το δείκτη του ποντικιού πάνω από την έξοδο (δεξιά) 
του χρωματολογίου. 

β. Πατήστε και κρατήστε πατημένο το κουμπί του ποντικιού και στη 
συνέχεια, σύρετε το σταγονόμετρο στην περιοχή της εικόνας, στην 
οθόνη από την οποία θέλετε να επιλέξετε μια τιμή εξόδου. 

γ. Απελευθερώστε το κουμπί του ποντικιού για να ολοκληρωθεί η 
επιλογή. 

9. Κάντε κλικ στο κουμπί Match Color. 
 
12.4 Ασφαλή χρώματα 
Το Color Correction της Avid μπορεί να σας προειδοποιήσει όταν οι 
τιμές φωτεινότητας, η γκάμα χρωμάτων RGB ή το σύνθετο φάσμα του 
σήματος της εικόνας στην ακολουθία σας πέφτει έξω από μια περιοχή 
που καθορίζετε. 
Τυπικά, αυτό είναι χρήσιμο για να διασφαλιστεί ότι η ακολουθία σας 
μένει μέσα σε ένα εύρος τιμών οι οποίες είναι αποδεκτές για μετάδοση 
ή για επιπλέον επεξεργασία, όπως κωδικοποίηση DVD, ή γενικότερα για 
να εξασφαλιστεί ότι τα χρώματα εμφανίζονται καλά στις τηλεοπτικές 
οθόνες. 

12.4.1 Διαχείριση των προειδοποιήσεων των Safe Color 

Μπορείτε να ενεργοποιήσετε ή να απενεργοποιήσετε την 
προειδοποίηση για τα ασφαλή χρώματα και να ορίσετε το εύρος των 
τιμών που θα πρέπει το Avid Color Correction να θεωρεί ασφαλή, στο 
παράθυρο διαλόγου Safe Color Settings. 
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Εικόνα 12.4.1 Το παράθυρο διαλόγου Safe Color Settings 

Για να ανοίξετε το παράθυρο διαλόγου Safe Color Settings, κάντε ένα 
από τα παρακάτω: 

Ø Από τη λίστα Settings του παραθύρου Project, κάντε διπλό κλικ στην 
επιλογή Safe Colors. 

Ø Από το εργαλείο Color Correction, κάντε κλικ στο κουμπί Safe Color 
Settings . 

Για να ενεργοποιήσετε ή να απενεργοποιήσετε την προειδοποίηση για 
τα ασφαλή χρώματα: 
Ø Κάντε κλικ σε ένα από τα κουμπιά Actions στο παράθυρο διαλόγου 

Safe Color Settings και επιλέξτε Warn για να ενεργοποιήσετε την 
προειδοποίηση για τα ασφαλή χρώματα ή Ignore για να 
απενεργοποιήσετε την προειδοποίηση για τα ασφαλή χρώματα. 
Τα κουμπιά Actions στο πάνω μέρος ελέγχουν τις προειδοποιήσεις 
για Composite και Luminance, τα κουμπιά Actions στο κάτω μέρος 
ελέγχουν τις προειδοποιήσεις για γκάμα RGB. 

Για να ορίσετε ένα ασφαλές εύρος τιμών για το χρώμα για έναν από 
τους τύπους τιμών (Composite, Luminance ή γκάμα RGB): 

1. Κάντε κλικ στο κουμπί Units για τον τύπο τιμών που θέλετε να 
ορίσετε στο παράθυρο διαλόγου Safe Color Settings και επιλέξτε μια 
μονάδα μέτρησης για τις τιμές σας. 

2. Πληκτρολογήστε χαμηλές και υψηλές τιμές στα πλαίσια κειμένου 
για τους τύπους τιμών. 
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12.4.2 Προειδοποιήσεις Safe Color στο παράθυρο Composer 

Όταν το Avid Color Correction είναι ορισμένο στο να παρέχει 
προειδοποιήσεις για τα ασφαλή χρώματα, πληροφορίες 
προειδοποίησης εμφανίζονται στο παράθυρο του Composer μόνιτορ 
για οποιαδήποτε εικόνα των οποίων οι τιμές χρώματος είναι έξω από το 
ασφαλές εύρος. Μπορείτε να δείτε ένα πορτοκαλί τρίγωνο στην πάνω 
αριστερή γωνία της εικόνας που θα προειδοποιεί για τα ασφαλή 
χρώματα, μαζί με τις προειδοποιητικές ενδείξεις για κάθε τύπο τιμών 
για τα ασφαλή χρώματα που είναι ορισμένα στο Warn αυτή τη στιγμή. 
Προειδοποιητικές χρωματιστές γραμμές εμφανίζονται σε ένα από 
τρία σημεία σε στήλη: 

· At the top (Στην κορυφή, υποδεικνύοντας ένα επίπεδο που είναι 
πολύ υψηλό) 

· At the bottom (Στο κάτω μέρος, υποδεικνύοντας ένα επίπεδο που 
είναι πολύ χαμηλό) 

· In the center (Στο κέντρο, υποδεικνύοντας ένα επίπεδο που είναι 
μεταξύ των ορίων) 

Αν μια προειδοποιητική ένδειξη εμφανιστεί στην οθόνη για μια εικόνα, 
μπορείτε να επιλέξετε να αφήσετε την εικόνα με τιμές χρωμάτων που 
υπερβαίνουν τα ασφαλή όρια σας, ή μπορείτε να κάνετε μία ή 
περισσότερες χρωματικές διορθώσεις για να επιστρέψετε τα επίπεδα 
εντός των ασφαλών ορίων. Άπαξ και βρίσκονται όλα τα επίπεδα μέσα 
στα ασφαλή όρια, το προειδοποιητικό τρίγωνο και οι προειδοποιητικές 
ενδείξεις δεν εμφανίζονται πια στο μόνιτορ. 
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Κεφάλαιο 13 

Δουλεύοντας με τον ήχο 

Μπορείτε να επεξεργαστείτε τον ήχο με πολλές από τις τεχνικές που 
χρησιμοποιείτε για να επεξεργαστείτε το βίντεο, συμπεριλαμβανομένου 
τις λειτουργίες του Segment mode και του Trim mode. Το Avid σύστημα 
σας, σας παρέχει μερικά μοναδικά χαρακτηριστικά που διευκολύνουν 
την επεξεργασία ήχου, όπως είναι το audio scrub, η εμφάνιση της 
κυματομορφής και τα εργαλεία για τη ρύθμιση και τη μίξη των ηχητικών 
επιπέδων, καθώς και την ισορροπία μεταξύ των δύο ηχείων. Επιπλέον 
μπορείτε να χρησιμοποιήσετε το εργαλείο Audio Equalization (EQ), για 
να ρυθμίσετε τις ψηλές, τις χαμηλές και τις μεσαίες συχνότητες των 
τμημάτων. 

13.1 Γνωριμία με τα εργαλεία ήχου 

Το σύστημα Avid, σας παρέχει μια σειρά από εργαλεία για τη διαχείριση 
και τον συντονισμό της έντασης του ήχου, την ισορρόπηση, την 
ισοστάθμιση και την μετάβαση. Τα εργαλεία αυτά είναι τα εξής: 

· Audio tool: Χρησιμοποιείστε αυτό το εργαλείο για να 
παρακολουθείτε τα εισερχόμενα και εξερχόμενα επίπεδα του ήχου 
κατά τη διάρκεια της καταγραφής από αναλογική πηγή ή κατά την 
εξαγωγή σε βιντεοκασέτα. 

 
Εικόνα 13.1.1 Το εργαλείο Audio Tool 
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· Audio Mixer tool: Χρησιμοποιείστε αυτό το εργαλείο για να 
ρυθμίσετε τις ισορροπίες και τις εντάσεις του ήχου στα κλιπ ή σε 
ολόκληρα track στην ακολουθία. 

 
Εικόνα 13.1.2 Το εργαλείο Audio Mixer 
 

· Audio EQ tool: Χρησιμοποιείστε αυτό το εργαλείο για να ρυθμίσετε 
τα χαρακτηριστικά των ηχητικών κλιπ μέσα στην ακολουθία 
βασισμένο στον έλεγχο τριών περιοχών, δηλαδή των ψηλών, των 
μεσαίων και χαμηλών συχνοτήτων. 

 
Εικόνα 13.1.3 Το εργαλείο Audio EQ 
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· Audio Suite Plug-In tool: Χρησιμοποιείστε αυτό το εργαλείο για να 
αποκτήσετε πρόσβαση σε εξωτερικά ηχητικά Plug-In. 

 
Εικόνα 13.1.4 Το εργαλείο Audio Suite 

 
· Audio Punch-In tool: Χρησιμοποιείστε αυτό το εργαλείο για να 

καταγράψετε μέχρι και δύο κανάλια του ήχου απευθείας στο 
Timeline για φωνητική αφήγηση. 

 
Εικόνα 13.1.5 Το εργαλείο Audio Punch-In 
 

13.2 Πρόσβαση στα Audio Effect Tools 
Μπορείτε να αποκτήσετε πρόσβαση στα παρακάτω εργαλεία από 
οποιοδήποτε audio effect tools: 

· Audio Mixer (για ρύθμιση της ισορροπίας και της έντασης) 
· Audio Suite 
· Audio EQ 

 
Για να αποκτήσετε πρόσβαση σε ένα από τα Audio effect tools: 
Ø Από το μενού της εφαρμογής επιλέξτε Tools > και το εργαλείο που 

επιθυμείτε. 
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Για να αλλάξετε εργαλείο: 
Ø Κάντε κλικ στο μενού Effect Mode Selector και επιλέξτε το νέο 

εργαλείο. 
Για να διατηρήσετε ανοιχτά, παραπάνω εργαλεία από ένα 
ταυτόχρονα: 
Ø Επιλέξτε το εργαλείο από το μενού Tools ή πατήστε και κρατήστε το 

πλήκτρο Alt ενώ επιλέγετε τα νέα εργαλεία από το μενού Effect 
Mode Selector. 
 

13.3 Βοηθήματα της επεξεργασίας ήχου 
Το σύστημα Avid, σας παρέχει την απομόνωση του Audio track, τις 
audio scrub λειτουργίες, τα pan defaults και τα waveform plots ειδικά 
σχεδιασμένα για την ακριβή καρέ παρακολούθηση, τη σημείωση και 
την επεξεργασία του ήχου. Μπορείτε να χρησιμοποιείτε αυτές τις 
λειτουργίες οποιαδήποτε στιγμή κατά τη διάρκεια επεξεργασίας ή 
καθώς κάνετε ρυθμίσεις με τα audio tools. 
Οι παρακάτω ενότητες παρέχουν περισσότερες πληροφορίες για τα 
βοηθήματα της επεξεργασίας ήχου: 
13.3.1 Απομόνωση των audio track στο Timeline 
Μπορείτε να απομονώσετε πολλαπλά track στο Timeline. Αυτή η 
λειτουργία σας επιτρέπει να: 

· Ακούσετε μερικά track ταυτόχρονα χωρίς να χρειάζεται να 
απενεργοποιήσετε τα άλλα audio track. 

· Απομονώσετε audio tracks για audio scrubbing χωρίς να χρειάζεται 
να αποεπιλέξετε την παρακολούθηση από όλα τα άλλα track. 

Για να απομονώσετε ένα audio track: 
Ø Κρατήστε πατημένο το πλήκτρο Ctrl από το πληκτρολόγιο και κάντε 

κλικ στο εικονίδιο του audio track με το ηχείο  για το track που 
θέλετε να απομονώσετε. 

Το εικονίδιο του audio track αλλάζει σε πράσινο χρώμα . 
Για να απενεργοποιήσετε την απομόνωση του track: 
Ø Κάντε κλικ στο εικονίδιο του audio track με το ηχείο. 
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Για να απενεργοποιήσετε την απομόνωση σε όλα τα track: 
Ø Κρατήστε πατημένα τα πλήκτρα Ctrl και Alt από το πληκτρολόγιο και 

κάντε κλικ στο εικονίδιο του audio track με το ηχείο σε κάποιο από 
τα track. 

 
13.3.2 Ρυθμίζοντας το Pan Defaults 
Ο τρόπος που το υλικό σας έχει καταγραφεί με τη κάμερα και ύστερα με 
την εφαρμογή Avid σας, επηρεάζει τον τρόπο που ο ήχος ισορροπεί 
μεταξύ των ηχείων. Από προεπιλογή, το σύστημα ισορροπεί τα audio 
track 1 και 3 στο αριστερό ηχείο και τα audio track 2 και 4 στο δεξιό 
ηχείο. 
Μπορείτε να αλλάξετε τις προεπιλεγμένες γενικές ρυθμίσεις της 
ισορροπίας πριν ή κατά τη διάρκεια της επεξεργασίας, 
χρησιμοποιώντας το παράθυρο Audio Settings και επιλέγοντας το All 
Tracks Centered. Το παράθυρο Audio Settings, παρέχει επίσης επιλογές 
για τη ρύθμιση του default audio pan όταν κάνετε επεξεργασία με νέα 
κλιπ και για τη ρύθμιση των παραμέτρων του ψηφιακού audio scrub για 
την παρακολούθηση και ανάλυση των audio track και των μεταβάσεων. 
Για να ανοίξετε το παράθυρο Audio Settings: 

1. Κάντε κλικ στην καρτέλα Settings στο παράθυρο του Project. 
Εμφανίζεται η λίστα Settings. 

2. Κάντε διπλό κλικ στην επιλογή Audio. 
Ανοίγει το παράθυρο Audio Settings. 

 
Εικόνα 13.3.1 Το παράθυρο Audio Settings 

 
Η επιλογή All Tracks Centered καθοδηγεί το σύστημα ώστε να κεντράρει 
την ισορροπία όλων των track μεταξύ των δύο ηχείων για την 
παρακολούθηση και την εξαγωγή. 
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13.3.3 Εμφάνιση του γραφήματος της κυματομορφής. 
Μπορείτε να χρησιμοποιείτε το γράφημα της κυματομορφής ώστε να 
σας βοηθήσει οπτικά να εντοπίζετε σημεία σε κάποιο audio track για 
επεξεργασία ή trimming. 
Για να εμφανίσετε το γράφημα της κυματομορφής: 

1. Αν ψάχνετε για ένα σημείο σε συγκεκριμένο τμήμα στο track, 
μεγεθύνετε και δείξτε περισσότερη λεπτομέρεια στην ακολουθία 
για να απομονώσετε το τμήμα του ήχου. 

2. Κάντε κλικ στο Fast Menu του Timeline και επιλέξτε Sample Plot. 
Το sample plot εμφανίζει ολόκληρο το πλάτος της κυματομορφής 
του ήχου. Αυτό είναι το ίδιο με τις τιμές της τάσης του δείγματος 
που θα βλέπατε σε κυματομορφή αναλογικού παλμοσκόπιου.  

3. Μαρκάρετε IN και OUT σημεία στο Composer μόνιτορ για το τμήμα 
που θέλετε να εμφανίσετε. 
Μαρκάρετε μόνο την περιοχή με την οποία θέλετε να δουλέψετε, 
διότι όσο πιο μεγάλη είναι η μαρκαρισμένη περιοχή, τόσο 
περισσότερο χρόνο χρειάζεται για να εμφανίσει την κυματομορφή. 

4. (Επιλογή) Μεγιστοποιήστε την ορατότητα της εμφάνισης της 
κυματομορφής χρησιμοποιώντας οποιαδήποτε από τις παρακάτω 
διαδικασίες: 
Ø Συνεχίστε να επεκτείνετε ή να συρρικνώνετε το οπτικό πεδίο του 

Timeline χρησιμοποιώντας το scale bar, για να απλώνεται 
αποτελεσματικά η κυματομορφή για να δείξει λεπτομερείς 
παραλλαγές στα επίπεδα ήχου. 

Ø Για να αυξήσετε το ύψος των επιλεγμένων audio track και 
ακολούθως τις εμφανίσεις της κυματομορφής, πατήστε Ctrl + L. 

Ø Για να μειώσετε το ύψος των επιλεγμένων audio track και 
ακολούθως τις εμφανίσεις της κυματομορφής, πατήστε Ctrl + Κ. 

Ø Για να αυξήσετε το μέγεθος της εικόνας του δείγματος χωρίς να 
αυξήσετε το track του, πιέστε Ctrl + Alt + L. 
Αυτή η διαδικασία είναι χρήσιμη όταν εμφανίζετε λεπτομέρειες σε 
αποσπάσματα με ησυχία. 

Ø Για να μειώσετε το μέγεθος της εικόνας του δείγματος χωρίς να 
μειώσετε το track του, πιέστε Ctrl + Alt + Κ. 
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Αυτή η διαδικασία είναι χρήσιμη όταν εμφανίζετε λεπτομέρειες σε 
αποσπάσματα με ένταση. 

5. Μετακινηθείτε διαμέσου του ήχου που εμφανίζεται στην 
κυματομορφή χρησιμοποιώντας οποιαδήποτε μέθοδο 
αναπαραγωγής. 
Ακούτε ήχο ενώ παρακολουθείτε τον ήχο οπτικά. Όταν ο δείκτης 
θέσης βρίσκεται στο σημείο που θέλετε στην κυματομορφή, 
μπορείτε να μαρκάρετε, να κάνετε trim, ή να εκτελέσετε 
οποιαδήποτε άλλη λειτουργία. 
 

13.3.4 Ρύθμιση των ελέγχων έντασης (Μόνο για λογισμικά 
συστήματα) 
Μπορείτε να ρυθμίσετε ή να μειώσετε εντελώς την ένταση στα ηχεία ή 
τα ακουστικά χωρίς να εγκαταλείψετε την εφαρμογή. Μπορείτε να 
ρυθμίσετε την ένταση από την πάνω εργαλειοθήκη του Timeline. 
Ρυθμίζοντας τους ελέγχους έντασης, επηρεάζεται η ένταση μόνο ενώ 
βρίσκεστε εντός της εφαρμογής Avid. Μόλις βγείτε από την εφαρμογή, 
οι έλεγχοι της έντασης επανέρχονται στην προεπιλεγμένη τους μορφή 
όπως ήταν ρυθμισμένοι στον υπολογιστή σας. 
Για να ρυθμίσετε τους ελέγχους έντασης: 

1. Στην πάνω εργαλειοθήκη στο Timeline, κάντε κλικ και κρατήστε 
πατημένο το κουμπί Monitor Volume . 
Αν δεν βλέπετε το κουμπί Monitor Volume, κάντε κλικ στο κουμπί 
Meter Menu  και επιλέξτε από το μενού Show Audio Meters. Το 
κουμπί Master Volume εμφανίζεται μαζί με τα Audio Meter. 
Εμφανίζεται ο κυλιόμενος έλεγχος έντασης. 

2. Συνεχίστε να κάνετε κλικ και να το κρατάτε και σύρετε τον έλεγχο 
έντασης στο ηχητικό επίπεδο που προτιμάτε. 

3. Ελευθερώστε το κουμπί του ποντικιού. 
Για να κλείσετε εντελώς την ένταση (mute): 
Ø Στην πάνω εργαλειοθήκη στο Timeline, κάντε κλικ στο κουμπί 

Monitor Volume . 
Μια γραμμή εμφανίζεται διαμέσου του κουμπιού και  δεν 
ακούγεται ήχος από τα ηχεία σας ή τα ακουστικά. 
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Για να απενεργοποιήσετε το mute: 
Ø Ξανά κάντε κλικ στο κουμπί Master Volume μέχρι να εμφανιστεί το 

κουμπί χωρίς τη κόκκινη γραμμή διαμέσου του. 
 

13.4 Χρήση του εργαλείου Audio Mixer για τη ρύθμιση και 
ισορρόπηση της έντασης στο Timeline 
Το εργαλείο Audio Mixer έχει τρία mode που σας επιτρέπουν να 
εκτελέσετε τις παρακάτω εργασίες: 

· Clip Gain and Pan mode σας επιτρέπει να ρυθμίσετε τη συνολική 
ένταση και τιμές ισορροπίας για ένα κλιπ στο Timeline. 

· Automation Gain and Pan mode σας επιτρέπει να κάνετε εγγραφή 
των αλλαγών της έντασης και της ισορροπίας εντός του κλιπ στο 
Timeline. 

· Live Mix mode σας επιτρέπει να παρακάμψετε προσωρινά 
οποιαδήποτε υπάρχουσα ρύθμιση Automation Gain and Pan. 
Μπορείτε να χρησιμοποιήσετε τους ελέγχους στο εργαλείο Audio 
Mixer ή να χρησιμοποιήσετε ένα εξωτερικό ελεγκτή για να αλλάξετε 
τις εντάσεις και τις ρυθμίσεις ισορροπίας χωρίς να τροποποιήσετε 
τις υπάρχουσες Automation Gain and Pan ρυθμίσεις.  

 
13.4.1 Χρήση του εργαλείου Audio Mixer 
Για να ανοίξετε το εργαλείο Audio Mixer, κάντε ένα από τα 
παρακάτω: 
Ø Αν ένα από τα Audio εργαλεία είναι ήδη ανοιχτό, κάντε κλικ στο 

μενού Effect Mode Selector και επιλέξτε Audio Mixer. 
Ø Από το μενού της εφαρμογής επιλέξτε Tools > Audio Mixer. 

Ανοίγει το εργαλείο Audio Mixer σε Clip Gain mode. 
Για να επιλέξετε Clip Gain mode ή Automation Gain and Pan mode: 
Ø Κάντε κλικ στο κουμπί Auto  για να αλλάξετε τα mode. Κάντε 

κλικ στο κουμπί για να εισέλθετε στο Automation Gain and Pan 
mode και ξανακάντε κλικ στο κουμπί Auto για να επιστρέψετε στο 
Clip Gain mode. 

Τα κουμπιά Track Solo  και Track Mute  σας επιτρέπουν να 
σιγήσετε ή να απομονώσετε μεμονωμένα Audio track κατά τη διάρκεια 
εγγραφής Automation Gain and Pan. 
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Για να επιλέξετε το Audio Mixer mode, κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ και κρατήστε το κουμπί Audio Mixer mode  και 

επιλέξτε το mode από το μενού. 
Ø Κάντε κλικ στο κουμπί Audio Mixer mode και πλοηγηθείτε μέσα από 

τις ρυθμίσεις του Audio Mixer mode για το mode που θέλετε να 
επιλέξετε. 

 
13.4.2 Αλλαγή μεγέθους του εργαλείου Audio Mixer 
Για να αλλάξετε την εμφάνιση από 8 track σε 4 track ή από 4 track σε 8 
track: 
Ø Κάντε κλικ στο κουμπί Number of Mix Panes  . 

Για να απλοποιήσετε την εμφάνιση του Audio Mixer Tool 
αποκρύπτοντας τα ρυθμιστικά Volume Level: 

1. Κάντε κλικ στο κουμπί Display/Hide . 
Το εργαλείο διπλώνεται. 

2. Συνεχίστε να ρυθμίζετε τα επίπεδα κάνοντας ένα από τα παρακάτω: 
Ø Επιλέξτε ένα track και πληκτρολογήστε τις τιμές χρησιμοποιώντας 

το αριθμητικό πληκτρολόγιο στο πληκτρολόγιο σας. 
Ø Πληκτρολογήστε μια τιμή στην οθόνη Volume Level . 

Για να αλλάξετε μέγεθος σε ολόκληρο το εργαλείο Audio Mixer: 
Ø Σύρετε την άκρη ή τη γωνία του εργαλείου. 

 
13.4.3 Επιλέγοντας τα track στο εργαλείο Audio Mixer 
Όταν επιλέγετε ένα track στο εργαλείο Audio Mixer, το σύστημα 
επιλέγει το αντίστοιχο track στο Timeline. Παρομοίως, όταν επιλέγετε 
ένα audio track στο Timeline, το σύστημα επιλέγει το αντίστοιχο track 
στο εργαλείο Audio Mixer. 
 
13.4.4 Χρήση των κουμπιών Track Solo και Track Mute 
Τα κουμπιά Track Solo  και Track Mute  λειτουργούν και στα τρία 
mode. Οι ρυθμίσεις εξακολουθούν να υπάρχουν μεταξύ των mode και 
παραμένουν σε ισχύ όταν κλείνετε το παράθυρο διαλόγου Audio Mixer. 



Σελίδα | 191  
 

13.5 Ρυθμίζοντας ένα Audio track τη φορά 

Για να ρυθμίσετε ένα Audio track τη φορά στο εργαλείο Audio Mixer: 
1. Φορτώστε ένα κλιπ ή μια ακολουθία και ενεργοποιήστε το 

κατάλληλο μόνιτορ. 
Ø Για να ρυθμίσετε ένα track σε πηγαίο κλιπ, κάντε κλικ στο Source 

μόνιτορ για να το ενεργοποιήσετε. 
Ø Για να ρυθμίσετε ένα track σε ακολουθία, κάντε κλικ στο Composer 

μόνιτορ για να το ενεργοποιήσετε. 
2. Επιλέξτε το track ή μερίδα του track που θα ρυθμιστεί: 
Ø Για να ρυθμίσετε ένα track σε μια ενιαία επεξεργασία του κλιπ 

στην ακολουθία, τοποθετείστε το δείκτη θέσης σε ένα κλιπ. 
Ø Για να ρυθμίσετε ένα απομονωμένο τμήμα ήχου σε track, 

μαρκάρετε IN και OUT σημεία. Ρυθμίζοντας το κλιπ με mark IN και 
mark OUT ρυθμίζεται ολόκληρο το κλιπ. 

Ø Για να ρυθμίσετε τα επίπεδα, από ένα σημείο IN μέχρι το τέλος του 
track, σημειώστε μόνο ένα σημείο IN. Ένα mark ρυθμίζει επίσης 
ολόκληρο το track από την αρχή του κλιπ που περιλαμβάνει το 
mark. 

Ø Για να ρυθμίσετε τα επίπεδα γενικά καθ' όλο το track, μην κάνετε 
καθόλου mark. 

3. Από το μενού της εφαρμογής επιλέξτε Tools > Audio Mixer. 
Ανοίγει το εργαλείο Audio Mixer 
Το εργαλείο Audio Mixer περιέχει τέσσερα ή οχτώ πάνελ, ένα για 
κάθε audio track στο Timeline ή για πηγαίο κλιπ. Τα κουμπιά 
επιλογής track ταιριάζουν με τα κουμπιά επιλογής track στην 
ακολουθία ή το πηγαίο κλιπ. Όταν επιλέξετε ένα track στο εργαλείο 
Audio Mixer, το σύστημα επιλέγει το αντίστοιχο track στο Timeline ή 
το πηγαίο κλιπ. 

4. Βεβαιωθείτε ότι το κουμπί Auto είναι αποεπιλεγμένο. 
5. Επιλέξτε το audio track που θα ρυθμιστεί κάνοντας ένα από τα 

παρακάτω: 
Ø Κάντε κλικ στο κουμπί Track Selection Menu  για το κατάλληλο 

audio track. 
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Ø Alt + κλικ στο κουμπί Track Selection Menu  και μετά επιλέξτε 
το track. 

6. Επιλέξτε Clip Gain and Pan mode ως εξής: 
Ø Κάντε κλικ και κρατήστε πατημένο το κουμπί Audio Mixer και 

επιλέξτε από το μενού Clip Gain and Pan. 
Ø Κάντε κλικ στο κουμπί Audio Mixer mode και πλοηγηθείτε μέσω 

των ρυθμίσεων του Audio Mixer στο Clip. 
7. Επιλέξτε το audio track που θα ρυθμιστεί κάνοντας ένα από τα 

παρακάτω: 
Ø Κάντε κλικ στο κουμπί Track Selection Menu για το κατάλληλο 

audio track. 
Ø Alt + κλικ στο κουμπί Track Selection Menu και μετά επιλέξτε το 

track. 
Για να επιβεβαιώσετε ή να αλλάξετε τα κανάλια εξόδου, 
χρησιμοποιήστε το εργαλείο Audio (Επιλέξτε Tools > Audio Tool). 

8. Έχοντας ενεργοποιημένο το εργαλείο Audio Mixer, χρησιμοποιήστε 
οποιαδήποτε μέθοδο αναπαραγωγής (όπως τα πλήκτρα J-K-L στο 
πληκτρολόγιο) για αναπαραγωγή, shuttle ή βηματισμό διαμέσου 
του ήχου για να ελέγξετε για τις κατάλληλες ρυθμίσεις έντασης ή 
ισορροπίας. 
Το πληκτρολόγιο μπορεί να ελέγξει είτε το Source pop-up είτε το 
Composer μόνιτορ, ανάλογα με το ποιό μόνιτορ ήταν ενεργό όταν 
ανοίξατε το εργαλείο Audio Mixer. Κάντε την επιλογή σας κάνοντας 
κλικ στο κατάλληλο μόνιτορ. 

9. Αποφασίστε αν θα αυξήσετε ή θα μειώσετε την ένταση του ήχου ή 
θα ισορροπήσετε δεξιά ή αριστερά,  το οποίο ρυθμίζει την ένταση ή 
την ισορροπία για ένα κλιπ.  

10. Ρυθμίστε τις τιμές ισορροπίας. 
11. Εφαρμόστε τις ρυθμίσεις για την επιλογή περιοχή του track 

χρησιμοποιώντας το κουμπί Fast Menu που βρίσκεται στο πάνω 
μέρος του εργαλείου. 

12. Αναπαράγετε ξανά τον ήχο, χρησιμοποιώντας τα πλήκτρα J-K-L.  
13. Επαναλάβετε τα βήματα 6 έως 9 μέχρι να είστε ικανοποιημένοι με 

τα επίπεδα έντασης και ισορροπίας. 
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Το σύστημα χρησιμοποιεί τις νέες ρυθμίσεις όποτε αναπαράγετε ή 
καταγράφετε την ακολουθία. 

 
13.5.1 Αλλάζοντας ένα επίπεδο ήχου (Audio Level) 
Για να αλλάξετε μία τιμή επιπέδου ήχου σε ένα audio track panel, 
κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ σε έναν αριθμό κατά μήκος του κάθετου άκρου του 

ρυθμιστή Level. 
Ø Κάντε κλικ στο ρυθμιστή Level, πληκτρολογήστε μια τιμή και 

πατήστε Enter. 
Οι τιμές είναι αθροιστικές μέχρι να πατήσετε το Enter. Για 
παράδειγμα, αν θέλετε να εισάγετε την τιμή 12, πληκτρολογήστε 
την. Ωστόσο, εάν εισάγετε την τιμή 1 και στη συνέχεια, θέλετε να 
αλλάξετε την τιμή σε 2, πατήστε Enter πριν πληκτρολογήσετε το 2. 

Ø Κάντε κλικ στο ρυθμιστή Level και σύρετε το ρυθμιστή σε νέα θέση. 
Ø Κάντε κλικ στην οθόνη Volume Level, πληκτρολογήστε μια τιμή και 

πατήστε Enter. 
Ø Alt + κλικ το ρυθμιστή Level για να επαναφέρετε την τιμή σε 0 dB. 

 
13.5.2 Ρύθμιση τιμών ισορροπίας 
Για να ρυθμίσετε τις τιμές ισορροπίας σε ένα audio track panel, κάντε 
ένα από τα παρακάτω: 
Ø Κάντε κλικ στην οθόνη Pan Value για να εμφανίσετε το ρυθμιστικό 

και σύρετε το ρυθμιστικό σε νέα θέση. 
Ø Alt + Κλικ στην οθόνη Pan Value για να κεντράρετε την επιλογή 

(MID). 
Αν η ακολουθία αναπαράγεται, η αναπαραγωγή σταματάει όταν 
κάνετε μια ρύθμιση (το εργαλείο Audio Mixer δεν παρέχει ηχητικό 
έλεγχο σε πραγματικό χρόνο). Μπορείτε να ρυθμίσετε την ένταση 
ενώ παίζει το κλιπ. 

 
13.6 Αλλαγή του Sample Rate 
Μπορείτε να αλλάξετε το ρυθμό δειγματοληψίας για τις ακολουθίες και 
τα ηχητικά κλιπ από το παράθυρο διαλόγου Change Sample Rate. 
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Δεδομένου ότι μπορείτε να συνδυάσετε κλιπ με διαφορετικό ρυθμό 
δειγματοληψίας στην ίδια ακολουθία, αυτό το χαρακτηριστικό είναι 
χρήσιμο όταν πρέπει να διασφαλίσετε ότι ολόκληρη η ακολουθία έχει 
το ίδιο ρυθμό δειγματοληψίας για μια ψηφιακή περικοπή ή την 
εξαγωγή. 
Για να αλλάξετε το ρυθμό δειγματοληψίας για μια ακολουθία σε ένα 
ηχητικό κλιπ: 

1. Επιλέξτε μία ή περισσότερες ακολουθίες ή ηχητικά κλιπ στο bin. 
2. Από το μενού της εφαρμογής, επιλέξτε Bin > Change Sample Rate. 

Ανοίγει το παράθυρο διαλόγου Change Sample Rate. 

 
Εικόνα 13.6.1 Το παράθυρο Change Sample Rate 
 

3. Επιλέξτε από τις επιλογές στον ακόλουθο πίνακα. 
Επιλογές αλλαγής ρυθμού δειγματοληψίας 
Επιλογή Περιγραφή 
Sample Rate Επιλέξτε μεταξύ 32, 44.1 και 48 kHz. 

Quality Επιλέγει Υψηλή, Μέτρια, ή Χαμηλή 
ποιότητα μετατροπής. 

Delete Original Media 
Το σύστημα διαγράφει αυτόματα τα 
αρχικά πολυμέσα αφού έχει ολοκληρωθεί 
η διαδικασία μετατροπής. 

Destination Drive 

Προσδιορίζει τη μονάδα για τα νέα αρχεία 
πολυμέσων. Βεβαιωθείτε ότι έχετε 
επιλέξει μια μονάδα δίσκου προορισμού 
με αρκετό χώρο αποθήκευσης για τα 
αρχεία πολυμέσων που δημιουργούνται 
και την δυνατότητα να γίνεται η 
αναπαραγωγή τους. 
 

4. Κάντε κλικ στο OK. 
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Κεφάλαιο 14 

Δουλεύοντας με τους τίτλους 

Μπορείτε να δημιουργείτε τίτλους στην εφαρμογή επεξεργασίας Avid, 
με ένα από τα δύο εργαλεία τίτλων, το κλασσικό εργαλείο Avid Title ή 
το εργαλείο Marquee Title. Οι τίτλοι μπορούν να ενσωματώσουν 
κείμενο, γραφικά αντικείμενα, εισαγόμενα γραφικά και βίντεο. Στις 
παρακάτω ενότητες, η ορολογία ''τίτλος'' αναφέρεται εξίσου και σε 
κείμενο και σε γραφικά, το κλασσικό εργαλείο Avid Title αναφέρεται ως 
το εργαλείο Title και το εργαλείο Marquee Title αναφέρεται ως 
Marquee. 

14.1 Ανοίγοντας τα εργαλεία τίτλων 

Μπορείτε να ανοίξετε είτε το εργαλείο Title ή το Marquee από το μενού 
Clip ή από το μενού Tools ή από την παλέτα Tools. Μπορείτε επίσης, να 
χρησιμοποιήσετε εντολές από τα μενού της εφαρμογής Windows ή 
Tools για να φέρετε το εργαλείο Tool σε πρώτο πλάνο αν καλύπτεται 
από άλλα παράθυρα. 

Για να ανοίξετε ένα από τα εργαλεία Title: 

1. Στο Record μόνιτορ, μετακινήστε το δείκτη θέσης στο βίντεο καρέ 
για να χρησιμοποιηθεί ως αναφορά. 
Αν δεν χρησιμοποιείτε βίντεο ως φόντο, μπορείτε να αγνοήσετε 
αυτό το βήμα. 

2. Από το μενού της εφαρμογής επιλέξτε Clip > New Title ή Tools > Title 
Tool ή από την παλέτα Tools πατήστε το κουμπί . 
Ανοίγει το παράθυρο New Title. 

 
Εικόνα 14.1.1 Το παράθυρο New Title 
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3. Κάντε ένα από τα παρακάτω: 
Ø Για να χρησιμοποιήσετε το Marquee, κάντε κλικ στο Marquee. 

Ανοίγει το Marquee μαζί με τα παράθυρα Quick Titles Properties, 
Styles Library, Transform Properties και Layers. 

 
Εικόνα 14.1.2 Το εργαλείο Marquee 

 

 
Εικόνα 14.1.3 Το παράθυρο Quick Titles Properties 
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Εικόνα 14.1.4 Το παράθυρο Styles Library 
 
 

 
Εικόνα 14.1.5 Το παράθυρο Transform Properties 
 
 

 
Εικόνα 14.1.6 Το παράθυρο Layers 
 
 

Ø Για να χρησιμοποιήσετε ο εργαλείο Title, κάντε κλικ στο Title Tool. 
Ανοίγει το εργαλείο Title. Το εργαλείο Text είναι επιλεγμένο 
αυτόματα και ο δείκτης γίνεται κέρσορας που αναβοσβήνει, 
έτοιμος για εισαγωγή κειμένου. 
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Εικόνα 14.1.7  Το εργαλείο Title 
 

Για να φέρετε το εργαλείο Title στο προσκήνιο, κάντε ένα από τα 
παρακάτω: 
Ø Από το μενού της εφαρμογής επιλέξτε Windows > Title Tool. 
Ø Από το μενού της εφαρμογής επιλέξτε Tools > Title Tool. 

 
14.2 Χρήση του Marquee 
Το εργαλείο Marquee είναι ένα εναλλακτικό εργαλείο για δημιουργία 
βασικών τίτλων και ένα εργαλείο για δημιουργία πολύ πιο εξελιγμένων 
τίτλων όπως 3D και κινούμενοι τίτλοι. Το Marquee ανοίγει μέσα από 
την εφαρμογή επεξεργασίας Avid αλλά έχει το δικό το αυτόνομο 
περιβάλλον χρήστη, συμπεριλαμβανομένου του δικού του συστήματος 
βοήθειας. 
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14.3 Ροή εργασίας για δημιουργία τίτλων 

Το παρακάτω είναι μια επισκόπηση των εργασιών που εκτελείτε για να 
δημιουργήσετε τίτλους και να τους συμπεριλάβετε στην ακολουθία: 

· Ρύθμιση του περιβάλλοντος σχεδίασης. Αφού ανοίξετε το εργαλείο 
Title, μπορείτε να επιλέξετε αν θα εμφανιστεί ένα χρώμα φόντου ή 
ένα καρέ του βίντεο από την ακολουθία. Μπορείτε επίσης να 
χρησιμοποιήσετε ασφαλή χρώματα ή ασφαλείς τίτλους και 
κατευθυντήριες γραμμές ή να εφαρμόσετε ένα πλέγμα για την 
τοποθέτηση των αντικειμένων. 

· Δημιουργία νέου τίτλου με το εργαλείο Title. Μπορείτε να 
δημιουργήσετε τίτλους εργαζόμενοι με κείμενο και γραφικά 
αντικείμενα και στη συνέχεια να εφαρμόσετε και αναπροσαρμόσετε 
τα όρια, τα χρώματα, τη διαφάνεια και τις σκιές. 

· Να αποθηκεύσετε τον τίτλο, να εξέλθετε από το εργαλείο Title και 
να επεξεργαστείτε τον τίτλο στην ακολουθία σας. Όταν 
αποθηκεύετε το νέο σας τίτλο, επιλέγετε το δίσκο προορισμού και 
ένα bin προορισμού για το πολυμέσο τίτλου. Μπορείτε επίσης, να 
αποθηκεύσετε μόνο τα στυλ του τίτλου για μελλοντική χρήση. Όταν 
κλείνετε το εργαλείο Title, ο νέος τίτλος εμφανίζεται στο bin και στο 
Source μόνιτορ, έτοιμο για επεξεργασία στην ακολουθία σας. 

 
14.4 Κατανόηση του εργαλείου Title 
Το εργαλείο Title έχει μερικά σημαντικά στοιχεία: 

· Το βίντεο φόντο βασίζεται στην ακολουθία ή σε χρωματικό φόντο 
που δημιουργείτε εσείς. 

· Ο τίτλος ή το γραφικό στο πρώτο πλάνο που δημιουργείτε εσείς. 
· Ο ασφαλής τίτλος και οι ασφαλείς κατευθυντήριες γραμμές. 
· Η εργαλειοθήκη στο κάτω μέρος της οθόνης.  
· Επιπλέον, υπάρχουν σχετιζόμενα με τίτλους μενού, στα μενού File, 

Edit, Object και Alignment. 
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14.5 Χρήση των εργαλείων Selection και Text 

Τα εργαλεία Selection  και Text  είναι τα δυο πιο συχνά 
χρησιμοποιούμενα εργαλεία στο εργαλείο Title. 
Χρησιμοποιείστε το εργαλείο Selection  όταν επιλέγετε και 
ρυθμίζετε ολόκληρα αντικείμενα σε ένα τίτλο (ολόκληρα τμήματα 
κειμένου ή γραφικά αντικείμενα). Χρησιμοποιείτε το εργαλείο Text όταν 
δημιουργείτε ή επεξεργάζεστε περιεχόμενο κειμένου. 
Για να επιλέξετε μεμονωμένο αντικείμενο: 
Ø Κάντε κλικ στο εργαλείο Selection  και μετά κάντε κλικ σε ένα 

αντικείμενο. 
Λαβές επιλογής εμφανίζονται γύρω από το αντικείμενο. 

Για να επιλέξετε πολλαπλά αντικείμενα, κάντε ένα από τα παρακάτω: 
Ø Κάντε Shift +κλικ έχοντας επιλεγμένο το εργαλείο Selection . 
Ø Κάντε κλικ έξω από τα αντικείμενα και σύρετε για να περιβάλλετε τα 

αντικείμενα με το λάσο. 
Για να χρησιμοποιήσετε το εργαλείο Text: 
Ø Κάντε κλικ στο εργαλείο Text, κάντε κλικ οπουδήποτε μέσα στο 

αντικείμενο κειμένου και ξεκινήστε να πληκτρολογείτε το κείμενο 
που θέλετε. 
Ένας κέρσορας που αναβοσβήνει, δείχνει την θέση σας μέσα στο 
κείμενο. Το εργαλείο Text παραμένει επιλεγμένο μέχρι να επιλέξετε 
άλλο εργαλείο. 
Από προεπιλογή, το εργαλείο Text είναι ενεργό όταν ανοίγετε το 
εργαλείο Title και μπορείτε να ξεκινήσετε την εισαγωγή του 
κειμένου μόλις κάνετε κλικ στο εργαλείο Title. 

Για να εναλλάσσεστε μεταξύ των εργαλείων Selection και Text: 
Ø Πατήστε το πλήκτρο Alt και κάντε κλικ οπουδήποτε μέσα στο 

εργαλείο Title. 
Για να χρησιμοποιήσετε το εργαλείο Selection προσωρινά όταν ένα 
άλλο εργαλείο είναι ενεργό: 

· Πατήστε και κρατήστε τα πλήκτρα Ctrl και Alt. 
Αφού χρησιμοποιήσετε ένα εργαλείο από την εργαλειοθήκη, το 
εργαλείο Title επανέρχεται στο εργαλείο Selection και ο δείκτης 
γίνεται ένα βελάκι. Για να αποτρέψουμε το εργαλείο από την 
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αυτόματη επαναφορά στο εργαλείο Selection, κάντε διπλό κλικ στο 
εικονίδιο του εργαλείου. 

 
14.6 Ρύθμιση του περιβάλλοντος σχεδίασης 
Αυτή η ενότητα περιγράφει, στα παρακάτω θέματα, ορισμένες βασικές 
πτυχές του εργαλείου Title που μπορείτε να χρησιμοποιήσετε για να 
δημιουργήσετε τη συνεδρία τίτλου ή σχεδίου. 
14.6.1 Προεπισκόπηση των τίτλων με Anti-Aliasing 
Το κείμενο και τα αντικείμενα στους τίτλους είναι δημιουργημένα anti-
aliased με ένα 8-bit alpha channel. Το Anti-aliasing διασφαλίζει ότι το 
κείμενο, οι γραμμές και οι άκρες των αντικειμένων εμφανίζονται λείες, 
ανεξάρτητα από το μέγεθος τους. Μπορείτε να κάνετε προεπισκόπηση 
ενός τίτλου για να δείτε τον τίτλο σχεδιασμένο με anti-aliasing, ακριβώς 
έτσι όπως θα αποθηκευτεί. 
Για να ενεργοποιήσετε ή απενεργοποιήσετε την εμφάνιση των anti-
aliased τίτλων: 

· Από το μενού της εφαρμογής επιλέξτε Object > Preview. 
Ένα σημάδι ελέγχου υποδεικνύει ότι το Preview mode είναι 
ενεργοποιημένο και ότι η εμφάνιση των anti-aliased τίτλων είναι 
ενεργό. 
Οι τίτλοι αποθηκεύονται πάντα σε anti-aliased τύπο. 

Η εμφανισιακή συμπεριφορά για τα αντικείμενα τίτλου στο Preview 
mode είναι όπως τα παρακάτω: 

· Μπορείτε να αλλάξετε τα γραφικά χαρακτηριστικά των 
αντικειμένων τίτλου (συμπεριλαμβανομένων των χρωμάτων, σκιών, 
ορίων και διαφανειών) χωρίς να χάσετε την Anti-aliased 
προεπισκόπηση. 

· Μπορείτε να επιλέξετε αντικείμενα κειμένου και να εφαρμόσετε 
στυλ κειμένου από το μενού Styles χωρίς να χάσετε την anti-aliased 
προεπισκόπηση. 

· Όταν κάνετε κλικ σε ένα αντικείμενο κειμένου για επεξεργασία, το 
εργαλείο Title εμφανίζει το κείμενο χωρίς anti-aliasing. Όταν 
τελειώνετε την επεξεργασία του κειμένου και κάνετε κλικ έξω από 
το αντικείμενο για να το αποεπιλέξετε, το εργαλείο Title αποκαθιστά 
την anti-aliased προεπισκόπηση. 
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14.6.2 Εμφάνιση των ασφαλών τίτλων και των ασφαλών 
κατευθυντήριων γραμμών στο εργαλείο Title 
Από προεπιλογή, το εργαλείο Title εμφανίζει δύο παράθυρα με 
περίγραμμα για χρήση ως κατευθυντήριες γραμμές. 
Το εσωτερικό παράθυρο είναι η ασφαλής περιοχή τίτλων. Όλα τα 
κείμενα για τις τηλεοπτικές εκπομπές θα πρέπει να παραμένουν εντός 
αυτού του εσωτερικού παραθύρου. Το εξωτερικό παράθυρο είναι η 
ασφαλής περιοχή για την εμφάνιση του βίντεο. Αυτές οι 
κατευθυντήριες γραμμές είναι αυτό-ρυθμιζόμενες για PAL και NTSC 
projects. 
Για να ενεργοποιήσετε ή απενεργοποιήσετε την ασφαλή περιοχή 
τίτλων ή την ασφαλή περιοχή των κατευθυντήριων γραμμών: 
Ø Από το μενού της εφαρμογής επιλέξτε Object > Safe Title 

Area/Global Grid. 
Ένα σημάδι ελέγχου υποδεικνύει ότι η ασφαλής περιοχή τίτλων 
είναι ενεργοποιημένη για εμφάνιση. 

 
14.6.3 Επιλέγοντας ένα φόντο για τους τίτλους 
Χρησιμοποιείτε το κουμπί Video Background για να εναλλάσσεστε 
μεταξύ του βίντεο φόντου και του αδιαφανή χρωματικού φόντου ή να 
αναβαθμίσετε το βίντεο φόντο με το τρέχων επιλεγμένο καρέ στο 
Timeline. 
Αν υπάρχει ακολουθία στο Record μόνιτορ, το εργαλείο Title ανοίγει με 
το βίντεο φόντο. Η τοποθεσία του δείκτη θέσης στο Timeline τη στιγμή 
που ανοίγετε το εργαλείο Title καθορίζει το αρχικό καρέ του βίντεο που 
εμφανίζεται. Αν δεν υπάρχει ακολουθία στο Record μόνιτορ, το 
εργαλείο Title ανοίγει χωρίς να εμφανίζεται κάποιο βίντεο (το φόντο 
εμφανίζεται μαύρο). 
Το κουμπί Video Background είναι πράσινο όταν δημιουργείτε τίτλο για 
εμφάνιση πάνω από το βίντεο φόντο. 
Το καρέ του βίντεο φόντου είναι μια αναφορά που σας βοηθάει να 
τοποθετήσετε αντικείμενα τίτλων σε σχέση με το βίντεο που σκοπεύετε 
να επεξεργαστείτε τον τίτλο πάνω. Μπορείτε να επεξεργαστείτε τον 
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τίτλο οπουδήποτε αλλού στην τρέχουσα ακολουθία ή σε άλλη 
ακολουθία. 
Για να ενημερώσετε το βίντεο φόντο: 

1. Κάντε κλικ στο κουμπί Video Background  από την εργαλειοθήκη 
για να ενεργοποιήσετε το βίντεο φόντο αν δεν το έχετε ήδη κάνει. 

2. Φορτώστε την ακολουθία στο Record μόνιτορ. 
3. Μετακινήστε το δείκτη θέσης στο Timeline ή στο Record μόνιτορ για 

να εμφανίσετε το νέο καρέ. 
4. Κάντε κλικ ξανά στο εργαλείο Title για να ενεργοποιήσετε το 

παράθυρό του. 
Το φόντο έχει ενημερωθεί ώστε να αντικατοπτρίζει το τρέχων 
περιεχόμενο του Record μόνιτορ. 

Για να δημιουργήσετε ένα τίτλο ο οποίος εμφανίζεται πάνω σε ένα 
αδιαφανές χρωματικό φόντο: 

1. Κάντε κλικ στο κουμπί Video Background  για να 
απενεργοποιήσετε το βίντεο φόντο εάν ήταν προηγουμένως 
ενεργοποιημένο. 

2. Κάντε κλικ και κρατήστε στο παράθυρο Background Color . 
3. Χρησιμοποιήστε το σταγονόμετρο του παραθύρου διαλόγου Title 

Tool Color Picker ή του παραθύρου διαλόγου Windows Color για να 
επιλέξετε ένα χρώμα. 
Το προεπιλεγμένο χρώμα φόντου είναι μαύρο. 

 
14.7 Δημιουργία Κειμένου 
Μπορείτε να δημιουργήσετε νέο κείμενο χρησιμοποιώντας το εργαλείο 
Text. Μπορείτε επίσης να αντιγράψετε και να επικολλήσετε κείμενο στο 
εργαλείο Title απευθείας από κάποια εφαρμογή επεξεργασίας 
κειμένου. 
Εκτός από στατικά αντικείμενα κειμένου, μπορείτε επίσης να 
δημιουργήσετε αντικείμενα κειμένου στο εργαλείο Title τα οποία είναι 
κυλιόμενα κάθετα (rolling titles) ή τα οποία είναι κυλιόμενα οριζόντια 
(crawling titles). 
Υπάρχει ένα όριο στο μέγεθος των αντικειμένων κειμένου που 
μπορείτε να δημιουργήσετε στο εργαλείο Title. Αποφύγετε να 
επικολλάτε μεγάλα τμήματα κειμένου (πολλές σελίδες στον 
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επεξεργαστή κειμένου) στο εργαλείο Title. Αντ' αυτού φροντίστε να 
επικολλάτε μικρότερα τμήματα κειμένου σε ξεχωριστά αντικείμενα 
κειμένου. 
 
Για να δημιουργήσετε κείμενο: 

1. Κάντε κλικ στο εργαλείο Text  από την εργαλειοθήκη. 
Ο δείκτης μετατρέπεται σε κέρσορα που αναβοσβήνει. 

2. Κάντε κλικ στη θέση καρέ που θέλετε να εισάγετε το κείμενο. 
Εμφανίζεται ένα σημείο εισαγωγής. 

3. Πληκτρολογήστε το κείμενο. 
Για να επανέλθετε στην αρχική θέση στην επόμενη γραμμή, πατήστε 
το Enter. 

4. Όταν έχετε τελειώσει με την πληκτρολόγηση του κειμένου, κάντε 
κλικ στο εργαλείο Selection  στην εργαλειοθήκη για να 
αποεπιλέξετε το αντικείμενο κειμένου. 

 
Για να αντιγράψετε και να επικολλήσετε κείμενο μέσα στο εργαλείο 
Title: 

1. Κάντε κλικ στο εργαλείο Text  από την εργαλειοθήκη. 
Ο δείκτης μετατρέπεται σε κέρσορα που αναβοσβήνει. 

2. Κάντε κλικ στη θέση καρέ που θέλετε να εισάγετε το κείμενο. 
Ένα σημείο εισαγωγής εμφανίζεται. 

3. Ανοίξτε ένα αρχείο κειμένου σε μια εφαρμογή επεξεργασίας 
κειμένου. 

4. Επιλέξτε το κείμενο στην εφαρμογή επεξεργασίας κειμένου. 
5. Επιλέξτε Edit > Copy ή κάντε δεξί κλικ στο επιλεγμένο κείμενο και 

Copy ή πατήστε από το πληκτρολόγιο Ctrl + C. 
6. Κάντε κλικ στο εργαλείο Title ξανά για να το ενεργοποιήσετε. 
7. Από το μενού της εφαρμογής Avid επιλέξτε Edit > Paste ή κάντε δεξί 

κλικ και επιλέξτε Paste ή από το πληκτρολόγιο πατήστε Ctrl + V. 
Το επικολλημένο κείμενο παίρνει τις τρέχων ρυθμίσεις που είναι 
ορισμένες στην εργαλειοθήκη του εργαλείο Title. 
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14.8 Αλλαγή μεγέθους και τοποθέτηση των αντικειμένων 
κειμένου 

Μπορείτε να αλλάξετε μέγεθος και να αλλάξετε τοποθεσία στα 
αντικείμενα κειμένου μέσα στο εργαλείο Title. Όταν αλλάζετε μέγεθος 
σε ένα αντικείμενο κειμένου, το κείμενο παραμένει στο ίδιο μέγεθος 
αλλά αναδιπλώνεται για να γεμίσει η ανασχηματισμένη περιοχή. 
Όταν δημιουργείτε κείμενο το οποίο είναι στοιχισμένο στην αριστερή 
πλευρά χρησιμοποιώντας αριστερή στοίχιση (την προεπιλεγμένη), 
μπορείτε να εξαλείψετε το αχρησιμοποίητο χώρο στη δεξιά πλευρά του 
νεοσυσταθείσα αντικειμένου κειμένου, ειδικά αν θέλετε να 
χρησιμοποιήσετε τις εντολές του μενού Alignment. 
Για να αλλάξετε μέγεθος στο αντικείμενο κειμένου: 

1. Κάντε κλικ στο εργαλείο Selection  και μετά κάντε κλικ στο 
αντικείμενο κειμένου. 

2. Κάντε κλικ σε μια από τις λαβές επιλογής αντικειμένου και σύρετε 
για να αυξήσετε ή να μειώσετε το μέγεθος. 
Μπορείτε να αλλάξετε μέγεθος μόνο στο πλάτος του αντικειμένου 
κειμένου. Το ύψος του αντικειμένου κειμένου καθορίζεται αυτόματα 
από τον αριθμό των λέξεων και το μέγεθος του κειμένου. 

Για να εξαλείψετε το αχρησιμοποίητο χώρο στη δεξιά πλευρά του 
αντικειμένου κειμένου με αριστερή στοίχιση: 
Ø Κάντε κλικ στη μεσαία λαβή επιλογής στη δεξιά πλευρά του 

πλαισίου κειμένου και σύρετε τη προς τα αριστερά μέχρι να 
πλησιάσει στο κείμενο. 

Για να επανατοποθετήσετε ένα αντικείμενο κειμένου: 
1. Κάντε κλικ στο εργαλείο Selection  και ύστερα κάντε κλικ στο 

αντικείμενο κειμένου. 
2. Μετακινήστε το κείμενο κάνοντας ένα από τα παρακάτω: 
Ø Κάντε κλικ στην μέση του αντικειμένου και σύρετε το σε νέα 

τοποθεσία. 
Ø Χρησιμοποιείστε τα πλήκτρα βέλους για να μετακινήσετε το 

αντικείμενο κατά ένα pixel κάθε φορά. 
Ø Χρησιμοποιείστε τις εντολές από το μενού Alignment για να 

τοποθετήσετε το κείμενο. 
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14.9 Μορφοποίηση Κειμένου 
Τα εργαλεία μορφοποίησης κειμένου ελέγχουν την εμφάνιση του 
κειμένου. Μπορείτε να κάνετε κλικ σε ένα αντικείμενο κειμένου με το 
εργαλείο Selection  για να μορφοποιήσετε όλο το κείμενο που 
βρίσκεται μέσα σε αυτό ή μπορείτε να χρησιμοποιήσετε το εργαλείο 
Text  για να επιλέξετε μια ακολουθία του κειμένου μέσα στο 
αντικείμενο κειμένου για να μορφοποιήσετε μεμονωμένους 
χαρακτήρες ή λέξεις.  
Καθώς πληκτρολογείτε το κείμενο, μόνο το χρώμα του κειμένου είναι 
εμφανές. Σκιές, περιγράμματα και τα άλλα χρωματικά χαρακτηριστικά 
εμφανίζονται όταν τελειώσετε την πληκτρολόγηση του κειμένου και 
κάνετε κλικ στο εργαλείο Selection. 
14.9.1 Ρύθμιση των προεπιλεγμένων ρυθμίσεων του 
κειμένου 
Όταν εκκινείτε την εφαρμογή και ανοίγετε το εργαλείο Title, η 
εφαρμογή χρησιμοποιεί τις προεπιλεγμένες ρυθμίσεις κειμένου. 
Μπορείτε να αλλάξετε αυτές τις προεπιλεγμένες ρυθμίσεις 
οποιαδήποτε στιγμή. Οι αλλαγές που κάνετε στις προεπιλεγμένες 
ρυθμίσεις του κειμένου εφαρμόζονται μέχρι να κλείσετε την εφαρμογή. 
Για να αλλάξετε τις προεπιλεγμένες ρυθμίσεις κειμένου: 

1. Κάντε κλικ στο εργαλείο Selection . 
2. Κάντε κλικ στο εργαλείο Title αλλά μην επιλέξετε κείμενο. 
3. Αλλάξτε οποιεσδήποτε ρυθμίσεις κειμένου όπως εσείς επιθυμείτε. 

Τώρα όποτε ξεκινάτε να γράφετε μια νέα ακολουθία, το εργαλείο Tool 
χρησιμοποιεί τις καινούριες σας ρυθμίσεις. 
14.9.2 Επιλογή Γραμματοσειράς 
Το κουμπί επιλογής γραμματοσειράς εμφανίζει την ονομασία της 
τρέχων γραμματοσειράς και σας επιτρέπει να την αλλάξετε. Όταν 
ανοίγετε για πρώτη φορά το εργαλείο Title, η γραμματοσειρά που 
αναφέρεται είναι η προτιμώμενη γραμματοσειρά του συστήματος. 
Για να εμφανίσετε όλες τις γραμματοσειρές που είναι εγκατεστημένες 
στο σύστημα: 
Ø Κάντε κλικ στο κουμπί επιλογής γραμματοσειράς . 
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Για να αλλάξετε μια γραμματοσειρά: 

Ø Κάντε κλικ στο κουμπί επιλογής γραμματοσειράς  και 
επιλέξτε μια γραμματοσειρά. 
Το εργαλείο Title εμφανίζει την ονομασία στο κουμπί επιλογής 
γραμματοσειράς και χρησιμοποιεί αυτή τη γραμματοσειρά για το 
κείμενο μέχρι να ξανά αλλάξετε γραμματοσειρά. 
Όταν επιλέγετε ένα αντικείμενο κειμένου, το κουμπί επιλογής 
γραμματοσειράς εμφανίζει την ονομασία της γραμματοσειράς που 
έχει το αντικείμενο κειμένου. 

14.9.3 Αλλαγή μεγέθους κειμένου 
Για να αλλάξετε το μέγεθος της γραμματοσειράς, κάντε ένα από τα 
παρακάτω: 
Ø Κάντε κλικ στο κουμπί μεγέθους γραμματοσειράς  που είναι 

το βελάκι και επιλέξτε το μέγεθος που επιθυμείτε από τη λίστα. 
Ø Κάντε διπλό κλικ στο πλαίσιο κειμένου , πληκτρολογήστε μια 

τιμή μεγέθους μεταξύ του 5 και 999 και πατήστε Enter. 
Ø Κάντε κλικ στο πλαίσιο κειμένου  και χρησιμοποιήστε τα 

πλήκτρα βέλους πάνω και κάτω για να αλλάξετε την τιμή σταδιακά. 
14.9.4 Εφαρμογή Έντονης και Πλάγιας γραφής 
Τα κουμπιά για την έντονη (Bold, B)  και πλάγια (Italic, I)  γραφή 
βρίσκονται κάτω από το κουμπί αλλαγής μεγέθους γραμματοσειράς. 
Επίσης μπορεί να γίνει εφαρμογή των εντολών από το μενού της 
εφαρμογής Object. 
Για να κάνετε το κείμενο έντονο ή πλάγιο: 

1. Επιλέξτε το κείμενο που θέλετε να αλλάξετε. 
2. Κάντε ένα από τα παρακάτω: 
Ø Πατήστε το κουμπί  για έντονη γραφή ή το  για πλάγια 

γραφή. 
Ø Από το μενού της εφαρμογής επιλέξτε Object > Bold για έντονη 

γραφή ή Object > Italic για πλάγια γραφή. 
Ø Από το πληκτρολόγιο πατήστε Shift + Ctrl + B για έντονη γραφή ή 

Shift + Ctrl + I για πλάγια γραφή. 
Για να αφαιρέσετε την έντονη ή πλάγια γραφή: 
Ø Επαναλάβετε τα παραπάνω βήματα. 
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14.9.5 Στοίχιση κειμένου 

Τα κουμπιά στοίχισης βρίσκονται  κάτω από το κουμπί αλλαγής 
γραμματοσειράς. 

Για να στοιχίσετε το κείμενο, κάντε ένα από τα παρακάτω: 
Ø Κάντε κλικ στο αριστερό κουμπί στοίχισης  για να στοιχίσετε το 

κείμενο στην αριστερή πλευρά του αντικειμένου κειμένου. 
Ø Κάντε κλικ στο κεντρικό κουμπί στοίχισης  για να στοιχίσετε το 

κείμενο στο κέντρο. 
Ø Κάντε κλικ στο δεξί κουμπί στοίχισης  για να στοιχίσετε το 

κείμενο στην δεξιά πλευρά του αντικειμένου κειμένου. 
 

14.9.6 Kerning κειμένου 
Το kerning αυξάνει ή μειώνει το κενό μεταξύ των γραμμάτων ή των 
χαρακτήρων στις λέξεις σε ένα κείμενο. Το στοιχείο ελέγχου του kerning 
βρίσκεται κάτω από τα κουμπιά στοίχισης κειμένου. Μπορείτε να 
εφαρμόσετε kerning σε ολόκληρο το αντικείμενο κειμένου ή μπορείτε 
να επιλέξετε μεμονωμένες λέξεις ή και κάποια γράμματα μέσα στις 
λέξεις. Οι θετικοί αριθμοί αυξάνουν το κενό ενώ οι αρνητικοί αριθμοί το 
μειώνουν. 
Για να ρυθμίσετε το kerning χειροκίνητα και τα πλήκτρα βέλους: 

1. Κάντε κλικ στο εργαλείο Text  από την εργαλειοθήκη. 
2. Κάντε κλικ μεταξύ δυο χαρακτήρων ή επιλέξτε μια ομάδα 

χαρακτήρων για να εφαρμοστεί το kerning. 
3. Πατήστε το πλήκτρο Alt και χρησιμοποιήστε το αριστερό ή δεξιό 

από τα πλήκτρα βέλους για να αυξήσετε ή να μειώσετε το kerning. 
Για να ρυθμίσετε το kerning με προκαθορισμένα μεγέθη: 

1. Επιλέξτε το κείμενο. 
2. (Επιλογή) Κάντε κλικ στο κουμπί Kerning  και επιλέξτε Pair 

Kerning για να εξαλείψετε το υπερβολικό κενό μεταξύ μερικών 
χαρακτήρων. 
Το kerning λειτουργεί μόνο σε γραμματοσειρές οι οποίες 
υποστηρίζουν τους kerning πίνακες. 

3. Κάντε κλικ στο κουμπί Kerning και επιλέξτε την kerning επιλογή: 
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¾ Loose: προσθέτει κενό μεταξύ χαρακτήρων. 
¾ Normal: αφήνει το κενό ανέπαφο. 
¾ Tight: αφαιρεί τα κενά μεταξύ των χαρακτήρων. 

Για να ρυθμίσετε το kerning με πλαίσιο κειμένου: 
Ø Κάντε κλικ στο πλαίσιο κειμένου Kerning  και 

πληκτρολογήστε μια θετική ή αρνητική αριθμητική τιμή. 
Ø Κάντε κλικ στο πλαίσιο κειμένου Kerning  και 

χρησιμοποιήστε τα πάνω κάτω πλήκτρα βέλους για να αλλάζετε τις 
τιμές σταδιακά. 
Το εργαλείο Title εφαρμόζει το kerning σε ολόκληρο το αντικείμενο 
κειμένου. 

14.9.7 Ρυθμίζοντας το Leading 
Χρησιμοποιήστε το leading για να ρυθμίσετε το κενό μεταξύ των 
γραμμών μέσα σε ένα τίτλο. Το Leading μετριέται σε στιγμές μεταξύ των 
βάσεων των γραμμών του κειμένου. Οι θετικές τιμές leading αυξάνουν 
το κενό ενώ οι αρνητικές τιμές μειώνουν το κενό. 
Για να ορίσετε το Leading: 
Ø Κάντε κλικ στο πλαίσιο κειμένου Leading  και 

πληκτρολογήστε έναν αριθμό για να ορίσετε την leading τιμή που 
θέλετε. 
Το εργαλείο Title ρυθμίζει το leading άμεσα. 

 
14.10 Δημιουργία Γραφικών 
Χρησιμοποιείστε τα εργαλεία σχεδίασης για να δημιουργήσετε γραφικά 
όπως τετράγωνα, ορθογώνια, κύκλους, οβάλ και γραμμές. 
Αυτή η ενότητα περιγράφει πώς να χρησιμοποιήσετε τα εργαλεία 
σχεδίασης για να δημιουργήσετε γραφικά. Αφού δημιουργήσετε τα 
γραφικά, μπορείτε να τα μορφοποιήσετε και να τα τροποποιήσετε με 
ποικίλους τρόπους. 
Από προεπιλογή, όταν χρησιμοποιείτε το εργαλείο σχεδίασης και 
αποεπιλέγετε τα δημιουργημένα αντικείμενα, ο δείκτης μετατρέπεται 
σε εργαλείο Selection. Για να το αποφύγετε αυτό, κάντε διπλό κλικ στο 
εργαλείο σχεδίασης όταν το επιλέγετε από την εργαλειοθήκη του 
εργαλείου Tool. 
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Για να σχεδιάσετε ένα τετράγωνο ή ένα ορθογώνιο: 

1. Κάντε κλικ στο εργαλείο Square and Rectangle  από την 
εργαλειοθήκη. 
Ο δείκτης μετατρέπεται σε σταυρόνημα. 

2. Κάντε κλικ στο εργαλείο Title και σύρετε για να δημιουργήσετε ένα 
αντικείμενο. 
Πατώντας το πλήκτρο Shift ενώ σύρετε, δημιουργείται τετράγωνο με 
ίσες πλευρές. 

Για να σχεδιάσετε ένα κύκλο ή οβάλ: 
1. Κάντε κλικ στο εργαλείο Circle  από την εργαλειοθήκη. 

Ο δείκτης μετατρέπεται σε σταυρόνημα. 
2. Κάντε κλικ στο εργαλείο Title και σύρετε για να δημιουργήσετε ένα 

αντικείμενο. 
Πατώντας το πλήκτρο Shift ενώ σύρετε, δημιουργείται κύκλος με 
ίσες ακτίνες. 

Για να σχεδιάσετε μία γραμμή: 
1. Κάντε κλικ στο εργαλείο Line  από την εργαλειοθήκη. 

Ο δείκτης μετατρέπεται σε σταυρόνημα. 
2. Κάντε κλικ στο εργαλείο Title και σύρετε για να δημιουργήσετε ένα 

αντικείμενο. 
Πατώντας το πλήκτρο Shift ενώ σύρετε, δημιουργείται ίσια κάθετη ή 
οριζόντια γραμμή. 
 

14.11 Αποθήκευση Τίτλων 
Αφού δημιουργήσετε το νέο τίτλο, υπάρχουν τρείς βασικοί τρόποι για 
να αποθηκεύσετε την εργασία σας: 
Ø Αποθήκευση του τίτλου και έξοδος από το εργαλείο Title. 
Ø Αποθήκευση του τίτλου και συνέχεια δημιουργίας επιπλέον τίτλων. 
Ø Αποθήκευση στυλ τίτλου το οποίο μπορείτε να εφαρμόσετε σε 

επιπλέον τίτλους που δημιουργείτε. 
Μπορείτε επίσης να ξανά ανοίξετε στο εργαλείο Title κάποιο 
αποθηκευμένο τίτλο για περαιτέρω επεξεργασία. 
Μπορείτε επίσης να αποθηκεύσετε τις ρυθμίσεις ενός συγκεκριμένου 
τίτλου ως στυλ τίτλου ή ως πρότυπο τίτλου που μπορείτε να 
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εφαρμόζετε επανειλημμένα σε άλλους τίτλους ή σε αντικείμενα τίτλων, 
σε μεγάλο βαθμό με τον ίδιο τρόπο που μπορείτε να αποθηκεύετε 
πρότυπα των εφέ. 
14.11.1 Ταίριασμα αναλύσεων κατά την αποθήκευση 
Όταν αποθηκεύετε έναν τίτλο, θα πρέπει να επιλέξετε μια ανάλυση για 
τον τίτλο η οποία είναι συμβατή με το project, βασισμένη στα 
ακόλουθα: 

· Δεν μπορείτε να αναμείξετε τίτλους από μια ομάδα ανάλυσης με 
πολυμέσα από άλλη ομάδα. Για παράδειγμα, δεν μπορείτε να 
αναμείξετε single-field τίτλους με two-field πολυμέσα στην 
ακολουθία. 

· Η εφαρμογή Avid χρησιμοποιεί τις πληροφορίες ανάλυσης για να 
υπολογίζει τις διαστάσεις του τίτλου.  

· Μολονότι οι τίτλοι είναι ασυμπίεστοι, αν αποφασίσετε κατά τη 
διάρκεια της επεξεργασίας ότι χρειάζεται να κάνετε render στον 
τίτλο ή να δημιουργήσετε ένα layered εφέ, το render γίνεται στον 
τίτλο με την ανάλυση που επιλέξατε όταν πρώτο-αποθηκεύσατε τον 
τίτλο. 

 
14.11.2 Αποθήκευση του τίτλου και έξοδος από το εργαλείο 
Title 
Για να αποθηκεύσετε τίτλο και να εξέλθετε από το εργαλείο Title: 

1. Από το μενού της εφαρμογής, επιλέξτε File > Close. 
Αν το περιεχόμενο του τίτλου έχει αλλάξει από την τελευταία φορά 
που είχατε κάνει αποθήκευση, ανοίγει ένα παράθυρο διαλόγου, 
ρωτώντας σας αν θέλετε να αποθηκεύσετε το υπάρχων τίτλο. 

 
Εικόνα 14.11.1 Παράθυρο ερώτησης αποθήκευσης 
 

2. Πατήστε Save. 
Ανοίγει το παράθυρο διαλόγου Save Title. 
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Εικόνα 14.11.2 Το παράθυρο Save Title 
 

3. Πληκτρολογήστε μια ονομασία για να προσδιορίζετε τον τίτλο στο 
bin, έπειτα επιλέξτε ένα bin, έναν δίσκο προορισμού και ανάλυση 
από τα μενού. 
Αν αποθηκεύετε ένα νέο τίτλο, η ανάλυση που επιλέγετε γίνεται η 
προεπιλεγμένη για μελλοντικές αποθηκεύσεις τίτλων. 
Θα πρέπει να επιλέξετε μια ανάλυση που είναι συμβατή με την 
ακολουθία. Οι τίτλοι δεν αναπαράγονται με ασύμβατα πολυμέσα. 
Μπορείτε επίσης να χρησιμοποιήσετε το παράθυρο διαλόγου Media 
Creation για να ορίσετε την ανάλυση και τους δίσκους προορισμού 
για τους τίτλους. 

4. Επιλέξτε ή αποεπιλέξτε την επιλογή Fast Save, ανάλογα με τις 
ανάγκες σας. 

5. Κάντε κλικ στο Save. 
Το εργαλείο Title κλείνει και η εφαρμογή φορτώνει τον νέο τίτλο στο 
Source μόνιτορ. Ένα Title Effect κλιπ, διάρκειας δύο λεπτών, το 
οποίο αντιστοιχίζεται στο νέο τίτλο εμφανίζεται στο bin. 

 
14.11.3 Αποθήκευση πολλαπλών τίτλων σε μία συνεδρία 
Για να αποθηκεύσετε πολλαπλούς τίτλους σε μια συνεδρία: 

1. Από το μενού της εφαρμογής επιλέξτε File > Save Title. 
Ανοίγει το παράθυρο διαλόγου Save Title. 

2. Πληκτρολογήστε μια ονομασία για να προσδιορίζετε τον τίτλο στο 
bin, έπειτα επιλέξτε ένα bin, έναν δίσκο προορισμού και ανάλυση 
από τα μενού. 
Θα πρέπει να επιλέξετε μια ανάλυση που είναι συμβατή με την 
ακολουθία. Οι τίτλοι δεν αναπαράγονται με ασύμβατα πολυμέσα. 
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Μπορείτε επίσης να χρησιμοποιήσετε το παράθυρο διαλόγου Media 
Creation για να ορίσετε την ανάλυση και τους δίσκους προορισμού 
για τους τίτλους. 

3. Επιλέξτε ή αποεπιλέξτε την επιλογή Fast Save, ανάλογα με τις 
ανάγκες σας. 

4. Κάντε κλικ στο Save. 
Το νέο Title Effect κλιπ εμφανίζεται στο bin. 

5. Δημιουργήστε ένα άλλο τίτλο. 
6. Από το μενού της εφαρμογής, επιλέξτε File > Save Title as και 

επαναλάβετε τα βήματα 2 έως 5 για κάθε επόμενο τίτλο που 
δημιουργείτε. 
Η εφαρμογή φορτώνει τους τίτλους στο Source μόνιτορ όπως έχουν 
αποθηκευτεί, έτσι ο πιο πρόσφατα αποθηκευμένος τίτλος 
εμφανίζεται πάντα στο Source μόνιτορ. 
 

14.11.4 Χρήση της συντόμευσης πληκτρολογίου για 
αποθήκευση του τίτλου 
Μπορείτε να χρησιμοποιήσετε τη συντόμευση του πληκτρολογίου που 
είναι ισοδύναμο με την επιλογή ''Save Title As'' από το μενού File του 
εργαλείου Title. Μπορείτε γρήγορα να αποθηκεύσετε την τελευταία 
έκδοση του τίτλου σας, χωρίς να αντικαταστήσετε το αυθεντικό. 
Για να αποθηκεύσετε ένα τίτλο, χρησιμοποιώντας συντόμευση: 

1. Πατήστε τα πλήκτρα Shift + Ctrl + S. 
Ανοίγει το παράθυρο διαλόγου Save Title. 

2. Πληκτρολογήστε μια ονομασία για τον τίτλο. 
3. Επιλέξτε ένα bin, ένα δίσκο προορισμού και την ανάλυση από τα 

μενού. 
4. Κάντε κλικ στο Save. 

 
14.11.5 Χρήση της επιλογής Fast Save 
Μπορείτε να χρησιμοποιήσετε την επιλογή Fast Save για να εργάζεστε 
πιο γρήγορα όταν δημιουργείτε και αποθηκεύετε πολλαπλούς τίτλους 
στη συνεδρία του εργαλείου Title. 
Το Fast Save παραλείπει τα βήματα που δημιουργούν τις anti-aliased 
εικόνες από τα αντικείμενα τίτλων. Αντ' αυτού, μόνο τα ακατέργαστα 
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αντικείμενα κειμένου (κείμενο και γραφικά) αποθηκεύονται στο bin, με 
το πρόθημα ''unrendered''. 
Μπορείτε να επεξεργαστείτε τους τίτλους και να εφαρμόσετε render σε 
αυτούς σε μια πιο κατάλληλη στιγμή. Το Fast Save είναι ιδανικό για 
εργασία με πολυσέλιδους κυλιόμενους τίτλους με πολύπλοκα στυλ και 
σκιές. 
Οι Fast-saved τίτλοι εμφανίζονται ως μαύροι στα μόνιτορ και είναι 
χαρακτηρισμένα  ως ''media offline'' κατά τη διάρκεια της επεξεργασίας. 
Για να χρησιμοποιήσετε την επιλογή Fast Save: 
Ø Επιλέξτε την επιλογή Fast Save (Unrendered) στο παράθυρο 

διαλόγου Save Title όταν αποθηκεύετε τον τίτλο. 
Το Fast Save παραμένει ενεργό μέχρι να το αποεπιλέξετε, να 
φορτώσετε ένα τίτλο που είχε αποθηκευτεί χωρίς να είναι 
επιλεγμένο το Fast Save ή να εξέλθετε από το εργαλείο Title. 

Για να τοποθετήσετε γρήγορα τους unrendered fast-saved τίτλους σε 
bin: 

1. Ανοίξτε το bin που περιέχει τους unrendered fast-saved τίτλους. 
2. Από το μενού της εφαρμογής, επιλέξτε Bin > Select Unrendered 

Titles. 
Οι fast-saved τίτλοι φωτίζονται στο bin. 

14.11.6 Αναθεώρηση του τίτλου στο bin 

Αν θέλετε να αναθεωρήσετε ένα τίτλο ο οποίος δεν έχει επεξεργαστεί 
στην ακολουθία, μπορείτε να το ξανά ανοίξετε στο εργαλείο Title 
κατευθείαν από το bin. 
Για να αναθεωρήσετε τον τίτλο σε ένα bin: 

1. Πατήστε το πλήκτρο Ctrl και κάντε διπλό κλικ στο εικονίδιο Title 
Effect στο bin. 
O τίτλος ανοίγει στο εργαλείο Title. 
Αν το εργαλείο Title είναι ήδη ανοιχτό, μπορείτε να σύρετε το Title 
Effect κλιπ από το bin απευθείας στο εργαλείο Title. 

2. Επεξεργαστείτε τον τίτλο, χρησιμοποιώντας τις τεχνικές που 
περιγράφονται στην ενότητα Editing a Title into a Sequence της 
βοήθειας της εφαρμογής. 
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3. Αποθηκεύστε τον τίτλο με το ίδιο όνομα και τις παραμέτρους 
πολυμέσων (bin, δίσκο προορισμού και ανάλυση) επιλέγοντας File > 
Save Title. 
Το αναθεωρημένο Title Effect κλιπ αντικαθιστά το προηγούμενο 
κλιπ στο bin. Το κλιπ εμφανίζεται επίσης στο Source μόνιτορ/ 
Το εργαλείο Title παραμένει ανοιχτό. Μπορείτε να συνεχίσετε να 
δημιουργείτε  επιπλέον τίτλους ή να επιλέξετε File > Close. 

4.  Αποθηκεύστε τον τίτλο με ένα νέο όνομα ή αλλάξτε οποιαδήποτε 
από τις παραμέτρους πολυμέσων (bin, δίσκο προορισμού και 
ανάλυση) κάνοντας τα παρακάτω: 
α. Επιλέξτε File > Save Title as 
β. Μετονομάστε τον τίτλο ή επιλέξτε άλλες επιλογές από τα μενού 
Bin, Drive και Resolution. 
γ. Επιλέξτε ή αποεπιλέξτε το Fast Save, ανάλογα με τις ανάγκες σας. 
δ. Κάντε κλικ στο Save για να αποθηκεύσετε τον τίτλο και να 
εξέλθετε από το εργαλείο Title. 

 
14.12 Αφαίρεση τίτλων 
Όταν έχετε επεξεργαστεί έναν τίτλο σε μια ακολουθία, μπορείτε να 
αφαιρέσετε ολόκληρο το τμήμα τίτλου ή μπορείτε να αφαιρέσετε μόνο 
τον τίτλο, αφήνοντας το αρχείο πολυμέσων alpha channel στη θέση του. 
 
Για να αφαιρέσετε ένα τμήμα τίτλου: 

1. Κάντε κλικ σε ένα από τα κουμπιά Segment Mode (Extract/Splice-in 
 ή Lift/Overwrite ) στο κάτω μέρος του Timeline. 

2. Επιλέξτε το τμήμα τίτλου και πατήστε το πλήκτρο Delete μια φορά 
για να διαγράψετε τον τίτλο. 

3. Επιλέξτε το τμήμα τίτλου ξανά και πατήστε το πλήκτρο Delete για να 
διαγράψετε το αρχείο πολυμέσων alpha channel του. 

Για να αφαιρέσετε μόνο τον τίτλο: 
1. Κάντε κλικ στο κουμπί Record Track στο Track Selector πάνελ για το 

track στο οποίο εμφανίζεται ο τίτλος. 
2. Μετακινήστε τον δείκτη θέσης στον τίτλο στο Timeline. 
3. Από την παλέτα Tool, κάντε κλικ στο κουμπί Remove Effect. 
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Ο τίτλος παραμένει στο bin. Για να αφαιρέσετε τον τίτλο από το bin, 
κάντε κλικ στο εικονίδιο Title Effect για το κλιπ στο bin και πατήστε 
το πλήκτρο Delete. 

 
14.13 Αντικατάσταση τίτλων 
Μπορείτε να αντικαταστήσετε γρήγορα ένα τμήμα τίτλου στην 
ακολουθία με ένα άλλο τίτλο από το bin. 
Για να αντικαταστήσετε ένα τίτλο στην ακολουθία: 

1. Κάντε κλικ στο κουμπί Lift/Overwrite  στο κάτω μέρος του 
Timeline. 

2. Κάντε κλικ στο τρέχων τμήμα τίτλου στην ακολουθία για να το 
επιλέξετε. 

3. Κάντε κλικ στο κουμπί Mark Clip για να μαρκάρετε ένα In σημείο 
στην αρχή του τμήματος τίτλου και ένα OUT σημείο στο τέλος του 
τμήματος. 

4. Σύρετε το νέο κλιπ τίτλου από το bin στο μαρκαρισμένο τμήμα. 
 

14.14 Σταδιακή εμφάνιση εξαφάνιση τίτλων (Fading) 
Μπορείτε να χρησιμοποιήσετε το κουμπί Fade Effect για να εμφανίσετε 
ή εξαφανίσετε σταδιακά τον τίτλο. Ένα παράθυρο διαλόγου ανοίγει το 
οποίο σας επιτρέπει να εισάγετε ένα αριθμό καρέ για να εμφανίσετε ή 
εξαφανίσετε σταδιακά τον τίτλο χωρίς να ανοίγετε τον Effect Editor. 
Αντί να προσθέτετε Dissolve εφέ που απαιτούν  rendering, μπορείτε να 
χρησιμοποιήσετε το κουμπί Fade Effect για να δημιουργήσετε γρήγορα 
καρέ κλειδιά στον τίτλο με τις κατάλληλες ρυθμίσεις επιπέδων για 
αναπαραγωγή σε πραγματικό χρόνο. Μπορείτε να αλλάξετε τα καρέ 
κλειδιά στο Effect Editor. 
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Κεφάλαιο 15 

Εξαγωγή Υλικού 

Μπορείτε να εξάγετε υλικό κατευθείαν από το Avid σύστημά σας σε 
πολλούς υποστηριζόμενους τύπους αρχείων. Μπορείτε να εξάγετε 
μεμονωμένα καρέ, επιλεγμένη περιοχή των πλάνων ή ολόκληρο το κλιπ 
ή την ακολουθία. 

15.1 Κατανόηση της εξαγωγής 

Υπάρχουν μερικοί λόγοι για τους οποίους μπορεί να θέλετε να εξάγετε 
βίντεο, ήχο ή και τα δυο από το Avid σύστημά σας: 

· Μπορείτε να εξάγετε αρχεία για να εμφανίζονται σαν ταινίες τύπου 
AVI ή Quicktime. 

· Μπορείτε να εξάγετε αρχεία σε τύπο αρχείων RealMedia, Windows 
Media και DV Stream. 

· Μπορείτε να εξάγετε αρχεία ήχου για περαιτέρω επεξεργασία σε 
digital audio workstation (DAW), όπως είναι το σύστημα Pro Tools. 

· Μπορείτε να εξάγετε βίντεο αρχεία για βελτίωση ή για δημιουργία 
ειδικών εφέ σε άλλες εφαρμογές ή σε άλλες Avid εφαρμογές. 

· Μπορείτε να χρησιμοποιήσετε τη διαδικασία εξαγωγής για να 
κάνετε μετατροπή των ηχητικών πολυμέσων από το ένα 
υποστηριζόμενο ηχητικό τύπο σε ένα άλλο. Το σύστημά Avid σας, 
υποστηρίζει τους τύπους AIFF-C και WAVE. 

 

15.2 Προετοιμασία για Εξαγωγή της ακολουθίας 

Αν θέλετε να εξάγετε μέρος ή όλη την ακολουθία - για να 
δημιουργήσετε ένα OMFI, AFF, Quicktime, AVI ή μια γραφική 
ακολουθία, για παράδειγμα- μπορείτε να επιταχύνετε τη διαδικασία 
εξαγωγής προετοιμάζοντας την ακολουθία εκ των προτέρων, όπως 
παρακάτω: 

· Βεβαιωθείτε ότι όλα τα πολυμέσα για την ακολουθία είναι σε 
απευθείας σύνδεση. 
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· Αν η ακολουθία σας περιέχει κλιπ ήχου με διαφορετικό ρυθμό 
δειγματοληψίας, χρησιμοποιείστε το παράθυρο διαλόγου Change 
Sample Rate για να διασφαλίσετε ότι όλα τα κλιπ έχουν το ίδιο 
ρυθμό δειγματοληψίας. 

· Ελέγξτε και ρυθμίστε όλα τα επίπεδα ήχου και ισορροπίας εκ των 
προτέρων. Όλες οι τρέχουσες ρυθμίσεις έντασης και ισορροπίας 
στην ακολουθία μεταφέρονται στα εξαγόμενα πολυμέσα. 

· Για τα OMFI αρχεία, φροντίστε να συγκεντρώσετε την ακολουθία για 
να δημιουργήσετε μικρότερα πηγαία αρχεία, εξοικονομώντας έτσι 
χρόνο και χώρο στο δίσκο. 

· Τα OMFI αρχεία με πολύ περίπλοκη ακολουθία μπορεί να αποτύχει 
κατά την εισαγωγή σε ορισμένες εφαρμογές, λόγω περιορισμών 
μνήμης. Δοκιμάστε μια από τις παρακάτω λύσεις: 
Ø Διασπάστε την ακολουθία σε μικρότερες ακολουθίες και εξάγετε 

τις νέες ακολουθίες. 
Ø Προσθέστε περισσότερη φυσική μνήμη. 

· Για να εξάγετε πολλαπλά κλιπ σε μεμονωμένο OMFI αρχείο, 
δημιουργήστε μια ακολουθία από αυτά τα αρχεία. Για παράδειγμα, 
μπορείτε να επιλέξετε όλα τα κλιπ, να κάνετε Alt + σύρσιμο στο 
Timeline για να δημιουργήσετε στιγμιαία ακολουθία και ύστερα να 
εξάγετε την ακολουθία. 

 
15.3 Εξαγωγή  
Το σύστημα Avid, σας δίνει πολλούς τρόπους με τους οποίους μπορείτε 
να εξάγετε υλικό από το λογισμικό. Μπορείτε να: 
Ø Εξάγετε ένα κλιπ. 
Ø Να μαρκάρετε σημεία και να εξάγετε τμήμα του κλιπ. 
Ø Να εξάγετε τμήμα της ακολουθίας. 
Ø Να εξάγετε ολόκληρη την ακολουθία. 
Ø Να μαρκάρετε σημεία στο Timeline και να εξάγετε τμήμα από το 

Timeline. 
Ø Να εξάγετε πολλαπλά αρχεία από ένα bin. 

Για να εξάγετε υλικό από την εφαρμογή σας, επιλέξτε το υλικό που 
θέλετε να εξάγετε και κάντε τα παρακάτω: 

1. Από το μενού της εφαρμογής, επιλέξτε File > Export 
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Εμφανίζεται το παράθυρο Export As. 
 

 
Εικόνα 15.3.1 Το παράθυρο Export As 
 

2. Ορίστε από το πλαίσιο ''Αποθήκευση σε'' το σημείο στο οποίο 
θέλετε να αποθηκευτεί το υλικό σας. 

3. Δώστε μια ονομασία στο υλικό που θα εξάγετε στο πλαίσιο ''Όνομα 
αρχείου''. 

4. Στο πλαίσιο ''Export Settings'' επιλέγετε πρότυπα εξαγωγής. 
Τα πρότυπα εξαγωγής υπάρχουν στη λίστα αφού δημιουργήσετε 
κάποιο εσείς. Από προεπιλογή η επιλογή αυτή είναι κενή και σαν 
ονομασία εμφανίζεται το Untitled. 

5. Πατήστε το κουμπί Options 
Ανοίγει το παράθυρο διαλόγου Export Settings. 
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Εικόνα 15.3.2 Το παράθυρο Export Settings 

 
6. Πατήστε στο μενού Export As και επιλέξτε τον τύπο αρχείου για την 

εξαγωγή του υλικού σας, μέσα από μια μεγάλη ποικιλία τύπων 
αρχείων. 
Επιλέγοντας τον κάθε τύπο αρχείου, αλλάζουν και οι επιλογές για 
τον εκάστοτε τύπο στο παράθυρο Export Settings. 

7. Κάντε κλικ στην επιλογή Use Marks, εάν έχετε μαρκάρει σημεία στο 
κλιπ ή στην ακολουθία για ένα τμήμα που θέλετε να εξάγετε. Αν δεν 
κάνετε κλικ στην επιλογή αυτή, το σύστημα θα αγνοήσει τα 
μαρκαρίσματα σας και θα εξάγει το κλιπ ή την ακολουθία ολόκληρα. 

8. (Επιλογή) Εάν θέλετε να εξάγετε συγκεκριμένα track από την 
ακολουθία σας, αποεπιλέξτε τα track που δεν θέλετε να εξαχθούν 
και αφήστε μόνο αυτά που θέλετε και κάντε κλικ στην επιλογή Use 
Enabled Tracks. 

9. Κάντε επιπλέον τροποποιήσεις που επιθυμείτε στο παράθυρο 
Export Settings. 
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Μπορείτε να ανατρέξετε στην ενότητα ''Export Settings'' της 
βοήθειας της εφαρμογής για αναλυτικές επεξηγήσεις σχετικά με τις 
ρυθμίσεις του για τον κάθε τύπο αρχείου στο παράθυρο Export 
Settings. 

10. (Επιλογή) Αφού κάνετε τις ρυθμίσεις για τον τύπο αρχείου που 
θέλετε, μπορείτε να τις αποθηκεύσετε για να μην χρειαστεί να ξανά 
κάνετε τις ρυθμίσεις από την αρχή. Για να το κάνετε αυτό, κάντε τις 
ρυθμίσεις που επιθυμείτε και πατήστε το κουμπί Save As. Στο 
παράθυρο Save Export Settings που θα σας ανοίξει, δώστε μια 
ονομασία στο πλαίσιο Settings Name και πατήστε το ΟΚ. 

 
Εικόνα 15.3.3 Το παράθυρο Save Export Settings 
 

11. Αφού έχετε κάνει τις απαραίτητες ρυθμίσεις στο παράθυρο Export 
Settings πατήστε το κουμπί Save. 

12. Στο παράθυρο Export As πατήστε και πάλι το πλήκτρο Αποθήκευση. 
 

Το υλικό που επιλέξατε να εξάγετε, εμφανίζεται στον τύπο αρχείου που 
επιλέξατε και στο σημείο που ορίσατε να αποθηκευθεί. 
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ΥΛΟΠΟΙΗΣΗ ΕΡΓΑΣΙΑΣ 

Για την συγγραφή των κειμένων, χρησιμοποίησα υλικό από τη βοήθεια 
της εφαρμογής και από την ιστοσελίδα http://www.lynda.com/Xpress-
Pro-5-5-tutorials/avid-essential-editing/376-2.html. Βοηθήθηκα κατά 
πολύ από αυτές τις δύο πηγές, διότι κάλυπταν απόλυτα όλες τις 
λειτουργίες του προγράμματος. Τη συγγραφή των κειμένων την 
πραγματοποίησα στο πρόγραμμα Microsoft Word και για την 
επεξεργασία των εικόνων στα κείμενα χρησιμοποίησα το πρόγραμμα 
Adobe Photoshop, που είναι ένα πρόγραμμα για την επεξεργασία των 
εικόνων. 

Για την πραγματοποίηση του DVD, ηχογράφησα τα κείμενα στο 
πρόγραμμα Cool Edit Pro, το οποίο είναι ένα πρόγραμμα ηχογράφησης 
και επεξεργασίας ήχου. Ύστερα, υπό το άκουσμα των ηχητικών κλιπ, 
βιντεοσκόπησα με το πρόγραμμα Camtasia Studio τα εικονικά μέρη. Τα 
επεξεργάστηκα κόβοντας τα μέρη που δεν χρειάζονταν και έβαλα 
τίτλους. Στη συνέχεια εισήγαγα στο Camtasia Studio τα ηχητικά μέρη 
και τα συγχρόνισα με τα εικονικά. Για να περάσω από τη μια ενότητα 
στην άλλη, πρόσθεσα τα εφέ μετάβασης (transitions). Και τέλος, 
εξήγαγα το κάθε κλιπ σε MP4, διατηρώντας την ανάλυση στην οποία 
βιντεοσκοπήθηκαν τα βίντεο.  

Το Camtasia Studio είναι ένα πρόγραμμα καταγραφής των κινήσεων της 
οθόνης και καταγραφής ήχου ταυτόχρονα. Επίσης, σας δίνονται πολλές 
επιλογές για διάφορες επεξεργασίες και προσθήκες τίτλων, εφέ στις 
μεταβάσεις κτλ. Και τέλος, μπορείτε να εξάγετε τη δουλεία σας, σε 
πάρα πολλούς τύπους αρχείων και διαφορετικές αναλύσεις. 

http://www.lynda.com/Xpress
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ΒΙΒΛΙΟΓΡΑΦΙΑ 

Η ιστοσελίδα http://www.lynda.com/Xpress-Pro-5-5-tutorials/avid-
essential-editing/376-2.html. 

Η βοήθεια της εφαρμογής Avid Xpress Pro. 

http://www.lynda.com/Xpress-Pro-5-5-tutorials/avid

